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C H A P T E R  1

System Manager Manual Overview

The System Manager Manual is designed to help you, the system manager, maintain the
Lucent Technologies Messaging 2000 (hereafter referred to as M2000) system installed
at your site. Information presented in this manual will help you monitor the system and
modify certain aspects of it when necessary to accommodate your company’s changing
automated attendant and voice/fax mail needs.

This manual provides information on using all available M2000 features and options.
Some of these features and options may not be available with the specific system
installed at your site. Be sure to contact your Lucent Technologies representative for
information on your system’s unique feature makeup and configuration.
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Your Role as a System Manager

The system manager is the individual representing the company at which the M2000
system is installed. This individual is responsible for administrating and maintaining the
system after installation and serving as a contact point for the Lucent Technologies
representative who installed and supports the system. The system manager may also
serve as a liaison between the phone switch representative and the Lucent Technologies
representative. If the Lucent Technologies representative needs specific information on
the phone system installed at the site, the system manager helps to gather that
information from the phone switch representative.

With respect to the system, the system manager’s responsibilities may include:

• Creating and maintaining system mailboxes.

• Keeping the automated attendant greetings and call routes up to date.

• Monitoring system usage by generating system reports.

• Modifying each subscriber’s access to certain system features depending on a
user’s specific and changing needs.

This System Manager Manual includes the step-by-step procedures for performing these
and other system manager duties.

As you work with M2000, if at some point you feel it is necessary that you modify the
contents of system program files or settings on the System Setup screens, do so only
after consulting your Lucent Technologies representative. Technical modifications made
to files or setup screens may have associated ramifications that could lead to system
functionality problems. In most cases, only certified Lucent Technologies system
installers should make modifications to program files and System Setup screens.

Using the System Manager Manual

The System Manager Manual is organized into chapters that describe general tasks you
may need to complete. These tasks include creating mailboxes, changing system
prompts, setting up network nodes, and many others. Within each chapter are lower-
level procedures that walk you, step-by-step, through the specific task.

To use the manual most effectively, refer to it with a specific task in mind. Simply
consult the table of contents or index to locate the chapter that contains information on
completing that task.

If you or a M2000 subscriber is encountering a specific problem with the system, be sure
to consult the comprehensive Troubleshooting chapter provided in this manual. This
chapter is designed to help you either independently resolve a given program issue or
collect information that will assist your Lucent Technologies representative with
determining a resolution. By consulting the Troubleshooting chapter before contacting
your Lucent Technologies representative, you may save significant time arriving at a
resolution.
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Additional Product Information Sources

In addition to this manual, other information tools are available for the M2000 system:

• Quick Reference Guide – An easy to reference, fold-out card, the Quick
Reference Guide shows system subscribers the telephone keypress navigation
paths to accessing voice mail features. Fifty Quick Reference Guides are
provided with each system shipped.

• Lucent Technologies Messaging 2000 Wallet Card – The size of a typical
business card, Lucent Technologies Messaging 2000 Wallet Cards can be easily
carried by subscribers at all times, providing them fast access to high-level
system navigation information. Fifty Lucent Technologies Messaging 2000 Wallet
Cards are provided with each system shipped.

• Online Help – Extensive online help is available on most M2000 utility and
system screens, including Visual Mailbox screens, to assist M2000 installers,
system managers, and subscribers with using the system. You can access online
help using options on the Help drop-down menu and, in many cases, by pressing
<F1> from program screens.

Keeping Your System Manager Manual Up-to-Date

Periodically, your Lucent Technologies representative may send you additional
information about your M2000 system. This information may document special
functionality considerations of which you must be made aware, or it may instruct you on
using features and options available in M2000 software updates installed on your
system.

The Additional Information tab provided in this manual is an organizational tool designed
to help you retain any supplemental information you receive about the M2000 system.
You may also decide to house M2000 reports you generate or additional notes you
accumulate behind this tab.

The Implementation Information tab is provided as a place behind which you can store
copies of the worksheets you and your Lucent Technologies representative completed
and used during the implementation of your M2000 system. As you or your
representative modify aspects of the system, you may want to update the information on
these worksheets to reflect system alterations.

Tabs for this manual are provided in separate wrapping. Using the color pages in the
manual as a guide, insert the tabs before their corresponding chapters. Place the
Additional Information tab and the Implementation Information tab at the back of the
manual for your later use.
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Notes:
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C H A P T E R  2

Feature and Functionality Overview

The M2000 system provides two general feature sets:  an Automated Attendant and a
voice/fax mail system. The Automated Attendant routes internal and external callers to
phone extensions or subscriber voice mailboxes. The attendant feature includes a
variety of options for controlling the exact conditions under which and techniques with
which calls are addressed and moved throughout a company’s phone system.

M2000 voice/fax mail features allow callers and subscribers to send and receive both
voice and fax messages in system mailboxes. An array of available mail options puts
callers and subscribers in complete control of their communications.

You can choose to use either or both Automated Attendant and voice/fax mail features
when implementing an M2000 system. Note, however, that voice-mail-only systems
cannot transfer callers to extensions or to subscriber mailboxes. These tasks must be
done by an operator if the Automated Attendant feature is not active.

Some of the features and options described in this chapter may not be available with the
specific system installed at your site. Be sure to contact your Lucent Technologies
representative for information on your system’s unique feature makeup and
configuration.
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Understanding Automated Attendant Capabilities

M2000’s Automated Attendant can be easily programmed to meet any organization’s
unique needs and preferences. While it is perfectly capable of answering all incoming
calls, you may elect to have it handle only those the live operator is unable to take. This
may include overflow calls during peak hours or calls that come in after hours, on
weekends, or during holidays. The Automated Attendant assures that callers are never
lost, forgotten on hold, or left listening to an unanswered phone’s eternal ring.

The M2000 Automated Attendant saves money by controlling the number of people an
organization must assign to call-answering duties and gives existing phone receptionists
time to handle more important duties.

Call Handling

M2000 provides flexible call-handling options that can be easily customized to meet the
exact needs of an organization.

Call Blocking

Call blocking routes calls directly to a voice mailbox without ringing a phone. This
feature helps to limit work interruptions, and callers are extended the courtesy of the
quickest possible transfer.

Call Forwarding

Call forwarding routes a call to ring an extension other than that originally entered. A
subscriber can use this feature to transfer important calls to another subscriber when the
original subscriber is unavailable, or to receive calls when in another subscriber’s office.
Call forwarding improves customer service by ensuring that important incoming calls are
handled personally.

Call Queuing

Call queuing allows callers to hold if an extension is busy. The system can be set up to
periodically announce holding callers’ positions in the queue and offer them options to
leave a voice-mail message, speak to an operator, transfer to another extension, or
disconnect. Prerecorded music or informative messages may be played to callers in
queue. Since queuing reduces hang-ups by easing the discomfort callers experience on
hold, it saves money by minimizing potentially expensive long-distance callbacks.

Call Screening

When call screening is activated, the system asks for the caller’s name and announces it
to the subscriber being phoned. The subscriber can accept or reject the call, or have it
redirected to another extension. If the call is rejected, the system informs the caller there
was no answer at the extension and offers options to leave a message, transfer to
another extension, speak with an operator, or disconnect. With call screening,
subscribers can choose when they are to be interrupted, accepting important calls and
redirecting those that can be handled later or by someone else.
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Intercom Paging

If the telephone system is equipped with a supported intercom paging feature, callers
can be offered the option of paging a subscriber when there is no answer at an
extension. After paging the subscriber, the system rerings the extension to deliver the
call. Intercom paging helps assure that subscribers are made aware of incoming calls
when they in the office but away from their phones.

Intercom Redirect

Intercom redirect gives subscribers with properly equipped telephone systems the ability
to respond to an intercom page from any extension—not just their own. When
subscribers are paged (“There is a call for <subscriber’s name>”), they need only dial
into the system from the nearest extension, enter their mailbox number, and enter the
extension number of the telephone they are using. The system then routes the call to
that extension. The mailbox owner’s name prompt is automatically voiced when calls are
transferred by intercom redirect, helping ensure the call is being transferred to the
appropriate subscriber.

Extension Directory

Callers who do not know the mailbox number of the subscriber or department they are
trying to reach can press a specified key to access the system’s employee or
departmental directory. Callers transfer to subscriber extensions by entering the first few
letters of the subscriber’s last name on the phone keypad.

Fax Tone Transfer

The system can transfer calls automatically to a fax machine when it detects a fax tone
during the Automated Attendant’s greeting.

Greeting by Port

Different greetings can be designated for various system ports. In such scenarios, each
port is totally partitioned from—and transparent to—the rest, ensuring independence
regardless of system configuration, subscriber call-handling selections, or directory use.
Using greeting by port, several businesses in an office (or several divisions within a
company) can share a single system.

Holiday/Time of Day Programmable Messages

On select dates, M2000 systems can play holiday greetings to callers. Greetings can be
prerecorded, covering up to 18 national, state, and/or local holidays. Personalized
holiday greetings may be retained, allowing their re-use in subsequent years. M2000
systems also answer calls with separate greetings for morning, afternoon, evening, and
after hours.

Name Prompt on Transfer

Name prompt on transfer is invaluable when two subscribers share a single phone, or
when a single subscriber performs more than one job. If this option is activated, the
subscriber hears, “There is a call for <subscriber’s name>,” instead of, “One moment,
you have a call,” when the auto attendant transfers calls. If, for example, the Automated
Attendant says, “For accounting, press 1; for customer billing, press 2...,” and both
actions ring the same extension, subscribers will be prompted as to which department’s
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phone they are answering (for example, “There is a call for accounting...” or “There is a
call for billing...”).

Multilingual Prompts

The system may be equipped with an optional module that allows it to offer callers and
subscribers syntactically correct prompts in languages other than English. Language
library modules include prerecorded phrase files and syntax tables custom designed for
the selected language.

Understanding Voice/Fax Mail Features

By eliminating the need for the simultaneous presence of both parties when important
information must be conveyed, voice mail maximizes the opportunity for every
telephone call to communicate effectively. With voice mail, messages are never lost,
garbled, or only partially delivered.

Systems equipped with the optional Fax Solution™ module allow subscribers to apply
the same power to fax communications. By shifting control of the fax machine to its
users, fax mail allows printed information to be more easily exchanged.

With voice mail and fax mail, information—both spoken and written—can be placed in a
mailbox at any time, from any location, using standard Touch-Tone phones and fax
machines. A subscriber’s access to this information is the same any time, from any
location, with just a telephone and a fax machine.

Mailbox Interfaces

The system’s mailbox interfaces allow subscribers to personalize, utilize, and easily
maintain their mailboxes.

Telephone Interface

With the telephone interface, subscribers use simple keystroke responses to system
prompts to access full system functionality from any Touch-Tone phone.

Visual Mailbox™

Visual Mailbox ties the subscriber’s computer to the telephone, thus allowing the
subscriber to take advantage of the features provided with each communication
medium.

With Visual Mailbox, a glance at the monitor relays how many messages a subscriber
has, who they are from, the day and time they were delivered, and their length. Icons
indicate whether the messages are voice or fax (or voice and fax), their delivery type
(normal, urgent, private, etc.), and whether they have been forwarded by another
subscriber. Space is provided for subscribers to add textual notes, helping them
recognize and/or categorize their messages for future reference.

Subscribers can listen to, save, or delete messages by simply pointing and clicking the
mouse. Icons indicate that messages have been saved or deleted, and subscribers can
change their minds at any time during the current session. Clicking on a fax message
activates the Fax Viewer, which allows subscribers to read, print, save, and/or export
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faxes. A unique fax rotation option allows subscribers to properly view faxes in both the
portrait (standard letter) or landscape (spreadsheet) orientations.

To copy, forward, or broadcast a message, subscribers need only request a mailbox
directory and click on the name of the intended recipient or list of recipients.

Mouse-driven “tape deck” controls make recording messages and greetings simpler and
more precise than ever. While recording, subscribers can pause, start over, or cancel the
message, and an append button lets subscribers continue recording or add more to the
end of a message. A confirmation message, similar to those provided by most e-mail
packages, can be generated when messages that subscribers send are received.

A Call Handling screen provides a graphical interface with which subscribers may
activate call blocking and pick specific handling options for incoming calls. Subscribers
may also select handling options for ring-no-answer and busy conditions when their
extensions are not blocked.

Mailbox Personalization

M2000 systems provide a number of features that allow subscribers to personalize their
mailboxes, making caller interactions comfortable.

Mailbox Default Operators

The system manager can assign a different default operator to each mailbox on the
system. When a caller presses <0> for an operator, the system transfers the caller to
that mailbox’s default operator instead of the regular operator. This allows separate
departments or subscribers to have calls taken by their own receptionists when callers
request an operator.

Mailbox-Specific Busy and No-Answer Greetings

The optional personal prompts, when activated, replace the standard system prompt
telling  callers that an extension is busy or that there is no answer. Unique (and
frequently updated) busy and no-answer greetings allow subscribers to further
personalize their voice mailboxes.

Personalized Prompts

Personalized voice prompts, in the subscriber’s own voice and tone, inform callers
immediately if they have reached the correct extension or mailbox. Available
personalized prompts include the subscriber’s name, directory listing, a please hold
prompt, a personal greeting prompt, and two optional prompts.

Leaving Messages

A large percentage of voice information management technology’s success lies in the
ease with which it allows its users to leave messages for each other.

Message Notification/Multiple Address Message Delivery

The system can dial up to eight different telephone or beeper numbers when messages
are received in a mailbox. Subscribers select the days and time frames they want to be
notified (for example, Monday through Friday, 10:00 AM to 8:00 PM), and the number at
which they want to be called. They may also choose whether they want to be notified
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upon receipt of all messages or only when their callers have marked their messages
“urgent.”

When subscribers are not sure where they will be, the system can be set to call a series
of numbers sequentially. This capability, called cascade outcalling, can be a particularly
valuable communication tool for companies with subscribers who work outside the office.

Future Delivery

Subscribers can place a message in the system to be delivered to themselves or another
subscriber at any time, on any specified date, up to a year in advance.

Message Confirmation

Message Confirmation allows subscribers to check the date and time a message they
sent to another subscriber was received. When subscribers request message
confirmation, the system announces the recipient’s name, the date and time the
subscriber sent the message, and the date and time the message was received, as well
as the duration of the message.

Message Sending Options

Subscribers can assign conditions to voice and fax messages they leave in another
subscriber’s mailbox, restricting or prioritizing their handling. Messages to local
subscribers can be marked “normal,” “listen-only,” “private,” or “urgent.”

Voice messages marked “listen-only” cannot be saved, skipped, or transferred—only
listened to and deleted. This capability provides extra security and reduces demand on
the system’s message file memory space.

Messages marked “private” cannot be forwarded or copied by the recipient. This
measure helps assure confidentiality.

Both outside callers and subscribers have the option of marking their messages “urgent.”
“Urgent” messages are placed at the top of the subscriber’s new message queue and are
always voiced first.

Multiple Message Capability

Callers who want to leave messages for more than one subscriber may do so without
redialing.

Sent Message Editing

As long as a subscriber receiving a message has not listened to or skipped the message,
the sending subscriber can delete, rerecord, review, or append additional information to
a previously sent message.

Wake-Up Messages

The system can be programmed to deliver wake-up calls at any time to any phone
number. Once called, subscribers may reschedule the wake-up with options to retain or
change the time and phone number.
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Message Retrieval

M2000 systems provide an assortment of features that pertain to retrieving and listening
to messages.

Automatic Date and Time

The system can be set to automatically voice the day and time each message was
received when subscribers listen to messages.

Automatic Station Login and Password

If the phone system is so equipped, subscribers can save time by directly accessing their
mailbox when calling from their own extensions. While the use of password security is
highly recommended, the system can also be configured to allow subscribers to access
their mailboxes without entering their passwords when they call from their own
extensions.

Message Deletion Notification

Saved messages are deleted automatically when they remain in subscribers’ mailboxes
for the maximum number of days the system manager has specified. When message
deletion notification is enabled, the system will alert subscribers before it deletes expired
saved messages. This helps subscribers keep from inadvertently losing important
information when expired messages are deleted.

Message Information

Message information provides the date and time a message was received, the length of
the message and if it was sent by another subscriber, that person’s name.

Message Rewind/Hold/Fast Forward

Subscribers can rewind, pause, or skip ahead in a message being played. These
functions improve productivity by helping subscribers obtain the important information
from messages as quickly and easily as possible.

Message Scanning

Subscribers can scan their mailboxes for new messages from a particular subscriber.
Other messages are skipped for later review.

Message Speed and Volume Control

Depending on the voice boards, Touch-Tone commands can allow subscribers to
increase the speed and/or volume of messages upon playback. The caller’s original pitch
is maintained even when message speed is altered.

Message Indicators

Depending on the type of phone system, the system can notify subscribers when voice
or fax messages are placed in their mailboxes. If the phone has a message indicator, a
glance provides visual notification that a message is waiting. Otherwise, the system can
be programmed to ring the subscriber’s extension periodically when messages are
waiting.
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Saved Messages

Subscribers can save new voice and fax messages for reference at a later time, helping
to assure that their content is preserved and fully understood.

Recover Deleted Messages

Subscribers can recover messages they have accidentally deleted during the current
call. Upon request, the system plays back all messages deleted during that call.
Subscribers can press <1> to restore the message to the queue from which it came (new
or saved) or <2> to leave the message deleted.

Skip Messages

A subscriber can skip a message while listening to it, leaving it in the new message
queue to review later. This allows subscribers to conserve time by listening only to
messages they need at the moment, saving personal or other noncritical messages for
review when time permits.

Message Management

M2000’s message management functions help subscribers digest, store, and
disseminate information with unprecedented efficiency.

Auto Forward

The system manager can have messages that have not been listened to within a
specified time automatically forwarded to a preselected mailbox. This feature helps to
ensure prompt action, an absolute necessity in efficient customer service.

Distribution Lists

Subscribers can send the same voice or fax message to a number of subscribers with a
single call. Distribution lists can contain any combination of destination mailboxes (local
and/or networked) or other distribution lists. Subscribers can also use global distribution
lists to reach every mailbox in a company or division.

Integrated Telephone Answering

When one subscriber leaves a voice-mail message to another subscriber, the second
subscriber can reply to the message or transfer to the subscriber who left the message
with one or two keypresses.

Network Message Forwarding

With network message forwarding (also known as Follow-Me-Forward), subscribers on
systems equipped with the optional Network Interface Module can elect to have
messages received in their mailboxes automatically forwarded to a destination mailbox
on another (Network-equipped) system. By centralizing messages in a single mailbox,
network message forwarding helps busy subscribers eliminate the need to check
mailboxes on multiple voice-mail systems.
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Online System Displays and Reports

Data on the usage of all mailboxes is recorded and made available to the system
manager through a selection of system displays and reports. Online system displays and
reports, including port contention, mailbox status, and hourly statistics, can be viewed
onscreen, saved to disk, or printed.

Send Copy of Message

Subscribers can send a copy of a message they receive to one or more subscribers or
network destinations and preface the message with comments. Subscribers can access
directories directly from their mailboxes if they do not know the extensions of other
subscribers to whom they want to direct the message.

Transfer or Reply to Sender

When subscribers receive voice-mail messages from other subscribers, they can either
transfer to the sender’s extension or send a reply message with just one keypress.

Folders

Subscribers can create up to nine folders in their mailboxes to organize saved voice and
fax messages. Voice folders, for example, can be created for individual callers, projects,
or dates. Messages received on these topics can then be saved in the appropriate folder.
When subscribers create new folders, they are prompted to record a descriptive folder
label. This label is voiced each time they choose the folder. The system is also equipped
to play for the subscriber a directory of all currently defined folders.

Specialty Mailboxes

M2000 systems support the creation and maintenance of several types of specialty
mailboxes for unique business needs.

Guest Mailboxes

Visitors, clients, and VIPs can be granted limited access to system features temporarily
with guest mailboxes. Guest mailboxes improve the ability to work with important outside
contacts.

Receive-Only Mailboxes

Receive-only mailboxes can be set up to collect information such as names, addresses,
and phone numbers from individuals who call the company. This feature can serve as an
important aid to customer service and/or marketing by allowing representatives to
address inquiries in the most timely and efficient manner possible.

Voice-Only Mailboxes

A system manager can set up announcement mailboxes that play prerecorded voice
information to callers. Voice-only mailboxes are beneficial in advertising, marketing,
public relations, and many other “call-for-more-information” applications.
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Mailbox Security

A carefully designed array of mailbox security features protect the system and the
information it contains.

Password Protection

Individuals can access voice and fax messages in mailboxes only after entering a user-
defined password. For additional security, the system manager can impose a minimum
password length default. The system can also be set to require subscribers to press the
<#> key after entering a password.

Forced Password Change

Subscribers can be forced to change their passwords at system-manager-selected
intervals. When a subscriber changes a password (either voluntarily or due to the forced-
change feature), the system will not accept a new password that matches the current
password.

Mailbox Passwords

When creating mailboxes, the system manager can either enter a default password or
have the system generate random passwords for each new mailbox.

V-Tree Password

The system can be programmed to require users to correctly enter a password (up to 11
digits) to progress from level to level within custom applications generated using V-
Trees. Placing password security at strategic levels within V-Trees gives callers
measured access to custom applications. For additional information on the V-Tree
feature, refer to the topic, "V-Trees," later in this chapter.

Fax Solution Fax Mail

Fax Mail

Subscribers can receive faxes regardless of the state of the fax machine—whether it’s
busy, out of paper, or even out of order. Like voice messages, a subscribers can retrieve
faxes in their mailbox at their convenience. When in the office, a subscriber can make a
single keypress to direct the fax messages to the default fax machine. Faxes retrieved
through Visual Mailbox can also be directed to print on a printer attached to the
subscriber’s PC. When out of the office, the subscriber can enter the telephone number
of the nearest fax machine and receive fax messages immediately, regardless of
location, time of day, time zone, etc. The system manager can set FaxComm hardcopies
to include a cover sheet, indicating the receiving subscriber’s name or extension
number, division, and company name.

Access to fax communications is password protected, and hardcopies of faxed
communications are only produced when a subscriber requests them.

Personal Default Fax Number

Subscribers who receive fax mail can specify fax machine numbers that override the
system default. A single keypress directs faxes to a departmental (or personal) machine.
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Fax AutoPrint

Subscribers with fax mail may elect to have all new faxes sent directly to a fax machine
(either system or personal default). In situations where security is less of an issue than
speed and accessibility, fax AutoPrint can significantly enhance productivity.

Voice Message Cover Sheets

Senders can preface their FaxComm faxes with voice messages, which is faster, more
effective, and less expensive than the traditional cover sheet.

V-Trees

Tools provided with M2000 allow system managers and subscribers to build unique
menus called V-Trees within mailboxes on the system. A V-Tree in a mailbox functions
like the Automated Attendant on a system-wide basis—the
V-Tree can route calls reaching the mailbox to different extensions or mailboxes, can
prompt the caller to answer a series of questions, can voice information (such as product
information) to the caller, and can even fax information to the caller—all depending on
the caller’s keypress selections. When you create a V-Tree, you record prompts for the
V-Tree that voice all the options available to callers when they reach the V-Tree.

V-Trees can significantly reduce the time employees spend performing basic, repetitive
tasks. A simple V-Tree can, for example, provide callers with options to hear answers to
common product questions, transfer to a specific department in the company, or leave
product orders. The optional Fax Solution module provides capabilities for setting up a
V-Tree to automatically fax certain documents to callers who request them.

Interview V-Trees (Forms-Filler V-Trees)

An interview-oriented V-Tree requests and collects information from callers. This type of
V-Tree can survey for customer satisfaction, for example, requesting callers’ names, the
products and/or services they use, their impressions of the products, and their
suggestions for improvements. All responses to an interview V-Tree are grouped in a
single message for playback by the mailbox owner.

Call-Routing V-Trees

A call-routing-oriented V-Tree provides callers with easy Touch-Tone phone access to
any department or subscriber in the company. By giving callers quick, simple, and
unassisted access to the exact subscriber or department they need in a given situation,
call routing can be the heart of a number of productivity- and customer service-
enhancing V-Trees.

Fax-on-Demand V-Trees

An information-on-demand-oriented V-Tree provides multilevel menus of information in
a mailbox. These menus can give callers access to spoken (audiotext) and written (fax
retrieval) information, 24 hours a day. Information-on-demand can significantly reduce
the time personnel spend answering routine questions.

Audiotext

Audiotext gives callers answers to frequently asked questions without requiring the
intervention of busy employees. Prerecorded messages placed in the system can, for
example, give callers directions to the company’s office or information on special sales
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promotions. Such information can be placed in easily updated announcements,
accessible 24 hours a day. Audiotext boosts productivity while improving customer
service by providing callers with Touch-Tone access to frequently requested information.
Callers get the facts they need quickly, and employees are left to handle more valuable
tasks with fewer interruptions.

Fax Retrieval

With Fax Retrieval, the company, its departments, or even individual subscribers can
offer callers the opportunity to request and receive faxed copies of documents stored in
the system. After requested (via the keypad), documents are transmitted automatically,
any time of day or night, to the fax machine of the caller’s choice. Frequently requested
documents, such as credit applications or order forms, are ideal candidates for Fax
Retrieval. Other productivity-enhancing possibilities include customer-service
documents, maps, legal documents, and sales promotions.

V-Tree Generation Interfaces

M2000 systems offer graphical and non-graphical V-Tree generation tools.

Generation with Visual V-Tree™ or Visual Architect™

Visual V-Tree and Visual Architect are graphical interfaces for creating V-Trees in
system and subscriber mailboxes. By incorporating today's most effective software tools,
like drop-down menus, toolbars, and point-and-click mouse operations, Visual V-Tree
and Visual Architect make it extremely easy for system managers to build intricate V-
Trees. Prompts to accompany the V-Tree are recorded using V-Edit™, M2000’s powerful
integrated voice editor.

Generation with the Telephone Interface

Subscribers can create custom V-Trees for their own mailboxes using the system’s
telephone V-Tree capabilities.

Enterprise-Wide Communications

AMIS Interface Module (AIM™)

Using the internationally-recognized Audio Messaging Interchange Specification (AMIS),
the optional AMIS Interface Module allows M2000 systems to exchange voice
information with AMIS-compatible voice-processing systems in satellite offices, vendor
locations, or other remote sites.

Using AMIS’s administered networking capabilities, the system manager can assign a
node number to each of the AMIS-compliant systems with which messages will be
exchanged. The node number serves as a code that represents the complete phone
number one must traditionally dial to access the remote system. When remote sites
have assigned node numbers, subscriber’s who want to send messages to mailboxes at
those sites must enter only the node number and the destination mailbox number.
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OctelNet™

Similar in nature to the AMIS Interface Module, the optional OctelNet module allows
M2000 systems to exchange voice information with other OctelNet-compatible voice
processing systems in satellite offices, vendor locations, and other remote sites. Unlike
AMIS, however, OctelNet provides subscribers communicating with remote supporting
systems with access to all the message-processing options (except fax mail) normally
available during inter-site communication, such as message confirmation, dial by name,
and more. As with AMIS’s administered networking capabilities, subscribers using
OctelNet need only enter node numbers and destination mailbox numbers when sending
messages to remote systems.
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Notes:
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C H A P T E R  3

Starting, Logging Into, and Shutting Down the System

Occasionally, you may be required to shut down and restart the M2000 system if
maintenance tasks must be performed or if the system stops for some reason, such as a
power failure. For security, the system requires you to enter a password before you can
access shutdown, maintenance, or setup functions. The procedures provided in this
chapter will help you to:

• Start the system.

• Log into the system using a password.

• Shut down the system.

• Disable ports.
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Starting the System

During installation, your Lucent Technologies representative may have configured
M2000 to start automatically any time the PC is restarted. If M2000 is not configured to
start automatically after a restart, you can use the following procedure to restart it.

To start the system:

1. Turn on the M2000 PC if not already running.

2. To open the program folder, double-click the Lucent Technologies icon on the OS/2
desktop. The folder contents display.

3. To start M2000, double-click the Lucent Technologies Messaging 2000 icon. The
main system window displays and the system is ready to answer calls.

Understanding System Security

M2000 controls access to system maintenance and setup functions by requiring
passwords to perform supervisor tasks. There are two levels of supervisor passwords:

• Level 2 – Level 2 access allows a supervisor to create, edit, and delete
mailboxes; access reports and system statistics; create and specify prompts;
maintain network nodes; and create V-Trees. The default Level 2 password is
12345.

• Level 3 – Level 3 access allows a supervisor to perform all Level 2 tasks, to set
system parameters using the System Setup module, configure greetings by port,
modify classes of service, and configure multilingual M2000 systems. The
default Level 3 password is 67890.

You can define only one Level 2 password and one Level 3 password on the system.

When giving the Level 2 or Level 3 password to supervisors, keep in mind that the more
people who have a password, the greater the possibility for problems to occur. However,
there should be more than one individual who knows the passwords for the system so
that when one supervisor is away from the office, another is available to maintain the
system.

Logging Into the System

You can access system setup and maintenance features either through the phone
interface or by using the M2000 PC screen interface. Using the phone interface, you can
create and edit mailboxes, record system prompts, and update distribution lists. To
access supervisor functions over the phone, at least one mailbox must exist on the
system with the supervisor feature enabled in that mailbox’s class of service.

Using the M2000 screen interface, you can perform the functions available through the
phone interface (with the exception of creating and editing distribution lists) as well as
access and modify network nodes, set up and record system prompts, and view system
reports and statistics.
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To log into M2000 through the phone interface:

1. Pick up the handset and dial the system access number.

2. Access a mailbox that has been assigned supervisor rights. The subscriber main
menu voices.

3. From the subscriber main menu, press <9> to access the supervisor functions.

4. When prompted, enter the supervisor password. The system voices the supervisor
main menu.

To log into M2000 using the screen interface:

1. From the File menu, select the Password option. The Supervisor Password dialog
box displays.

 

2. Enter the password in the field by either typing in the numbers using the M2000 PC
keyboard or use the mouse to click the onscreen button keypad. For additional
security, the password displays in the field as a series of asterisks (*).

3. Under Logoff In_____ Minutes, enter the maximum amount of time after supervisor
inactivity before the system automatically logs out of the security access. In most
cases, the default, 10 minutes, should be sufficient.

4. Click OK. The Password Accepted dialog box displays. Click OK to close the dialog
box. You are logged in and the main system window displays.

Changing Passwords

For additional security, it is recommended you change supervisor passwords from their
default settings. Note that if you change the Level 2 and Level 3 passwords to the same
password, you will only be able to access Level 2 features; therefore, the two passwords
must be different. Though the passwords can be alphanumeric, it is recommended you
assign passwords that contain only numeric characters, so you can access supervisor
functions through the phone interface.

If you change the Level 3 password, be sure to notify the representative who installed
the M2000 system of the new password.
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To change a supervisor password:

1. To change the Level 2 password, log into M2000 as a Level 2 supervisor. To change
the Level 3 password, log into M2000 as a Level 3 supervisor.

2. From the File menu, select Change Password. The Change Password dialog box
displays. The dialog box displays the password level that can be changed.

 

3. Enter the new password in the first field using the M2000 PC keyboard. The new
password must be between two and nine characters in length. For security, the
password displays in the field as a series of asterisks (*).

4. Verify the password by reentering it in the second field. For security, the password
displays in the field as a series of asterisks (*).

5. To accept the new password, click OK. The Change Password dialog box closes and
the main system window displays. The new password is in effect the next time you
log in.

Logging Off the System

When you finish performing supervisor tasks on the M2000 PC, be sure to log off from
the system. This reduces the possibility of an unauthorized person gaining access to the
system when you leave the M2000 PC.

To log off the system:

1. From the File menu, select the Logoff option. A Message dialog box displays
informing you that you are logged off.

 

2. To close the Message dialog box, click OK. The main system window displays.

Shutting Down the System

You must exit M2000 to use certain utilities such as V-Edit, Quick Assist, or Dial Plan
and to install system updates or upgrades. When you exit M2000 using the procedure
below, the system disables ports as soon as they become inactive. When all the ports
are inactive and disabled, the main system window closes, and the system software
shuts down.
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To shut down the system:

1. Log into M2000 as a Level 2 or 3 supervisor. For additional information, refer to the
topic, "Logging Into the System," earlier in this chapter.

2. To shut down the system, select Exit from the File menu. A dialog box displays a
message prompting you to indicate how to shut down the system.

 

3. Click OK to perform the shutdown. A dialog box displays a message asking if you
want to wait for channel activity to cease. Wait for channel activity to cease. Do not
click Force. When all the ports are inactive, the system shuts down.

If the M2000 system does not shut down in a few minutes, you may perform the
procedure to shut down the system again, and click Force when the Shutdown the
System dialog box displays. However, Force causes the system to issue a drop
command to the remaining active ports, which terminates calls. Selecting Force is not
recommended since callers are dropped without warning. If the M2000 system does not
shut down within a few minutes after you select Force, contact a Lucent Technologies
technical support representative.

Never shut down the M2000 system by turning off the PC or pressing
<CTRL+ALT+DEL> to restart, as this could cause severe data corruption.

Disabling Ports and Dropping Calls

M2000 allows you to shut down ports temporarily if phone lines connected to the system
are temporarily out of service. This prevents the port from trying to send calls or
messages when the line is not available. Disabling a port using the procedure below is
only temporary, and the system will enable the port if the system restarts.

M2000 also allows you to drop a call on a port. You should only use this option when you
receive reports that a port is constantly busy, or you see that the status line next to the
channel number button in the Channel Status window displays a status other than
Waiting for Ring for an excessive amount of time.

If you determine that you need to drop a call on a port, and the status in the Channel
Status window displays EXTERNAL APPLICATION, contact a Lucent Technologies
technical support representative.
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To disable a port:

1. Log into M2000 as a Level 3 supervisor. For additional information, refer to the topic,
"Logging Into the System," earlier in this chapter.

2. In the Channel Status window, click the Channel number button for the port you want
to disable. The Channel (number) pop-up menu displays.

 

3. Click Disable. If there is a call on the port, the port is disabled when the call ends.
The Channel Status window displays the status Disabled next to the Channel
number button.

To enable a port:

1. Log into M2000 as a Level 3 supervisor.

2. In the Channel Status window, click the Channel number button for the port you want
to enable. The Channel (number) pop-up menu displays.

 

3. Click Enable. The Channel Status displays the status Waiting for Call or Waiting for
DID next to the Channel number button.

To drop a call from a port:

1. Log into M2000 as a Level 3 supervisor.

2. In the Channel Status window, click the Channel number for the port you want to
drop. The Channel (number) pop-up menu displays.

 

3. Click Drop. The call is terminated, and the Channel Status window displays the
status Waiting for Call or Waiting for DID next to the Channel number button.
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C H A P T E R  4

Managing System Mailboxes

System mailboxes are one of the primary ways that users interact with M2000.
Mailboxes allow users to record messages, store messages, and perform many other
actions on the system. Procedures provided in this chapter will help you to:

• Create mailboxes.

• Edit a mailbox.

• Delete a mailbox.

• View mailbox information.

• Search for a mailbox.

• Automatically forward messages to other mailboxes.

• Notify subscribers of new messages through a phone or a beeper.

• Manage mailbox subscriber settings.

• Clear mailbox information.

• Unlock mailboxes

• Understand Class of Service options

• Using dialing codes

The procedures in this chapter provide steps for managing system mailboxes using the
screen interface. You can also perform some system mailbox management functions via
the Supervisor menu over the phone. For information on accessing the Supervisor menu
over the phone, see Chapter 3, “Starting, Logging Into, and Shutting Down the System.”
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Creating Mailboxes

When you create mailboxes, it is important that each mailbox has the appropriate
features available for its purpose on the system. Mailboxes you create for subscribers
may need very different features than mailboxes that are used simply to store messages
or handle calls. To help you create mailboxes more efficiently, M2000 provides
techniques you can use to create:

• A single mailbox

• A single copy of an existing mailbox

• Multiple mailboxes with different features

• Multiple mailboxes with the same features

• A guest mailbox, which uses another mailbox as a sponsor

Knowing the needs of M2000 subscribers can help you determine how you create
mailboxes. For example, if you need to create mailboxes for 20 new employees who all
need the same mailbox features, you can create 20 mailboxes with the same features
simultaneously, only having to enter an employee name and extension for each.

See Preinstallation Configuration Worksheets

When creating system mailboxes, refer to information provided on the Mailbox
Assignment Sheet(s).

Things to Consider Before Creating Mailboxes

Before you create any mailboxes, you should consider the purpose and needs of the
subscriber. This enables you to determine how you will create the mailboxes. When you
create mailboxes, you must specify the following information for each mailbox:

• Mailbox number.

• Subscriber’s extension.

• Subscriber’s name.

• Company.

• Division.

• Password.

You can also enter a personal operator for a mailbox and set special mailbox features
such as class of service, subscriber settings, auto-forwarding of messages, Message
Notification, and V-Trees. It is recommended that you collect and organize this
information before you create any mailboxes, so you can generate the appropriate
mailboxes with the least amount of effort.
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Creating a Single Mailbox

Use this procedure to create one mailbox on the system. This procedure allows you to
specify mailbox information and features for a single mailbox. For additional information
about creating mailboxes, see the topics, "Creating a Single Duplicate Mailbox,"
"Creating Multiple Mailboxes," or "Creating Multiple Duplicate Mailboxes," later in this
chapter.

It is recommended that you use this procedure to create a mailbox with unique features
or a mailbox that will be used as a template to create other similar mailboxes.

To create a mailbox:

1. From the Mailbox menu, select Create. The Create Mailbox dialog box displays.

 

2. In the Create ____ Mailboxes field, enter 1 to indicate that you want to create one
mailbox.

3. In the Starting with Number field, enter a mailbox number for the new mailbox. For
easier organization, it is recommended that the mailbox number be the same as the
mailbox subscriber’s extension.

4. To select mailbox features, click Create. The Mailbox Entry dialog box displays with
the mailbox number displayed in the Mailbox field.

 

5. If the mailbox subscriber’s extension is different from the mailbox number, enter the
extension for the mailbox in the Extension field.

6. In the First Name field, enter the first name of the mailbox subscriber.

7. In the Last Name field, enter the last name of the mailbox subscriber.

8. In the Company Name field, enter in alphanumeric characters the name of the
company to which the mailbox subscriber belongs. The company name you enter
allows subscribers to send messages to all subscribers in the same company through
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system-wide distribution lists. Note that the company name must match the company
name entered for other mailboxes exactly.

9. In the Division field, enter in alphanumeric characters the name of the division to
which the mailbox subscriber belongs. The division name you enter allows
subscribers to send messages to all subscribers in the same division through
system-wide distribution lists. Note that the division name must exactly match the
division name entered for other mailboxes.

Mailboxes for which you specify no Company or Division receive all messages sent
to company list 99 or division list 98, respectively.

10. If the system is not set up to automatically generate a password, and you want the
mailbox to have a password, enter the password for the mailbox in the Password
field. The system displays the password as asterisks (*) for added system security.

It is recommended that you use the password automatically generated by the
system. If the system is set up so that no password is required for a mailbox, a
password is not generated by the system and the field is blank. If the system is set
up to use a default password for each mailbox, the default password, usually 1111, is
automatically assigned to the mailbox. If the system is set up to generate a random
password, a dialog box displays the mailbox number and the random password
generated for the mailbox, when you save the mailbox. Record the mailbox
password at that time and provide it to the mailbox subscriber.

11. If the mailbox requires a personal operator other than the default operator, enter the
mailbox number of the personal operator. The personal operator feature allows you
to assign a mailbox to a mailbox other than the system operator mailbox. For
example, you can assign the sales receptionist’s mailbox as the personal operator
mailbox for all subscribers in the sales department.
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12. To select a Class of Service for the mailbox, click View/Edit under Class of Service.
The Class of Service dialog box displays the selected features available for the
displayed Class of Service. For information on individual Class of Service features,
see the topic, "Class of Service Options," later in this chapter.

See Preinstallation Configuration Worksheets

When assigning classes of service to mailboxes, refer to information provided on the
Class of Service Sheet(s), the COS Redefinition Sheet, and the Custom COS
Definition Sheet.

 

13. To display the other defaults for Classes of Service, click Next or Previous.

14. If the features for the defined classes of service are not appropriate for the mailbox,
you can create a custom Class of Service if you are logged into the system as a
Level 3 supervisor. To create a custom Class of Service for the mailbox, click Use
Custom COS and select the appropriate options. It is recommended, however, that
you use the default classes of service to select mailbox features, so there is more
consistency among system mailbox setups.

The custom Class of Service options on the Class of Service dialog box are not
displayed unless you are logged in as a Level 3 supervisor.

15. To assign the selected Class of Service, click Save, then click Exit. The Mailbox
Entry dialog box displays.

16. If you want to automatically forward messages in the mailbox to another mailbox,
click Auto Forwarding under Edit, then select the appropriate options. For additional
information, see the topic, "Auto-Forwarding Messages Between Mailboxes on the
Same System," later in this chapter.

17. If you want to notify the mailbox subscriber of messages in the mailbox by phone or
beeper, click Message Notification, then select the appropriate options. For
additional information, see the topic, "Notifying Subscribers of New Messages," later
in this chapter.
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18. If you want to change the settings a subscriber can assign to the mailbox, click
Subscriber Settings, then select the appropriate options. For additional information,
see the topic, "Managing Subscriber Settings," later in this chapter.

19. If you want to create a guest mailbox for the mailbox, click Guest Mailbox, then
select the appropriate options. For additional information, see the topic, "Creating a
Guest Mailbox," later in this chapter.

20. If you want to create or assign a V-Tree to the mailbox, click Visual V-Tree, then
select the appropriate options. For additional information, see Chapter 10, “Working
with V-Trees.”

21. To create the mailbox with the entered options, click Save. A dialog box displays
informing you that the mailbox has been created. Click OK to close the dialog box.

If the system is set up to generate random passwords for mailboxes, a dialog box
displays the password assigned to the mailbox. Record the mailbox password and
provide it to the mailbox subscriber.

22. To close the Mailbox Entry dialog box, click OK. The new mailbox displays on the
Mailbox Status screen.

Creating a Single Duplicate Mailbox

Use this procedure to create a new mailbox with the same company, division, personal
operator, and Class of Service as an existing mailbox. For example, you could use this
procedure to create a mailbox for a new employee in the sales department that has the
exact same features as the other sales department employee mailboxes. When you
copy a mailbox, you need to enter the mailbox number, extension, and subscriber’s
name. Note that you can modify a mailbox’s features after you duplicate an existing
mailbox.

To create a single duplicate mailbox:

1. From the Mailbox menu, select Edit. The Edit Mailbox dialog box displays.

 

2. Enter the number of the mailbox to copy, then click Edit. The Mailbox Entry dialog
box displays the selected mailbox’s information.

If you do not know the mailbox number for the mailbox number to edit, click Search
and locate the mailbox. For additional information, see the topic, "Searching for a
Mailbox," later in this chapter.
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3. To copy the displayed mailbox information, click Duplicate Mailbox. The Duplicate
Mailbox dialog box displays.

 

4. Enter the mailbox number for the mailbox to create, then click Create. The new
mailbox displays.

 

5. In the Extension field, enter the extension for the mailbox if it is different from the
mailbox number.

6. In the First Name field, enter the first name of the mailbox subscriber.

7. In the Last Name field, enter the last name of the mailbox subscriber.

8. If any mailbox information or features need to be changed, enter the changes.

9. To create the mailbox with the entered features, click Save. A dialog box displays
informing you that the mailbox has been created. Click OK to close the dialog box.

10. To close the Mailbox Entry dialog box, click OK. The new mailbox displays on the
Mailbox Status screen of the main system window.

If the tutor was already run for the mailbox you copied, the owner of the duplicate
mailbox will not hear the tutor at first login.
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Creating Multiple Mailboxes

Use this procedure to create multiple system mailboxes at one time. For each mailbox
you create, you must specify the mailbox features for that mailbox if they are different
from the default features. To create multiple mailboxes that have the same features, see
the topic, "Creating Multiple Duplicate Mailboxes," later in this chapter.

To create multiple mailboxes:

1. From the Mailbox menu, select Create. The Create Mailbox dialog box displays.

 

2. In the Create ____ Mailboxes field, enter the number of mailboxes that you want to
create.

3. In the Starting with Number field, enter the first mailbox number for the new
mailboxes. It is recommended that the mailbox number match the mailbox
subscriber’s extension.

4. Under Increment By, select the number by which to increment the new mailbox
numbers. For example, if you create five mailboxes starting with mailbox number
2000 and increment them by 5, the mailboxes created are numbered 2000, 2005,
2010, 2015, and 2020.

5. To select mailbox features, click Create. The Mailbox Entry dialog box displays the
first mailbox with the mailbox number displayed in the Mailbox field.

 

6. To create all of the new mailboxes, click Save. The mailboxes are created with the
default features and a dialog box displays informing you that the mailboxes have
been created. Click OK to close the dialog box. The first new mailbox redisplays.
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Steps 7-23 explain how to enter mailbox features for the currently displayed mailbox.
To enter mailbox features for another of the newly created mailboxes, click Next
until the mailbox is displayed and continue with this procedure.

7. In the Extension field, enter the extension for the mailbox if it is different from the
mailbox number.

8. In the First Name field, enter the first name of the mailbox subscriber.

9. In the Last Name field, enter the last name of the mailbox subscriber.

10. In the Company Name field, enter the name of the company to which the mailbox
subscriber belongs. The company name you enter allows subscribers to send
messages to all subscribers in the same company through system-wide distribution
lists. Note that the company name must match the company name entered for other
mailboxes exactly.

11. In the Division field, enter the name of the division to which the mailbox subscriber
belongs. The division name you enter allows subscribers to send messages to all
subscribers in the same division through system-wide distribution lists. Note that the
division name must match the division name entered for other mailboxes exactly.

Mailboxes for which you specify no Company or Division receive all messages sent
to company list 99 or division list 98, respectively.

12. If the system is not set up to generate a password automatically, and you want the
mailbox to have a password, enter the password for the mailbox in the Password
field. The system displays the password as asterisks (*) for added system security.

It is recommended that you use the password automatically generated by the
system. If the system is set up so that no password is required for a mailbox,
passwords are not generated by the system, and the field is blank. If the system is
set up to use a default password for each mailbox, the default password, usually
1111, is automatically assigned to the mailboxes. If the system is set up to generate
a random password, a dialog box displays when you save the mailboxes, which
displays the mailbox numbers and the random passwords generated for the
mailboxes. You can print this list or save it to disk. Make sure you provide the
passwords to the mailbox subscribers.

13. If the mailbox requires a personal operator other than the default operator, enter the
mailbox number of the personal operator. The personal operator feature allows you
to assign a mailbox to a mailbox other than the system operator mailbox. For
example, you can assign the sales receptionist’s mailbox as the personal operator
mailbox for all subscribers in the sales department.

14. To select a Class of Service for the mailbox, click View/Edit under Class of Service.
The Class of Service dialog box displays the selected features available for the
displayed Class of Service. For information on individual Class of Service features,
see the topic, "Class of Service Options," later in this chapter.
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See Preinstallation Configuration Worksheets

When assigning classes of service to mailboxes, refer to information provided on the
Class of Service Sheet(s), the COS Redefinition Sheet, and the Custom COS
Definition Sheet.

 

15. To display the other default classes of service, click Next or Previous.

16. If the features for the defined classes of service are not appropriate for the mailbox,
you can create a custom Class of Service if you are logged into the system as a
Level 3 supervisor. To create a custom Class of Service for the mailbox, click Use
Custom COS and select the appropriate options. It is recommended, however, that
you use the default classes of service to select mailbox features, so there is more
consistency among system mailbox setups.

The custom Class of Service options on the Class of Service dialog box are not
displayed unless you are logged in as a Level 3 supervisor.

17. To assign the selected Class of Service, click Save, then click Exit. The Mailbox
Entry dialog box displays.

18. If you want to automatically forward messages in the mailbox to another mailbox,
click Auto Forwarding under Edit, then select the appropriate options. For additional
information, see the topic, "Auto-Forwarding Messages Between Mailboxes on the
Same System," later in this chapter.

19. If you want to notify the mailbox subscriber of messages in the mailbox by pager or
call forwarding, click Message Notification, then select the appropriate options. For
additional information, see the topic, "Notifying Subscribers of New Messages," later
in this chapter.

20. If you want to change the settings the subscriber can assign to the mailbox, click
Subscriber Settings, then select the appropriate options. For additional information,
see the topic, "Managing Subscriber Settings," later in this chapter.
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21. If you want to create a guest mailbox for the mailbox, click Guest Mailbox, then
select the appropriate options. For additional information, see the topic, "Creating a
Guest Mailbox," later in this chapter.

22. If you want to create or assign a V-Tree to the mailbox, click Visual V-Tree, then
select the appropriate options. For additional information, see Chapter 10,
“Working with V-Trees.”

23. To save the entered features, click Save. The mailbox features for the mailbox are
saved.

24. To enter mailbox features for the next newly created mailbox, click Next and repeat
this procedure starting with step 7.

25. To close the Mailbox Entry dialog box, click OK. The new mailboxes display on the
Mailbox Status screen.

Creating Multiple Duplicate Mailboxes

Use this procedure to create multiple mailboxes that all have the same company,
division, personal operator, and class of service. You do have to enter the subscriber’s
name, extension, and mailbox number for each mailbox created. For example, you could
use this procedure to create mailboxes with the same features for all system subscribers
or for a group of subscribers who all perform similar jobs.

To create multiple duplicate mailboxes:

1. From the Mailbox menu, select Create. The Create Mailbox dialog box displays.

 

2. In the Create ____ Mailboxes field, enter the number of mailboxes that you want to
create.

3. In the Starting with Number field, enter the first mailbox number for the new
mailboxes. It is recommended that the mailbox numbers be the same as the mailbox
subscriber’s extension.

4. Under Increment by, select the number by which to increment the new mailbox
numbers. For example, if you create five mailboxes starting with mailbox number
2000 and increment them by 5, the mailboxes created will be numbered 2000, 2005,
2010, 2015, and 2020.
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5. To select mailbox features, click Create. The Mailbox Entry dialog box displays the
first mailbox with the mailbox number displayed in the Mailbox field.

 

Steps 6-22 explain how to enter the mailbox features that will be copied to all of the
new mailboxes.

6. In the Company Name field, enter the name of the company to which the mailbox
subscriber belongs. The company name you enter allows subscribers to send
messages to all subscribers in the same company through system-wide distribution
lists. Note that the company name must match the company name entered for other
mailboxes exactly.

7. In the Division field, enter the name of the division to which the mailbox subscriber
belongs. The division name you enter allows subscribers to send messages to all
subscribers in the same division through system-wide distribution lists. Note that the
division name must match the division name entered for other mailboxes exactly.

Mailboxes for which you specify no Company or Division receive all messages sent
to company list 99 or division list 98, respectively.

8. If the system is not set up to generate a password automatically, and you want the
mailbox to have a password, enter the password for the mailbox in the Password
field. The system displays the password as asterisks (*) for added system security.

It is recommended that you use the password automatically generated by the
system. If the system is set up so that no password is required for a mailbox,
passwords are not generated by the system, and the field is blank. If the system is
set up to use a default password for each mailbox, the default password, usually
1111, is automatically assigned to the mailboxes. If the system is set up to generate
a random password, a dialog box displays when you save the mailboxes, which
displays the mailbox numbers and the random passwords generated for the
mailboxes. You can print this list or save it to disk. Make sure you provide the
passwords to the mailbox subscribers.

9. If the mailbox requires a personal operator other than the default operator, enter the
mailbox number of the personal operator. The personal operator feature allows you
to assign a mailbox to a mailbox other than the system operator mailbox. For
example, you can assign the sales receptionist’s mailbox as the personal operator
mailbox for all subscribers in the sales department.
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10. To select a Class of Service for the mailbox, click View/Edit under Class of Service.
The Class of Service dialog box displays the selected features available for the
displayed Class of Service. For information on individual Class of Service features,
see the topic, "Class of Service Options," later in this chapter.

See Preinstallation Configuration Worksheet:

When assigning classes of service to mailboxes, refer to information provided on the
Class of Service Sheet(s), the COS Redefinition Sheet, and the Custom COS
Definition Sheet.

 

11. To display the other default classes of service, click Next or Previous.

12. If the features for the defined classes of service are not appropriate for the mailbox,
you can create a custom Class of Service if you are logged into the system as a
Level 3 supervisor. To create a custom Class of Service for the mailbox, click Use
Custom COS and select the appropriate options. It is recommended, however, that
you use the default classes of service to select mailbox features, so there is more
consistency among system mailbox setups.

The custom Class of Service options on the Class of Service dialog box are not
displayed unless you are logged in as a Level 3 supervisor.

13. To assign the selected Class of Service, click Save, then click Exit. The Mailbox
Entry dialog box displays.

14. If you want to automatically forward messages in the mailbox to another mailbox,
click Auto Forwarding under Edit, then select the appropriate options. For additional
information, see the topic, "Auto-Forwarding Messages to Mailboxes," later in this
chapter.
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15. If you want to notify the mailbox subscriber of messages in the mailbox by phone or
beeper, click Message Notification, then select the appropriate options. For
additional information, see the topic, "Notifying Subscribers of New Messages," later
in this chapter.

16. If you want to change the settings a subscriber can assign to the mailbox, click
Subscriber Settings, then select the appropriate options. For additional information,
see the topic, "Managing Subscriber Settings," later in this chapter.

17. If you want to create a guest mailbox for the mailbox, click Guest Mailbox, then
select the appropriate options. For additional information, see the topic, "Creating a
Guest Mailbox," later in this chapter.

18. If you want to create or assign a V-Tree to the mailbox, click Visual V-Tree, then
select the appropriate options. For additional information, see Chapter 10, “Working
with V-Trees.”

19. To save the entered features, click Save. The new mailboxes are created, and the
mailbox features you entered are copied to all the new mailboxes. A dialog box
displays informing you that the mailboxes have been created. Click OK to close the
dialog box. The first new mailbox redisplays.

Steps 20-24 explain how to enter the mailbox subscriber’s extension and name for
each of the newly created mailboxes.

20. In the Extension field, enter the extension for the mailbox if it is different from the
mailbox number.

21. In the First Name field, enter the first name of the mailbox subscriber.

22. In the Last Name field, enter the last name of the mailbox subscriber.

23. To save the subscriber’s extension and name, click Save. The mailbox information
is saved.

24. To enter the mailbox subscriber’s extension and name for the next newly created
mailbox, click Next and repeat this procedure starting with step 20.

25. To close the Mailbox Entry dialog box, click OK. The new mailboxes display on the
Mailbox Status screen.
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Creating a Guest Mailbox

Use this procedure to create a guest mailbox, which is a mailbox with limited features
that uses an existing mailbox as a sponsor mailbox. A guest-mailbox subscriber can
receive messages from anyone but can only send messages to the sponsor mailbox. For
example, you could create a guest mailbox for a temporary consultant working for the
sales manager. The guest mailbox would be sponsored by the sales manager’s mailbox.
The consultant could only send messages to the sales manager, but could receive
messages from anyone who can send messages to the sponsor mailbox.

To create a guest mailbox:

1. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.

 

2. Enter the number of the mailbox for which you want to create a guest mailbox, then
click Edit. The Mailbox Entry dialog box displays the mailbox information.

 

3. Under Edit, click Guest Mailbox Options. The Guest Mailbox Options dialog box
displays the current guest mailboxes for the mailbox.

 

4. To create a new mailbox, click Create Guest. A new mailbox is added to the guest
mailbox list. The mailbox is automatically assigned the next available mailbox
number after the sponsorship mailbox number.

5. If the system is not set up to automatically generate a password, and you want the
mailbox to have a password, click Change Password. When the Guest Mailbox Edit
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Password dialog box displays, enter the new password, then click OK. The system
displays the password as asterisks (*) for added system security.

It is recommended that you use the password automatically generated by the
system. If the system is set up so that no password is required for a mailbox, a
password is not generated by the system. If the system is set up to use a default
password for each mailbox, the default password, usually 1111, is automatically
assigned to the mailbox. If the system is set up to generate a random password, a
dialog box displays when you save the mailbox, identifying the mailbox number and
the random password generated for the mailbox. Record the mailbox password at
that time and provide it to the guest mailbox subscriber.

6. To change the password for a guest mailbox, click Change Password. When the
Guest Mailbox Edit Password dialog box displays, enter the new password, then click
OK.

7. To delete a guest mailbox from the sponsor mailbox, select the mailbox to delete,
then click Delete Guest. When the Delete dialog box displays, click OK to confirm
the mailbox deletion.

8. To save the mailboxes in the list, click OK. The guest mailbox subscriber can begin
using the mailbox.

Editing a Mailbox

Use this procedure to edit a system mailbox. When you edit a mailbox, you can edit any
of the mailbox features including the mailbox subscriber’s name and extension. This
procedure is especially useful if a subscriber leaves your office and you want to assign
the mailbox to a new employee without having to create a new mailbox. Note that you
can only edit one mailbox at a time.

You can also edit a mailbox by clicking the mailbox to edit, then when the Mailbox dialog
box displays, click the Edit button. The Mailbox Entry dialog box displays the mailbox
features.

To edit a mailbox:

1. From the Mailbox menu, select Edit. The Edit Mailbox dialog box displays.
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2. Enter the mailbox number you want to edit, then click Edit. The Mailbox Entry dialog
box displays the mailbox features.

If you do not know the number of the mailbox you want to edit, click Search and
locate the mailbox. For additional information, see the topic, "Searching for a
Mailbox," later in this chapter.

3. Make the changes to the mailbox, then click Save to save the changes.

4. To close the Mailbox Entry dialog box, click OK. The main system window displays.

Deleting Mailboxes

Use this procedure to delete a mailbox. When you delete a mailbox, all mailbox features
and messages stored in the mailbox are also deleted.

To delete a mailbox:

1. From the Mailbox menu, select Delete. The Delete Mailbox dialog box displays.

2. Enter the mailbox number you want to Delete, then click Delete. A deletion
confirmation dialog box displays.

If you do not know the number of the mailbox you want to delete, click Search and
locate the mailbox. For additional information, see the topic, "Searching for a
Mailbox," later in this chapter.

3. To delete the mailbox from the system, click Yes. A dialog box displays informing
you that the mailbox has been deleted. Click OK to close the dialog box. The main
system window displays.
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You can also delete a mailbox displayed on the Mailbox Entry dialog box by clicking
Delete.

Viewing Mailbox Information

Use this procedure to view mailbox information. If you want to view mailbox information
for multiple mailboxes, generate one of the mailbox reports available on the Reports
menu. For additional information, see Chapter 7, “Generating and Interpreting Reports.”

You can also view mailbox information by clicking the mailbox to view, then when the
Mailbox dialog box displays, clicking Edit. The Mailbox Entry dialog box displays the
mailbox features.

To view mailbox information:

1. From the Mailbox menu, select Edit. The Edit Mailbox dialog box displays.

 

2. Enter the mailbox number you want to view, then click Edit. The Mailbox Entry
dialog box displays the mailbox features.

If you do not know the number of the mailbox you want to view, click Search and
locate the mailbox. For additional information, see the topic, "Searching for a
Mailbox," later in this chapter.

3. If you want to modify the mailbox, make the changes, then click Save to save the
changes.

4. When you finish viewing the mailbox information, click OK to close the dialog box.
The main system window displays.
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Searching for a Mailbox

Use this procedure to locate a mailbox by the mailbox subscriber’s last name. Depending
on how you access the Search feature of the system, you can view, edit, or delete
mailboxes after locating a mailbox.

To search for a mailbox:

1. To search for a mailbox, do one of the following:

• From the Mailbox menu, click Edit. When the Edit dialog box displays, click
Search.

• From the Mailbox menu, click Delete. When the Delete dialog box displays,
click Search.

• From the Mailbox Entry dialog box, click Search.

 The Search dialog box displays all of the system mailboxes alphabetically by the
mailbox subscriber’s last name.

 

2. Use the scroll bars to display additional mailboxes.

3. To search for a mailbox by entering the mailbox subscriber’s last name, enter the
name to search for in the Target field, then click Begin New Search. The system
displays the mailbox name at the top of the list if a match was found. If a match of
the name was not found, the next closest name alphabetically displays.

4. Click OK to select the mailbox. If you searched for a mailbox from the Edit dialog
box or Mailbox Entry dialog box, the selected mailbox displays. If you searched for a
mailbox from the Delete Mailbox dialog box, a deletion confirmation dialog box
displays.

Auto-Forwarding Messages to Mailboxes

You can set up a mailbox to send messages automatically to other system mailboxes or
to mailboxes on other voice-mail systems.
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When the Visual Mailbox main window is open on a subscriber’s PC desktop, new
messages received in the mailbox are not auto-forwarded. This is because Visual
Mailbox assumes that the subscriber is actively monitoring the mailbox, even if he/she is
periodically away from the computer. For the system to perform auto-forwarding
functions set up for the mailbox, the subscriber must either minimize the Visual Mailbox
window or exit Visual Mailbox.

Auto-Forwarding Messages Between Mailboxes on the Same
System

The auto-forwarding feature allows you to send messages in one system mailbox to
another system mailbox if the message is not listened to within a specified time. For
example, if a customer leaves a message in a salesperson’s mailbox and the message is
not listened to within an hour, the mailbox can be set up to automatically send the
message to another salesperson.

Messages marked private or listen-only that are sent or recorded in a mailbox cannot be
auto-forwarded.

See Preinstallation Configuration Worksheets

When setting up Auto Forwarding for mailboxes, see information provided on the Auto
Forward Sheet.

To automatically forward messages from one system mailbox to another:

1. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.

 

2. Enter the number of the mailbox for which you want to auto forward messages, then
click Edit. The Mailbox Entry dialog box displays the mailbox information.
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3. Under Edit, click Auto Forwarding. The Auto Forwarding dialog box displays.

 

4. To turn the auto-forward feature on for the mailbox, select the Auto Forwarding
Active option.

5. In the Forward to field, enter the mailbox to which you want the messages
forwarded. If you do not know the mailbox number, click Search to locate the
mailbox. For additional information, see the topic, "Searching for a Mailbox," earlier
in this chapter.

6. Under Delay, in the Hours and Minutes fields, enter the length of time a message
can remain in the original mailbox before being forwarded to the other mailbox.

7. If you want the message to be deleted from the original mailbox when it is forwarded
to the other mailbox, select the Delete Message After Forwarding option. If this
option is not selected, the message remains in the original mailbox, and a copy of
the message is forwarded to the other mailbox.

8. To save the auto-forwarding options for the mailbox, click OK. The Mailbox Entry
dialog box displays.

9. To save the auto-forwarding feature and close the Mailbox Entry dialog box, click
Save, then click OK. The main system window displays.

Auto-Forwarding Messages Between Mailboxes on Different
Systems

The Follow-Me-Forward feature allows you to forward messages to a mailbox on another
voice-mail system. Note that the appropriate network nodes must be set up before you
can use this feature.

Messages that are sent to a mailbox on this system from another voice-mail system
cannot use the Follow-Me-Forward feature. The messages are delivered to the system
mailbox and must be accessed by logging into the mailbox as the subscriber.

This feature is available through the subscriber settings. If the mailbox Class of Service
does not permit network messaging, you can use this procedure to override the Class of
Service and enable this option. If you override the Class of Service, the subscriber can
turn this feature off after it is activated but cannot turn it back on.
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To automatically forward messages from a system mailbox to another system:

1. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.

 

2. Enter the number of the mailbox  for which you want to auto-forward messages, then
click Edit. The Mailbox Entry dialog box displays the mailbox information.

 

3. Under Edit, click Subscriber Settings. The Subscriber Settings dialog box displays.

 

4. Under Follow Me Forward, select the Active option to turn the feature on.

5. In the Network Address field, enter the node address and mailbox number where you
want to send messages. For additional information, see Chapter 9, “Using Network
Messaging.”

6. To save the options, click OK. The Mailbox Entry dialog box displays.
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7. To close the Mailbox Entry dialog box, click OK. The main system window displays
and all new messages to the mailbox are automatically sent to the network address
according to the network options set up on the system.

Notifying Subscribers of New Messages

The Message Notification feature allows subscribers to be notified of new messages in
their mailboxes by having the system call them at a specified phone or beeper number.
For example, a mailbox can be set up to call the subscriber on a beeper on weekends
when the subscriber is away from the office. This feature can also enable you to notify
subscribers who do not have Message Indicators on their phones that they have new
messages by having the system call their extension.

When the Visual Mailbox main window is open on a subscriber’s PC desktop, new
messages received in the mailbox are not dispatched through Message Notification. This
is because Visual Mailbox assumes that the subscriber is actively monitoring the
mailbox, even if he/she is periodically away from the computer. For the system to
perform Message Notification functions set up for the mailbox, the subscriber must exit
Visual Mailbox.

See Preinstallation Configuration Worksheets

When setting up Message Notification for mailboxes, refer to information provided on
the Message Notification Sheet(s).

Sample Message Notification scenarios are provided at the end of this procedure to help
you configure entries for subscriber mailboxes.

To set up a mailbox for Message Notification through a phone or beeper:

1. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.
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2. Enter the number of the mailbox for which you want to activate Message
Notification, then click Edit. The Mailbox Entry dialog box displays the mailbox
information.

 

3. Under Edit, click Message Notification. The Message Notification dialog box
displays.

 

4. In the Entry # field, select the number to assign to the Message Notification
configuration. You can set up eight different configurations to have the system call a
phone or beeper. For example, you could specify Entry #1 to have the system call a
sales representative’s  beeper, and specify Entry #2 to have the system call another
sales representative’s beeper when the first sales representative fails to receive the
message.

Regardless of when a message is received by the system, it attempts to deliver the
message based on the specifications for the first active Entry #. Only when the
maximum number of attempts to deliver the message has been met, does the system
attempt to deliver the message based on the next active Entry # specifications.

If the day and time specified for message delivery/notification for the first active Entry #
includes all the days and times of the week, the system immediately attempts to deliver
a message as soon as it is received by the system. For example, if the system receives
a message at 4:00 AM, it attempts to deliver the message at 4:00 AM.

5. To turn the Message Notification feature on for the entry, select the Active option.

6. In the On Time field, enter the time of day to start Message Notification for the
currently selected Entry #.
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You must include AM or PM in the time of day you enter.

7. In the Off Time field, enter the time of day to end Message Notification for the
currently selected Entry #.

8. In the On Day field, select the day to start Message Notification for the currently
selected Entry #.

9. In the Off Day field, select the day to end Message Notification for the currently
selected Entry #. The On Day and Off Day you select determines the range of days
the messages are delivered. For example, if you specify Tuesday as the On Day and
Sunday as the Off Day, the Message Notification feature will deliver messages
during the times you specify for every day of the week except Monday.

10. Under Retries in the Max Attempts field, enter the maximum number of times the
system should attempt to call either the phone number or beeper.

11. Under Retries in the Busy Delay field, enter the number of minutes the system
should wait before reattempting to call a number that is busy.

12. Under Retries in the No Ans Delay field, enter the number of minutes the system
should wait before reattempting to call a number when there is no answer at the
number.

13. In the Phone # field, enter the complete phone number, including long distance
access code and area code, to dial to notify the subscriber that a new message is in
the mailbox. If the digits in the phone number are less than the number of digits
defined as a local number in System Setup, the system assumes the number is an
internal extension. If the number contains at least the defined number of digits, the
code to access an outside line is used to place the call. If the number is for a beeper,
the letter N should usually precede the number so that call progress is not used. For
additional information, see the topic, "Using Dialing Codes," later in this chapter.

14. In the Call Back field, enter one of the following:

• The number you want to display on the beeper when the subscriber is
notified. This number is usually the number the subscriber calls to access
the system.

You may need to enter a comma or series of commas before the call back
number to ensure the paging system receives the call-back number.

• PHONE to have the system call the entered phone number and voice, “I
have a message for <subscriber’s name>,” when the subscriber answers the
phone.

• OPER to have the system call the entered phone number and voice,
“<mailbox number> has not picked up messages,” notifying the operator that
the subscriber has not listened to messages in the mailbox.

15. In the Line 1 field, enter the system port to use if you want to use a specific port to
call the subscriber. To use any available port to call the subscriber, enter 99.

The port you specify for Message Notification must be set up on the system to allow
Message Notification through that port.
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16. To enter another configuration for Message Notification, select another Entry # and
repeat this procedure starting with step 5.

17. To save the entered Message Notification entries, click OK. The Mailbox Entry
dialog box displays.

18. To close the dialog box, click OK. The main system window displays.

Message Notification Sample Scenarios

The following scenarios show how messages are delivered based on the specifications
for the active Entry #s and on when the message is received by the system.

Example 1

Entry #1 is set to deliver messages Monday through Friday from 8:30 AM to 5:30 PM.

System receives message: System attempts to deliver message:

Tuesday 11:30 AM Tuesday 11:30 AM

Wednesday 7:00 PM Thursday 8:30 AM

Friday 8:00 PM Monday 8:30 AM

Example 2

Entry #1 is set to deliver messages Saturday through Sunday from 7:30 AM to 8:30 PM.

System receives message: System attempts to deliver message:

Tuesday 11:30 AM Saturday 7:30 AM.
(If the mailbox subscriber checks messages before Saturday at 7:30 AM,

the system does not attempt to deliver the message.)

Saturday 2:00 PM Saturday 2:00 PM

Saturday 11:00 PM Sunday 7:30 AM

Example 3

Entry #1 is set to deliver messages to Sales Rep 1’s beeper Monday through Friday from
7:30 AM to 1:30 PM and attempts to deliver the message a maximum of five times. Entry
#2 is set to deliver messages to Sales Rep 2’s beeper Monday through Friday from
11:00 AM to 6:30 PM and attempts to deliver the message a maximum of five times.

System receives message: System attempts to deliver message:

Tuesday 9:30 AM To Sales Rep 1, Tuesday at 9:30 AM

(If the message is not delivered to Sales Rep 1 after five attempts, the
system attempts to deliver the message to Sales Rep 2, Tuesday at

11:00 AM.)

Tuesday 5:00 PM To Sales Rep 1, Wednesday at 7:30 AM

(If the message is not delivered to Sales Rep 1 after five attempts, the
system attempts to deliver the message to Sales Rep 2, Wednesday at

11:00 AM.)

Saturday 5:00 PM To Sales Rep 1, Monday at 7:30 AM

(If the message is not delivered to Sales Rep 1 after five attempts, the
system attempts to deliver the message to Sales Rep 2, Monday at

11:00 AM.)
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Example 4

Entry #1 is set to deliver messages to a beeper Monday through Friday from 5:30 PM to
11:30 PM and attempts to deliver the message a maximum of five times. Entry #2 is set
to deliver messages to a beeper Saturday through Sunday from 8:00 AM to 6:30 PM and
attempts to deliver the message a maximum of five times.

System receives message: System attempts to deliver message:

Tuesday 6:00 PM Tuesday at 6:00 PM

(If the message is not delivered to the subscriber after five attempts, the
system attempts to deliver the message Saturday at 8:00 AM.)

Tuesday 1:00 PM Tuesday at 5:30 PM

(If the message is not delivered to the subscriber after five attempts, the
system attempts to deliver the message Saturday at 8:00 AM.)

Sunday 2:00 PM Monday at 5:30 PM

(If the message is not delivered to the subscriber after five attempts, the
system attempts to deliver the message Saturday at 8:00 AM.)

Managing Subscriber Settings

Use the following procedures to help manage the settings subscribers that have applied
to their system mailboxes. You can view or change the options that a subscriber
currently has set up and change those settings based on the subscriber’s needs.

When you change subscriber settings, you can enable features that are not part of the
mailbox’s Class of Service. If  you enable a feature for a mailbox that is not in the Class
of Service, the subscriber cannot change the option, except to turn the feature off. After
a feature is turned off, the subscriber cannot turn it back on.

To view or change the subscriber settings for a mailbox:

1. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.
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2. Enter the number of the mailbox for which you want to view or change subscriber
settings, then click Edit. The Mailbox Entry dialog box displays the mailbox
information.

 

3. Under Edit, click Subscriber Settings. The Subscriber Settings dialog box displays
the currently selected options for the mailbox.

 

4. To set all of the subscriber settings to the system defaults, click Set to Defaults. This
feature allows you to reset all current settings that either the system manager or
subscriber has previously set for the mailbox.

5. Under Intercom Paging select the appropriate option.

• Off – Does not allow callers to page subscribers through the intercom.

• On – Provides callers with the option to page subscribers through the
intercom if there is no answer at the extension.

• Automatic – Automatically pages the subscriber through the intercom.

• Number – Specifies the paging number if the On or Automatic option is
selected. Enter the number to call to page the subscriber if it is different from
the system default paging number. For example, if the system uses zone
paging, enter the number for the zone to which the mailbox is assigned. If
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the field is left blank, the system calls the default paging number set up on
the system.

Intercom paging is available only if an intercom is connected to the system, and
an intercom paging number is specified either as a System Setup parameter or
in the Number field.

 If a subscriber is paged through the intercom, the subscriber can reroute the call
from the mailbox to another extension on the system, using the intercom redirect
feature. If a subscriber does not answer a page, the caller has the option of
leaving a message for the subscriber, calling a different mailbox, transferring to
the operator, or disconnecting.

The options you select in steps 6-8 set up the Call Handling for the mailbox, which
determines how calls to the mailbox are handled by the system under certain
conditions.

6. To block all incoming calls to a particular mailbox, without first ringing the extension,
and then to handle the calls according to an option you specify, select the Call
Blocking option.

7. Under No Answer/Call Blocking, select the appropriate No Answer option to perform
when a caller receives no answer at the subscriber’s extension, or select the
appropriate call-blocking option if the call is to be blocked:

• Default – Forwards callers to the subscriber’s mailbox.

• V-Tree – Activates the V-Tree assigned to the mailbox if one has been
assigned.

• Optional 1 – Voices the Optional 1 prompt, then forwards callers to the
subscriber’s mailbox.

• Optional 2 – Voices the Optional 2 prompt, then forwards callers to the
subscriber’s mailbox.

• Forward To – Forwards callers to the mailbox number entered in the field
next to the option.

If a caller is forwarded to another mailbox, then chooses to record a message,
the message is recorded in the original mailbox the caller accessed. Even if the
caller is forwarded to multiple mailboxes, the message is recorded in the original
mailbox.

8. Under Busy, select the appropriate option to perform when a caller receives a busy
signal when calling the subscriber’s extension.

• Default – Forwards callers to the subscriber’s mailbox.

• V-Tree – Activates the V-Tree assigned to the mailbox if one has been
assigned.

• Optional 1 – Voices the Optional 1 prompt, then forwards callers to the
subscriber’s mailbox.

• Optional 2 – Voices the Optional 2 prompt, then forwards callers to the
subscriber’s mailbox.
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• Forward To – Forwards callers to the mailbox number entered in the field
next to the option.

If a caller is forwarded to another mailbox, then chooses to record a message, the
message is recorded in the original mailbox the caller accessed. Even if the caller
is forwarded to multiple mailboxes, the message is recorded in the original
mailbox.

9. Under Special Features, select the Call Queuing option to place callers in a queue
when the extension is busy. Make sure that call-queuing prompts have been
recorded so that callers are notified appropriately that their call is in a queue and will
soon be addressed.

10. Under Special Features, select the Call Screening option to prompt callers to record
their name to announce the call before the subscriber receives it. This feature allows
subscribers to identify a caller and then determine if they want to receive the call.

11. Under Message Notification, select the appropriate option to notify users of new
messages. For additional information, see the topic, "Notifying Subscribers of New
Messages," earlier in this chapter.

• Disabled – Message notification does not notify subscribers of new
messages.

• Urgent Only – Notifies subscribers of new messages through a phone or
beeper only when urgent messages are sent to the mailbox.

• All Messages – Notifies subscribers of any new messages through a phone
or a beeper.

12. Under Subscriber Options, select Announce Subscriber to have the system voice, “I
have a call for <subscriber’s name prompt>,” instead of the default prompt, “One
moment, you have a call,” when the system transfers a call to an extension. This
feature enables subscribers to hear who a call is for before the transfer is completed,
which is especially useful when multiple subscribers share the same extension.

13. Under Subscriber Options, select Auto Time-Date Voiceback to voice the date and
time a message was received in the mailbox at the beginning of each message.

14. Under Security Options, select Mailbox-Lockout to lock a mailbox when a caller
attempts to log into the mailbox and is disconnected after failing to enter the correct
mailbox password within the specified number of attempts. A locked mailbox
prevents any caller, including the subscriber, from logging into the mailbox. The
system manager must manually unlock the mailbox before the subscriber can
access the mailbox. For additional information, see the topic, "Unlocking a Mailbox,"
later in this chapter.

15. Under Security Options, select Failed Login Notify to notify the subscriber when
logging into the mailbox that a caller to the system has unsuccessfully attempted to
access the mailbox. The subscriber can review the failed login message or delete it.
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16. Under Fax Options in the Personal Fax Number field, enter the number of the fax
machine to which the mailbox is to send fax messages if it is different from the Local
Fax Machine number specified in System Setup. If you want faxes to print
automatically on the fax machine when sent to the mailbox, select the AutoPrint
option.

The system must include the optional Fax Solution module to use Fax Options.

17. To automatically send messages in the mailbox to another voice-mail system, under
Follow-Me-Forward, enter the network node address to which the messages are to
be sent in the Network Address field. Select the Active option to have the system
automatically send the message or deselect the option to retain the network node
address yet disable the feature until needed. For additional information on network
nodes, see the topic, "Auto-Forwarding Messages Between Mailboxes on Different
Systems," earlier in this chapter.

18. To save the changes made to the subscriber settings, click OK. The Mailbox Entry
dialog box displays.

19. To close the Mailbox Entry dialog box, click OK. The main system window displays.

Clearing Mailbox Information

Use this procedure to clear mailbox information for specified mailboxes. For example,
you can clear all of the mailbox information for a mailbox whose subscriber is being
transferred to another office in the company and will no longer need the mailbox. This
allows you to reassign the mailbox to a new subscriber without having to create a new
mailbox.

Clearing a mailbox is permanent and irreversible.

When you clear mailboxes, you can specify which mailboxes to clear by entering a range
of mailbox numbers, a company, and/or a division. Mailboxes that are not included in the
range, company, and division you enter are not cleared. You can clear the following
information for the mailboxes you select:

• Statistics – Erases all of the mailbox statistics that are displayed when you
generate mailbox reports. This enables you to view mailbox statistics from the
time you cleared the mailbox statistics to the present date.

• Messages – Erases all new and saved messages in the selected mailboxes.

• Prompts – Erases all of the prompts the subscribers have recorded for the
selected mailboxes and replaces the prompts with the default system prompts.

• Distribution Lists – Erases all distribution lists created by the subscribers in the
mailboxes. Clearing distribution lists for mailboxes does not clear system
distribution lists.

• Guest Mailboxes – Deletes all guest mailboxes in the selected mailboxes.

• Folders – Deletes all folders created by subscribers in the selected mailboxes.
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• V-Tree – Deletes the V-Trees from the selected mailboxes.

If the Visual Architect Developer’s Toolkit is installed and set up on the system,
and the V-Tree for a mailbox is exported to a file, the V-Tree file is not deleted
from the system when the mailbox is cleared. The V-Tree is simply deleted from
the mailbox.

• Subscriber Settings – Resets all of the mailbox subscriber settings to the
default settings.

To clear mailbox information:

1. From the Mailbox menu, select Clear. The Clear Mailbox dialog box displays.

 

2. Under Items to be cleared, select the options for the items you want to clear from the
mailbox.

To clear information for a mailbox, the mailbox must be in the entered range of
mailbox numbers, in the entered company, and in the entered division. If a mailbox
does not meet all of the entered values, the mailbox information is not cleared. For
example, if you include all mailbox numbers in the range, all divisions, and enter
ABC for the company, only mailboxes in company ABC are cleared. Mailboxes in all
other companies are not cleared.

3. If you do not want to include all the system mailboxes in the range to clear, enter the
number of the first mailbox in the range you want to clear in the From field under
Clear Mailboxes, and enter the last mailbox number in the range you want to clear in
the To field. If you only want to clear information for a single mailbox, enter that
mailbox number in both the From and To fields.

The number entered in the From field must be equal to or smaller than the number
entered in the To field.

4. In the Company field, enter the name of the company to clear, or enter All to clear
mailbox information for all companies on the system. If this field is left blank, the
system includes all companies in the range.

5. In the Division field, enter the name of the division to clear, or enter All to clear
mailbox information for all divisions on the system. If this field is left blank, the
system includes all divisions in the range.
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6. To clear the mailbox information based on the entered options, click OK. A clear
mailbox confirmation dialog box displays.

 

7. To clear only the displayed mailbox, click OK. The next mailbox in the range of
mailboxes displays or, if there are no more mailboxes in the range, the main system
window displays.

8. To retain the mailbox information for the displayed mailbox and continue with the
next mailbox in the range, click Skip. The next mailbox in the range displays or, if
there are no more mailboxes in the range, the main system window displays.

9. To clear all of the mailboxes in the range you specified without being prompted for
each mailbox, click No Ask. All of the mailboxes in the range are cleared, and the
main system window displays.

10. To cancel clearing any additional mailboxes, click Stop. No additional mailboxes in
the range are cleared, and the main system window displays. Note that all mailbox
information that was cleared before you clicked on Stop remains cleared.

Unlocking a Mailbox

Use this procedure to unlock a mailbox that has been locked because a caller attempted
to access the mailbox by entering the incorrect mailbox password several consecutive
times. The mailbox locking feature helps prevent callers from accessing mailboxes
without permission.

The password parameters defined in System Setup determine how many times a caller
can enter an incorrect password before being disconnected. Subscribers are notified that
their mailboxes are locked when they log in using the correct password. The system
manager must then unlock the mailbox before the subscriber can again access the
mailbox.

You can also unlock a mailbox by clearing the subscriber settings for a mailbox. Since
clearing subscriber settings resets all of the subscriber settings, not just the mailbox
locking feature, it is recommended that you use the following procedure to unlock a
mailbox.

To unlock a mailbox:

1. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.
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2. Enter the number for the mailbox you want to unlock, then click Edit. The Mailbox
Entry dialog box displays the mailbox information.

 

3. In the Password field, enter a new password for the mailbox. Write down this new
password and provide it to the mailbox subscriber. Note that the password you enter
displays as asterisks for additional security.

4. To save the new password, click Save. The mailbox is now unlocked and has a new
password assigned to it. The subscriber can now access the mailbox using the new
password, then change it to another password.

Subscribers can change their passwords back to their original passwords when they
log into their mailboxes after the system manager has unlocked the mailbox.

5. To close the Mailbox Entry dialog box, click OK. The main system window displays.
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Class of Service Options

A Class of Service is a set of features and specifications that are assigned to a mailbox.
The Class of Service assigned to a mailbox dictates which features are accessible to the
subscriber. When a feature, such as call screening, is not activated in the Class of
Service assigned to a mailbox, options relating to the feature are not voiced when the
subscriber accesses the mailbox.

There are 25 defined classes of services you can assign to a mailbox. To view the
features available for each Class of Service, click the Next and Previous buttons on the
Class of Service dialog box. You may also create custom classes of service for
individual mailboxes if you are logged into the system as a Level 3 supervisor. Note that
the custom Class of Service options on the Class of Service dialog box are not displayed
unless you are logged in as a Level 3 supervisor on the system.

See Preinstallation Configuration Worksheets

When adjusting default classes of service or creating custom classes of service, see
information provided on the Class of Service Sheet(s), the COS Redefinition Sheet, and
the Custom COS Definition Sheet.

You can use the Subscriber Settings feature to control some of the features available to
a subscriber, without creating a custom Class of Service. You can disable Subscriber
Settings features for the mailbox, preventing the subscriber from using the features. You
can also enable features in the Subscriber Settings that are not selected in the mailbox’s
Class of Service. See the topic, "Managing Subscriber Settings," earlier in this chapter
for information on the using Subscriber Settings.

Some Class of Service features are not available for use in a mailbox unless the system
has been set up to use those features. For example, if the system does not have the Fax
Solution module installed and set up, the mailbox subscriber cannot create V-Trees that
use faxes, send faxes, or receive faxes.
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Call Screening

Call Screening allows a subscriber to accept, reject, or redirect a call. When call
screening is activated, the system instructs callers requesting an extension to, “Please
speak your name at the tone, so I may say who is calling.”  Before the call is transferred
to the subscriber’s extension, the subscriber hears, “You have a call from <caller’s
name>. To take this call, press pound. To reject the call, press one. Or to redirect the
call, press star.”  If the subscriber wants to take the call, the subscriber presses <#>, and
the caller is transferred to the extension. If the subscriber wants to reject the call, the
subscriber presses <1> and immediately hangs up the phone. The caller is then told
there was no answer at the extension and is given the choice of trying another extension,
leaving a voice-mail message, transferring to the operator’s extension, or disconnecting.
If a call is rejected by the subscriber, the caller is not given the option to page. The
subscriber may also choose to redirect the call by pressing <*>, followed by the
destination mailbox number. The subscriber must then immediately hang up the phone
so the caller can be transferred to the specified extension.

If you want to prohibit subscribers from changing the call screening for their mailbox, do
not select the Call Screening option in the mailbox’s Class of Service, and instead select
the Call Screening option in the mailbox’s subscriber settings.

Message Confirmation

Message Confirmation allows the subscriber to review the date and time a message was
sent, to whom it was sent, and, if applicable, the date and time the recipient listened to
or skipped the message. This feature helps the sender of a message determine if and
when another subscriber received the message. This feature is not supported by the
AMIS protocol; only messages sent to local subscribers or OctelNet destinations may be
sent with confirmation.

Folders

The folders feature allows a subscriber to organize messages and faxes by storing them
in “folders” in the mailbox. A subscriber can create up to nine folders to store messages.
The subscriber records a label for each folder, which is voiced when the subscriber
accesses the mailbox. For example, if a subscriber regularly receives messages that are
either technical or administrative, the subscriber can create two folders with the labels
“Technical” and “Administration” to save and organize the messages.

Call Queuing

Call Queuing allows callers either to hold for a specific extension or leave a voice
message when an extension is busy. Depending on the how call queuing is set up on the
system, callers may be informed of their status in the queue, including their position (the
number of calls ahead of them), while they hold for that extension. Call queuing may
also give callers periodic opportunities to leave a voice message, continue to hold, or
disconnect. The caller on hold may be provided with prerecorded music or messages,
such as product information.

You may record up to nine verbal or musical messages for callers to listen to while
holding in the queue. For example, the messages could provide new product information
or sales promotions to callers in the queue. The system voices each of the nine
messages to each caller in the queue. After voicing each recorded message, the system
voices the caller’s status followed by the available options. After the system plays all the
recorded messages, it returns to the first message and begins voicing the messages
again. All mailboxes on a system that have call queuing activated in the Class of Service
use the same nine prompts. The first caller in the queue hears a prompt before the call is
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transferred to the extension. For additional information, see the topic, "Setting Up Call
Queuing Prompts," in Chapter 5, “Setting Up System Prompts.”

If the system is set up to play prerecorded music when callers are placed in the queue,
do not use music that plays long tones. The system may misinterpret the long tones as
disconnect signals.

If you want to prohibit subscribers from changing the call queuing for their mailboxes, do
not select the Call Queuing option in the mailboxes' Classes of Service. Instead, select
the Call Queuing option in the mailboxes' subscriber settings.

Message Indicator

Message Indicators, such as lights and LEDs, can be used to notify subscribers of new
messages in their mailboxes. After a subscriber listens to or skips a message in a
mailbox, the Message Indicator on the phone is turned off. Note that Message Indicators
only work if the phone system supports the feature, and the system has been set up to
use the Message Indicators.

Intercom Paging

Intercom Paging allows a caller to page a subscriber who does not answer the mailbox
extension. When a subscriber is paged, the system announces over the paging system,
“There is a call for <subscriber’s name>.”  The subscriber can then either retrieve the call
from the subscriber’s extension or use the intercom redirect feature to access the call
from another extension by rerouting the call. If the subscriber does not respond to the
page, the caller is given the option to try another extension, leave a voice message in
the subscriber’s mailbox, transfer to the operator, or disconnect. If the caller retries to
call the original extension, the system waits approximately one minute before redialing
that extension.

Paging may be set to Off, On, or Automatic. When paging is Off, callers cannot page
subscribers. When paging is On, the caller is given the option to page when there is no
answer at the subscriber’s extension. When paging is set to Automatic, the subscriber is
always paged once before the system performs the Call Handling options that are set up
for the mailbox.

If you want to prohibit subscribers from changing the selected Intercom Paging option for
their mailbox, do not select the Intercom Paging option in the mailbox’s Class of Service.
Instead, select the appropriate intercom paging option in the mailbox’s subscriber
settings.

Paging is available only if an intercom is connected to the phone system and the
intercom paging feature has been set up on the system.

Personal Group List

Personal Group List allows subscribers to create lists of mailboxes, so one message can
be sent to multiple recipients in one step. For example, a subscriber can create a
personal group list of all subscribers working on a particular project. The subscriber can
then send a message to all subscribers on the project by entering a single number.
Subscribers can create up to 10 personal group lists in their mailboxes, numbered 11-20
(unless the system is set up to use different numbers). Each of the personal group lists
can contain up to 50 destinations, which can include local subscriber mailboxes,
destinations on other voice-mail systems through network nodes, or other group list
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numbers, including global group lists (if available in the mailbox’s Class of Service).
Each group list included as a destination on a personal group list counts as one
destination. To include destinations on other voice-mail systems, the subscriber must
also be permitted access to network message features in the mailbox’s Class of Service.

Global Group List

Global Group List allows subscribers to send messages to system group lists, numbered
26-35 (unless the system is set up with different numbers), and the global group lists,
numbered 98 and 99. Each group list can contain up to 50 destinations, which can
include local subscriber mailboxes, destinations on other voice-mail systems through
network nodes, or other group list numbers. System group lists 26-35, which are created
by the system manager over the phone in a supervisor mailbox by following the prompts,
allow subscribers to send messages to mailboxes defined by the system manager.
Global Group Lists 98 and 99, which are created automatically by the system, allow
subscribers to send messages to all mailboxes in the subscriber’s division and company,
respectively. Subscribers cannot include these lists in their own personal group lists
unless Global Group List is selected for the mailbox’s Class of Service.

Dial by Name

Dial by Name allows subscribers to enter a subscriber name through the phone keypad
to dial a mailbox number, which allows subscribers to send messages to other
subscribers without requiring them to know the subscriber’s mailbox number. If there are
multiple subscribers with the same or similar names, the system voices those names
then allows the subscriber to choose from the available names. This feature can also be
used to send messages to other systems through the NameNet feature. For additional
information, see the topic, "Specifying Mailboxes on Other OctelNet Systems," in
Chapter 9, “Using Network Messaging.”

In some instances, subscribers may belong to a voice-mail service bureau, in which case
they do not need to know the mailbox numbers of other system subscribers. In this case,
this feature should be disabled. If the system is set up to use Greeting by Port, only
mailboxes with the same company or those that have no assigned company are voiced
when a directory is requested.

Call Handling

Call Handling allows subscribers to control how calls to their mailboxes are routed. For
example, a subscriber can set up a mailbox to block all calls to a prompt that requests
the caller to leave a message while the subscriber is on vacation. The mailbox can be
set up to voice an optional prompt, forward the call to another extension, or route the call
to a V-Tree. The mailbox can also be set up to perform one of these actions for all calls
to the mailbox, calls that are not answered, calls that receive a busy signal, or calls that
are busy or not answered. For additional information, see the topic, "Managing
Subscriber Settings," earlier in this chapter.

If you want to prohibit subscribers from changing the selected Call Handling option for
their mailbox, do not select the Call Handling option in the mailbox’s Class of Service.
Instead, select the appropriate Call Handling option in the mailbox’s subscriber settings.
This is especially useful when mailboxes are blocked to V-Trees because it prevents the
feature from being accidentally de-activated by a subscriber. For additional information,
see the topic, "Managing Subscriber Settings," earlier in this chapter.
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V-Tree

V-Trees allow subscribers to create custom voice menus in their mailboxes. V-Trees can
route calls, provide information to callers, or collect information from callers. For
example, a mailbox for a sales department can contain a V-Tree that allows callers to
press <1> for information on product A, press <2> for information on product B, or press
<3> to talk to a sales representative. For additional information, see Chapter 10,
“Working with V-Trees.”

If you want to prohibit subscribers from changing the selected V-Tree options for their
mailbox, do not select the V-Tree option in the mailbox’s Class of Service. Instead,
select the appropriate V-Tree options in the mailbox’s subscriber settings.

Fax V-Tree

Fax V-Tree allows subscribers to create V-Trees in their mailboxes that have fax
options. For example, a mailbox for a sales department can contain a V-Tree that allows
callers to press <1> for information on product A, press <2> for information on product
B, press <3> to talk to a sales representative, or press <4> to have information on all
products faxed to them. Note that the system must have the Fax Solution module set up,
and have both the Fax V-Tree and V-Tree options selected in the mailbox’s Class of
Service to allow the subscriber to include fax features in a V-Tree.

If you are loading faxes into the M2000 system and need to retrieve the fax document
numbers for use in a V-Tree, the 8-digit fax number is only voiced as part of Envelope
Information if the Fax V-Tree option is enabled in the mailbox’s Class of Service.

Send Messages

Send Messages allows subscribers to send messages from their mailboxes to other
system subscribers or subscribers on other voice-mail systems, if networking options are
set up for the system. For additional information on networking options, see Chapter 9,
“Using Network Messaging.”

Receive Messages

Receive Messages allows subscribers to receive messages in their mailboxes from both
subscribers and outside callers (non-subscribers). When both this feature is selected and
the system is set up to receive messages from other voice-mail systems, subscribers
can receive messages from remote subscribers whose voice-mail systems support AMIS
or OctelNet. For additional information on networking options, see Chapter 9, “Using
Network Messaging.”

Save Messages

Save Messages allows subscribers to save messages sent to their mailboxes. The
values entered in the Days to Save chapter of the Class of Service dialog box determine
how long the mailbox subscriber can save a messages in the mailbox before the system
deletes them.

Undelete Messages

Undelete Messages allows subscribers to recover either new or saved messages deleted
from their mailboxes. This feature helps prevent subscribers from accidentally deleting a
message in the mailbox. Subscribers can only undelete the messages that they deleted
during the current session. After a subscriber exits a mailbox by hanging up or backing
out of the mailbox, the messages are permanently deleted.



4. Managing System Mailboxes

Lucent Technologies Messaging 2000   Class of Service Options
System Manager Manual
585-345-101  (Issue 1.0 May 1998) 4-40

Locate Messages Received

Locate Messages Received allows subscribers to scan their new messages for
messages sent from a particular subscriber. This feature allows subscribers to scan for a
message only from another subscriber on the system. Subscribers cannot locate
messages from another voice-mail system or an outside caller.

Locate Messages Sent

Locate Messages Sent allows subscribers to search for and edit messages they have
already sent to other mailboxes as long as the messages are still in the mailbox’s new
message queue. Subscribers can only use this feature to locate and edit messages sent
to other subscribers on the system. Messages designated for dispatch to other voice-
mail systems, including those scheduled for Follow-Me-Forward, cannot be edited.

Record Prompts

Record Prompts allows mailbox subscribers to record their own mailbox prompts. These
prompts include the Please Hold prompt, Name prompt, Personal Greeting prompt,
Optional 1 prompt, and Optional 2 prompt. If prompts are not recorded for a mailbox, the
system default prompts are used. It is recommended that subscribers be allowed to
record their own prompts to add a personal touch to the system.

Operator Access

Operator Access allows callers to the mailbox to transfer to the mailbox’s operator. This
operator can be the default operator set up for the system or a personal operator
specified on the Mailbox Entry dialog box.

Failed Login Notification

Failed Login Notification allows the system to notify the subscriber logging into the
mailbox that a caller to the system has attempted to access the mailbox by entering an
incorrect password. After the subscriber is notified, the subscriber can review the failed
login message or delete it.

If you want to prohibit subscribers from changing the failed login notification feature for
their mailbox, do not select the Failed Login Notification option in the mailbox’s Class of
Service. Instead, select the Failed Login Notification option in the mailbox’s subscriber
settings.

Mailbox Lock-Out Option

Mailbox Lock-Out Option allows the system to lock a mailbox when a caller attempts to
log into the mailbox and is disconnected after failing to enter the correct password for the
mailbox after a specified number of attempts. A locked mailbox prevents any caller,
including the subscriber from gaining access to the mailbox other than to leave
messages. The system manager must manually unlock the mailbox before the
subscriber can access the mailbox. For additional information, see the topic, "Unlocking
a Mailbox," earlier in this chapter.

If you want to prohibit subscribers from changing the mailbox lock-out feature for their
mailbox, do not select the Mailbox Lock-Out Option in the mailbox’s Class of Service.
Instead, select the Mailbox Lock-Out Option in the mailbox’s subscriber settings.
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Auto Time-Date Voiceback

Auto Time-Date Voiceback configures the system to voice the time and date a message
was received in a subscriber mailbox automatically when the subscriber listens to a
message. When activated in a mailbox, the time and date information is voiced first for
each message sent to the mailbox. This feature differs from the message information
feature in three ways:

• Auto Time-Date Voiceback, when selected, is voiced for every message.
Message information is only voiced when selected for an individual message.

• Auto Time-Date Voiceback is voiced before the message. Message Information is
voiced only after the message has been voiced, and the subscriber has selected
Message Information from the Message menu.

• Auto Time-Date Voiceback is selected in a mailbox’s Class of Service and must
be turned on or off by either the system manager in the mailbox’s subscriber
settings or by the mailbox subscriber. The Message Information feature is always
available to the subscriber from the Message menu.

Visual Mailbox

Visual Mailbox is an add-on module that allows subscribers to access their mailbox using
a visual interface on their PC. For additional information on using Visual Mailbox, see
Chapter 20, “Installing and Configuring Visual Mailbox,” in the Implementation and
Service Manual, online help, or your Lucent Technologies representative.

Enable Multilingual Support

Enable Multilingual Support allows callers to the mailbox to choose the language in
which they want the prompts to voice when they perform actions in the mailbox if a
language has not already been selected at some point during the call. For example, if a
caller dials an extension without accessing the automated attendant, a prompt is voiced
that allows the caller to select the language in which system prompts are to be voiced.
From that point on in the call, all system prompts are voiced in the selected language.

If a language has already been selected at some point during the call, no language
prompt is voiced when the caller accesses the mailbox. For additional information, see
the topic, "Setting Up the Language Selection Prompt," in Chapter 5, “Setting Up System
Prompts.”

Note that this feature only selects the language for system prompts. The prompts
associated with personal prompts or V-Trees voice in the language in which they were
recorded.

Supervisor

Supervisor allows a subscriber to access the Supervisor menu over the phone by logging
into the mailbox, pressing <9> at the Main menu, and entering the system’s Level 2 or 3
supervisor password. This allows the subscriber to perform a number of supervisor
functions through the phone, including creating, editing, and deleting mailboxes;
recording system and personalized prompts; maintaining system group lists; and using
SOLVE, the Supervisor Online Voice Editor. Although the system allows any number of
supervisors, only a few subscribers should have the supervisor feature selected in their
mailbox’s Class of Service to limit the control of supervisor functions. It is recommend
that one subscriber in each company be able to use supervisor features, if the system is
set up to use Greeting by Port.
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Delivery Options

Delivery Options control whether subscribers can use the Message Notification, Wake-
Up Call, Casual AMIS, and primary fax destination features in the mailbox, and whether
they can call local and long-distance numbers.

Not Allowed

Not Allowed does not permit subscribers to use the Message Notification, Wake-Up
Calls, Casual AMIS, and primary fax destination features.

Local Only

Local Only allows subscribers to enter only numbers defined as local numbers. The
number of characters a subscriber can enter for a local number is limited by values
entered during the setup of the system.

A system manager can manually enter a long-distance number for a mailbox feature
even though the mailbox has Local Only selected as a delivery option. This allows the
system manager to specify which features the mailbox can use to call long-distance
numbers. To manually enter a long-distance number for a feature, enter the long-
distance number (up to 16 characters) in the mailbox’s subscriber settings. The
subscriber cannot change this number in the mailbox after it is entered in the subscriber
settings.

Long Distance

Long Distance allows subscribers to enter up to 16 numbers to call numbers for the
Message Notification, Wake-Up Calls, Casual AMIS, and primary fax destination
features.

Batch Mode

Batch Mode, if selected, specifies that when the system performs Message Notification,
it should consider the subscriber successfully notified of the message when someone or
something, such as an answering machine, answers. For example, if the system calls the
number specified for Message Notification, and an answering machine answers the call,
the system interprets the attempt as successful and does not attempt to notify the
subscriber again.

If the Batch Mode option is not selected, the system interprets a Message Notification
attempt successful when the subscriber logs into the mailbox.

The batch mode feature does not affect Message Notification through a beeper. Batch
mode is only used with Message Notification and has no effect on the Wake-Up Calls,
Casual AMIS, and primary fax destination features.

Networking Options

Networking Options determine subscriber ability to send messages to other voice-mail
systems.
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Highest Outgoing Dispatch

Highest Outgoing Dispatch defines how messages are sent from the mailbox.

• Not Allowed – Does not allow the mailbox subscriber to send any messages to
other voice-mail systems.

• Economy – Sends messages to other voice-mail systems during the economy
hours set up for the system. You can override the economy hours for individual
network nodes if appropriate. For additional information, see Chapter 9, “Using
Network Messaging.”

• Standard – Allows subscribers to send messages marked with either economy or
standard dispatch. Messages sent to other voice-mail systems with standard
dispatch are held in a queue for the maximum time set up for the system or until
a defined number of messages accumulate in the same queue, whichever occurs
first.

• Priority – Allows subscribers to send messages marked with economy, standard,
or priority dispatch. Messages sent to other voice-mail systems with priority
dispatch are sent to the remote address after a three-minute delay. Note that to
use the future delivery feature to send a message to another system, a subscriber
must be able to send priority messages.

Casual AMIS

Casual AMIS allows subscribers to send messages to other voice-mail systems that
support the AMIS protocol. If Casual AMIS is the only Networking option activated in the
mailbox’s Class of Service, the subscriber can only send messages to AMIS-compatible
systems by entering the complete phone number of the system and the destination
mailbox number. For additional information, see Chapter 9, “Using Network Messaging.”

The option selected under Delivery Options determines whether the subscriber can enter
long-distance telephone numbers to access distant AMIS destinations. If Local Only is
selected, subscribers cannot send messages to destinations that have long-distance
telephone numbers.

Administered AMIS

Administered AMIS allows subscribers to send messages to defined AMIS nodes. Nodes
allow subscribers to enter a short series of digits that represent the complete phone
number of another voice-mail system instead of entering the entire phone number. If
Administered AMIS is the only Networking option activated in the mailbox’s Class of
Service, the subscriber can only send messages to sites designated as AMIS nodes.
Administered AMIS must be selected here if a subscriber is to be permitted to use the
Follow-Me-Forward feature to access AMIS destinations. For additional information, see
Chapter 9, “Using Network Messaging.”

The option selected under Delivery Options does not affect a subscriber’s ability to
specify Administered AMIS destinations, including those for Follow-Me-Forward.

OctelNet

OctelNet allows subscribers to send messages to defined OctelNet nodes. OctelNet
nodes allow subscribers to enter a short series of digits that represent the complete
phone number of another system that supports OctelNet. If OctelNet is the only
Networking option activated in the mailbox’s Class of Service, the subscriber can only
send messages to sites designated as OctelNet nodes. OctelNet must be selected here if
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a subscriber is to be permitted to use the Follow-Me-Forward feature to access OctelNet
destinations. For additional information, see Chapter 9, “Using Network Messaging.”

The option selected under Delivery Options does not affect a subscriber’s ability to
specify OctelNet destinations, including those for Follow-Me-Forward.

Follow-Me-Forward

Follow-Me-Forward allows subscribers to forward mailbox messages received from
outside callers or internal subscribers automatically to a mailbox on another system. The
Follow-Me-Forward feature is set up either by the system manager in the subscriber
settings or by the mailbox subscriber through the mailbox. The Follow-Me-Forward
feature is only available to subscribers on systems set up with AMIS and OctelNet
nodes. For additional information, see the topic, "Auto-Forwarding Messages Between
Mailboxes on Different Systems," earlier in this chapter.

Messages that are sent to a mailbox from another voice-mail system cannot be
forwarded again using the Follow-Me-Forward feature. These messages must be
accessed by logging into the original destination mailbox.

If you want to prohibit subscribers from changing the Follow-Me-Forward options for their
mailbox, do not select the Follow-Me-Forward option in the mailbox’s Class of Service.
Instead, select the appropriate Follow-Me-Forward options in the mailbox’s subscriber
settings.

Network Reply

Network Reply permits subscribers to reply to messages sent from other voice-mail
systems. Since the system stores the address of the other voice-mail system that sent
the message, subscribers are not required to enter the recipient’s telephone and mailbox
number.

Language

Language allows you to select the default language to use for the mailbox if your system
is configured for multiple languages. The system can support as many as five
languages. This feature only selects the language in which mailbox prompts are voiced
after the mailbox is accessed. For additional information, see the topic, "Setting Up the
Language Selection Prompt," in Chapter 5, “Setting Up System Prompts.”

Fax Options

Fax Options allows subscribers to use the Fax Solution module if it is installed on the
system. The module allows subscribers to send and receive faxes in their mailboxes.

Send Faxes

Send Faxes allows subscribers to send fax messages, including copies of voice/fax
messages, from their mailboxes to other system subscribers. Note that the Fax Solution
module must be set up on the system to use this feature.

Faxes cannot be sent to other voice-mail systems. If a fax message is sent to a group
list that contains both local subscribers and network destinations, only the local
subscribers who are permitted to receive faxes receive the attached fax message.
Recipients at the remote system only receive the voice portion of the message.
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The Send Faxes option must be selected for subscribers to include fax capabilities in
V-Trees they create for their mailboxes.

Receive Faxes

Receive Faxes allows subscribers to receive fax messages in their mailboxes from both
subscribers and outside callers. This option must be selected for the primary fax
destination and AutoPrint features to be available to subscribers over the phone. Note
that the Fax Solution module must be set up on the system to use this feature.

Max Messages

Max Messages defines the maximum number of messages (both new and saved)
permitted in the mailbox. This feature helps to manage the system’s available disk space
by limiting the amount of space mailbox messages can take up on the system. The
functions of the mailbox should be considered when setting this value. For example, you
may want to allow the sales department mailboxes to store more messages than
mailboxes in other departments. Make sure that the operators’ mailboxes are able to
store enough messages to allow for high call volume. The maximum number of
messages a mailbox can contain is 1,000. The recommended Max Messages value is
under 70.

For subscribers using Visual Mailbox, set the Max Messages value to under 60 for the
best system performance.

Msg Time

Msg Time defines the maximum length (in seconds) allowed for the following types of
messages:

• Messages that subscribers record to send to other subscribers.

• Messages sent from other voice-mail systems.

• Messages sent to mailboxes from outside callers.

This feature helps to manage the system’s available disk space by limiting the amount of
space mailbox messages can take up on the system. The functions of the mailbox
should be considered when setting this value. For example, a customer service
department may require a longer message time than an accounting department. The
minimum message length is 30 seconds; the maximum message length is 6,000
seconds. If AMIS messaging is permitted, this value should be set to no more than 480
seconds (eight minutes) to accommodate the maximum AMIS message time.

Max Rings

Max Rings defines the number of rings before the M2000 system determines that there
is no answer at a subscriber’s extension.

The number entered in Max Rings overrides the number of rings specified on the Port
Parameters tab in System Setup.

If you enter a zero (0), the system transfers and releases the call without determining if
there is no answer or the extension is busy. If there is no answer, or if the mailbox is
busy, the call does not go back to the system unless an integration feature is being used
on the system, or the phone itself is forwarded to the voice-mail extension.
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Make sure this number is at least one less than the number of rings set up on the
system’s telephone switch. If the number is not at least one less than the number of rings
set up for the switch, calls are not routed to the M2000 system.

It is recommended that you do not set the ring count to less than 3, or more than 15. The
system may not recognize less than three rings on some telephone switches, and more
than 15 rings may produce unpredictable results.

On integrated systems, if Max Rings is set to 0, do not activate the call screening or
announce subscriber name prompt features in a mailbox’s subscriber settings. If either of
these features is active and Max Rings is set to 0, M2000 does not integrate properly
with the switch.

New Messages

The New Messages field specifies the number of days a message that has not been
listened to can remain in the mailbox before it is automatically deleted by the system. To
keep messages in the mailbox until they are either saved or deleted, enter 99. The
system can also be set up to notify mailbox subscribers that a message has been
deleted from their mailbox by the system.

Saved Messages

The Saved Messages field specifies the total number of days that a message can remain
in the mailbox before it is automatically deleted by the system. The total number of days
a message has been in a mailbox starts as soon as the mailbox receives the message.
For example, if this field is set to 14 days, and a message was sent to the mailbox 4
days ago, it will only be saved for 10 more days, even though it was listened to and
saved by the subscriber after 2 days. To save messages indefinitely, enter 99. The
system can also be set up to notify mailbox subscribers that a message has been
deleted from their mailbox by the system.

Make sure that the number of days entered in the Saved Messages field is always
greater than the number of days entered in the New Message field. If New Messages is
set to 99, Saved Messages should also be set to 99.
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Using Dialing Codes

There are several places in M2000, such as Message Notification and personal fax
number set up, that you may need to enter a dialing code in addition to the phone
number to allow the system to dial the number correctly. For example, you may need to
precede a beeper number with several commas for the system to effectively notify a
beeper during Message Notification. These commas indicate pauses that allow the
beeper notification service time to receive the number to display on the beeper.

Some codes are only meaningful if the system uses certain switches. Be sure to refer to
the switch documentation or contact your Lucent Technologies representative before
changing dialing codes currently set up on the system.

The following characters represent dialing codes that are used by the M2000 system.

Note that the H, X, C, W, B, -, and + codes can be used only for calls to internal
extensions—number of digits is less than the Number of Digits in Local Phone Number
parameter in System Setup. The remaining codes can be used for calls to internal or
external destinations.

  Code Use

& Represents a flash hook. A flash hook is similar to quickly depressing
and releasing the buttons in the cradle of a telephone.

, Represents a pause.

- Signals the switch to go on hook. On hook indicates that the buttons
in the cradle of the telephone are depressed.

+ Signals the switch to come off hook. Off hook indicates that the
buttons in the cradle of the telephone are not depressed.

D Instructs the switch to dial with call progress.

H Instructs the switch to perform a hard hang-up. A hard hang-up
causes the system to immediately end the call without
communicating any additional information to the system.

N Instructs the switch to dial without call progress.

R For calls to internal extensions, this code signals the switch to
release the call to M2000. For calls to outside numbers, this code
instructs activates Earth Loop Recall.

X Places the extension in the dialing string.

B Aborts the transfer if a busy (or reorder) signal is received from the
switch after the extension is dialed. Otherwise, the transfer is
completed as an unsupervised transfer. This code should only be
used on switches, such as the Lucent PARTNER®, that do not allow
completion of transfers into busy or reorder tone. When using this
code, Max Rings in the Class of Service must be set to 0; otherwise,
this code is ignored.

W(Number) Instructs the switch to wait the specified number of seconds for
recognized dial tone. If dial tone is not detected, and an R is included
in the string immediately following the W(number), a busy release
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code is sent if. The transfer is then reattempted starting at the
beginning of the customer transfer code string. If it fails again, the
caller hears the busy options. Valid settings are 0 – 9; 1 through 9
indicate the number of seconds to wait, and 0 indicates that the
system should wait up to 60 seconds. The suggested setting is W5.
Note that this code must be set higher than the DTONWAIT
parameter because DTONWAIT determines the amount of
continuous energy the system must detect to recognize it as dial
tone.

C(Number) Indicates that the system is to send a special feature code to the
switch. The C is always followed by a number that defines how many
characters are in the special feature code. For example, if 550 is the
special feature code to activate intercom paging, a C3 would be
entered in the dialing code string for intercom paging.

T Instructs the switch to use DTMF dialing.

M Instructs the switch to use Multi-Frequency (MF) dialing.

P Instructs the switch to use Pulse dialing.

Do not use M or P unless required by the switch. Once used, all calls are dialed using
multi-frequency or pulse dialing until you restart the M2000 system.



Lucent Technologies Messaging 2000   Setting Up System Prompts
System Manager Manual
585-345-101  (Issue 1.0 May 1998) 5-1

C H A P T E R  5

Setting Up System Prompts

M2000 provides default voice prompts for the system; however, you can specify custom
prompts to personalize the system to meet your company’s needs. You can:

• Set up prompts to voice morning, afternoon, evening, and after hours messages.

• Set up prompts for special holidays.

• Set up Greeting by Port prompts.

• Set up a Language Selection prompt.

• Set up the Attendant Menu prompt.

• Set up Call Queuing prompts.

• Set up Message Notification prompts.

• Set up Network Node prompts.
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Understanding System Prompts

System prompts greet callers and direct them through the M2000 system so they can
dial extensions, leave messages, send faxes, or access different types of information.
You can customize system prompts to personalize the system to meet the company’s
needs or use the default prompts provided with the system. This chapter describes the
system prompts and explaining how to specify custom prompts. For procedures on how
to record and edit prompts, see Chapter 6, “Recording and Editing Prompts.”

M2000 allows you to specify the following system prompts:

• System Greetings prompts – Greet callers with a morning, afternoon, evening,
or office closed message.

• Holiday Greetings prompts – Greet callers with specific holiday messages.

• Greeting by Port prompts – Greet callers to specific ports on the same system
with different messages. These prompts are used when several companies share
the same system.

• Language Selection prompt – Prompts callers to select the language in which
system prompts are to be voiced.

• Attendant Menu prompt – Directs callers on selecting options for proceeding
through the system.

• Message Notification prompt – Informs subscribers of new messages in their
mailboxes.

• Call Queuing prompts – Provide information to callers waiting on hold in call
queues.

When callers call the system on a typical day, the first prompt they hear is a System
Greeting prompt (or a Greeting by Port prompt, if set up). An example is, “Hello and
thank you for calling ABC corporation.”  If the system includes language files for multiple
languages, the next prompt callers hear is the Language Selection prompt, such as, “For
service in English, press <1>. Pour la service en Français, appuyez sur <2>.”  After
callers select a language, the remaining system prompts are voiced in that language.
The Attendant Menu prompt is voiced next to guide callers through the system. A typical
Attendant Menu prompt is, “Enter the extension of the person you would like to speak
with, or press one of the following options, followed by <#>. To speak to Sales, press
<1>; to leave a message, press <2>;  to send a fax, press <3>; for a directory, press
<4>; or to speak to an operator, press <0>.”  Depending on the selections the callers
make, callers are transferred to either extensions or the operator, or they hear prompts
for mailboxes, instructions for voice mail, or instructions for sending faxes.

Setting Up System Greetings

System Greetings are prompts that are voiced at specified times of the day. These
prompts include a morning, afternoon, evening, and an office-closed prompt. The
System Greeting prompt is the first prompt voiced by the system to callers (except on
days specified as holidays). A typical morning System Greeting prompt may say, “Good
morning, and thank you for calling ABC Corporation.”

Entries on the Time/Greetings tab in System Setup determine when the morning,
afternoon, and evening greetings are voiced. The daily business hours specified under
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the Attendant menu Business Hours option determine when the office-closed greeting is
voiced.

The System Greetings prompts are not voiced if the Greeting by Port feature is used.

To set up System Greetings prompts:

1. From the Attendant menu, select Prompts. The System Prompts dialog box displays.

 

2. Under System Greetings, click in the field for the prompt you want to specify.

3. Enter the prompt number of the prompt you want the system to voice. If you want to
use a prompt stored in the [Language]3.O32 phrase file, where [Language] is the
primary language on the system, precede the phrase number with the letter D.

If the prompt has not been recorded, record it using any of the three tools described
in Chapter 6, “Recording and Editing Prompts.”

See Preinstallation Configuration Worksheets

When recording System Greetings prompts, refer to information provided on the
Single-Company Greetings Sheet(s). Enter the numbers of the prompts you record in
the Prompt # fields on the sheet.

4. To save the entered prompts, click OK. The main system window displays.

5. To adjust the daily business hours, which determine when the office-closed prompt is
voiced, select Business Hours from the Attendant menu. The Daily Business Hours
dialog box displays.
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See Preinstallation Configuration Worksheets

When defining the daily business hours, refer to entries made on the Company
Profile Sheet. If the Greeting by Port feature is set up, the daily business hours
specified on the Greeting by Port dialog box override the business hours specified in
the Daily Business Hours dialog box for the active port.

6. To select the day of the week for which you want to specify business hours, select
the appropriate day of the week from the pull-down menu.

7. In the box below the day of week, select the appropriate business hours option.

• Open All Day – The time-of-day greetings (morning, afternoon, and evening)
are voiced at the appropriate times during the day at the times specified on
the System Setup Time/Greetings tab. The office-closed greeting is not
voiced during that day.

• Closed All Day – The office-closed greeting is voiced during the whole day.
The time-of-day greetings are not voiced during that day.

• Selected Hours – The time-of-day greetings are voiced during the times
specified in the Open and Close fields. The office-closed greeting is voiced
the rest of that day.

8. If you chose the Selected Hours option, enter the time of day the company opens for
business and closes in the Open and Close fields in either standard AM/PM format or
military format.

9. If you want to configure several consecutive days with the same daily business
hours, click Copy To: to copy the information to the next day.

10. To save the entered daily business hours, click OK. The main system window
displays.

Setting Up Greeting by Port

Greeting by Port allows you to set up mailboxes to answer different ports with unique
greetings. This feature is often used when several companies share the same system.

See Preinstallation Configuration Worksheets

To determine whether the system should be set up to voice greetings by port, refer to
entries made on the Call Flow Sheet under “If more than one company or organization is
being supported... .”

When setting up Greeting by Port, consider the following:

• For each port, it is recommended that you designate two mailboxes to answer the
port. On the Greeting by Port dialog box, set up the first mailbox to voice a
during-hours greeting and the second mailbox to voice an after hours greeting. If
only one greeting needs to be voiced for the port, you can enter the same
mailbox number in the During Hours and After Hours fields on the Greeting by
Port dialog box.

• To ensure that the appropriate mailboxes are included in the company-wide
directories, verify that the entries in the Company field on the Mailbox Entry
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screen are the same for the mailbox assigned to answer the port and the
subscriber mailboxes assigned to the company. For additional information, see
Chapter 4, “Managing System Mailboxes.”

• For the mailbox designated to answer calls to the port, record the greeting for the
port as the Personal Greeting prompt for the mailbox.

• If you want the system to voice the Attendant Menu prompt, do not select the Call
Blocking option on the Subscriber Settings dialog box. If you want to use an
optional prompt, a V-Tree, or call forwarding, select the Call Blocking option on
the Subscriber Settings dialog box, then select the appropriate Call Blocking
option. For additional information, see the topic, "Managing Subscriber Settings,"
in Chapter 4, “Managing System Mailboxes.”

• To allow the supervisor access to all the ports on the system through the phone
interface, do not enter a Company for the supervisor’s mailbox. For additional
information, see Chapter 4, “Managing System Mailboxes.”

To configure Greeting by Port:

1. Start M2000 if it is not already running and log in as a Level 3 supervisor.

2. From the Options menu, select Greeting by Port. The Greeting by Port dialog box
displays.

 

See Preinstallation Configuration Worksheets

When recording the prompts to be used for Greeting by Port, see the
Multiple-Company Greetings Sheet(s). Enter the numbers of the mailboxes for which
you recorded greetings in the Mailbox # fields on the sheet.

3. In the Port # field, enter the number of the port you want to configure for greeting by
port.

4. To activate the port for greeting by port, select the Active option.

5. Under Mailboxes to use, enter the number of the mailbox you want to assign to
answer the port during business hours in the During Hours field.
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6. Under Mailboxes to use, enter the number of the mailbox you want to assign to
answer the port after business hours in the After Hours field.

7. Under Daily Business Hours, select the appropriate day of the week from the
drop-down menu.

8. In the box below the day of week field, select the appropriate business hours option:

• Open All Day – The Mailbox to Use During Hours is used all day.

• Closed All Day – The Mailbox to Use After Hours is used all day.

• Selected Hours – The Mailbox to Use During Hours is used during the hours
specified in the Open and Close field. The Mailbox to Use After Hours is used
the rest of the day.

See Preinstallation Configuration Worksheets

When specifying daily business hours on the Greeting by Port dialog box, refer to
entries made in the Business Hours section on the Company Profile Sheet(s).

9. If you chose the Selected Hours option, enter the time of day the company opens for
business and closes in the Open and Close fields in either standard AM/PM format or
military format.

10. If you want to configure several consecutive days with the same daily business
hours, click the Copy To: button to copy the information to the next day.

11. To save the entered Greeting by Port information, click Save.

12. To copy the entered information to the next consecutive port number on the system,
click Copy to Port #.

13. To close the Greeting by Port dialog box, click OK. The main system window
displays.

Setting Up the Language Selection Prompt

The Language Selection prompt is voiced on multilingual M2000 systems to allow callers
to select the language in which they want to hear system prompts and to instruct callers
as to which key to press to change the language of the prompts voiced by the system.

If the system only uses one language, do not set up this prompt.

To set up the Language Selection prompt, you must specify the languages available in
the Language Selection dialog box, then specify the Language Selection prompt in the
System Prompts dialog box. The field numbers on the Language Selection dialog box
correspond to the keypresses a caller must enter to select the languages. For example, if
you specify French in the number 2 field on the Language Selection dialog box, the
Language Selection prompt must instruct callers to press <2> to select French.

The Attendant Menu prompt and the Message Notification prompts can be voiced in up
to five languages. The language 1–5 fields under Attendant and Message Notification on
the System Prompts dialog box correspond to the languages specified in the number
fields on the Language Selection dialog box. For example, if French is specified in the
number 2 field of the Language Selection dialog box, and the caller presses <2> to
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select French at the Language Selection prompt, the system searches the French phrase
files and voices the Attendant Menu prompt or Message Notification prompt associated
with the prompt number specified in the Language 2 field on the System Prompts dialog
box.

To set up the Language Selection prompt:

1. Log into the system as a Level 3 supervisor.

2. From the Options menu, select Language Selection. The Language Selection dialog
box displays.

 

See Preinstallation Configuration Worksheets

When completing the Language Selection dialog box, refer to entries made in the
“Languages to be supported…” section on the Company Profile Sheet(s).

3. Under Primary Language, select the primary language from the drop-down menu.
The primary language is the language used for the system greeting prompts until a
caller selects another language.

If you change the primary language, all classes of service that had the previous
primary language selected in the Language field on the Class of Service dialog box
are updated to use the new primary language you indicate on the Language
Selection dialog box.

4. To select secondary languages, click a language field under Secondary Languages
and select a language from the drop-down menu. The Secondary Language prompts
are used when a caller selects to hear system prompts in a language other than the
primary language.

5. To save the language selections, click OK. The main system window displays.
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6. From the Attendant menu, select Prompts. The System Prompts dialog box displays.

 

7. In the Language Select Prompt field, enter the prompt number of the prompt you
want the system to voice. If the system is using one language, do not enter a
number in this field. If the prompt has not been recorded, record it using any of the
three tools described in Chapter 6, “Recording and Editing Prompts.”  If you want to
use a prompt stored in the [Language]3.O32 phrase file where [Language] is the
primary language on the system, precede the phrase number with the letter D.

8. To save the entered Language Selection, click OK. The prompt information is saved
and the main system window displays.

Setting Up the Attendant Menu Prompt

The automated attendant feature allows you to provide options to callers, such as
contacting specific subscribers, leaving messages, and sending faxes. For example,
when callers call the company, the attendant may give them the options to dial a
particular extension, press <1> to speak to Sales, press <2> to speak to technical
support, press <3> to use the dial by name feature, press <4> to send a fax, or press
<5> to leave a message. These options are voiced to callers by the Attendant Menu
prompt. The Attendant Menu prompt is voiced after the morning, afternoon, and evening
System Greetings prompts, and the Language Selection prompt, if one is set up on the
system.

The Attendant Menu prompt you record should instruct callers to press <#> immediately
after entering an Attendant Menu option. This prevents callers from experiencing a slight
delay while the system determines whether they are entering an Attendant Menu option
or a mailbox number. Callers entering a mailbox number at the Attendant Menu prompt
do not need to press <#>. For example, “Enter the extension of the person you would
like to speak with, or press one of the following options, followed by <#>. To speak to
Sales, press <1>; to leave a message, press <2>;  to send a fax, press <3>; for a
directory, press <4>; or to speak to an operator, press <0>.”

To set up the automated attendant, you must first record the Attendant Menu prompt
then configure the Attendant Menu prompt options. If no Attendant Menu prompt is
recorded, the system voices the default prompt, “Please dial the number of the person
you are calling. If you have a mailbox on the system, please press <#>. If you need
assistance, press <0>. If you do not have a Touch-Tone phone, or require assistance,
please stay on the line.”
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Record the Attendant Menu prompt before you configure the Attendant Menu prompt
options.

When you record the Attendant Menu prompt, consider the following:

• If you want to provide an option for callers to transfer to departments, such as
Sales or Customer Service, compile a list of the departments and the assigned
mailbox numbers to help you configure the Attendant menu options.

• If you want to provide an option for callers to leave a message for a subscriber,
you may want to inform callers that if they select this option, they are transferred
to voice mail, not to the caller’s extension.

• If you want to provide an option for callers to send faxes to a subscriber, you
may want to inform callers selecting this option that they must be calling from a
fax machine.

• When you set up Attendant Menu prompts, record and specify a prompt for each
language you specified in the Language Selection dialog box. For additional
information, see the topic, "Setting Up the Language Selection Prompt," earlier
in this chapter.

To set up the Automated Attendant prompt:

1. From the Attendant menu, select Prompts. The System Prompts dialog box displays.

 

2. In the Language fields under Attendant Menu, enter the prompt number of the
prompts you want the system to voice for each language. If the system only uses
one language, specify the prompt number in the Language 1 field. If you want to use
a prompt stored in the [Language]3.O32 phrase file where [Language] is the primary
language on the system, precede the phrase number with the letter D.

 If the prompt has not been recorded, record it using any of the three tools described
in Chapter 6, “Recording and Editing Prompts.”

See Preinstallation Configuration Worksheets

When recording the Attendant Menu prompt, consider entries made on the Call Flow
Sheet and the Attendant Menu Prompt Sheet(s). Enter the number of the Attendant
Menu prompt you record in the Attendant Prompt # field on the Attendant Menu
Prompt Sheet.
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3. To save the entered automated attendant prompts, click OK. The main system
window displays.

4. To configure the Attendant Menu prompt options, select Attendant from the
Attendant menu. The Attendant Main Menu Editor dialog box displays.

 

5. Enter the options for each caller keypress option in the field next to the keypress
icon based on the options recorded in the Attendant Menu prompt. When you
configure the Attendant Menu prompt options, there are four different options you
can assign to a keypress:

• Mailbox Number – If you want callers to be transferred to a particular mailbox,
enter the mailbox number in the field. For example, if you want to transfer
callers to mailbox 3124 when they press <2>, type 3124 next to the 2
keypress icon.

• FAX – If you want callers to be able to send a fax to system mailboxes, type
FAX in the field. Callers selecting this option are prompted to enter the number
of the mailbox to which they want to send the fax. The system delivers the fax
to the mailbox if the mailbox is enabled for fax receipt in its associated class of
service, or to the local fax machine if the mailbox is not enabled for fax receipt.

The optional Fax Solution module must be installed and set up on the system
to use the fax mail features.

• MESSAGE – If you want callers to transfer directly to voice mail to leave a
message for a subscriber, type MESSAGE in the field. The system prompts the
caller to enter the destination mailbox and record the message.

• DIRECTORY – If you want callers to be able to use the Dial by Name feature,
type DIRECTORY in the field next to the keypress. Dial by name allows callers
who do not know a subscriber’s extension or mailbox number to access it by
spelling the subscriber’s last name using the telephone keypad.

6. To save the entered Automated Attendant options, click OK. The main system
window displays.
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Setting Up Holiday Greeting Prompts

The holiday feature allows you to designate as holidays specific days the office is closed
and to record special holiday greetings. During days designated as holidays, the system
voices the Holiday Greeting prompt all day instead of the System Greetings prompts
(morning, afternoon, evening, and closed). Any messages left by callers are stored in the
After Hours Operator mailbox if it is specified.

To set up Holiday prompts:

1. From the Attendant menu, select Holidays. Note that you can also access the
Holidays dialog box from the System Prompts dialog box by clicking the Holiday
Greetings button. The Holidays dialog box displays.

 

2. In a Date field, enter the date of the holiday in month/day (MM/DD) format.

3. In the Msg # field, enter the prompt number of the prompt you want the system to
voice on the corresponding date. If the prompt has not been recorded, record it using
any of the three tools described in Chapter 6, “Recording and Editing Prompts.”

See Preinstallation Configuration Worksheets

When recording Holiday Greeting prompts, refer to information provided on the
Holiday Greetings Sheet(s). Enter the numbers of the prompts you record in the
Prompt # fields on the sheet.

4. If you want the system to automatically retain the same date as a holiday for the
next year and voice the same prompt, select the Retain option next to the Msg #
field.

5. To save the entered Holiday prompts, click OK. If you accessed the Holidays dialog
box from the System Prompts dialog box, the System Prompts dialog box displays.
Otherwise, the main system window displays.
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Setting Up Call Queuing Prompts

The Call Queuing prompts allow you to record up to nine different messages the system
voices to callers waiting in a call queue. For example, you can record messages about
the products and services the company offers. You can also record a call-queuing
transfer prompt voiced to the first caller in the queue when the system attempts to
transfer the caller to the busy extension. These queuing prompts are voiced in addition
to the system Call Queuing prompts enabled on the Call Queuing tab in System Setup.
The system voices the Call Queuing prompts in the order specified on the Call Queuing
System Prompts dialog box.

To set up Call Queuing prompts:

1. From the Attendant menu, select Prompts. The System Prompts dialog box displays.

 

2. Click Call Queuing Prompts. The Call Queuing Prompts dialog box displays.

 

3. In each appropriate prompt field, enter the prompt number of the prompt you want
the system to voice. If the prompt has not been recorded, record it using any of the
three tools described in Chapter 6, “Recording and Editing Prompts.”

See Preinstallation Configuration Worksheets

When recording Call Queuing prompts, refer to information provided on the Call
Queuing Prompts Sheet(s). Enter the numbers of the prompts you record in the
Prompt # fields on the sheet.

4. To save the entered Call Queuing prompts, click OK. The System Prompts dialog
box displays.
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5. To close the System Prompts dialog box, click OK. The main system window
displays.

Setting Up Message Notification Prompts

Message Notification prompts are voiced to subscribers when the system calls to inform
them of new messages that are in their mailboxes. The system voices the Message
Notification prompt in the language specified in the class of service assigned to the
subscriber’s mailbox.

When you set up Message Notification prompts, record and specify a prompt for each
language set up on the system. For additional information, see the topic, "Setting Up the
Language Selection Prompt," earlier in this chapter.

To set up Message Notification prompts:

1. From the Attendant menu, select Prompts. The System Prompts dialog box displays.

2. In the Message Notification Language fields, enter the prompt numbers of the
prompts you want the system to voice. If the system uses only one language, enter
the prompt number in the Language 1 field. If the prompt has not been recorded,
record it using any of the three tools described in Chapter 6, “Recording and Editing
Prompts.”

3. To save the entered Message Notification prompts, click OK. The main system
window displays.

Setting Up Network Node Prompts

Network Node prompts are voiced as part of the destination information provided to
subscribers when they send a network message. The prompt voices the site or company
name where the node sends the messages. If you do not record a prompt for the node,
the default system prompt, “To send to node <node number> mailbox number <mailbox
number>, press pound now,” voices when subscribers enter a network destination for a
message.
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To set up Network Node prompts:

1. From the Options menu, select Network Maintenance. The Select Node dialog box
displays.

 

2. In the Enter Node Number field, enter the number of the node for which you
recorded the prompt, then click Edit. The Network Node Maintenance dialog box
displays. If you do not know the node number, use the search feature to help locate
the appropriate node. For additional information, see the topic, "Searching for a
Node," in Chapter 9, “Using Network Messaging.”

 

3. In the System Prompt field, enter the number of the prompt you want the system to
voice. If the prompt has not been recorded, record it using any of the three tools
described in Chapter 6, “Recording and Editing Prompts.”

4. To save the entered Network Node prompt, click OK. The main system window
displays.
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C H A P T E R  6

Recording and Editing Prompts

You can record and edit system prompts to help customize the M2000 system.
Procedures provided in this chapter will help you to record and edit prompts using three
recording and editing techniques:

• Keypad prompt recording functions.

• Supervisor’s Online Voice Editor (SOLVE).

• Visual Voice Editor (V-Edit).
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Selecting a Recording and Editing Technique

M2000 provides three tools for recording and editing prompts:

• Keypad prompt recording functions – The keypad prompt recording functions
allow you to rerecord existing prompts from a telephone without accessing the
M2000 PC. To rerecord prompts using the keypad prompt recording functions,
access a supervisor mailbox over the phone and enter the number of the prompt
you want to rerecord, then record over the existing prompt. Note that you can
record new prompts using the keypad functions, but you cannot set up the
prompts to voice on the system unless you access the M2000 screen interface
and enter the prompt number in the appropriate prompt number field.

• SOLVE – SOLVE uses both the screen and phone interfaces to allow you to
specify and record prompts at the same time. This helps ensure that you are
specifying the prompt you want in the appropriate prompt number field. To use
SOLVE, access the M2000 PC and start SOLVE from any screen containing a
prompt number field. Prompts you record using SOLVE are stored in the \REC00
directory as .SUP files and are accessible from both SOLVE and the keypad
prompt recording functions.

• V-Edit – V-Edit is an advanced phrase editing tool that allows you to make
intricate modifications to existing phrases. Though more complicated in nature,
V-Edit features allow you to generate the highest quality system phrases.

Recording and Editing Prompts Using the Keypad Prompt
Recording Functions

You can record system prompts over the phone using the keypad prompt recording
functions available in supervisor mailboxes. When you record system prompts using the
keypad prompt recording functions, the prompts are saved by prompt number in the
\REC00 directory with the .SUP file extension.

Be sure to write down the prompt numbers assigned to the prompts you record. You
must specify the prompt numbers in the appropriate fields of the screens on which you
specify prompts to be voiced by the system.

Phrases in the .O32 files (for example, ENGLISH2.O32) can only be edited using V-
Edit.

To record prompts using the keypad prompt recording functions:

1. Pick up the handset and dial the system access number.

2. Access a mailbox that has been assigned supervisor rights. The Subscriber main
menu voices.

3. From the Subscriber main menu, press <9> to access the supervisor functions.

4. When prompted, enter the system manager password. The system voices the
Supervisor main menu.

5. At the Supervisor main menu, press <2> to select Change System Prompts.
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6. To record a prompt, enter the number of the prompt you want to record, followed by
<#>. The system voices the prompt associated with the prompt number if one exists.
To rerecord the prompt, press <2>.

7. When you hear the beep, record the prompt, then press <#> to stop recording. The
system voices the prompt you recorded.

8. To accept the prompt, press <1>. To rerecord the prompt, press <2>. To delete the
prompt, press <3>.

9. To exit Change System Prompts and return to the Supervisor main menu, press
<Q>.

Recording and Editing Prompts Using SOLVE

SOLVE allows you to use both the M2000 screen and phone interfaces to assign and
record system prompts. When you record system prompts using SOLVE, the prompts
are saved by prompt number in the \REC directories with the .SUP file extension.

Be sure to write down the prompt numbers assigned to the prompts you record. You
must specify the prompt numbers in the appropriate fields of the screens on which you
specify prompts to be voiced by the system.

Phrases in the .O32 files (for example, ENGLISH2.O32) can only be edited using V-
Edit.

To record and edit prompts using SOLVE:

1. Open the screen on which the prompt number for the prompt you want to record is to
be specified. Place the cursor in the field for the prompt. If the field is blank, no
custom prompt is currently set up to voice. You can assign a prompt number in the
field now or allow the system to assign a number automatically when you record and
accept a prompt.

 If a prompt number exists in the field, a prompt is currently set up to voice on the
system. In this case, you can accept or rerecord the prompt.

2. To start SOLVE, press <F7>. The SOLVE Prompt Recorder dialog box displays and
shows the status Waiting for Login.

3. Call into the system over the phone and log into a supervisor mailbox.

4. From the Main menu, press <4> to select Personal Options, then when prompted,
enter the Level 2 or Level 3 supervisor password.
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5. From the Supervisor main menu, press <4>. The Prompt Recorder dialog box shows
the status Supervisor logged in.

 

6. To begin recording a new prompt, click the Record button. To rerecord an existing
prompt, click Rerecord. When you hear the beep over the handset, begin recording
the prompt.

7. To stop or pause recording, click Stop. The prompt recording is saved and assigned
to the prompt number displayed next to Message Number. The length field displays
the length of the prompt in seconds.

8. To listen to the prompt, click Play.

9. To rerecord the prompt, click Rerecord.

10. To delete the prompt and start over, click Delete.

11. After you access the Prompt Recorder dialog box, you can create other new prompts
or select existing prompts to review and edit. To create a new prompt, click New.
SOLVE automatically assigns a new number to the prompt. To select an existing
prompt to review or edit, click Select. The Select Phrase dialog box displays. Select
the number of the prompt you want to review or edit and click OK. Follow the steps
above to record and review prompts.

12. To close the Prompt Recorder dialog box and return to the prompt screen, click OK.

13. To log out of the SOLVE phone interface, press <Q> on the phone keypad. Always
log out of SOLVE by pressing <Q> before hanging up the handset to allow the port
to reset.

Never shut down a port running SOLVE or perform a Force shutdown while you are
logged into SOLVE. This causes channel errors that will eventually halt M2000
operation.

Recording and Editing Prompts Using V-Edit

V-Edit is an advanced phrase editing tool that allows you to combine and edit:

• Existing phrases previously recorded with V-Edit.

• Phrases professionally recorded outside the M2000.
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V-Edit is also a phrase recording tool used in conjunction with the Visual Architect
V-Tree authoring tool. The phrases you create or modify using V-Edit are stored by
phrase number in the [Language]3.O32 phrase file, where [Language] is the primary
language on the system.

Starting V-Edit

When you start V-Edit, you can configure the startup routine to automatically prompt you
to connect to V-Edit using the phone, or you can go directly to the V-Edit main window.
Note that if you want to record or play phrases, you must connect to V-Edit through the
phone. If you want to perform any other V-Edit tasks, for example, entering text
comments for phrases and editing phrase files, you can do so without connecting over
the phone.

To start V-Edit:

1. Shut down M2000 if it is running. For additional information on shutting down the
system, see the topic, ”Shutting Down the System," in Chapter 3, “Starting, Logging
Into, and Shutting Down the System.”

2. From the Lucent Technologies folder, double-click the Visual Voice Editor icon. By
default, the Answer Phone dialog box displays.

 

3. To connect to V-Edit over the phone, select the channel you want to use to call into
V-Edit and dial the access phone number. If you do not want to connect to V-Edit
over the phone, click the Connect button. The V-Edit main window displays.

Steps 4-8 describe how to modify the startup routine for V-Edit.

4. To modify the startup routine, select Hardware from the Voice menu. The Hardware
Options dialog box displays.

 

5. In the Device Channel Number field, enter the channel number you want to use to
call into V-Edit. The number you enter in this field displays as the default channel
number in the Answer Phone dialog box.
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6. In the Maximum Time of Record field, enter the maximum recording time allowed.
This number limits the amount of time, in seconds, you can record during a single
recording session using the phone—not the maximum length of the phrases you
record. When this maximum is reached, V-Edit stops recording the phrase, and you
must begin recording again.

7. If you want to change the startup routine to start V-Edit without connecting over the
phone, select the Connect directly option. When this option is selected, the V-Edit
main window displays immediately when you start V-Edit.

8. To save the settings, click OK. The V-Edit main window displays.

You can connect to V-Edit over the phone any time by selecting Connect under the
File menu. When you select Connect, the Answer Phone dialog box displays. To
connect, select the channel you want to use to call into V-Edit and dial the access
phone number. The V-Edit main window displays.

Changing the V-Edit Display

You can change the V-Edit displays to help you perform different tasks. The V-Edit
display contains two windows, Voice and Text. The Voice window displays a graphical
representation of a phrase. The Text window displays any comments attached to the
phrase. When you first start V-Edit, both the Voice and the Text windows are tiled with
the Voice window above the Text window. To view one window at a time, cascade the
windows. You can use the zoom features in the Voice window to change the
magnification of the phrase graphic.

To cascade the Voice and Text windows:

1. Start V-Edit if it is not already running.

2. To cascade the window so that the Voice and Text windows overlap, select Cascade
from the Window menu.

3. To display the Voice window, select Voice from the Window menu. The Voice
window displays in the V-Edit main window.
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4. To display the Text window, select Text from the Window menu. The Text window
displays in the V-Edit main window.

To tile the Voice and Text windows:

1. Start V-Edit if it is not already running.

2. To tile the windows so both the Voice and Text windows display without overlapping,
select Tile from the Window menu.

To change the magnification of the phrase graphic in the Voice window:

1. Start V-Edit if it is not already running. Open the phrase file containing the phrase
you want to view.

2. To increase the magnification of the graphic, select Zoom In from the Voice menu.

3. To decrease the magnification of the graphic, select Zoom Out from the Voice
menu.
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Opening Phrase Files

M2000 includes two phrase files for each language that store the default prompts voiced
by the system. The system also provides a third phrase file to store the custom phrases
you create using V-Edit tools or that you have professionally recorded outside of the
M2000. These phrase files are designated by the language name and the .O32 file
extension. For example, the default phrase files for English are stored ENGLISH1.O32
and ENGLISH2.O32. ENGLISH3.O32 is provided for storage of custom phrases you
generate.

When you specify in a prompt number field a number for a phrase stored in the third
.O32 phrase file, you must precede the prompt number with the letter D. The D instructs
the system that the prompt you want the system to voice is stored in the .O32 file and
not in a \REC directory where the prompts you create using SOLVE or keypad prompt
recording functions are stored.

Use this procedure whenever you are instructed to open a phrase file in V-Edit.

To open an existing phrase file:

1. Start V-Edit, if it is not running.

2. From the File menu, select Open. The Open dialog box displays.

 

3. Select the drive, directory, and phrase filename of the phrase you want to open, then
click OK. The V-Edit main window displays the first phrase in the file.

4. The first time you open the [Language]3.O32 phrase file, there are 100 blank
phrases. To create room for the additional phrases, select Compress from the File
menu and enter the number of phrases you want to store in the file in the Maximum
Number of Phrases field up to a maximum of 4001. When entering a number in this
field, consider the amount of hard disk space you want the file to use. The larger the
number, the more space the file uses. To create the space for the phrases, click OK.
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Selecting Individual Phrases in the Phrase File

You can select a specific phrase from a phrase file by either selecting the phrase
number from a list of existing phrases or by entering the phrase number.

To select a phrase from a list:

1. Open the file containing the phrase you want to select.

2. From the Phrase menu, select List. The Phrase List dialog box displays.

 

3. Select the phrase you want to select, then click OK. The Voice window displays a
graphical representation of the phrase you selected.

To display the next or previous phrase in the phrase file, select Next or Previous
from the Phrase menu.

To select a phrase by entering its phrase number:

1. Open the file containing the phrase you want to select.

2. From the Phrase menu, select Number. The Go to phrase dialog box displays.

 

3. Enter the number of the phrase you want to select, then click OK. The Voice window
displays a graphical representation of the phrase you selected.

To display the next or previous phrase in the phrase file, select Next or Previous
from the Phrase menu.
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Recording Phrases

Use these procedures to record phrases using V-Edit record features. You can record a
single phrase at a time or use the Record Group option to speed procedures for
recording several phrases during one session. The Record Group option speeds the
recording process by automatically prompting you to record phrases, saving you the time
it takes to do so by selecting menus and options.

Be sure to write down the numbers assigned to the new prompts you create. You must
specify the prompt numbers—preceded with the letter D to indicate phrases stored in a
.O32 file)—in the appropriate fields of the screens on which you specify prompts voiced
by the system.

To record a single phrase:

1. Start V-Edit, if it is not running.

2. If the Answer Phone dialog box does not automatically display, select Connect from
the File menu. The Answer Phone dialog box displays. To connect to V-Edit through
the phone, dial the system access phone number.

3. Open the phrase file in which you want to store the phrase.

4. From the Phrase menu, select Number or List to indicate the number of the phrase
you want to record or rerecord.

5. To record the phrase, select Record Phrase from the Voice menu. The V-Editor #
dialog box displays.

 

6. Click the Record button and begin recording the phrase when you hear the beep.

7. To stop recording, click Stop. The phrase is saved and assigned the number
displayed next to V-Editor # in the dialog box's title bar. The Time field displays the
length, in seconds, of the phrase you recorded.

8. To listen to the phrase, click Play.

9. To rerecord the phrase, click Record. Begin recording the prompt when you hear the
beep.

10. To close the V-Edit # dialog box, click OK. A graphical representation of the
recording displays in the Voice window of the V-Edit main window.
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To record a group of phrases:

1. Start V-Edit, if it is not running.

2. If the Answer Phone dialog box does not automatically display, select Connect from
the File menu. The Answer Phone dialog box displays. To connect to V-Edit through
the phone, dial the system access phone number.

3. Open the phrase file in which you want to store the phrase.

4. From the Voice menu, select Record Group. The Record dialog box displays.

 

5. In the Phrase Number field, enter the number of the first phrase in the group you
want to record, then click OK. The V-Editor # dialog box displays.

 

6. To record the phrase, click Record and begin recording the phrase when you hear
the beep.

7. To stop recording, click Stop. The recording is saved and assigned the number
displayed next to Phrase # in the dialog box title bar. The Time field displays the
length, in seconds, of the phrase you recorded.

8. To listen to the phrase, click Play.

9. To rerecord the phrase, click Record. Begin recording the phrase when you hear the
beep.

10. To save the current phrase and record the next phrase, click OK. The Record dialog
box displays, and the Phrase number field displays the next consecutive phrase
number in the phrase file.

11. To accept this phrase number, click OK. To enter a new number, enter the number
in the Phrase Number field, then click OK. The V-Editor # dialog box displays.

12. Repeat steps 4-11 until you have recorded all the phrases in the group.

13. When you finish recording phrases, click Cancel in the Record dialog box. The
V-Edit main window displays. A graphical representation for the last phrase you
recorded displays in the Voice window of the V-Edit main window.
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Adding Segments to Phrases

V-Edit editing tools allow you to construct new phrases by piecing together parts of
existing phrases. You can use the cut, copy, and paste features of V-Edit to merge parts
of phrases to create a single phrase. You can also insert existing files and new
recordings into phrases.

To undo the last editing task you performed, select the Undo from the Edit menu.

To cut or copy and paste parts of phrases into other phrases:

1. Start V-Edit, if it is not running.

2. Open the phrase file in which the phrase from which you want to cut or copy a
segment is currently stored.

3. From the Phrase menu, select Number or List to select the number of the phrase
from which you want to cut or copy.

4. Using the mouse, select the part of the phrase you want to cut or copy. The selected
part is marked with vertical dotted lines. To select the entire phrase, choose Select
All from the Edit menu.

5. To listen to the selected part of the phrase, select Play from the Voice menu. To
listen to the unselected part of the phrase, select Play Unselected from the Voice
menu. This helps to ensure that you have selected the correct part of the phrase.
Note that you must be connected to V-Edit through the phone to use the play
features.

6. To remove the selected part from the phrase and place it on the clipboard, select
Cut from the Edit menu. The selected part is removed and the remaining parts of the
phrase are displayed in the Voice window.

7. To copy the selected part from the phrase and leave the original phrase intact, select
Copy from the Edit menu. The selected part of the phrase is copied to the clipboard.

After you use the Cut or Copy options under the Edit menu, they are not active again
until you clear the clipboard by selecting the Paste command.

8. Open the phrase in which you want to add the phrase segment you cut or copied.

9. In the Voice window, click the graphical representation of the phrase to place the
insertion point where you want to paste the phrase from the clipboard. The insertion
point is marked with a vertical dotted line. If the Voice window for the phrase you
want to add to is blank, click in the Voice window to place the insertion point at the
left side of the window.

10. To add the phrase from the clipboard into the currently displayed phrase, select
Paste from the Edit menu. The segment is inserted to the right of the insertion point.
The Voice window displays the modified phrase.

To insert a file or recording into a phrase or replace a phrase:

1. Start V-Edit, if it is not running.

2. Open the phrase file in which the phrase you want to edit is currently stored.
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3. From the Phrase menu, select Number or List to select the number of the phrase
you want to edit.

4. In the Voice window, click the graphical representation of the phrase to place the
insertion point where you want to insert the file or recording. The insertion point is
marked with a vertical dotted line.

5. From the Insert menu, select File if you want to insert a phrase file, or select Record
if you want to add a recording to a phrase. If you select File, the Open dialog box
displays. If you select Record, the V-Editor # dialog box displays.

6. To insert a file, select the drive, directory, and filename for the file you want to
insert, then click OK. The selected file is copied into the current phrase, and the
modified phrase displays in the Voice window of the V-Edit main window.

7. To insert a recording, select Record Phrase from the Insert menu, record the phrase,
then click OK. The modified phrase displays in the Voice window of the V-Edit main
window. For additional information on recording, see the topic, "Recording Phrases,"
earlier in this chapter.

8. To replace the phrase with another phrase, select Read from the Voice menu. Select
the file containing the phrase that is to replace the current phrase from the dialog
box, then click OK.

Removing Parts of a Phrase

You can remove parts of phrases by using the Delete and Trim options under the Edit
menu. The Delete feature allows you to specify the parts of the phrase you want to
delete. The Trim feature allows you to specify the parts of the phrase you want to save.

To undo the last editing task you performed, select Undo from the Edit menu .

To delete parts of a phrase:

1. Start V-Edit, if it is not running.

2. Open the phrase file containing the phrase you want to modify.

3. Using the mouse, select the part of the phrase you want to delete.

4. To listen to the selected part of the phrase, select Play from the Voice menu. To
listen to the unselected part of the phrase, select Play Unselected from the Voice
menu. This helps to ensure that you have selected the correct part of the phrase.
Note that you must be connected to V-Edit through the phone to use the play
features.

5. To delete the selected part of the phrase, select Delete from the Edit menu. The
Voice window displays the modified phrase.

To trim parts of a phrase:

1. Start V-Edit, if it is not running.

2. Open the phrase file containing the phrase you want to modify.

3. Using the mouse, select the part of the phrase you want to save.
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4. To listen to the selected part of the phrase, select Play from the Voice menu. To
listen to the unselected part of the phrase, select Play Unselected from the Voice
menu. This helps to ensure that you have selected the correct part of the phrase.
Note that you must be connected to V-Edit through the phone to use the play
features.

5. To trim the unselected part of the phrase, select Trim from the Edit menu. The Voice
window displays the modified phrase.

Controlling Silence Before and After a Phrase

V-Edit allows you to specify the amount of silence to leave at the beginning and the end
of every phrase. A small amount of silence before and after phrases provides a natural
break in voicing when phrases are strung together. For example, if you enter 250 in the
from end of phrase field, ¼ second of silence is left at the end of the phrase. After you
specify the amount of silence you want to leave before and after all phrases, you can
use the Delete Silence option to delete excess silence from individual phrases.

To control silences before and after a phrase:

1. Start V-Edit if it is not running.

2. To specify the amount of silence that should be left at the beginning and end of
phrases, select Voice from the Options menu. The Voice Options dialog box
displays.

 

3. In the From Start of Phrase field, enter the number of milliseconds of silence you
want at the beginning of phrases.

4. In the From End of Phrase field, enter the number of milliseconds of silence you
want at the end of phrases.

5. To save the entered values, click OK. The V-Edit main window displays.

6. To remove excess silence from an individual phrase, open the phrase file and select
the phrase’s phrase number.

7. From the Voice menu, select Del Silence. V-Edit removes any silence before and
after the phrase in excess of the amount you specified in the Voice Options dialog
box.
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Managing Phrase Files

V-Edit provides options that allow you to display detailed phrase file information, copy
several phrases into another phrase file for modifying, and compress phrase files to
eliminate unused file space.

To display phrase file information:

1. Open the phrase file for which you want to display file information.

2. From the File menu, select File Information. The File Information dialog box displays
the following information:

• File Name – The path and name of the phrase file.

• File Size – The length of the file in milliseconds.

• Unused File Space – The amount of silence in the file in milliseconds.

• Phrase in Use – The phrase number currently displayed in the Voice window.

• Sampling Rate – The number of times per second the voice board converts
the voice signal to digital.

• Channel – The channel to which the phone interface connects to V-Edit.

• VOXLIB.DLL – Displays whether the play and record functions are available
on the system.

 

3. To close the File Information dialog box, click OK. The V-Edit main window displays.

To save a range of phrases into another phrase file:

1. Open the phrase file containing the phrases you want to save to another file.

2. From the File menu, select Save As. The Save As dialog box displays.

 

3. Verify that the path and filename of the file containing the phrases you want to save
is displayed in the From field. If the path and filename are not correct, either enter
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the appropriate path and filename, or click From and select the appropriate path and
filename.

4. Under Phrase, enter the first phrase number in the range of phrases you want to
save in the Start field next to From.

5. Under Phrase, enter the last phrase number in the range of phrases in the End field
next to From.

6. Enter the path and filename where you want to save the phrases by either entering
the path and filename in the To field, or clicking To and selecting the path and
filename.

7. Under Phrase, select the first phrase number for the phrases in the Start field next to
To.

8. To save the phrases in the new file, click OK. The V-Edit main window displays.

Existing phrases within the specified range are overwritten in the current file.

To compress phrase files:

1. Open the phrase file you want to compress.

2. From the File menu, select Compress. The Compress dialog box displays.

 

3. In the Maximum Number of Phrases field, enter a number larger than the highest
phrase number in the file.

If you enter a number lower than the highest phrase number, all phrases with
numbers higher than that number are deleted when you compress the file.

4. To compress the file, click OK. A progress indicator box displays the progress of the
compression.
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Creating, Displaying, and Printing Text Comments

You can use V-Edit’s text options to attach comments to phrase files to help you identify
phrase contents when performing editing tasks. You can enter comments in V-Edit by
typing text directly in the Text window or importing text created using other text editors
into the .O32 phrase files. You can also use V-Edit to export text you entered in the Text
window to a text file.

To enter text comments using V-Edit:

1. Open the phrase file and number containing the phrases to which you want to enter
comments.

2. Click the Text window to select it, or select Text from the Window menu.

3. Enter the comments in the Text window. When you finish entering comments, click
the Voice window to activate it, or select another phrase number.

To import text comments into a .O32 file:

1. Open the phrase file containing the phrases to which you want to import comments.

2. From the Text menu, select Read. The Read Comments dialog box displays.

 

3. Specify the text file you want to import by either entering the path and filename, or
clicking File and selecting the drive, directory, and filename.

Only comments contained in .TXT files can be read into V-Edit phrase files. Each
comment in the text file should start on a new line and must be preceded by the
corresponding phrase number in brackets, such as:

[1] Enter the extension of the person you are calling.

4. In the Starting phrase field, enter the first phrase number for which you want to
import comments.

5. In the Ending phrase field, enter the phrase number of the last phrase file for which
you want to import comments.

6. To import the comments for the selected file, click OK. The file imports, and the
V-Edit main window displays.

Existing comments within the specified range are overwritten in the current phrase
file.
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To export text comments to text files:

1. Open the phrase file containing comments you want to export to a file.

2. From the Text menu, select Write. The Write Comments dialog box displays.

 

3. Specify the .TXT file you want to export to either by entering the path and filename
or by clicking File and selecting the drive, directory, and filename.

4. In the Starting phrase field, enter the number of the first phrase containing the
comments you want to export.

5. In the Ending phrase field, enter the number of the last phrase containing the
comments you want to export.

6. To export the comments to the selected file, click OK. The comments export to the
file you specified, and the V-Edit main window displays.

To print text comments:

1. Open the phrase file containing the comments you want to print.

2. From the Text menu, select Print. The Print Comments dialog box displays.

 

3. In the Starting phrase field, enter the number of the first phrase containing the
comments you want to print.

4. In the Ending phrase field, enter the number of the last phrase containing the
comments you want to print.

5. To print the comments for the selected file, click OK. The comments print, and the
V-Edit main window displays.
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To delete comments:

1. Open the file containing the comments you want to delete.

2. From the Text menu, select Delete. The Delete Comments dialog box displays.

 

3. In the Starting Phrase field, enter the number of the first phrase containing the
comment you want to delete.

4. In the Ending Phrase field, enter the number of the last phrase containing the
comment you want to delete.

5. To delete the comments for the selected file, click OK. The comments are deleted,
and the V-Edit main window displays.

Shutting Down V-Edit

When you have completed the recording or editing session, use this procedure to shut
down V-Edit. If you connected to V-Edit over the phone, do not disconnect by hanging up
the handset since this could prevent the port from resetting.

To shut down V-Edit:

1. From the File menu, select Quit.

2. The V-Edit main window closes, and the phone connection, if established, is
terminated. The OS/2 desktop displays.
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Notes:
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C H A P T E R  7

Generating and Interpreting Reports

This chapter provides information on generating nine different reports on M2000 to help
you monitor subscriber mailboxes, system configuration, and network messaging. You
can generate the following reports:

• Mailbox Quick List report.

• Mailbox Usage report.

• Mailbox Information report.

• Login Failures report.

• Uninitialized Mailboxes report.

• Port Assignments report.

• Class of Service report.

• Prompt Assignments report.

• Network Statistics report.
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Printing, Saving, and Displaying Reports

When you generate a report, you can either print it, save it to disk, or display it onscreen.
Printing a report allows you to print the report to a printer. Saving a report to disk allows
you to save the report electronically so you can easily store it or send it to someone else.
Displaying a report on screen allows you to view report information quickly. No matter
which report you want to generate, you follow the same general steps to print the report,
save it to a file, or display it on screen.

Printing a Report

To print a report:

1. Verify that the M2000 PC is attached to a printer either directly or over a network.

Contact the LAN administrator if you want to configure the M2000 PC to print over a
network.

2. Log into M2000 as a Level 2 or 3 supervisor.

3. From the Reports menu, select the name of the report you want to print. The Reports
dialog box displays.

4. Complete the dialog box by entering the appropriate information. For details on
completing dialog box options for a specific report, see the appropriate topic that
follows.

5. To print the report, click Printer. The report prints and the main system window
displays.

Saving a Report to Disk

You can save the report to a hard drive, diskette drive, network drive, or any other
storage location available on the M2000 PC.

To save the report to disk:

1. Log into M2000 as a Level 2 or 3 supervisor.

2. From the Reports menu, select the name of the report you want to generate and
save to disk. The Reports dialog box displays.

3. Complete the dialog box by entering the appropriate information. For details on
completing specific dialog box options for a report, see the section on that report.
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4. To save the report to disk, click Disk. A file destination dialog box displays.

 

5. Enter the drive and destination where you want to save the report. If you want to
save the report on diskette, place the diskette into the diskette drive. For example, if
you want to save the report as REPORT1.TXT on the A: diskette drive, type
A:\REPORT1.TXT.

6. To save the report, click OK. The report is saved to the drive and directory you
specified, and the main system window displays.

Displaying a Report Onscreen

To display a report onscreen:

1. Log into M2000 as a Level 2 or 3 supervisor.

2. From the Reports menu, select the name of the report you want to display. The
Reports dialog box displays.

3. Complete the dialog box by entering the appropriate information. For details on
completing dialog box options for a specific report, see the appropriate section that
follows.

4. To display the report on screen, click Screen. The report displays.

5. To close the report, double-click the upper-left corner of the report title bar. The
report closes, and the main system window displays.

If you accidentally minimize or hide a report onscreen, the report menu will be dimmed.
Press <CTRL+ESC> to display the Window menu, double-click Lister to restore the
report window, then close the report window.  You can then access the Report menu
options.

Mailbox Quick List Report

The Mailbox Quick List report provides general information about all system mailboxes,
as follows:

• Mailbox number.

• Mailbox subscriber’s name.

• Mailbox subscriber’s extension.

• Mailbox subscriber’s company.

• Mailbox subscriber’s division.
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Generating the Mailbox Quick List Report

To generate the Mailbox Quick List report, select Mailbox Quick List from the Reports
menu. When the Reports dialog box displays, select the appropriate options, then click
Printer, Disk, or Screen.

Sort By Name – Sorts the report alphabetically by mailbox subscriber’s last name.

Sort By Mailbox – Sorts the report by mailbox number in ascending order.

Company – Identifies the companies to be included in the report. Enter the name of a
company whose mailboxes you want to display, or type ALL to display mailboxes for all
companies.

Division – Identifies the divisions to be included in the report. Enter the name of a
division whose mailboxes you want to display, or type ALL to display mailboxes for all
divisions.

Interpreting the Mailbox Quick List Report

When you generate the Mailbox Quick List report, the report displays the following
information:

Name – Displays the mailbox subscriber’s last name, then first name, separated by a
comma.

Box # – Displays the system mailbox number.

Extension – Displays the mailbox subscriber’s telephone extension.

Company – Displays the mailbox subscriber’s company.

Division – Displays the mailbox subscriber’s division.
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MAILBOXES – QUICK LIST          11/01/97     11:03 AM Page 1

Name Box # Extension Company Division

Williams,Jane 1000 1000 ABC Sales

Feather,Heidi 1100 1100 ABC Sales

Fulton,John 1200 1200 ABC Sales

Teller,Susan 1300 1300 ABC Sales

Hunter,Beth 1400 1400 ABC Sales

Kessle,Joan 1500 1500 ABC Sales

Pattser,Amber 1600 1600 ABC Sales

Robinson,Kim 1700 1700 ABC Sales

Green,Emily 1800 1800 ABC Sales

Brown,Daniel 1900 1900 ABC Sales

Winters,Robert 2000 2000 ABC Support

Graham,Ellen 2100 2100 ABC Support

Mailbox Usage Report

The Mailbox Usage report provides information on system mailbox activity, as follows:

• Number of messages that have been sent to the mailbox during the current
month.

• Total amount of time callers spent logged into the mailbox during the current
month.

• Number of calls that have accessed the mailbox during the current month.

Generating the Mailbox Usage Report

To generate the Mailbox Usage report, select Mailbox Usage from the Reports menu.
When the Reports dialog box displays, select the appropriate options, then click Printer,
Disk, or Screen.

Sort By Name – Sorts the report alphabetically by mailbox subscriber’s last name.

Sort By Mailbox – Sorts the report by mailbox number in ascending order.

Company – Identifies the companies to be included in the report. Enter the name of a
company whose mailboxes you want to display, or type ALL to display mailboxes for all
companies.
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Division – Identifies the divisions to be included in the report. Enter the name of a
division whose mailboxes you want to display, or type ALL to display mailboxes for all
divisions.

Interpreting the Mailbox Usage Report

When you generate the Mailbox Usage report, the report displays the following
information:

Mailbox – Displays the system mailbox number.

Name – Displays the mailbox subscriber’s name.

Company – Displays the mailbox subscriber’s company.

Division – Displays the mailbox subscriber’s division.

Msgs – Displays the total number of messages that have been sent to the mailbox
during the current month, or since the mailbox statistics were cleared.

Sub – Displays the total amount of time, in minutes, that the subscriber spent logged
into the mailbox during the current month, or since the mailbox statistics were cleared.

NonSub – Displays the total amount of time, in minutes, that non-subscribers spent in
the mailbox during the current month or since the mailbox statistics were cleared. This
includes the time a non-subscriber spent using a V-Tree in a mailbox if the mailbox uses
a V-Tree.

In – Displays the total number of calls transferred to the mailbox from the automated
attendant during the current month or since the mailbox statistics were cleared.

Out – Displays the total number of times the mailbox used an outbound port for calls.
This includes sending message notifications, sending faxes, autoprinting faxes, lighting
message indicators, or delivering wake-up calls during the current month, or since the
mailbox statistics were reset using Clear Mailbox under the Mailbox menu.

MAILBOXES - USAGE              11/01/97           11:03 AM           Page 1

Mailbox Name Company Division Msgs Sub NonSub In Out

1000 Williams,Jane ABC Sales 49 57m 20m 27 5
1100 Feather,Heidi ABC Sales 139 176m 87m 74 31
1200 Fulton,John ABC Sales 80 128m 39m 75 0
1300 Teller,Susan ABC Sales 124 339m 58m 68 23
1400 Hunter,Beth ABC Sales 99 167m 60m 105 126
1500 Kessle,Joan ABC Sales 177 273m 168m 286 109
1600 Pattser,Amber ABC Sales 76 84m 56m 51 3
1700 Robinson,Kim ABC Sales 147 145m 49m 39 12
1800 Green,Emily ABC Sales 39 60m 25m 26 0
1900 Brown,Daniel ABC Sales 107 173m 94m 133 10
2000 Winters,Robert ABC Support 78 112m 385m 25 31
2100 Graham,Ellen ABC Support 63 95m 87m 56 64
2200 Sanders,Gary ABC Support 129 268m 96m 56 122
2300 Toth,Frank ABC Support 90 146m 187m 40 20
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Mailbox Information Report

The Mailbox Information report provides detailed information about system mailboxes,
as follows:

• Mailbox’s class of service number.

• Mailbox’s personal operator.

• Total time the mailbox was used during the current and previous months.

• Total time the mailbox was used since its creation.

Generating the Mailbox Information Report

To generate the Mailbox Information report, select Mailbox Information from the Reports
menu. When the Reports dialog box displays, select the appropriate options, then click
Printer, Disk, or Screen.

Sort By Name – Sorts the report alphabetically by mailbox subscriber’s last name.

Sort By Mailbox – Sorts the report by mailbox number in ascending order.

Company – Identifies the companies to be included in the report. Enter the name of a
company whose mailboxes you want to display, or type ALL to display mailboxes for all
companies.

Division – Identifies the divisions to be included in the report. Enter the name of a
division whose mailboxes you want to display, or type ALL to display mailboxes for all
divisions.

Interpreting the Mailbox Information Report

When you generate the Mailbox Information report, the report displays the following
information:

Mailbox Number – Displays the system mailbox number.

Extension – Displays the mailbox subscriber’s extension number.

Class of Service – Displays the Class of Service number assigned to the mailbox.

Subscriber – Displays the mailbox subscriber’s name.

Date Last Use – Displays the date the last time the mailbox was accessed.
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Personal Operator – Displays the personal operator mailbox number where callers are
routed when they request to speak to an operator when the extension is busy or not
answered.

Cur Column – Displays mailbox usage for the current month, or since the mailbox
statistics were cleared.

Last Column – Displays mailbox usage for the previous month, or since the mailbox
statistics were cleared.

Total – Displays the total mailbox usage since the mailbox was created, or since the
mailbox statistics were cleared.

Calls Received – Displays the total number of times the extension has been dialed by
internal or external callers during the current month, or since the mailbox statistics were
cleared.

Mailbox Used – Displays the number of times the subscriber successfully logged into
the mailbox during the current month or since the mailbox statistics were cleared.

Messages – Displays the number of messages sent to the mailbox during the current
month, or since the mailbox statistics were cleared.

Message Time – Displays the total length of time, in minutes, of the messages in the
mailbox during the current month, or since the mailbox statistics were cleared.

Subscriber Time – Displays the total amount of time, in minutes, that the subscriber
spent logged into the mailbox during the current month, or since the mailbox statistics
were cleared.

NonSubscriber Time – Displays the length of time, in minutes, that a nonsubscriber
accessed the mailbox.

Outcalls – Displays the total number of times the mailbox placed a call during the
current month, or since the mailbox statistics were cleared. This includes sending
message notifications, sending faxes, autoprinting faxes, lighting message indicators, or
delivering wake-up calls.

Outcall Time – Displays the total amount of time, in minutes, used for the outcalls.

Transfers (Busy) – Displays the number transfers from the automated attendant to the
mailbox extension when the extension was busy.

Transfers (NOAN) – Displays the number of calls transferred from the automated
attendant to the mailbox extension when the extension was not answered.

Transfers (To Ext.) – Displays the number of calls transferred from the automated
attendant to the mailbox extension that were successfully connected.

Faxes Received – Displays the number of faxes received by the mailbox during the
current month, or since the mailbox statistics were cleared.

Faxes Sent – Displays the total number of faxes sent from this mailbox during the
current month, or since the mailbox statistics were cleared.

Network Admin Outbound – Displays the number of administered network messages
sent from the mailbox during the current month, or since the mailbox statistics were
cleared.

Network Inbound – Displays the number of network messages sent to the mailbox
during the current month, or since the mailbox statistics were cleared.

Network Casual Outbound – Displays the number of casual AMIS messages sent from
the mailbox during the current month, or since the mailbox statistics were cleared.
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MAILBOXES–INFORMATION 11/01/97     11:38 AM                        Page 1

Mailbox number: 1400 Ext: 1400 COS: 1

Subscriber: Adams,Tom ABC Sales

Date of last use: 10/28/97 Personal Operator:

Cur Last Total Cur Last Total
Calls Received: 112 130 242 Mailbox Used 68 83 151
Messages: 68 79 147 Message Time (m) 70 88 158
Subscriber Time(m): 129 157 286 NonSubscriber

Time:
45 57 102

Outcalls: 22 30 52 Outcall Time (m): 13 20 33
Transfers (BUSY): 24 32 56 Transfers (NOAN): 32 45 77
Transfers (To Ext.): 18 12 30
Faxes Received: 12 21 33 Faxes Sent: 41 52 93
Network Admin Out: 5 8 13 Network Inbound: 3 8 11
Network Casual Out: 6 5 11

Login Failure Report

The Login Failure report provides a list of all unsuccessful login attempts to system
mailboxes. An unsuccessful login attempt occurs when a subscriber enters a mailbox
number but fails to enter the valid password. For each mailbox to which an unsuccessful
login attempt was made, the report displays the following information:

• Mailbox number.

• Mailbox subscriber’s name.

• Mailbox subscriber’s company.

• Mailbox subscriber’s division.

• Date and time of the failed login.

Generating the Login Failure Report

To generate the Login Failure report, select Failed Logins from the Reports menu. When
the Reports dialog box displays, select the appropriate options, then click Printer, Disk,
or Screen.



7.  Generating and Interpreting Reports

Lucent Technologies Messaging 2000   Login Failure Report
System Manager Manual
585-345-101  (Issue 1.0 May 1998) 7-10

Sort By Last Name – Sorts the report alphabetically by mailbox subscriber’s last name.

Sort By Mailbox Number – Sorts the report by mailbox number in ascending order.

Sort by Date – Sorts the report by date of failed login in ascending order.

Company – Identifies the companies to be included in the report. Enter the name of a
company whose mailboxes you want to display, or type ALL to display mailboxes for all
companies on the system.

Division – Identifies the divisions to be included in the report. Enter the name of a
division whose mailboxes you want to display, or type ALL to display mailboxes for all
divisions in the company.

Date Range Options – Identifies a range of days to include in the report.

Interpreting the Login Failure Report

When you generate the Login Failure report, the report displays the following
information:

Sorted By – Displays how the report is sorted.

Mailbox Range – Displays the range of the mailbox numbers included in the report.

Date Range – Displays the range of days included in the report.

Total Recorded – Displays total number of failed login attempts on the M2000.

Total Displayed – Displays the total number of failed login attempts included in the
report.

Mailbox Number – Displays the mailbox number that experienced the failed login.

Mailbox Name – Displays the mailbox subscriber’s name.

Company – Displays the mailbox subscriber’s company.

Division – Displays the mailbox subscriber’s division.

Date – Displays the date of the failed login attempt.

Time – Displays the time of the failed login attempt.
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Uninitialized Mailboxes Report

The Uninitialized Mailboxes report provides information about mailboxes whose
subscribers have not changed their passwords since the mailbox was created or
reassigned. The report displays:

• Mailbox number.

• Mailbox subscriber’s name.

• Mailbox’s initial password.

• Date the mailbox subscriber last logged into the mailbox.

Generating the Uninitialized Mailboxes Report

To generate the Uninitialized Mailboxes report, you must be logged in as a Level 3
Supervisor. To display the Uninitialized Mailboxes report, select Uninitialized Mailboxes
from the Reports menu. When the Reports dialog box displays, select the appropriate
options, then click Printer, Disk, or Screen.

Sort By Last Name – Sorts the report alphabetically by mailbox subscriber’s last name.

Sort By Mailbox Number – Sorts the report by mailbox number in ascending order.

Sort By Date – Sorts the report by date of the last login.

Date Range Options – Identifies a range of days to include in the report.

Interpreting the Uninitialized Mailboxes Report

When you generate the Uninitialized Mailboxes report, the report displays the following
information:

Sorted By – Displays how the report is sorted.

Mailbox Range – Displays the range of the mailbox numbers included in the report.

Date Range – Displays the range of days included in the Reports dialog box.

Total Recorded – Displays total number of uninitialized mailboxes on M2000.
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Total Displayed – Displays the total number of uninitialized mailboxes included in the
report.

Mailbox Number – Displays the uninitialized mailbox’s number.

Mailbox Name – Displays the mailbox subscriber’s name.

Password – Displays the mailbox’s initial password.

Date Last Login – Displays the date the mailbox subscriber last logged into the mailbox.

Port Assignments Report

The Port Assignments report provides information on how the system voice ports are
used in conjunction with the Greeting by Port feature. The Greeting by Port feature
allows more than one company or unique organization to share the M2000 system by
voicing a unique greeting for calls to each company.

The Port Assignments Report displays the following information:

• Port number.

• Whether the port is active or inactive for greeting by port.

• Mailbox assigned to answer the port during business hours.

• Mailbox assigned to answer the port after business hours.

• Business hours specified for each day.

Generating the Port Assignments Report

To generate the Port Assignments report, select Port Assignments from the Reports
menu. When the Reports dialog box displays, click Printer, Disk, or Screen.
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Interpreting the Port Assignments Report

When you generate the Port Assignments report, the report displays the following
information:

Port – Displays the number of the voice port on the system.

Active – Displays whether the port is enabled for greeting by port.

During Hours – Displays the mailbox that answers calls for that port during business
hours.

After Hours – Displays the mailbox that answers calls for that port after business hours.

Day – Displays the days of the week for each port.

Open – Displays the beginning of business hours for each day of the week.

Close – Displays the end of business hours for each day of the week.

PORT ASSIGNMENTS        11/01/97     03:57 PM              Page 1

Port     Active      During Hours      After Hours    Day   Open  Close

0 Yes 1000 1200 Sun Open all day
Mon Open all day
Tue Open all day
Wed Open all day
Thu Open all day
Fri Open all day
Sat Open all day

1 Yes 1100 1300 Sun Closed all day
Mon 800 1700
Tue 800 1700
Wed 800 1700
Thu 800 2000
Fri 800 1500
Sat 1200 1700

2 Yes 1400 1400 Sun 1200 1800
Mon 1000 1800
Tue 1000 1800
Wed 1000 1800
Thu 1000 1800
Fri 1000 1800
Sat 1000 1800

3 Yes 1500 1500 Sun Closed all day
Mon Open all day
Tue Open all day
Wed Open all day
Thu Open all day
Fri Open all day
Sat Open all day

Class of Service Report

The Class of Service report displays the current setting for each feature included in each
of the 25 default Classes of Service available on the system.

Generating the Class of Service Report

To generate the Class of Service report, select Class of Service from the Reports menu.
When the Reports dialog box displays, click Printer, Disk, or Screen.
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Interpreting the Class of Service Report

When you generate the Class of Service report, the report displays the following
information:

Features Column – Displays the features available on the Class of Service screen.

COS Number Column – Displays the setting of each feature for the class of service
number specified.

CLASS OF SERVICE REPORT    11/01/97      11:14 AM                       Page 1

                                 COS Number
1 2 3 4 5 6 7 8 9

Call Screening Yes No Yes Yes Yes Yes Yes Yes Yes
Msg Confirmation Yes No Yes Yes Yes Yes Yes Yes Yes
Voice Folders Yes No Yes Yes Yes Yes Yes Yes Yes
Call Queuing Yes No Yes Yes Yes Yes No No No
Msg Indicators Yes No No No Yes Yes Yes Yes No
Intercom Paging No No No No No No No No Yes
Personal Lists Yes No Yes Yes Yes Yes Yes Yes Yes
Global Lists Yes No Yes Yes Yes Yes Yes Yes Yes
Dial By Name Yes Yes Yes Yes Yes Yes Yes Yes Yes
Call Handling Yes No Yes Yes Yes Yes Yes Yes Yes
V-Trees allowed No No Yes Yes Yes Yes Yes Yes Yes
V-Tree Fax Support No No No No No No No No No
Send Messages Yes Yes Yes Yes Yes Yes Yes Yes Yes
Receive Messages Yes Yes Yes Yes Yes Yes Yes Yes Yes
Archive Messages Yes Yes Yes Yes Yes Yes Yes Yes Yes
Undelete Messages Yes Yes Yes Yes Yes Yes Yes Yes Yes
Record Prompts Yes Yes Yes Yes Yes Yes Yes Yes Yes
Operator Access Yes Yes Yes Yes Yes Yes Yes Yes Yes
Failed Login Notify Yes Yes Yes Yes Yes Yes Yes Yes Yes
Mailbox Lock-Out Yes Yes Yes Yes Yes Yes Yes Yes Yes
Auto Time Stamp Yes Yes Yes Yes Yes Yes Yes Yes Yes
Visual Mailbox No No No No No No No No No
Multilingual Support No No No No No No No No No
Supervisor Mailbox No No No No No No No No No
Delivery Options (All) No No No No No No No No
Outcalling Type Local None Local Long Long Local Local Local Local
Batch Mode No No No No No No No No No
Network Method None None None None None None None None None
Amis Casual No No No No No No No No No
Amis Administered No No No No No No No No No
OctelNet No No No No No No No No No
Follow-Me-Forward No No No No No No No No No
Network Replies No No No No No No No No No
Language Eng. Eng. Eng. Eng. Eng. Eng. Eng. Eng. Eng.
Send Faxes No No No No No No No No No
Receive Faxes No No No No No No No No No
Max. # of Messages 30 30 30 30 30 1000 30 30 300
Max Rings 5 5 5 5 5 5 5 5 5
Max. Single Msg 300 300 300 300 300 590 300 300 300
Days for New Msg. 7 7 7 7 7 7 7 7 7
Days for Arch. Msg. 14 14 14 14 14 14 14 14 14

Prompt Assignments Report

The Prompt Assignments report provides a list of the system greetings and the prompt
number currently assigned to each prompt. The report displays:

• Standard office greetings.

• Call Queuing prompts.

• Language option prompts.

• Holiday prompts.
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Generating the Prompt Assignments Report

To generate the Prompt Assignments report, select Prompt Assignments from the Report
menu. When the Reports dialog box displays, click Printer, Disk, or Screen.

Interpreting the Prompt Assignments Report

When you generate the Prompt Assignments report, the report displays the following:

Area of Use – Displays the names of all the system greetings.

Prompt # – Displays the prompt numbers associated with greetings. A dot indicates that
no prompt is assigned for the greeting. If no prompt is recorded for the system greetings
prompts (Morning, Afternoon, Evening, and Closed greetings), the system voices a
default prompt.

SYSTEM PROMPT ASSIGNMENTS  11/01/97   11:14 AM

Area Of Use Prompt #

Morning Greeting D34
Afternoon Greeting D35
Evening Greeting D36
Closed Greeting D37
Multilingual Selection .

Call Transfer Phrase 50
Call Queuing Phrase #1 51
Call Queuing Phrase #2 52
Call Queuing Phrase #3 53
Call Queuing Phrase #4 54
Call Queuing Phrase #5 55
Call Queuing Phrase #6 56
Call Queuing Phrase #7 57
Call Queuing Phrase #8 .
Call Queuing Phrase #9 .

Attendant Menu #1 40
Attendant Menu #2 .
Attendant Menu #3 .
Attendant Menu #4 .
Attendant Menu #5 .

Message Notification Language #1 42
Message Notification Language #2 .
Message Notification Language #3 .
Message Notification Language #4 .
Message Notification Language #5 .

Holiday #1 12/25 Save 100
Holiday #2 11/26 101
Holiday #3 04/22 102
Holiday #4 01/01 Save 110
Holiday #5 .
Holiday #6 . .

Prompt numbers with a D prefix are prompts stored in the [Language]3.O32 phrase file,
where [Language] is the primary language on the system. This file generally contains
prompts that are professionally recorded or prompts recorded using V-Edit. Other prompt
numbers are phrases recorded using SOLVE or the supervisor keypad functions. For
additional information, see Chapter 6, “Recording and Editing Prompts.”
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Network Statistics Report

The Network Statistics report provides information on network events, which are
messages sent or received using the OctelNet and AMIS protocols. In addition to the
message activity, you can select whether this report is to display node information and
network statistics on a node-by-node basis. For additional information, see Chapter 9,
“Communicating Outside the System.”

Generating the Network Statistics Report

To generate the Network Statistics report, select Network Statistics from the Reports
menu. When the Networking Report dialog box displays, select the appropriate options,
then click Printer, Disk, or Screen.

Tracking Reports Options

List Errors Only – Displays only the network events that encountered errors.

Inbound – Displays a record of messages received from other voice-mail systems.

Outbound – Displays a record of messages sent to other voice-mail systems.

OctelNet – Displays messages sent or received using the OctelNet protocol.

Amis – Displays messages sent or received using the AMIS protocol.

Node Information Report Options

None – Does not display any node information.

Sort by Node Number – Displays the Node Information report sorted by node
number.

Sort by Access Phone Number – Displays the Node Information report sorted by
the phone number the system dials to send messages to another voice-mail system.

Sort by System Name – Displays the Node Information report sorted by system
name in alphabetical order.
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Interpreting the Network Statistics Report

When you generate the Network Statistics report, the report displays the following
information:

Access Number – Displays the phone number the system dials to send messages to
another voice-mail system. The word "Local" indicates the call was received by the
system.

Date – Displays the date the message was sent or received.

Time – Displays the time when the message was sent or received.

Method – Displays the dispatch option selected for the mailbox.

Connect Status – Displays whether or not a connection was established with the other
voice-mail system and the networking protocol used to send the message. The message
n/a indicates the call was received by the system.

Channel – Displays the port on which the message was sent or received.

Box ID – Displays the number of the mailbox to which the message was sent.

Duration – Displays the total length of the message in seconds.

Origination – Displays the system where the message originated. If the message was
sent from the system, the column displays the word "Local."  If the message was sent
from another voice-mail system, the column displays the access phone number.

Message Status – Displays whether the message was received. If the message was not
received, the column displays the error. For additional information on network message
errors, contact your Lucent Technologies technical support representative.

Retry – Displays the number of times the system attempted to send the message to
another voice-mail system.
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 INBOUND ERROR TRACKING - AUDIT TRAIL 09/10/97     04:26 PM                                    Page 1

ACCESS NUMBER BOX ID DATE TIME DURATION(sec.) METHOD-MSGS ORIGINATION CONNECT STATUS MESSAGE STATUS CHANNEL

LOCAL 1005 09/06/97 04:01 PM 1 n/a 14055693 n/a Bad connection 2

LOCAL 2060 09/07/97 04:07 PM 1 n/a 14055693 n/a Node deleted 9

LOCAL 3000 09/07/97 08:49 PM 23 n/a 14055693 n/a Rejected call 3

LOCAL 1000 09/08/97 09:01 AM 1 n/a 14055693 n/a Bad line 2

*** End of Report ***

OUTBOUND ERROR TRACKING - AUDIT TRAIL 09/10/97  04:26 PM Page 1

ACCESS NUMBER BOX ID DATE TIME METHOD-MSGS ORIGINATION CONNECT STATUS MESSAGE STATUS CHANNEL RETRY

44555 1042 09/06/97 04:01 PM IMMEDIATE-0 LOCAL OCTELNET NODE DISABLE 2 0

44555 2060 09/07/97 04:07 PM IMMEDIATE-0 LOCAL OCTELNET NODE DISABLE 2 0

44555 1838 09/07/97 08:49 PM IMMEDIATE-0 LOCAL OCTELNET NODE DISABLE 2 0

44555 1045 09/08/97 09:01 AM IMMEDIATE-0 LOCAL OCTELNET NODE DISABLE 2 0

*** End of Report ***

INBOUND CHECKING - AUDIT TRAIL 09/17/97  03:00 PM Page 1

ACCESS NUMBER BOX ID DATE TIME DURATION(sec.) METHOD-MSGS ORIGINATION CONNECT STATUS MESSAGE STATUS CHANNEL

LOCAL 1000 09/06/97 04:01 PM 1 n/a 14055693 n/a Delivered 2

LOCAL 2000 09/07/97 04:07 PM 1 n/a 14055693 n/a Bad line 9

LOCAL 1000 09/07/97 08:49 PM 23 n/a 14055693 n/a Mailbox Full 3

LOCAL 1000 09/08/97 09:01 AM 1 n/a 14055693 n/a Delivered 2

*** End of Report ***

OUTBOUND CHECKING - AUDIT TRAIL 08/15/97  06:54 PM Page 1

ACCESS NUMBER BOX ID DATE TIME METHOD-MSGS ORIGINATION CONNECT STATUS MESSAGE STATUS CHANNEL RETRY

44555 1002 09/06/97 04:01 PM IMMEDIATE-0 LOCAL OCTELNET Delivered 2 0

44555 2000 09/07/97 04:07 PM IMMEDIATE-0 LOCAL OCTELNET NODE DISABLE 2 0

44555 1834 09/07/97 08:49 PM IMMEDIATE-0 LOCAL OCTELNET Delivered 2 0

44555 1000 09/08/97 09:01 AM IMMEDIATE-0 LOCAL OCTELNET NODE DISABLE 2 0

*** End of Report ***

If on the Networking Reports dialog box you chose to generate a Node Information
report, the report displays the following information:

Node Number – Displays the node number on the system.

Status – Displays whether the node is active or inactive for network events. The status
may be inactive either if the system manager deactivated the node, or if the system
deactivated the node due to an excessive number of errors.

Access Number – Displays the phone number the system dials to send messages to the
other voice-mail system associated with the node.

System Name – Displays the name of the site or company for the other voice-mail
system.

Supervisor Name – Displays the name of the system manager for the other voice-mail
system.

Prompt Number – Displays the number assigned to the prompt that the system plays
when the system voices the destination of a network message for confirmation.
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Supervisor’s Box – Displays the mailbox number of the system manager on the other
voice-mail system.

Maximum Messages – Displays the maximum number of messages allowed in a queue
before the system sends the messages.

Maximum Delay – Displays the maximum amount of time the system allows messages
to wait in a queue before sending them.

Weekdays On – Displays the hour that begins the weekday economy hours.

Weekdays Off – Displays the hour that ends the weekday economy hours.

Weekends On – Displays the hour that begins the weekend economy hours.

Weekends Off – Displays the hour that ends the weekend economy hours.

Maximum Delay – Displays the maximum amount of time the system allows messages
to wait in a queue before sending them.

Outbound Attempts – Displays the number of messages the system attempted to send.

Attempts Complete – Displays the number of outbound events successfully completed.

Message Attempts – Displays the number of messages the system attempted to
deliver.

Messages Complete – Displays the number of messages successfully delivered.

Total Outcall Time – Displays the total length of time, in seconds, of all messages sent.

Total Message Time – Displays the total length of time, in seconds, of all messages
sent or received.

Failed (Busy) – Displays the total number of times the system encountered a busy
condition at the other voice-mail system.

Failed (No Answer) – Displays the total number of times the system encountered a no
answer at the other voice-mail system.

NETWORK NODE - INFORMATION 11/10/97    04:26PM                       Page 1

Node Number: 111 Status: Active
Access Number: 18135551234
System Name: Lab 1 Supervisor Name: Ellen Gray
Prompt Number: 20 Supervisors Box: 555
Maximum Msgs: 9 Maximum Delay: 90
Weekdays On: 2300 Weekdays Off: 0600
Weekends On: 2300 Weekends Off: 0600

OUTCALL Statistics: Cur Last Total MESSAGE Statistics: Cur Last Total
Outbound Attempts:  13 16 29 Message Attempts: 10 8 18
Attempts Complete: 10 14 24 Messages Complete:  10 8 18
Total Outcall Time: 234 349 583 Total Message Time: 325 113 438
Failed (Busy): 2 0 2 Failed (No Answer): 1 2 3
*** End of Report ***



7.  Generating and Interpreting Reports

Lucent Technologies Messaging 2000
System Manager Manual
585-345-101  (Issue 1.0 May 1998) 7-20

Notes:
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C H A P T E R  8

Displaying System Statistics

This chapter provides information on displaying seven different kinds of system statistics
screens on the M2000 PC to help you monitor system usage. You can display the
following:

• Channel Status window.

• Mailbox Status screen.

• Calls per Hour screen.

• System Usage screen.

• 50% Contention screen.

• 100% Contention screen.

• System Status dialog box.
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You can press <CTRL+M> to toggle between window displays. This is especially useful if
the Activate Digit Grabber (DIGRAB) and Debug Mode options are enabled in System
Setup.

Channel Status Window

The Channel Status window displays the status of each port on the system. You can also
choose to display the number of internal and external calls handled by each port
followed by the average length of the calls. The Channel Status window displays in the
top half of the screen by default when you first start M2000.

Displaying the Channel Status Window

To display the Channel Status window, select Channel Status from the Window menu.
The Channel Status window displays directly below the menu bar.

From the Display menu of the Channel Status window, select Status to display the status
of each port, or select Statistics to display the total number of calls to each port and the
average length of each call.

Interpreting the Channel Status Window

The Channel Status window displays information for four ports at a time. If the system
has more than four ports, use the scroll bars on the right side of the window to display
information for the other ports.

Status view – Displays the call activity for each port. When a call comes into a port, the
status for the port changes as the caller performs actions on the system.

Statistics view – Displays the number of incoming calls handled by the port since the
system was installed.

Mailbox Status Screen

The Mailbox Status screen displays each mailbox on the system and identifies whether
each box contains new and/or saved messages. You can also choose to display general
information about the mailboxes on the system. The Mailbox Status screen displays in
the bottom half of the screen by default when you first start M2000.

Displaying the Mailbox Status Screen

To display the Mailbox Status screen, select Mailbox Status from the Window menu. The
Mailbox Status screen displays directly below the menu bar. If the Channel Status
window is displayed, the Mailbox Status screen displays directly below the Channel
Status window. The  Mailbox Status screen displays in the bottom half of the screen by
default when you first start M2000.
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Interpreting the Mailbox Status Screen

The Mailbox Status screen displays all M2000 system mailboxes in columns across the
screen. If necessary, use the scroll bars on the right side and bottom of the screen to
display any mailboxes currently hidden from view.

Next to each mailbox number, the Mailbox Status screen displays whether the mailbox
contains new and/or saved messages. Each new message is represented by an
envelope icon . Multiple icons represent multiple new messages. A maximum of four
envelope icons will display. Saved messages are represented by a letter icon .  M2000
displays one letter icon per mailbox, regardless of the number of saved messages in the
mailbox.

You can view general information about a mailbox by clicking on the mailbox number.
The following mailbox information displays:

Mailbox – Displays the M2000 mailbox number.

Extension – Displays the mailbox subscriber’s telephone extension.

Name – Displays the mailbox subscriber’s name with the last name first.

Company – Displays the mailbox subscriber’s company.

Division – Displays the mailbox subscriber’s division.

Messages, New – Displays the number of new messages in the mailbox.

Messages, Saved – Displays the number of saved messages in the mailbox.
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Calls per Hour Screen

The Calls per Hour screen displays a bar graph depicting the number of calls to the
system per hour during the current day and previous days.

Displaying the Calls per Hour Screen

To display the Calls per Hour screen, select Calls per Hour from the Window menu. The
Calls per Hour screen displays directly below the menu bar. If the Channel Status
window is displayed, the Calls per Hour screen displays below the Channel Status
window.

Interpreting the Calls per Hour Screen

The Calls per Hour screen displays as a bar graph depicting the number of internal and
external calls that accessed either system mailboxes or the automated attendant each
hour during the current day or previous days. The left side of the graph displays the
number of calls. The bottom of the graph displays the time of day in six-hour segments
starting at midnight. Each bar identifies the call activity during a given hour. If M2000 did
not receive any calls during a particular hour, the graph displays a dash. Note that the
horizontal lines across the bar graph do not reflect specific call figures; they are
designed to assist you in interpreting the bars.

System Usage Screen

The System Usage screen displays as a bar graph depicting the percentage of available
system time that was used handling calls during each hour for the current day and
previous days.

Displaying the System Usage Screen

To display the System Usage screen, select System Usage from the Window menu. The
System Usage screen displays directly below the menu bar. If the Channel Status
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window is displayed, the System Usage screen displays below the Channel Status
window.

Interpreting the System Usage Screen

Available system time is calculated by multiplying the number of ports installed on the
system by 60 minutes. For example, if the system has four ports, the available system
time in one hour for the system is 240 minutes (60 x 4). Usage is the percentage of the
available system time in an hour that the system handled calls.

The left side of the System Usage screen displays the percentage of system usage. The
bottom of the graph displays the time of day in six-hour segments starting at midnight.
Each bar identifies the percentage of available system time the system handled calls
during a given hour. If the system did not receive any calls during a particular hour, the
graph displays a dash. Note that the horizontal lines across the bar graph do not reflect
specific usage figures; they are designed to assist you in interpreting the bars.

50% Contention Screen

The 50% Contention screen displays the percentage of an hour that half of the ports
installed on the system were handling calls at the same time for the current day and
previous days.

Displaying the 50% Contention Screen

To select the 50% Contention screen, select 50% Contention from the Window menu.
The 50% Contention screen displays directly below the menu bar. If the Channel Status
window is displayed, the 50% Contention screen displays below the Channel Status
window.
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Interpreting the 50% Contention Screen

The left side of the 50% Contention screen displays the percentage of 50% port
contention. The bottom of the graph displays the time of day in six-hour segments
starting at midnight. Each bar identifies the percentage of available time the system
handled calls during a given hour. If the system did not receive any calls during a
particular hour, the graph displays a dash. Note that the lines across the bar graph do not
indicate exact contention figures, they are designed to assist you with interpreting the
bars.

100% Contention Screen

The 100% Contention screen displays the percentage of an hour that all the ports
installed on the system were occupied at the same time for the current day and previous
days. If M2000 repeatedly experiences 100% contention for two to five percent of any
particular hour, it is recommended that you install more ports on the system, to
accommodate the call traffic.

Displaying the 100% Contention Screen

To select the 100% Contention screen, select 100% Contention from the Window menu.
The 100% Contention screen displays directly below the menu bar. If the Channel Status
window is displayed, the 100% Contention screen displays below the Channel Status
window.
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Interpreting the 100% Contention Screen

The left side of the graph displays the percentage of the hour that the system
experienced 100% contention. The bottom of the graph displays the time of day in six-
hour segments starting at midnight. Each bar identifies the percentage of available time
the system handled calls during a given hour. If the system did not receive any calls
during a particular hour, the graph displays a dash. Note that the lines across the bar
graph do not indicate exact contention figures, they are designed to assist you with
interpreting the bars.

System Status Dialog Box

The System Status dialog box displays general information about call activity handled by
the system.

Displaying the System Status Dialog Box

To display the Status dialog box, select System Status from the Options menu. The
Status dialog box displays. To close the dialog box, click OK. The main system window
displays.

Interpreting the System Status Dialog Box

Active – Displays the number of live calls currently using the system.

Messages – Displays the total number of messages sent to system mailboxes since the
system was installed.

Ckp Rate – Displays the number of calls received before the system saves the
Checkpoint file. The Checkpoint file stores critical system settings information and allows
the system to resume operation after a failure, such as a power loss. The Checkpoint
rate value is specified in System Setup.
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Total Calls – Displays the total number of calls handled by the ports on the system since
the system was installed.
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C H A P T E R  9

Using Network Messaging

One important feature of M2000 is its ability to communicate with other voice-mail
systems. Procedures in this chapter will help you to:

• Send messages to other voice-mail systems.

• Receive messages from other voice-mail systems.

• Create network nodes.

• Edit a network nodes.

• Delete a network node.

• Deactivate a node.

• Activate a node.

• Search for a network node.

• Specify mailboxes on other voice-mail systems.
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Sending Messages to Other Voice Mail Systems

The Audio Messaging Interchange Specification (AMIS) and OctelNet are network
protocols that allow M2000 to communicate with other voice-mail systems. Using AMIS
or OctelNet, a M2000 subscriber can address and send voice-mail messages to a
subscriber on another voice-mail system basically the same way the subscriber sends a
message to another subscriber on the same system.

The AMIS protocol allows M2000 to communicate with virtually any other voice-mail
system. Messages sent using AMIS can be Casual, meaning the sender addresses the
message by specifying the entire phone number of the other voice-mail system and the
destination mailbox number, or they can be Administered, meaning the sender specifies
only the node number of the other voice-mail system and the destination mailbox
number. A node number is simply a code that represents the complete phone number for
another voice-mail system. You must set up node numbers in the M2000 system before
subscribers attempt to use them to send messages to other voice-mail systems.

Though AMIS allows M2000 to communicate with other voice-mail systems, this protocol
limits the options available to the subscriber sending the message. The subscriber
cannot, for example, use the Message Confirmation or the Dial by Name features when
sending AMIS messages.

The OctelNet protocol allows M2000 to communicate only with other systems that
support OctelNet. This protocol, however, provides the subscriber with all of the options,
except sending faxes, normally available when the message is sent to another
subscriber on the same system, such as Message Confirmation and Dial by Name. As
with Administered AMIS, subscribers using OctelNet need only enter node numbers and
destination mailbox numbers when sending messages to other systems that support
OctelNet.

To send a message to a voice-mail system that has no defined node number:

1. Log into the mailbox and record a message.

If you hang up while recording, the message will not be sent because it has not been
addressed.

2. At the prompt, “Enter the destination...,” press <#> <#>.

3. When prompted, enter the telephone number of the other voice-mail system, then
press <#>.

4. When prompted, enter the destination mailbox number, then press <#>. A
destination confirmation message voices.

5. To send the message using the Economy dispatch options set up for the mailbox,
press <6>. Otherwise, the system automatically sends the message with the highest
dispatch option available for the mailbox.

6. To send the message, press <#>. The message is sent to the entered destination.

Fax messages cannot be sent to another voice-mail system. If you attempt to send a
message that includes a fax, only the voice message is sent to the other voice-mail
system.
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To send a message to a voice-mail system that has a defined node number:

1. Log into the mailbox and record a message.

If you hang up while recording, the message will not be sent because it has not been
addressed.

2. At the prompt, “Enter the destination...,” enter the destination node number and
mailbox number. For example, to send a message to mailbox 1234 on the voice-
mail system designated by node 324, enter 3241234.

3. When prompted, select the appropriate dispatch option. The message is sent based
on the dispatch option you selected and the node setup.

4. To send the message using the Economy dispatch options set up for the mailbox,
press <6>. Otherwise, the system automatically sends the message with the highest
dispatch option available for the mailbox.

5. To send the message, press <#>. The message is sent to the entered destination.

Fax messages cannot be sent to another voice-mail system. If you attempt to send a
message that includes a fax, only the voice message is sent to the other voice-mail
system.

Receiving Messages from Other Voice Mail Systems

A message sent to a M2000 mailbox from another voice-mail system is received like any
other message to the mailbox. The system manager on the other voice-mail system
must simply set up a connection to M2000 to allow the two systems to communicate.

As long as M2000 is set up to receive network messages from other voice-mail systems,
and the class of service enables a mailbox to receive messages, the mailbox can
receive messages from all other voice-mail systems.

Creating a Network Node

You can create two types of network nodes that allow the system to communicate with
other voice-mail systems:

• AMIS nodes.

• OctelNet nodes.

OctelNet nodes can only be created for use with another system that supports OctelNet.
You can create multiple OctelNet nodes that use the same serial number. For additional
information, see the topic, "Creating Multiple OctelNet Nodes for Another System," later
in this chapter.
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To create an AMIS node:

1. From the Options menu, click Network Maintenance. The Select Node dialog box
displays.

 

2. In the Enter Node Number field, enter the number of the node to create, then click
Create. The Network Node Maintenance dialog box displays the node number in the
Node Number field. Note that you must enter a number for the node in the Select
Node dialog box since there is no default value, and it cannot begin with zero.

 

The number that a subscriber enters to send a message to another voice-mail
system is comprised of the node number and the mailbox number on the other
system. If the other system uses the same first number or numbers for all of the
mailboxes, you can shorten the number the subscriber has to enter to send
messages to the other system by including the common number(s) at the end of the
node number you specify and changing the number of insignificant digits on the
Network Node Maintenance dialog box. The insignificant digits value denotes the
number of digits that are not part of the mailbox number.

For example, if all mailboxes on the other voice-mail system begin with a 7 and are
four digits long, you can enter 347 as the node number, and specify that there are
only two insignificant digits. To send a message to mailbox 7234 through that node,
the subscriber enters 347234. If all the mailboxes on the other voice-mail system do
not begin with a 7, however, the node number would be 347 and the insignificant
digits would be the default value 3. To send a message to mailbox 7234 through the
node, the subscriber must enter 3477234.

3. In the System Name field, enter the name of the other voice-mail system. The
system name is used to help locate a specific node using the search feature. If the
system name is left blank, the Access Phone number is used for the system name.

The first eight characters of each system name must be unique.
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4. To allow subscribers to use the node to send messages, select the Node Active
option. This option enables you to turn a node on or off easily without deleting the
node. When you turn the node off, subscribers cannot send messages to the other
voice-mail system through the node, and all messages that were scheduled to be
sent to that system are returned to the message sender with an appropriate
message.

5. If there is an internal telephone network that allows users to call extensions on the
other voice-mail system, enter the internal telephone network prefix for that location
in the Prefix Code field. If there is not an internal telephone network set up for the
other voice-mail system, do not change the default for the Prefix Code field. The
prefix you enter can be up to three digits long.

6. In the Access Phone Number field, enter the number (up to 16 characters) to dial for
the other voice-mail system. Note that this number must be unique on the system.
Two AMIS nodes cannot be set up to dial the same phone number.

The access phone number must include the country code, area code, and local
number of the other voice-mail system. For example, to create a node that has 1 for
the country code, 941 as the area code, and 555-1234 for the local number, you
must enter 19415551234 in the Access Phone Number field.

7. If the node number includes the first number or numbers used for all the mailbox
numbers on the other voice-mail system, enter the number of digits from the left
before the common mailbox number(s) in the Insignificant Digits field. For example,
if all mailboxes begin with a 7 and the node number is 347, enter 2 in the
Insignificant Digits field to specify that the 7 in the node number is part of the
mailbox number.

8. In the Mailbox Length field, enter the number of digits in the mailbox number on the
other system. This value determines how many numbers the subscriber has to enter
to specify the message destination mailbox. If the subscriber does not enter the
correct number of digits for this voice-mail system’s mailboxes, the system prompts
the subscriber to reenter the number.

The total number of digits the subscriber must enter to send a message to a node is
determined by adding the number of insignificant digits to the number of digits in the
mailbox number.

9. To override call progress when the system calls the other voice-mail system, enter
the number of seconds the system should wait before messages are sent in the
Answer Time field. It is recommended that you change this value from the default
value of zero only when the system is unable to send messages to the system with
call progress active.

Use caution when overriding call progress. The system calls the other voice-mail
system and waits the number of seconds entered in the Answer Time field. If this
value is set too high, such as the maximum 999, the system uses a port on the
system for over 15 minutes, preventing the system from using that port for logging
calls or performing system maintenance.

10. In the System Prompt field, enter the number of the prompt that is voiced when
subscribers send messages to this voice system. Note that this prompt must be
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recorded using SOLVE. For additional information, see the topic, "Recording and
Editing Prompts Using SOLVE," in Chapter 6, “Recording and Editing Prompts.”

11. Under Network Node Type, select AMIS to specify that this is an AMIS node.

The Standard Dispatch and Economy Dispatch options on this dialog box allow you
to override the dispatch options set up for the system. For example, you may alter
the economy dispatch options to send messages to voice-mail systems in other time
zones to enable subscribers to receive messages during normal business hours in
their particular time zone.

12. In the Maximum Messages field, enter the number of messages that should be
marked for dispatch to this node before the system sends all the messages to the
node. This allows the system to send multiple messages at one time, reducing long-
distance fees.

13. In the Maximum Delay field, enter the number of minutes that should be marked for
dispatch to this node before the system sends all the messages to the node. This
allows you to set a maximum time limit on how long a message can wait before it is
sent to the other voice-mail system.

All messages marked for standard dispatch through a node are sent when either the
maximum number of messages is reached, or the first message marked for dispatch
exceeds the maximum delay value, whichever occurs first.

14. Under Economy Dispatch, in the Weekday On field, enter the time of day to begin
the economy dispatch for weekdays. Economy dispatch options allow you to specify
the time when it is most economical to send messages to other voice-mail systems,
based on long distance fees.

15. Under Economy Dispatch, in the Weekday Off field, enter the time of day to end the
economy dispatch for weekdays.

16. Under Economy Dispatch, in the Weekend On field, enter the time of day to begin
economy dispatch on weekends.

17. Under Economy Dispatch, in the Weekend Off field, enter the time of day to end the
economy dispatch on weekends.

If a weekday time frame extends past midnight, the economy dispatch extends to
that time on Saturday morning. This also applies if the weekend time frame extends
past midnight. The economy dispatch then extends into Monday morning.

18. Under System Administrator Information, in the First Name field, enter the first name
of the person responsible for maintaining the other voice-mail system.

19. Under System Administrator Information, in the Last Name field, enter the last name
of the person responsible for maintaining the other voice-mail system.

20. Under System Administrator Information, in the Phone Number field, enter the
phone number of the person responsible for maintaining the other voice-mail
system.

21. Under System Administrator Information, in the Mailbox field, enter the mailbox
number of the person responsible for maintaining the other voice-mail system.
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The System Administrator Information is for your information only. By entering the
appropriate information, you can keep a record of the person responsible for
maintaining the other voice-mail system.

22. To save the node with the entered values, click Save. The node is created with the
entered values.

23. To create another node, click Create, then when the Select Node dialog box
displays, follow steps 2 – 22.

24. To view other nodes, click Previous or Next.

25. To close the dialog box, click OK. The main window displays.

To create an OctelNet node:

1. From the Options menu, click Network Maintenance. The Select Node dialog box
displays.

 

2. In the Enter Node Number field, enter the number of the node to create, then click
Create. The Network Node Maintenance dialog box displays the node number in the
Node Number field. Note that you must enter a number for the node since there is no
default value, this number must be unique and cannot begin with zero.
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The number that a subscriber enters to send a message to another voice-mail
system is comprised of the node number and the mailbox number on the other
system. If the other system uses the same first number or numbers for all of the
mailboxes, you can shorten the number that the subscriber has to enter to send
messages to the other system by including the repeated number at the end of the
node number you specify and changing the number of insignificant digits on the
Network Node Maintenance dialog box. The insignificant digits value denotes the
number of digits that are not part of the mailbox number.

For example, if all mailboxes on the other voice-mail system begin with a 7 and are
four digits long, you can enter 347 as the node number, and specify that there are
only two insignificant digits. To send a message to mailbox 7234 through that node,
the subscriber enters 347234. If all the mailboxes on the other voice-mail system do
not begin with a 7, however, the node number would be 347, and the insignificant
digits would be the default value 3. To send a message to mailbox 7234 through the
node, the subscriber must enter 3477234.

3. In the System Name field, enter the name of the other voice-mail system. The
system name is used to help locate a specific node using the search feature. If the
system name is left blank, the Access Phone number is used for the system name.

The first eight characters of each system name must be unique.

4. To allow subscribers to use the node to send messages, select the Node Active
option. This option enables you to turn a node on or off easily without deleting the
node. When you turn the node off, subscribers cannot send messages to the other
voice-mail system through the node, and all messages that were scheduled to be
sent to that system are returned to the message sender with an appropriate
message.

5. If there is an internal telephone network that allows users to call extensions on the
other voice-mail system, enter the internal telephone network prefix for that location
in the Prefix Code field. If there is not an internal telephone network set up for the
other voice-mail system, do not change the default for the Prefix Code field. The
prefix you enter can be up to three digits long.

6. In the Access Phone Number field, enter the number (up to 16 characters) to dial for
the other voice-mail system.

The access phone number must include the country code, area code, and local
number of the other voice-mail system. For example, to create a node that has 1 for
the country code, 212 as the area code, and 555-1234 for the local number, you
must enter 12125551234 in the Access Phone Number field.

7. If the node number includes the first number or numbers used for all the mailbox
numbers on the other voice-mail system, enter the number of digits from the left
before the common mailbox number(s) in the Insignificant Digits field. For example,
if all mailboxes begin with a 7 and the node number is 347, enter 2 in the
Insignificant Digits field to specify that the 7 in the node number is part of the
mailbox number.

8. In the Mailbox Length field, enter the number of digits in the mailbox number on the
other system. This value determines how many numbers the subscriber has to enter
to specify the message destination mailbox. If the subscriber does not enter the
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correct number of digits for this voice-mail system’s mailboxes, the system prompts
the subscriber to reenter the number.

The total number of digits the subscriber must enter to send a message to a node is
determined by adding the number of insignificant digits to the number of digits in the
mailbox number.

9. To override call progress when the system calls the other voice-mail system, enter
the number of seconds the system should wait before messages are sent in the
Answer Time field. It is recommended that you change this value from the default
value of zero only when the system is unable to send messages to the system with
call progress active.

Use caution when overriding call progress. The system calls the other voice-mail
system and waits the number of seconds entered in the Answer Time field. If this
value is set too high, such as the maximum 999, the system uses a port on the
system for over 15 minutes, preventing the system from using that port for logging
calls or performing system maintenance.

10. In the System Prompt field, enter the number of the prompt that is voiced when
subscribers send messages to the M2000 system. Note that this prompt must be
recorded using SOLVE. For additional information, see the topic, "Recording and
Editing Prompts Using SOLVE," in Chapter 6, “Recording and Editing Prompts.”

The Serial Number for the node is only used for OctelNet nodes and is automatically
retrieved by the system from the other voice-mail system the first time a message is
sent. This number is simply used to identify the unique serial number of the sentinel
used by the other voice-mail system.

11. In the Number Attempts field, enter the number of times the system should attempt
to connect with the other voice-mail system to send a message. An unsuccessful
attempt occurs when the necessary DTMF signal is not received from the other
voice-mail system. If the system fails to connect with the other voice-mail system
after the number of times specified in this field, any message that was scheduled to
be sent to that system is returned to the message sender with an appropriate
message, and the node is deactivated.

12. Under Network Node Type, select OctelNet to specify that this is an OctelNet node.

13. To facilitate the turnaround time of network message delivery, select the Response
Allowed option. When the voice-mail system is dispatching messages to another
voice-mail system, this option allows the sending system to collect any messages
queued for dispatch to it during the same call. Note, however, that this option may
lead to an increase in the toll charges incurred by the sending system.

14. To have the message sender’s Name prompt voice to the message recipient during
playback before each message that subscribers send, select the Transmit Name
option.

15. To enter NameNet entries, which allow subscribers to hear mailbox Name prompts
and use the Dial by Name feature to send messages to mailboxes on the other
voice-mail system, you must first click Save, then click NameNet. When the
NameNet dialog box displays, enter the appropriate mailbox numbers. For additional
information, see the topic, "Specifying Mailboxes on Other OctelNet Systems," later
in this chapter.
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The Standard Dispatch and Economy Dispatch options on this dialog box allow you
to override the dispatch options set up for the system. For example, you may alter
the economy dispatch options to send messages to voice-mail systems in other time
zones to enable subscribers to receive messages during normal business hours in
their particular time zone.

16. In the Maximum Messages field, enter the number of messages that should be
marked for dispatch to this node before the system sends all the messages to the
node. This allows the system to send multiple messages at one time, reducing long-
distance fees.

17. In the Maximum Delay field, enter the number of minutes that should be marked for
dispatch to this node before the system sends all the messages to the node. This
allows you to set a maximum time limit on how long a message can wait before it is
sent to the other voice-mail system.

All messages marked for standard dispatch through a node are sent when either the
maximum number of messages is reached, or the first message marked for dispatch
exceeds the maximum delay value, whichever occurs first.

18. Under Economy Dispatch, in the Weekday On field, enter the time of day to begin
the economy dispatch for weekdays. Economy dispatch options allow you to specify
the time when it is most economical to send messages to other voice-mail systems,
based on long distance fees.

19. Under Economy Dispatch, in the Weekday Off field, enter the time of day to end the
economy dispatch for weekdays.

20. Under Economy Dispatch, in the Weekend On field, enter the time of day to begin
economy dispatch on weekends.

21. Under Economy Dispatch, in the Weekend Off field, enter the time of day to end the
economy dispatch on weekends.

If a weekday time frame extends past midnight, the economy dispatch extends to
that time on Saturday morning. This also applies if the weekend time frame extends
past midnight. The economy dispatch then extends into Monday morning.

22. Under System Administrator Information, in the First Name field, enter the first name
of the person responsible for maintaining the other voice-mail system.

23. Under System Administrator Information, in the Last Name field, enter the last name
of the person responsible for maintaining the other voice-mail system.

24. Under System Administrator Information, in the Phone Number field, enter the
phone number of the person responsible for maintaining the other voice-mail
system.

25. Under System Administrator Information, in the Mailbox field, enter the mailbox
number of the person responsible for maintaining the other voice-mail system.
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The System Administrator Information is for your information only. By entering the
appropriate information, you can keep a record of the person responsible for
maintaining the other voice-mail system.

26. To save the node with the entered values, click Save. The node is created with the
entered values.

27. To create another node, click Create, then when the Select Node dialog box
displays, follow steps 2 – 26.

28. To view other nodes, click Previous or Next.

29. To close the dialog box, click OK. The main system window displays.

Creating Multiple OctelNet Nodes for Another System

Each M2000 system is assigned a unique serial number, stored on the sentinel that
identifies the system. You can create multiple OctelNet nodes for each serial number.
This is useful if another system has more than one telephone access number, and you
want to create a node for each of the numbers.

Consider the following points before assigning the same serial number to multiple
OctelNet nodes:

• On the Network Node Maintenance dialog box, you must configure all nodes
assigned the same serial number with the same Network Node Type, Network
Prefix, Standard Dispatch, and Number Attempts settings.

 This is necessary because the M2000 system places messages in dispatch
queues based on the Access Phone Number and the dispatch method. For each
Access Phone Number, there are three possible dispatch queues:  economy,
queued, and priority. When the M2000 system dispatches the messages, it uses
the node information for the first node that matches the access phone number.
Therefore, if each node is configured differently, the system may use incorrect
information to send to the other nodes, and the dispatch attempt to those nodes
may not be successful.

• You must assign the same System Prompt number to each node associated with
a particular serial number. During message receipt or reply, the system voices
the prompt for the first node it finds that matches the serial number. If there are
multiple nodes assigned to the serial number, and there are different System
Prompts assigned, the wrong prompt may be voiced.

Also, there will be multiple NameNet entries for each mailbox on remote
systems for which you create multiple nodes because NameNet entries are
based on node numbers instead of serial numbers. When a subscriber sends a
message to a mailbox at one of the nodes, the system voices the destination
confirmation information for the first match of the entry that it locates, even if it
is for a different node from the one to which the subscriber is sending the
message.

• When sorting network reports, you can obtain a complete list of nodes by sorting
by Node Number. When sorting AMIS or OctelNet reports by Access Number or
System Name, the system only includes the first occurrence of each Access
Phone Number or System Name. Other nodes assigned the same Access Phone
Number are not included.
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Editing a Node

Use this procedure to view and edit node information. The information entered for a
node specifies how a subscriber can send messages to the voice-mail system connected
through the node.

To edit a node:

1. From the Options menu, click Network Maintenance. The Select Node dialog box
displays.

 

2. In the Enter Node Number field, enter the number of the node you want to edit, then
click Edit. The Network Node Maintenance dialog box displays. If you do not know
the node number, use the search feature to help locate the appropriate node. For
additional information, see the topic, "Searching for a Node," later in this chapter.

 

3. Make the changes to the node information. For additional information on specific
fields, see one of the procedures under the topic, "Creating a Network Node," earlier
in this chapter.

4. To save your changes, click Save. The changes are saved, and the new node
settings are active for subscribers.

5. To close the dialog box, click OK. The main system window displays.
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Deleting a Node

Use this procedure to delete a node from the system. Note that you can also simply
deactivate a node without deleting it. Deactivating a node prevents subscribers from
sending messages to that voice-mail system through the node until you reactivate the
node. For additional information, see the topic, "Deactivating a Node," later in this
chapter.

To delete a node:

1. From the Options menu, click Network Maintenance. The Select Node dialog box
displays.

 

2. In the Enter Node Number field, enter the number of the node you want to delete,
then click Delete. A deletion confirmation dialog box displays. If you do not know the
node number, use the search feature to help locate the appropriate node. For
additional information, see the topic, "Searching for a Node," later in this chapter.

 

3. To confirm that you want to delete the node, click Yes. The node is deleted from the
system, and the main system window displays.

Deactivating a Node

Use this procedure to turn off a node, preventing subscribers from sending messages to
that voice-mail system through the node. This feature allows you to retain all of the node
information while preventing subscribers from using it. To remove a node permanently
from the system, you can use the network maintenance delete feature. For additional
information, see the topic, "Deleting a Node," earlier in this chapter.

Even though a node is deactivated, subscribers can still send messages to the voice-
mail system by manually entering the entire telephone and mailbox number.

Nodes can be deactivated automatically by the system when repeated attempts to send
messages to a voice-mail system are unsuccessful.
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To deactivate a node:

1. From the Options menu, click Network Maintenance. The Select Node dialog box
displays.

 

2. In the Enter Node Number field, enter the number of the node you want to
deactivate, then click Edit. The Network Node Maintenance dialog box displays. If
you do not know the node number, use the search feature to help locate the
appropriate node. For additional information, see the topic, "Searching for a Node,"
later in this chapter.

 

3. Deselect the Node Active option in the upper-right-hand corner of the dialog box.
The check mark is removed from the option.

4. To deactivate the node, click Save. The node is deactivated.

To reactivate the node, follow this procedure and select the Node Active option. A
check mark displays next to the option.

5. To close the dialog box, click OK. The main system window displays.
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Activating a Node

Use this procedure to turn a deactivated node back on, allowing subscribers to send
messages to that voice-mail system through the node. This feature allows you to turn
nodes back on that were either manually deactivated or automatically deactivated by the
system when repeated attempts to send messages to a voice-mail system were
unsuccessful.

Even though a node is deactivated, subscribers can still send messages to the voice-
mail system by manually entering the entire telephone and mailbox number.

To activate a node:

1. From the Options menu, click Network Maintenance. The Select Node dialog box
displays.

 

2. In the Enter Node Number field, enter the number of the node you want to activate,
then click Edit. The Network Node Maintenance dialog box displays. If you do not
know the node number, use the search feature to help locate the appropriate node.
For additional information, see the topic, "Searching for a Node," later in this
chapter.

 

3. Select the Node Active option in the upper-right-hand corner of the dialog box. A
check mark displays in the option.

4. To activate the node, click Save. The node is activated.

5. To close the dialog box, click OK. The main system window displays.
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Searching for a Node

Use this procedure to locate a node by the system name. Depending on how you access
the search feature, you can view, edit, or delete a node after locating it.

To search for a node:

1. To search for a node, do one of the following:

• From the Options menu, click Network Maintenance, then when the Select
Node dialog box displays, click Search.

• From the Network Node Maintenance dialog box, click Search.

 The Search dialog box displays all of the nodes alphabetically by system name.

 

2. Use the scroll bar to display additional nodes that are not displayed in the window.

3. To search for a node by entering the system name, enter the name to search for in
the Target field, then click Begin New Search. The system displays the node name
at the top of the list if a match was found. If a match of the name was not found, the
next closest name alphabetically displays.

4. Click OK to select the node. If you searched for a node from the Select Node dialog
box, the node number displays in the Enter Node Number field. If you searched for a
node from the Network Node Maintenance dialog box, the node information displays.

Specifying Mailboxes on Other OctelNet Systems

NameNet allows subscribers to use the Dial by Name feature when sending messages to
systems defined as OctelNet nodes and allows subscribers to hear the Name prompt of
the entered mailbox to verify that the message is addressed to the appropriate
subscriber on the other voice-mail system.

A NameNet entry is automatically recorded by the system the first time a message is
sent to a subscriber on the other system. You can also manually create a NameNet entry
for a mailbox on an OctelNet system through the Network Node Maintenance screen.

Once a NameNet entry is entered on the system either automatically or manually, it can
be defined as permanent or usage-based. Usage-based NameNet entries are deleted
from the system when new messages are not sent to the mailbox after a period of time
set up on the system. When a NameNet entry is marked permanent, it is stored by the
system until it is manually deleted, or the system runs low on disk space. By default, all
NameNet entries are classified as usage-based unless manually specified as permanent.
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NameNet entries are automatically deleted by the system when the system reaches 90%
storage capacity. When this occurs, the system begins deleting usage-based entries,
followed by permanent entries until the system reaches 80% storage capacity.

Use the following procedures to:

• Enter a new NameNet entry for a node.

• Mark a NameNet entry as a permanent entry.

• Delete a NameNet entry.

To enter a New NameNet entry for a node:

1. From the Options menu, click Network Maintenance. The Select Node dialog box
displays.

 

2. In the Enter Node Number field, enter the number of the node you want to edit, then
click Edit. The Network Node Maintenance dialog box displays. If you do not know
the node number, use the search feature to help locate the appropriate node. For
additional information, see the topic, "Searching for a Node," earlier in this chapter.
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3. Click NameNet Entries. The NameNet Maintenance dialog box displays the current
NameNet entries for the node.

 

4. To add a new NameNet entry, click Add New Entry. The NameNet entry dialog box
displays.

5. In the Mailbox field, enter the number of the mailbox you want to add.

6. To mark this entry as a permanent NameNet entry, select the Permanent option.

7. To create the NameNet entry for the entered mailbox number, click OK. The new
entry displays on the NameNet Maintenance dialog box. Note that the mailbox
subscriber’s name is not displayed until the system sends an administrative message
to the other voice-mail system to retrieve the mailbox subscriber’s name and Name
prompt.

8. To close the NameNet Maintenance dialog box, click OK. The Network Node
Maintenance dialog box displays.

9. To close the Network Node Maintenance dialog box, click OK. The main system
window displays.

To mark a NameNet entry as a permanent entry:

1. From the Options menu, click Network Maintenance. The Select Node dialog box
displays.
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2. In the Enter Node Number field, enter the number of the node you want to edit, then
click Edit. The Network Node Maintenance dialog box displays. If you do not know
the node number, use the search feature to help locate the appropriate node. For
additional information, see the topic, "Searching for a Node," earlier in this chapter.

 

3. Click NameNet Entries. The NameNet Maintenance dialog box displays the current
NameNet entries for the node.

 

4. Highlight the NameNet entry you want to mark as permanent, then click Permanent.
The letter "P" displays before the subscriber name.

5. To mark a permanent NameNet entry as usage-based, select the entry, then click
Permanent. The letter "U" displays next to the subscriber’s name.

6. To close the NameNet Maintenance dialog box, click OK. The Network Node
Maintenance dialog box displays.

7. To close the Network Node Maintenance dialog box, click OK. The main system
window displays.



9. Using Network Messaging

Lucent Technologies Messaging 2000 Specifying Mailboxes on Other OctelNet Systems
System Manager Manual
585-345-101  (Issue 1.0 May 1998) 9-20

To delete a NameNet entry:

1. From the Options menu, click Network Maintenance. The Select Node dialog box
displays.

 

2. In the Enter Node Number field, enter the number of the node you want to edit, then
click Edit. The Network Node Maintenance dialog box displays. If you do not know
the node number, use the search feature to help locate the appropriate node. For
additional information, see the topic, "Searching for a Node," earlier in this chapter.

 

3. Click NameNet Entries. The NameNet Maintenance dialog box displays the current
NameNet entries for the node.

 

4. Highlight the NameNet entry you want to delete, then click Delete. The entry is
deleted.

5. To close the NameNet Maintenance dialog box, click OK. The Network Node
Maintenance dialog box displays.

6. To close the Network Node Maintenance dialog box, click OK. The main system
window displays.
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C H A P T E R  1 0

Working with V-Trees

Procedures in this chapter will help you to:

• Understand V-Trees.

• Create a V-Tree.

• Define V-Tree actions.

• Assign prompts to a V-Tree.

• Activate and deactivate a V-Tree.

• Open a V-Tree.

• Save a V-Tree.

• Edit a V-Tree.

• Delete a V-Tree.

• Print a V-Tree.

• Change the V-Tree display.

• Manage Fax Retrieval documents.
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Understanding V-Trees

V-Trees are menus that you can create to provide callers with options from which they
can choose to perform actions on M2000. Callers use a V-Tree in the same way they use
the system's Attendant menu; however, V-Trees are assigned to specific mailboxes, not
to the entire M2000 system. If, for example, a caller selects an option from the Attendant
menu to speak to the sales department, the call can be transferred to a mailbox where a
V-Tree prompts the caller to choose to speak with the product A, product B, or product C
sales group. Depending on the caller’s selection, the call is then routed to an appropriate
extension.

Each menu on a V-Tree can provide callers with up to nine options. Each option
performs a certain action on the system, including advancing the caller to another menu
that contains additional options. You can create as many menus as necessary. The
actions you can assign to menu options are:

• Advance to another menu.

• Return to the previous menu.

• Record a message to a mailbox and return to the previous menu.

• Record a message to a mailbox then advance to another menu.

• Require the caller to enter a password to advance to another menu.

• Allow the caller to review and rerecord a message.

• Send a fax, which the caller selects from a voiced list.

• Send a specified fax, for which the caller enters a fax document number.

• Disconnect from the system.

• Log into a mailbox.

• Send a message to a mailbox.

• Return the caller to the system’s Automated Attendant .

• Access the subscriber directory to use the Dial by Name feature.

• Transfer the caller to a mailbox.

For additional information on a specific action, refer to the topic, "Defining V-Tree
Actions," later in this chapter.

A V-Tree assigned to a mailbox is called a mailbox V-Tree. You can edit a mailbox
V-Tree only by accessing the mailbox to which the V-Tree is assigned.

If you have the Visual Architect Developer’s Toolkit installed on the system, you can also
create non-mailbox-associated V-Tree files. V-Tree files are “portable” V-Trees, which
you can copy to other mailboxes and even other systems. The toolkit enables you to
work with V-Tree files outside of M2000 without having to open a mailbox. V-Tree files,
however, are not used by the system to perform any actions on the system until the
V-Tree file is copied to a mailbox, making it a mailbox V-Tree. For additional information
on the toolkit, refer to the topic, "Creating a V-Tree File with the Toolkit," later in this
chapter.



10. Working with V-Trees

Lucent Technologies Messaging 2000   Creating V-Trees
System Manager Manual
585-345-101  (Issue 1.0 May 1998) 10-3

Do not confuse the term node, which is used on several Visual Architect screens, with
the term network node. In Visual Architect, the term node denotes an option available on
a V-Tree menu and the options below it. In networking-related aspects, the term node
denotes a connection to another system. To eliminate possible confusion, procedures in
this chapter do not use node to describe V-Tree menu options, even though the word
appears on several program screens.

Creating V-Trees

M2000 includes two tools for creating mailbox V-Trees:

• Visual Architect or Visual V-Tree

• Phone interface

Each M2000 system has either the Visual Architect feature or the Visual V-Tree feature.
The V-Tree feature available is determined at the time of system purchase or upgrade.

Visual Architect and Visual V-Tree are graphical V-Tree generation tools, accessible only
on the M2000 PC. The phone interface is an audio, prompt-driven interface, accessible
from within a mailbox over the phone. Because they are graphical, Visual Architect and
Visual V-Tree are much easier to use to create mailbox V-Trees than the phone
interface.

To create a V-Tree file, you must have access to the Visual Architect Developer’s
Toolkit, an optional add-on module available for use with Visual Architect.

If you plan to create a V-Tree for use in a single mailbox, you need only create a
mailbox V-Tree. If you plan to create a V-Tree for use in more that one mailbox,
however, you should consider using the toolkit to create a V-Tree file, which enables you
to create one V-Tree and then copy it to more than one mailbox or even mailboxes on
other systems. Furthermore, you should use the toolkit to create a V-Tree file if you are
currently unsure to which mailbox the V-Tree must be assigned.

Before you attempt to create a V-Tree on the system, it is recommended that you
identify all of the options you want to make available to the caller on paper, in a
graphical format, to help you build the actual V-Tree.

See Preinstallation Configuration Worksheets

When setting up V-Trees on the system, refer to information provided on the V-Tree
Design Sheet(s).
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Creating a Mailbox V-Tree Using Visual Architect

Use the following procedure to create a V-Tree for a particular mailbox. This procedure
assumes that the mailbox for which you want to create a V-Tree already exists.

To create a mailbox V-Tree:

1. Start M2000, if it is not running.

2. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.

 

3. Enter the mailbox number for the mailbox for which you want to create a V-Tree,
then click Edit. The Mailbox Entry dialog box displays the mailbox information.

 

4. Under Edit, click Visual V-Tree. Visual Architect starts, and a blank V-Tree displays.
Note that, if a V-Tree already exists for the mailbox, the V-Tree displays.
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5. Double-click the V-Tree Main Greeting icon . The V-Tree Main Greeting dialog
box displays.

 

6. In the Title field, enter a title for the V-Tree. The title displays next to the V-Tree
Main Greeting icon to help you identify the V-Tree.

7. If a prompt has already been recorded for the V-Tree’s main greeting, which is the
first V-Tree menu the caller hears, enter the prompt number in the Prompt Number
field. If the prompt has been recorded and saved in the [Language]3 file with an
.O32 file extension, where [Language] is the primary language on the system, enter
the prompt number in the Prompt Number field and select the Custom Phrase File
option to specify the location of the prompt. Otherwise, the system assumes the
prompt is located in a \REC directory.

 If no prompt has been recorded for the V-Tree’s main greeting, click Voice Editor
and record the prompt. For additional information, refer to the topic, "Recording a
New Prompt for an Option on a V-Tree," later in this chapter.

8. In the Comments field, enter a description of the prompt. It is recommended that you
enter an exact transcription of the prompt to provide a quick reference of what
options the prompt voices, as well as any special instructions for selecting those
options. Note that the comments you enter are displayed on each menu action’s
dialog box to help you define each action.

9. To specify V-Tree menu options, in addition to the nine options on the V-Tree menu,
click More Options, then do either of the following:

• To allow callers to press <#> to return to the previous menu or <0> to
transfer to the operator, deselect the Functions for Special Keys option if it is
selected, then click Save. The V-Tree Main Greeting dialog box displays.

• To allow callers to press <#> to log into a mailbox:

a. Press <0> to transfer to the operator, or enter a mailbox number to
immediately transfer to that mailbox without selecting a V-Tree menu
option.

b. Select the Functions for Special Keys option if it is not selected.

c. In the Dial Thru Timeout field, enter the number of seconds for the
system to wait for a keypress. This enables the system to determine
whether the caller is selecting a V-Tree menu option or entering a
mailbox number.

d. To save the value, click Save. The V-Tree Main Greeting dialog box
displays.
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If you select the Functions for Special Keys option, you must enter a value
other than zero in the Dial Thru Timeout field to provide callers with enough
time to select a V-Tree option or to enter a mailbox number. It is
recommended that you enter a value of only two or three seconds in the Dial
Thru Timeout field to prevent the caller from having to wait too long after
selecting an option.

Dial Thru Timeout should not be activated for menus that include the
Require Password to Proceed to Next Level action. When both the Dial Thru
Timeout and the Require Password to Proceed to Next Level action are
activated for a menu, the Dial Thru Timeout takes precedence, and the
caller is unable to enter a password since the system interprets the password
as a mailbox number.

10. To save the entered information, click Save. The main Visual Architect window
displays.

Steps 11-14 describe how to select an action to assign to an option on the V-Tree.
For additional information on each action that you can assign to an option, refer to
the topic, "Defining V-Tree Actions," later in this chapter.

11. Click one of the toolbox buttons displayed on the right side of the window. The
actions for that toolbox button display to the left of the toolbox button.

 

Each menu on the V-Tree can have a maximum of nine options, which are assigned
to the keypresses 1-9. Note that you do not have to assign an option to each
available keypress; you can skip keypresses on a menu.

12. Click the action to assign to the V-Tree option. A dark gray box displays around the
selected action.

13. With the right mouse button, click the action and drag it to the appropriate menu
option of the V-Tree. When the cursor is over the menu option, release the mouse
button to assign the action to that menu option. When you "click and drag" the
action, the cursor changes to resemble the action icon, and then changes again to
display a hand with a pointed finger when the cursor is over a blank menu option of
the V-Tree. If the action provides submenu options, nine blank options display
beneath the action.
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If a menu has nine or less options assigned to it and there are no blank options
displayed to which to drag the action, expand the V-Tree options and display the
blank options. Refer to the topics, "Hiding and Displaying Blank Options," and,
"Expanding and Collapsing V-Tree Menus," later in this chapter.

14. Define the action for the V-Tree. For additional information, refer to the topic,
"Defining V-Tree Actions," later in this chapter.

15. Repeat steps 11-14 until all of the menu and submenu options for the V-Tree are
assigned and defined.

16. To close Visual Architect, select Exit from the File menu. The Mailbox Entry dialog
box displays. Note that the Visual Architect automatically saves the V-Tree as you
create it.

17. Activate the V-Tree for the mailbox. For additional information, refer to the topic,
"Activating a V-Tree for a Mailbox," later in this chapter.

18. To close the Mailbox Entry dialog box, click OK. The main system window displays.

19. Call into the system and access the mailbox to verify that the V-Tree is activated
correctly and that each prompt and option works appropriately. If the V-Tree is not
functioning correctly, open the V-Tree and make the necessary changes.

Make sure that you disable the V-Tree in Call Handling before you edit it.

Creating a V-Tree File from a Mailbox V-Tree

Use this procedure to create a V-Tree for use in a mailbox, then save the V-Tree to a file
so it can be copied to other mailboxes. If the V-Tree already exists for a mailbox and you
just want to copy it to a V-Tree file, refer to the topic, "Saving a Mailbox V-Tree to a
V-Tree File,” later in this chapter.

The Visual Architect Developer’s Toolkit must be installed to generate V-Tree files.

To create a V-Tree file from a mailbox V-Tree:

1. Start M2000, if it is not running.

2. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.

 

3. Enter the mailbox number for the mailbox for which you want to create a V-Tree,
then click Edit. The Mailbox Entry dialog box displays the mailbox information.
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4. Under Edit, click Visual V-Tree. Visual Architect starts, and a blank V-Tree displays.
Note that, if a V-Tree already exists for the mailbox, the V-Tree displays.

 

5. Double-click the V-Tree Main Greeting icon . The V-Tree Main Greeting dialog
box displays.

 

6. In the Title field, enter a title for the V-Tree. The title displays next to the V-Tree
Main Greeting icon to help you identify the V-Tree.

7. If a prompt has already been recorded for the V-Tree’s main greeting, which is the
first V-Tree menu the caller hears, enter the prompt number in the Prompt Number
field. If the prompt has been recorded and saved in the [Language]3 file with an
.O32 file extension, where [Language] is the primary language on the system, enter
the prompt number in the Prompt Number field and select the Custom Phrase File
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option to specify the location of the prompt. Otherwise, the system assumes the
prompt is located in a \REC directory.

 If no prompt has been recorded for the V-Tree’s main greeting, click Voice Editor
and record the prompt. For additional information, refer to the topic, "Recording a
New Prompt for an Option on a V-Tree," later in this chapter.

8. In the Comments field, enter a description of the prompt. It is recommended that you
enter an exact transcription of the prompt to provide a quick reference of what
options the prompt voices, as well as any special instructions for selecting those
options. Note that the comments you enter are displayed on each menu action’s
dialog box to help you define each action.

9. To specify V-Tree menu options, in addition to the nine options on the V-Tree menu,
click More Options, then do either of the following:

• To allow callers to press <#> to return to the previous menu or <0> to
transfer to the operator, deselect the Functions for Special Keys option if it is
selected, then click Save. The V-Tree Main Greeting dialog box displays.

• To allow callers to press <#> to log into a mailbox:

a. Press <0> to transfer to the operator, or enter a mailbox number to
immediately transfer to that mailbox without selecting a V-Tree menu
option.

b. Select the Functions for Special Keys option if it is not selected.

c. In the Dial Thru Timeout field, enter the number of seconds for the
system to wait for a keypress. This enables the system to determine
whether the caller is selecting a V-Tree menu option or entering a
mailbox number.

d. To save the value, click Save. The V-Tree Main Greeting dialog box
displays.

If you select the Functions for Special Keys option, you must enter a value
other than zero in the Dial Thru Timeout field to provide callers with enough
time to select a V-Tree option or to enter a mailbox number. It is
recommended that you enter a value of only two or three seconds in the Dial
Thru Timeout field to prevent the caller from having to wait too long after
selecting an option.

Dial Thru Timeout should not be activated for menus that include the
Require Password to Proceed to Next Level action. When both the Dial Thru
Timeout and the Require Password to Proceed to Next Level action are
activated for a menu, the Dial Thru Timeout takes precedence, and the
caller is unable to enter a password since the system interprets the password
as a mailbox number.

10. To save the entered information, click Save. The main Visual Architect window
displays.

Steps 11-14 describe how to select an action to assign to an option on the V-Tree.
For additional information on each action that you can assign to an option, refer to
the topic, "Defining V-Tree Actions," later in this chapter.



10. Working with V-Trees

Lucent Technologies Messaging 2000   Creating V-Trees
System Manager Manual
585-345-101  (Issue 1.0 May 1998) 10-10

11. Click one of the toolbox buttons displayed on the right side of the window. The
actions for that toolbox button display to the left of the toolbox button.

 

Each menu on the V-Tree can have a maximum of nine options, which are assigned
to the keypresses 1-9. Note that you do not have to assign an option to each
available keypress; you can skip keypresses on a menu.

12. Click the action to assign to the V-Tree option. A dark gray box displays around the
selected action.

13. With the right mouse button, click the action and drag it to the appropriate menu
option of the V-Tree. When the cursor is over the menu option, release the mouse
button to assign the action to that menu option. When you click and drag the action,
the cursor changes to resemble the action icon, and then changes again to display a
hand with a pointed finger when the cursor is over a blank menu option of the
V-Tree. If the action provides submenu options, nine blank options display beneath
the action.

If a menu has nine or less options assigned to it and there are no blank options
displayed to which to drag the action, expand the V-Tree options and display the
blank options. Refer to the topics, "Hiding and Displaying Blank Options," and,
"Expanding and Collapsing V-Tree Menus," later in this chapter.

14. Define the action for the V-Tree. For additional information, refer to the topic,
"Defining V-Tree Actions," later in this chapter.

15. Repeat steps 11-14 until all of the menu and submenu options for the V-Tree are
assigned and defined.
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16. To create the V-Tree file, select Export from the File menu. The Export Options
dialog box displays.

 

17. To save all of the comments added to the V-Tree actions in the V-Tree file, select
the Copy V-Tree Comments option.

18. To save all of the prompts associated with the V-Tree in the V-Tree file, select the
Copy V-Tree Prompts option.

19. To save all of the faxes assigned to the V-Tree in the V-Tree file, select the Copy
V-Tree Fax Documents option.

20. To save the V-Tree with the selected options in the V-Tree file, click OK. The V-Tree
Export dialog box displays.

 

21. In the Save as filename field, enter a name for the file followed by an .OVT file
extension.

22. In the Drive field, select the drive on which you want to save the V-Tree.

23. In the Directory field, select the directory in which you want to save the V-Tree.

24. To save the V-Tree with the entered name, drive, and directory, click OK. The
V-Tree is saved, and you can now copy it to another mailbox or copy it for use on
another system. For additional information, refer to the topic, "Copying a V-Tree File
to a Mailbox," later in this chapter.

25. To close Visual Architect, select Exit from the File menu. The Mailbox Entry dialog
box displays. Note that the Visual Architect automatically saves the V-Tree in the
mailbox as you create it.

26. Activate the V-Tree for the mailbox. For additional information, refer to the topic,
"Activating a V-Tree for a Mailbox," later in this chapter.
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27. To close the Mailbox Entry dialog box, click OK. The main system window displays.

28. Call into the system and access the mailbox to verify that the V-Tree is activated
correctly and that each prompt and option works appropriately. If the V-Tree is not
functioning correctly, open the V-Tree and make the necessary changes to the
mailbox V-Tree, then resave the V-Tree file.

Creating a V-Tree File with the Toolkit

Use this procedure to create a V-Tree using the Visual Architect Developer’s Toolkit.
This optional module allows you to create a V-Tree file without assigning the V-Tree to a
mailbox. After creating the V-Tree file, you can copy the V-Tree file to a mailbox. For
additional information, refer to the topic, "Copying a V-Tree File to a Mailbox," later in
this chapter.

To create a V-Tree file with the toolkit:

1. Start M2000, if it is not running.

2. Open an OS/2 window.

3. From the C:\ prompt, type CD CVR then press <ENTER>.

4. From the \CVR prompt, type VTREE then press <ENTER>. Visual Architect starts,
and a blank V-Tree displays.

 

5. Double-click the V-Tree Main Greeting icon . The V-Tree Main Greeting dialog
box displays.
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6. In the Title field, enter a title for the V-Tree. The title displays next to the V-Tree
Main Greeting icon to help you identify the V-Tree.

7. If a prompt has already been recorded for the V-Tree’s main greeting, which is the
first V-Tree menu the caller hears, enter the prompt number in the Prompt Number
field. If the prompt has been recorded and saved in the [Language]3 file with an
.O32 file extension, where [Language] is the primary language on the system, enter
the prompt number in the Prompt Number field and select the Custom Phrase File
option to specify the location of the prompt. Otherwise, the system assumes the
prompt is located in a \REC directory.

 If no prompt has been recorded for the V-Tree’s main greeting, click Voice Editor
and record the prompt. For additional information, refer to the topic, "Recording a
New Prompt for an Option on a V-Tree," later in this chapter.

8. In the Comments field, enter a description of the prompt. It is recommended that you
enter an exact transcription of the prompt to provide a quick reference of what
options the prompt voices, as well as any special instructions for selecting those
options. Note that the comments you enter are displayed on each menu action’s
dialog box to help you define each action.

9. To specify V-Tree menu options, in addition to the nine options on the V-Tree menu,
click More Options, then do either of the following:

• To allow callers to press <#> to return to the previous menu or <0> to
transfer to the operator, deselect the Functions for Special Keys option if it is
selected, then click Save. The V-Tree Main Greeting dialog box displays.

• To allow callers to press <#> to log into a mailbox:

a. Press <0> to transfer to the operator, or enter a mailbox number to
immediately transfer to that mailbox without selecting a V-Tree menu
option.

b. Select the Functions for Special Keys option if it is not selected.

c. In the Dial Thru Timeout field, enter the number of seconds for the
system to wait for a keypress. This enables the system to determine
whether the caller is selecting a V-Tree menu option or entering a
mailbox number.

d. To save the value, click Save. The V-Tree Main Greeting dialog box
displays.

If you select the Functions for Special Keys option, you must enter a value
other than zero in the Dial Thru Timeout field to provide callers with enough
time to select a V-Tree option or to enter a mailbox number. It is
recommended that you enter a value of only two or three seconds in the Dial
Thru Timeout field to prevent the caller from having to wait too long after
selecting an option.

Dial Thru Timeout should not be activated for menus that include the
Require Password to Proceed to Next Level action. When both the Dial Thru
Timeout and the Require Password to Proceed to Next Level action are
activated for a menu, the Dial Thru Timeout takes precedence, and the
caller is unable to enter a password since the system interprets the password
as a mailbox number.
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10. To save the entered information, click Save. The main Visual Architect window
displays.

Steps 11-14 describe how to select an action to assign to an option on the V-Tree.
For additional information on each action that you can assign to an option, refer to
the topic, "Defining V-Tree Actions," later in this chapter.

11. Click one of the toolbox buttons displayed on the right side of the window. The
actions for that toolbox button display to the left of the toolbox button.

 

Each menu on the V-Tree can have a maximum of nine options, which are assigned
to the keypresses 1-9. Note that you do not have to assign an option to each
available keypress; you can skip keypresses on a menu.

12. Click the action to assign to the V-Tree option. A dark gray box displays around the
selected action.

13. With the right mouse button, click the action and drag it to the appropriate menu
option of the V-Tree. When the cursor is over the menu option, release the mouse
button to assign the action to that menu option. When you click and drag the action,
the cursor changes to resemble the action icon, and then changes again to display a
hand with a pointed finger when the cursor is over a blank menu option of the
V-Tree. If the action provides submenu options, nine blank options display beneath
the action.

If a menu has nine or less options assigned to it and there are no blank options
displayed to which to drag the action, expand the V-Tree options and display the
blank options. Refer to the topics, "Hiding and Displaying Blank Options," and,
"Expanding and Collapsing V-Tree Menus," later in this chapter.

13. Define the action for the V-Tree. For additional information, refer to the topic,
"Defining V-Tree Actions," later in this chapter.

14. Repeat steps 10-13 until all of the menu and submenu options for the V-Tree are
assigned and defined.

15. To save the V-Tree file, select Save from the File menu. The V-Tree Save As dialog
box displays.
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16. In the Save as filename field, enter a name for the file followed by an .OVT file
extension.

17. In the Drive field, select the drive on which you want to save the V-Tree.

18. In the Directory field, select the directory in which you want to save the V-Tree.

19. To save the V-Tree with the entered name, drive, and directory, click OK. The
Export Options dialog box displays.

 

20. To save all of the comments added to the V-Tree actions in the V-Tree file, select
the Copy V-Tree Comments option.

21. To save all of the prompts associated with the V-Tree in the V-Tree file, select the
Copy V-Tree Prompts option.

22. To save all of the faxes assigned to the V-Tree in the V-Tree file, select the Copy
V-Tree Fax Documents option.

23. To save the V-Tree with the selected options in the V-Tree file, click OK. The V-Tree
is saved, and you can now copy it to another mailbox or copy it for use on another
system. For additional information, refer to the topic, "Copying a V-Tree File to a
Mailbox," later in this chapter.

24. To close Visual Architect, select Exit from the File menu. Visual Architect closes.

25. To test the V-Tree, copy the V-Tree to a mailbox, activate it for the mailbox, then
call the mailbox on the system to verify that the V-Tree is activated correctly and
that each prompt and option works appropriately. If the V-Tree is not functioning
correctly, open the V-Tree and make the necessary changes.
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Creating a V-Tree Using Visual V-Tree

Use this procedure to create a V-Tree for a mailbox using the Visual V-Tree feature. This
procedure assumes that the mailbox for which you want to create a V-Tree already
exists.

For information on the actions you assign to options on the V-Tree (in step 6), refer to
the topic, "Defining V-Tree Actions," later in this chapter. Also, be advised that at any
level in a V-Tree created with Visual V-Tree, callers can be instructed to press <0> to
transfer to the operator or to press <#> to return from a submenu to the previous V-Tree
menu.

To create a V-Tree using Visual V-Tree:

1. Start M2000, if it is not running.

2. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.

 

3. Enter the mailbox number for the mailbox for which you want to create a V-Tree,
then click Edit. The Mailbox Entry dialog box displays the mailbox information.
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4. Under Edit, click Visual V-Tree. The Visual V-Tree dialog box displays.

 

5. Click the arrow button to the right of the Option 1 field to display a menu of the
available actions.

6. Select an action for Option 1. If the action you select requires you to define a
variable, such as a mailbox number or fax document number, a field displays next to
the option field. You must define the variable for the V-Tree to function properly. If
the assigned action requires you to define a subsequent level, a Next button displays
next to the option field. For additional information on V-Tree actions, refer to the
topic, "Defining V-Tree Actions," later in this chapter.

7. Repeat step 6 for each option you want to define on the first level.

8. In the Prompt field, enter the number of the prompt you want the system to voice for
that level. Note that this prompt should include the actions available at the current
level.

9. If you want callers to be able either to enter an extension number at the current level
or select a menu option, select Attendant Menu Options, then enter the number of
seconds, in the Mailbox Input Timeout field, that callers have to enter an extension
number.

10. For each option with a Next button displayed, click the Next button and repeat steps
5-9.

11. Click the appropriate button at the bottom of the Visual Mailbox dialog box:

a. To display the sequence of keypresses required for a caller to advance to the
current level of the V-Tree, click Path.

b. To return to the previous level of the V-Tree, click Previous. To return to the first
level of the V-Tree, click Top.

c. To exit the V-Tree, click Exit. The Mailbox Entry dialog box displays. Note that
the V-Tree is automatically saved as you create it.

12. Activate the V-Tree for the mailbox. For additional information, refer to the topic,
"Activating a V-Tree for a Mailbox," later in this chapter.

13. To close the Mailbox Entry dialog box, click OK. The main system window displays.
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14. Call into the system and access the mailbox to verify that the V-Tree is activated
correctly and that each prompt and option works appropriately. If the V-Tree is not
functioning correctly, open the V-Tree and make the necessary changes.

Creating V-Trees Through the Phone Interface

Use this procedure to create a V-Tree for a mailbox through the phone interface. Once a
V-Tree is created through the phone interface, you can open it using Visual Architect or
Visual V-Trees. Mailbox subscribers can also use this procedure to create V-Trees for
their mailboxes.

If a mailbox does not have V-Trees selected in the Class of Service, you cannot create
V-Trees through the phone interface.

To create a V-Tree through the phone interface:

1. Log into the mailbox for which you want to create a V-Tree.

2. From the Main menu, press <4> to access the Personal Options menu.

3. From the Personal Options menu, press <2> to access the Special Features menu.

4. From the Special Features menu, press <8> to access the V-Tree menu.

5. Follow the prompts to create and edit the V-Tree.

6. When you have finished creating the V-Tree, set the appropriate Call Handling
features to allow callers to access the V-Tree.

7. Log out of the mailbox, then call into the system and access the mailbox to verify
that the V-Tree is activated correctly and that each prompt and option works
appropriately. If the V-Tree is not functioning correctly, open the V-Tree and make
the necessary changes.

Defining V-Tree Actions

V-Tree actions determine what happens when a caller chooses an option from a V-Tree
menu. There are 14 actions that you can assign to a V-Tree menu option:

• Advance to Next Menu

• Return to Previous Menu

• Record to Mailbox Return to Previous Level

• Record to Mailbox and Advance

• Require Password to Proceed to Next Level

• Review/Edit Message

• Send a Requested Fax and Advance

• Send a Predefined Fax and Advance

• Disconnect

• Go to Mailbox Login Point

• Go to Voice Mail
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• Go to Extension Entry Point

• Go To Directory Services

• Transfer to a Mailbox

If you assign only one action to a V-Tree menu, the system automatically performs that
action when the caller accesses that menu. For example, if you create a V-Tree that
allows a caller to record a message then advance to another menu, you can assign the
Disconnect action to this option’s submenu to automatically disconnect the caller after
recording a message.

The procedure following each V-Tree action description describes how to assign the
action to a V-Tree using Visual Architect. For additional information on assigning actions
to a V-Tree using Visual V-Tree, refer to the topic, "Creating a V-Tree Using Visual
V-Tree," earlier in this chapter.

V-Tree Action Summary Table

The following table displays whether each action you can assign to an option on a
V-Tree has a submenu that extends from the action and whether a prompt is voiced after
the action is performed, as well as the variable you need to specify for the action, if
necessary. For additional information, refer to details on each action that follow this
table.

Advance to Next Menu Yes Yes None

Return to Previous Menu No No None

Record to Mailbox Return to Previous Level No No Mailbox #

Record to Mailbox and Advance Yes Yes Mailbox #

Require Password to Proceed to Next Level Yes Yes None

Review/Edit Message Yes Yes None

Send a Requested Fax and Advance Yes Yes None

Send a Predefined Fax and Advance Yes Yes Fax doc #

Disconnect No No None

Go to Mailbox Login Point No No None

Go to Voice Mail No No None

Go to Extension Entry Point No No None

Go To Directory Services No No None

Transfer to a Mailbox No No Mailbox #

 Advance to Next Menu

The Advance to Next Menu action allows callers to access a submenu. This action can
provide a menu for the caller with additional options from which to choose, or it simply
can voice a prompt to communicate specific information. For example, you can use this
option to list all of the new products in a product line, along with their prices, then assign
an action on the submenu to return the caller to the main V-Tree menu.

V-Tree Action Submenu Prompt
Voiced

Variable
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Note that there are other actions that also advance the caller to the next menu; this
action, however, performs no action other than advancing the caller to the next menu
and voicing a prompt.

To define the Advance to Next Menu action:

1. Assign the Advance to Next Menu action to a blank menu option. For additional
information, refer to the topic, "Creating V-Trees," earlier in this chapter.

2. Double-click the menu option that displays the Advance to Next Menu icon. The
Advance to Next Menu dialog box displays the prompt number and comments from
the previous menu, as well as the sequence of options the caller selects to reach this
action.

 

The numbers in the Path or Outline field represent the keypresses the user must
enter to access this option. The dots between the numbers signify a menu. For
example, if the numbers in the field are 1.2.1, the caller must press <1>, then <2>,
then <1> on the phone keypad to access this action after accessing this V-Tree.

3. In the Title field, enter a title for the option. The title displays next to the action icon
to help you identify the purpose of this option on the V-Tree.

Steps 4 specifies the prompt that the caller hears after this action is performed on
the system. This prompt can voice the options available on the next menu, provide
special instructions on using the next available menu options, or simply provide the
caller with information.

4. If a prompt has already been recorded to voice after this action, enter the prompt
number in the Prompt Number field. If the prompt has been recorded and saved in
the [Language]3 file with an .O32 file extension, where [Language] is the primary
language on the system, enter the prompt number in the Prompt Number field and
select the Custom Phrase File option to specify the location of the prompt.
Otherwise, the system assumes the prompt is located in a \REC directory.

 If no prompt has been recorded for this option, click Voice Editor and record the
prompt. For additional information, refer to the topic, "Recording a New Prompt for
an Option on a V-Tree," later in this chapter.
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5. In the Comments field, enter a description of the prompt. It is recommended that you
enter an exact transcription of the prompt to provide a quick reference of what
options the prompt voices, as well as any special instructions for selecting those
options. Note that the comments you enter are displayed on each menu action’s
dialog box to help you define each action.

6. To specify V-Tree menu options, in addition to the nine options on the V-Tree menu,
click More Options, then do either of the following:

• To allow callers to press <#> to return to the previous menu or <0> to
transfer to the operator, deselect the Functions for Special Keys option if it is
selected, then click Save. The V-Tree Main Greeting dialog box displays.

• To allow callers to press <#> to log into a mailbox:

a. Press <0> to transfer to the operator, or enter a mailbox number to
immediately transfer to that mailbox without selecting a V-Tree menu
option.

b. Select the Functions for Special Keys option if it is not selected.

c. In the Dial Thru Timeout field, enter the number of seconds for the
system to wait for a keypress. This enables the system to determine
whether the caller is selecting a V-Tree menu option or entering a
mailbox number.

d. To save the value, click Save. The V-Tree Main Greeting dialog box
displays.

If you select the Functions for Special Keys option, you must enter a value
other than zero in the Dial Thru Timeout field to provide callers with enough
time to select a V-Tree option or to enter a mailbox number. It is
recommended that you enter a value of only two or three seconds in the Dial
Thru Timeout field to prevent the caller from having to wait too long after
selecting an option.

Dial Thru Timeout should not be activated for menus that include the
Require Password to Proceed to Next Level action. When both the Dial Thru
Timeout and the Require Password to Proceed to Next Level action are
activated for a menu, the Dial Thru Timeout takes precedence and the caller
is unable to enter a password since the system interprets the password as a
mailbox number.

7. To save the entered information, click Save. The main Visual Architect window
displays.

 Return to Previous Menu

The Return to Previous Menu action allows callers to return to the last menu that had
more than one option available. This feature allows the caller to perform an action on the
system and then return to a previous menu to perform another action without having to
call the mailbox again. For example, you can use this action to return to the beginning of
a V-Tree that used single-option menus to record several messages on the system.

There are no prompts or variables that can be assigned to the Return to Previous Menu
action, since this action only allows a caller to return to the previous menu. You can
double-click the menu option to display the Return to Previous Menu dialog box, which
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displays the prompt number and comments from the previous menu and the sequence of
options the caller selects to reach this action.

 

Instead of assigning this action to an option on the V-Tree, you can set up the More
Options feature of the previous menu option to allow the caller to press <#> to return to
the previous menu.

 Record to Mailbox and Return to Previous Level

The Record to Mailbox and Return to Previous Level action allows callers to record a
message in a mailbox, then return to the previous menu. This feature is useful when a
caller wants to leave a message in a mailbox, yet wants to perform additional actions on
the system before ending the call. Note that, when the caller selects this option, the
caller hears a beep to begin recording a message. The prompt that voices this option to
the caller should also instruct the caller to record a message.

To define the Record to Mailbox and Return to Previous Level action:

1. Assign the Record to Mailbox and Return to Previous Level action to a blank menu
option. For additional information, refer to the topic, "Creating V-Trees," earlier in
this chapter.

2. Double-click the menu option that displays the Record to Mailbox and Return to
Previous Level icon. The Record to Mailbox and Return to Previous Level dialog box
displays the prompt number and comments from the previous menu, as well as the
sequence of options the caller selects to reach this action.
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The numbers in the Path or Outline field represent the keypresses the user must
enter to access this option. The dots between the numbers signify a menu. For
example, if the numbers in the field are 1.2.1, the caller must press <1>, then <2>,
then <1> on the phone keypad to access this action after accessing this V-Tree.

3. In the Mailbox Number field, enter the number of the mailbox in which you want the
caller to record the message. Ensure that the mailbox has already been created
before you enter the mailbox number for this action.

4. To save the entered information, click Save. The main Visual Architect window
displays.

 Record to Mailbox and Advance

The Record to Mailbox and Advance action allows callers to record a message in a
mailbox, then advance to another menu in the V-Tree. For example, you can allow a
caller to leave a message in a mailbox, then provide them with a new menu of options
that allows them to leave additional messages in other mailboxes.

Note that you can assign this action to several menus on a V-Tree to allow callers to
record a string of information to a mailbox, then use the Review/Edit Message action to
edit all of the recorded information. This feature is available only if the Record to
Mailbox and Advance actions are part of the same path of menus and all the messages
are recorded to the same mailbox.

This option is useful in Form Filler V-Trees (Interview V-Trees).

To define the Record to Mailbox and Advance action:

1. Assign the Record to Mailbox and Advance action to a blank menu option. For
additional information, refer to the topic, "Creating V-Trees," earlier in this chapter.

2. Double-click the menu option that displays the Record to Mailbox and Advance icon.
The Record to Mailbox and Advance dialog box displays the prompt number and
comments from the previous menu as well as the sequence of options the caller
selects to reach this action.
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The numbers in the Path or Outline field represent the keypresses the user must
enter to access this option. The dots between the numbers signify a menu. For
example, if the numbers in the field are 1.2.1, the caller must press <1>, then <2>,
then <1> on the phone keypad to access this action after accessing this V-Tree.

3. In the Mailbox Number field, enter the number of the mailbox in which you want the
caller to record the message. Ensure that the mailbox has already been created
before you enter the mailbox number for this action.

4. In the Title field, enter a title for the option. The title displays next to the action icon
to help you identify the purpose of this option on the V-Tree.

Steps 5 specifies the prompt that the caller hears after this action is performed on
the system. This prompt can voice the options available on the next menu, provide
special instructions on using the next available menu options, or simply provide the
caller with information.

5. If a prompt has already been recorded to voice after this action, enter the prompt
number in the Prompt Number field. If the prompt has been recorded and saved in
the [Language]3 file with an .O32 file extension, where [Language] is the primary
language on the system, enter the prompt number in the Prompt Number field and
select the Custom Phrase File option to specify the location of the prompt.
Otherwise, the system assumes the prompt is located in a \REC directory.

 If no prompt has been recorded for this option, click Voice Editor and record the
prompt. For additional information, refer to the topic, "Recording a New Prompt for
an Option on a V-Tree," later in this chapter.

6. In the Comments field, enter a description of the prompt. It is recommended that you
enter an exact transcription of the prompt to provide a quick reference of what
options the prompt voices as well as any special instructions for selecting those
options. Note that the comments you enter are displayed on each menu action’s
dialog box to help you define each action.

7. To specify V-Tree menu options, in addition to the nine options on the V-Tree menu,
click More Options, then do either of the following:

• To allow callers to press <#> to return to the previous menu or <0> to
transfer to the operator, deselect the Functions for Special Keys option if it is
selected, then click Save. The V-Tree Main Greeting dialog box displays.

• To allow callers to press <#> to log into a mailbox:

a. Press <0> to transfer to the operator, or enter a mailbox number to
immediately transfer to that mailbox without selecting a V-Tree menu
option.

b. Select the Functions for Special Keys option if it is not selected.

c. In the Dial Thru Timeout field, enter the number of seconds for the
system to wait for a keypress. This enables the system to determine
whether the caller is selecting a V-Tree menu option or entering a
mailbox number.

d. To save the value, click Save. The V-Tree Main Greeting dialog box
displays.
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If you select the Functions for Special Keys option, you must enter a value
other than zero in the Dial Thru Timeout field to provide callers with enough
time to enter a mailbox number. It is recommended that you enter a value of
only two or three seconds in the Dial Thru Timeout field to prevent the caller
from having to wait too long after selecting an option.

Dial Thru Timeout should not be activated for menus that include the
Require Password to Proceed to Next Level action. When both the Dial Thru
Timeout and the Require Password to Proceed to Next Level action are
activated for a menu, the Dial Thru Timeout takes precedence and the caller
is unable to enter a password since the system interprets the password as a
mailbox number.

8. To save the entered information, click Save. The main Visual Architect window
displays.

 Require Password to Proceed to Next Level

The Require Password to Proceed to Next Level action allows you to require callers to
enter a password before they can advance to another menu. For example, you may want
to use this action to allow only current customers to receive faxes from the system by
requiring customers to enter a password before they can access the Fax Retrieval
options of the V-Tree.

Note that, if a caller attempting to access a menu enters an incorrect password, the
system handles the callers the same way as an incorrect password when logging into a
mailbox. The way the incorrect password entry is handled depends on the how the
system is set up.

To define the Require Password to Proceed to Next Level action:

1. Assign the Require Password to Proceed to Next Level action to a blank menu
option. For additional information, refer to the topic, "Creating V-Trees," earlier in
this chapter.
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2. Double-click the menu option that displays the Require Password to Proceed icon.
The Require Password to Proceed dialog box displays the prompt number and
comments from the previous menu, as well as and the sequence of options the caller
selects to reach this action.

 

The numbers in the Path or Outline field represent the keypresses the user must
enter to access this option. The dots between the numbers signify a menu. For
example, if the numbers in the field are 1.2.1, the caller must press <1>, then <2>,
then <1> on the phone keypad to access this action after accessing this V-Tree.

3. In the Password Required field, enter the password the caller must enter to access
the next menu.

Only one password can be assigned to the action. Each caller must enter the same
password to access the next menu.

4. In the Title field, enter a title for the option. The title displays next to the action icon
to help you identify the purpose of this option on the V-Tree.

Steps 5-6 specify the prompt that the caller hears after this action is performed on
the system. This prompt can voice the options available on the next menu, provide
special instructions on using the next available menu options, or simply provide the
caller with information.

5. If a prompt has already been recorded to voice after this action, enter the prompt
number in the Prompt Number field. If the prompt has been recorded and saved in
the [Language]3 file with an .O32 file extension, where [Language] is the primary
language on the system, enter the prompt number in the Prompt Number field and
select the Custom Phrase File option to specify the location of the prompt.
Otherwise, the system assumes the prompt is located in a \REC directory.

 If no prompt has been recorded for this option, click Voice Editor and record the
prompt. For additional information, refer to the topic, "Recording a New Prompt for
an Option on a V-Tree," later in this chapter.
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6. In the Comments field, enter a description of the prompt. It is recommended that you
enter an exact transcription of the prompt to provide a quick reference of what
options the prompt voices as well as any special instructions for selecting those
options. Note that the comments you enter are displayed on each menu action’s
dialog box to help you define each action.

7. To specify V-Tree menu options, in addition to the nine options on the V-Tree menu,
click More Options, then do either of the following:

• To allow callers to press <#> to return to the previous menu or <0> to
transfer to the operator, deselect the Functions for Special Keys option if it is
selected, then click Save. The V-Tree Main Greeting dialog box displays.

• To allow callers to press <#> to log into a mailbox:

a. Press <0> to transfer to the operator, or enter a mailbox number to
immediately transfer to that mailbox without selecting a V-Tree menu
option.

b. Select the Functions for Special Keys option if it is not selected.

c. In the Dial Thru Timeout field, enter the number of seconds for the
system to wait for a keypress. This enables the system to determine
whether the caller is selecting a V-Tree menu option or entering a
mailbox number.

d. To save the value, click Save. The V-Tree Main Greeting dialog box
displays.

If you select the Functions for Special Keys option, you must enter a value
other than zero in the Dial Thru Timeout field to provide callers with enough
time to select a V-Tree option or to enter a mailbox number. It is
recommended that you enter a value of only two or three seconds in the Dial
Thru Timeout field to prevent the caller from having to wait too long after
selecting an option.

Dial Thru Timeout should not be activated for menus that include the
Require Password to Proceed to Next Level action. When both the Dial Thru
Timeout and the Require Password to Proceed to Next Level action are
activated for a menu, the Dial Thru Timeout takes precedence and the caller
is unable to enter a password since the system interprets the password as a
mailbox number.

8. To save the entered information, click Save. The main Visual Architect window
displays.

 Review/Edit Message and Advance

The Review/Edit Message action allows callers who just recorded a message to review it
and then either accept or rerecord it. The system automatically plays the recorded
message, then voices, “If this message is correct, press <1>, if not press <2>.” If the
caller presses <1>, the message is saved and the caller is advanced to the next menu. If
the caller presses <2>, the prompt for the previous option voices, prompting the caller to
begin rerecording the message.
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The Review/Edit action does not need to be assigned to each menu after a message is
recorded to a mailbox. You can use one Review/Edit Message action at the end of
several Record to Mailbox and Advance actions to allow callers to record a string of
information to a mailbox, then edit all of the recorded information. This feature is only
available if the Record to Mailbox and Advance actions are part of the same path of
menus and all the messages are recorded to the same mailbox.

To define the Review/Edit Message action:

1. Assign the Review/Edit Message action to a blank menu option. For additional
information, refer to the topic, "Creating V-Trees," earlier in this chapter.

2. Double-click the menu option that displays the Review/Edit Message icon. The
Review/Edit Message dialog box displays the prompt number and comments from
the previous menu, as well as the sequence of options the caller selects to reach this
action.

 

The numbers in the Path or Outline field represent the keypresses the user must
enter to access this option. The dots between the numbers signify a menu. For
example, if the numbers in the field are 1.2.1, the caller must press <1>, then <2>,
then <1> on the phone keypad to access this action after accessing this V-Tree.

3. In the Title field, enter a title for the option. The title displays next to the action icon
to help you identify the purpose of this option on the V-Tree.

Steps 4 specifies the prompt that the caller hears after this action is performed on
the system. This prompt can voice the options available on the next menu, provide
special instructions on using the next available menu options, or simply provide the
caller with information.

4. If a prompt has already been recorded to voice after this action, enter the prompt
number in the Prompt Number field. If the prompt has been recorded and saved in
the [Language]3 file with an .O32 file extension, where [Language] is the primary
language on the system, enter the prompt number in the Prompt Number field and
select the Custom Phrase File option to specify the location of the prompt.
Otherwise, the system assumes the prompt is located in a \REC directory.
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 If no prompt has been recorded for this option, click Voice Editor and record the
prompt. For additional information, refer to the topic, "Recording a New Prompt for
an Option on a V-Tree," later in this chapter.

5. In the Comments field, enter a description of the prompt. It is recommended that you
enter an exact transcription of the prompt to provide a quick reference of what
options the prompt voices as well as any special instructions for selecting those
options. Note that the comments you enter are displayed on each menu action’s
dialog box to help you define each action.

6. To specify V-Tree menu options, in addition to the nine options on the V-Tree menu,
click More Options, then do either of the following:

• To allow callers to press <#> to return to the previous menu or <0> to
transfer to the operator, deselect the Functions for Special Keys option if it is
selected, then click Save. The V-Tree Main Greeting dialog box displays.

• To allow callers to press <#> to log into a mailbox:

a. Press <0> to transfer to the operator, or enter a mailbox number to
immediately transfer to that mailbox without selecting a V-Tree menu
option.

b. Select the Functions for Special Keys option if it is not selected.

c. In the Dial Thru Timeout field, enter the number of seconds for the
system to wait for a keypress. This enables the system to determine
whether the caller is selecting a V-Tree menu option or entering a
mailbox number.

d. To save the value, click Save. The V-Tree Main Greeting dialog box
displays.

If you select the Functions for Special Keys option, you must enter a value
other than zero in the Dial Thru Timeout field to provide callers with enough
time to select a V-Tree option or to enter a mailbox number. It is
recommended that you enter a value of only two or three seconds in the Dial
Thru Timeout field to prevent the caller from having to wait too long after
selecting an option.

Dial Thru Timeout should not be activated for menus that include the
Require Password to Proceed to Next Level action. When both the Dial Thru
Timeout and the Require Password to Proceed to Next Level action are
activated for a menu, the Dial Thru Timeout takes precedence and the caller
is unable to enter a password since the system interprets the password as a
mailbox number.

7. To save the entered information, click Save. The main Visual Architect window
displays.
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 Send a Requested Fax and Advance

The Send a Requested Fax and Advance action allows callers to select a fax to receive
from the system by entering the corresponding fax document number. The system
prompts the caller to enter the fax document number and the number to which the caller
would like the fax to be sent. After the caller enters the requested information, the caller
advances to the next option. For additional information, refer to the topic, "Managing Fax
Retrieval Documents," later in this chapter.

This action requires that the caller know the fax document number. If the list of fax
documents is extensive, you may want to send all callers a list of the fax documents and
their numbers, or include an option that faxes the caller a list of the available fax
documents and their corresponding numbers.

If you only have a few fax documents that a caller can retrieve, consider using the Send
a Predefined Fax and Advance action so that the caller does not have to enter the fax
document number.

This action is useful in Fax-on-Demand V-Trees.

To define the Send a Requested Fax and Advance action:

1. Assign the Send a Requested Fax and Advance action to a blank menu option. For
additional information, refer to the topic, "Creating V-Trees," earlier in this chapter.

2. Double-click the menu option that displays the Send a Requested Fax and Advance
icon. The Send a Requested Fax and Advance dialog box displays the prompt
number and comments from the previous menu, as well as the sequence of options
the caller selects to reach this action.

 

The numbers in the Path or Outline field represent the keypresses the user must
enter to access this option. The dots between the numbers signify a menu. For
example, if the numbers in the field are 1.2.1, the caller must press <1>, then <2>,
then <1> on the phone keypad to access this action after accessing this V-Tree.
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3. In the Title field, enter a title for the option. The title displays next to the action icon
to help you identify the purpose of this option on the V-Tree.

Steps 4 specifies the prompt that the caller hears after this action is performed on
the system. This prompt can voice the options available on the next menu, provide
special instructions on using the next available menu options, or simply provide the
caller with information.

4. If a prompt has already been recorded to voice after this action, enter the prompt
number in the Prompt Number field. If the prompt has been recorded and saved in
the [Language]3 file with an .O32 file extension, where [Language] is the primary
language on the system, enter the prompt number in the Prompt Number field and
select the Custom Phrase File option to specify the location of the prompt.
Otherwise, the system assumes the prompt is located in a \REC directory.

 If no prompt has been recorded for this option, click Voice Editor and record the
prompt. For additional information, refer to the topic, "Recording a New Prompt for
an Option on a V-Tree," later in this chapter.

5. In the Comments field, enter a description of the prompt. It is recommended that you
enter an exact transcription of the prompt to provide a quick reference of what
options the prompt voices as well as any special instructions for selecting those
options. Note that the comments you enter are displayed on each menu action’s
dialog box to help you define each action.

6. To specify V-Tree menu options, in addition to the nine options on the V-Tree menu,
click More Options, then do either of the following:

• To allow callers to press <#> to return to the previous menu or <0> to
transfer to the operator, deselect the Functions for Special Keys option if it is
selected, then click Save. The V-Tree Main Greeting dialog box displays.

• To allow callers to press <#> to log into a mailbox:

a. Press <0> to transfer to the operator, or enter a mailbox number to
immediately transfer to that mailbox without selecting a V-Tree menu
option.

b. Select the Functions for Special Keys option if it is not selected.

c. In the Dial Thru Timeout field, enter the number of seconds for the
system to wait for a keypress. This enables the system to determine
whether the caller is selecting a V-Tree menu option or entering a
mailbox number.

d. To save the value, click Save. The V-Tree Main Greeting dialog box
displays.
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If you select the Functions for Special Keys option, you must enter a value other
than zero in the Dial Thru Timeout field to provide callers with enough time to select
a V-Tree option or to enter a mailbox number. It is recommended that you enter a
value of only two or three seconds in the Dial Thru Timeout field to prevent the caller
from having to wait too long after selecting an option.

Dial Thru Timeout should not be activated for menus that include the Require
Password to Proceed to Next Level action. When both the Dial Thru Timeout and the
Require Password to Proceed to Next Level action are activated for a menu, the Dial
Thru Timeout takes precedence and the caller is unable to enter a password since
the system interprets the password as a mailbox number.

7. To save the entered information, click Save. The main Visual Architect window
displays.

 Send a Predefined Fax and Advance

The Send a Predefined Fax and Advance action allows callers to select a particular fax
through a single keypress. For example, you can create a V-Tree that prompts the caller
to, “Press <1>to receive a fax on new products, press <2> to receive a fax on company
locations, or press <3> to receive a fax on the company profile.” Note that the system
automatically prompts the caller to enter the number to which the fax is to be sent. After
doing so, the caller advances to the next menu. For additional information, refer to the
topic, "Managing Fax Retrieval Documents," later in this chapter.

If the number of fax documents available is extensive, consider using the Send a
Requested Fax and Advance action, which requires the caller to enter the fax document
number.

This action is useful in Fax on Demand V-Trees.

To define the Send a Predefined Fax and Advance action:

1. Assign the Send a Predefined Fax and Advance action to a blank menu option. For
additional information, refer to the topic, "Creating V-Trees," earlier in this chapter.

2. Double-click the menu option that displays the Send a Predefined Fax and Advance
icon. The Send a Predefined Fax and Advance dialog box displays the prompt
number and comments from the previous menu, as well as the sequence of options
the caller selects to reach this action.
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The numbers in the Path or Outline field represent the keypresses the user must
enter to access this option. The dots between the numbers signify a menu. For
example, if the numbers in the field are 1.2.1, the caller must press <1>, then <2>,
then <1> on the phone keypad to access this action after accessing this V-Tree.

3. In the Document Number field, enter the fax document number of the fax to be sent
when the caller selects this option.

4. In the Title field, enter a title for the option. The title displays next to the action icon
to help you identify the purpose of this option on the V-Tree.

Steps 5 specifies the prompt that the caller hears after this action is performed on
the system. This prompt can voice the options available on the next menu, provide
special instructions on using the next available menu options, or simply provide the
caller with information.

5. If a prompt has already been recorded to voice after this action, enter the prompt
number in the Prompt Number field. If the prompt has been recorded and saved in
the [Language]3 file with an .O32 file extension, where [Language] is the primary
language on the system, enter the prompt number in the Prompt Number field and
select the Custom Phrase File option to specify the location of the prompt.
Otherwise, the system assumes the prompt is located in a \REC directory.

 If no prompt has been recorded for this option, click Voice Editor and record the
prompt. For additional information, refer to the topic, "Recording a New Prompt for
an Option on a V-Tree," later in this chapter.

6. In the Comments field, enter a description of the prompt. It is recommended that you
enter an exact transcription of the prompt to provide a quick reference of what
options the prompt voices as well as any special instructions for selecting those
options. Note that the comments you enter are displayed on each menu action’s
dialog box to help you define each action.

7. To specify V-Tree menu options, in addition to the nine options on the V-Tree menu,
click More Options, then do either of the following:

• To allow callers to press <#> to return to the previous menu or <0> to
transfer to the operator, deselect the Functions for Special Keys option if it is
selected, then click Save. The V-Tree Main Greeting dialog box displays.

• To allow callers to press <#> to log into a mailbox:

a. Press <0> to transfer to the operator, or enter a mailbox number to
immediately transfer to that mailbox without selecting a V-Tree menu
option.

b. Select the Functions for Special Keys option if it is not selected.

c. In the Dial Thru Timeout field, enter the number of seconds for the
system to wait for a keypress. This enables the system to determine
whether the caller is selecting a V-Tree menu option or entering a
mailbox number.

d. To save the value, click Save. The V-Tree Main Greeting dialog box
displays.
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If you select the Functions for Special Keys option, you must enter a value
other than zero in the Dial Thru Timeout field to provide callers with enough
time to select a V-Tree option or to enter a mailbox number. It is
recommended that you enter a value of only two or three seconds in the Dial
Thru Timeout field to prevent the caller from having to wait too long after
selecting an option.

Dial Thru Timeout should not be activated for menus that include the
Require Password to Proceed to Next Level action. When both the Dial Thru
Timeout and the Require Password to Proceed to Next Level action are
activated for a menu, the Dial Thru Timeout takes precedence and the caller
is unable to enter a password since the system interprets the password as a
mailbox number.

8. To save the entered information, click Save. The main Visual Architect window
displays.

 Disconnect

The Disconnect action allows callers to end calls to the system. When callers use this
action to end a call, the system is able to free the port faster than if the caller were to
simply hang up.

There are no prompts or variables to assign to the Disconnect action since it only allows
a caller to disconnect from the system. You can double-click the menu option to display
the Disconnect dialog box, which displays the prompt number and comments from the
previous menu, as well as the sequence of options the caller selects to reach this action.

 

 Go to Mailbox Login Point

The Go to Mailbox Login Point action allows callers to log into a mailbox as the mailbox
subscriber. When a caller selects this action, the prompt, “Please enter your mailbox
number,” voices, then prompts the caller to enter the mailbox password. This enables
subscribers to quickly log into their mailbox from the V-Tree.
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There are no prompts or variables to assign to the Go to Mailbox Login Point action,
since it only allows a caller to log into their mailbox from the V-Tree by entering their
mailbox number and password. You can double-click the menu option to display the Go
to Mailbox Login Point dialog box, which displays the prompt number and comments
from the previous menu, as well as the sequence of options the caller selects to reach
this action.

 

Instead of assigning this action to an option on the V-Tree, you can also set up the More
Options feature of the previous menu option to allow the caller to press <#> to log into a
mailbox.

 Go to Voice Mail

The Go to Voice Mail action allows callers to enter a number for a mailbox in which they
can record a message. Callers must know the mailbox number to record a message.
Note that this action does not transfer the call to the mailbox’s associated extension or
allow the mailbox subscriber to log into the mailbox. This option only allows the caller to
record a message in the entered mailbox.

There are no prompts or variables to assign to the Go to Voice Mail action, since it
allows a caller to record a message in a mailbox by entering the mailbox number. You
can double-click the menu option to display the Go to Voice Mail dialog box, which
displays the prompt number and comments from the previous menu, as well as the
sequence of options the caller selects to reach this action.

 

 Go to Extension Entry Point (Automated Attendant)

The Go to Extension Entry Point action allows callers to quickly return to the Automated
Attendant for the system, no matter how many prior options or menus they have
accessed. Note that the automated attendant feature should be set up on the system
when you assign this action to a V-Tree.
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There are no prompts or variables to assign to the Go to Extension Entry Point action
since it only allows a caller to return to the automated attendant. You can double-click
the menu option to display the Go to Extension Entry Point dialog box, which displays
the prompt number and comments from the previous menu and the sequence of options
the caller selects to reach this action.

 

 Go to Directory Services

The Go to Directory Services action allows callers to use the dial by name feature, which
permits callers who do not know a subscriber’s mailbox number to enter a subscriber
name through the phone keypad. This action should only be used on systems that are
set up to allow callers to access directory services.

There are no prompts or variables to assign to the Go to Directory Services action, since
it only allows a caller to enter the subscriber’s name rather than mailbox number to
transfer to that subscriber’s mailbox. You can double-click the menu option to display the
Go to Directory Services dialog box, which displays the prompt number and comments
from the previous menu, as well as the sequence of options the caller selects to reach
this action.

 

 Transfer to a Mailbox

The Transfer to a Mailbox action allows callers to transfer to a specified mailbox. For
example, you can use this action to transfer callers to a sales representative or to a
mailbox that is blocked to another V-Tree.

To define the Transfer to a Mailbox action:

1. Assign the Transfer to a Mailbox action to a blank menu option. For additional
information, refer to the topic, "Creating V-Trees," earlier in this chapter.
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2. Double-click the menu option that displays the Transfer to a Mailbox icon. The
Transfer to Mailbox dialog box displays the prompt number and comments from the
previous menu, as well as the sequence of options the caller selects to reach this
action.

 

The numbers in the Path or Outline field represent the keypresses the user must
enter to access this option. The dots between the numbers signify a menu. For
example, if the numbers in the field are 1.2.1, the caller must press <1>, then <2>,
then <1> on the phone keypad to access this action after accessing this V-Tree.

3. In the Mailbox Number field, enter the number of the mailbox to which you want to
transfer the caller. Ensure that the mailbox has already been created before you
enter the mailbox number for this action.

4. To save the entered information, click Save. The main Visual Architect window
displays.

Assigning Prompts to V-Trees

The following procedures assign prompts to options on a V-Tree created using Visual
Architect. You can:

• Assign an existing prompt to an option on a V-Tree

• Record a new prompt for an option on a V-Tree

The prompts voiced by a V-Tree explain the options available from a menu and provide
instructions on how to select them. For example, you may need to assign a prompt that
explains how to enter a password or what information the caller should include in a
message. It is extremely important that the prompts you record match the V-Tree options
to prevent callers from becoming confused when choosing options. The prompts you
record for a V-Tree should also sound similar and use the same syntax as the other
prompts on the system.

Assigning an Existing Prompt to an Option on a V-Tree

Use this procedure to assign a prompt that has already been recorded to an option on
the V-Tree. The prompt you use can be recorded using any of the recording tools
provided on the system. For additional information, refer to Chapter 6, "Recording and
Editing Prompts."
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To assign an existing prompt to an option:

1. Double-click the option to which you want to assign a prompt. The option’s dialog
box displays.

2. If the prompt you want to assign is located in [Language]3.O32 file, where
[Language] is the primary language on the system, select the Custom Phrase File
option. Otherwise, the system assumes the prompt is located in a \REC directory.

3. Enter the prompt number for the prompt you want to assign to the option.

4. In the Comments field, enter a description of the prompt. It is recommended that you
enter an exact transcription of the prompt to provide a quick reference of what
options the prompt voices, as well as any special instructions for selecting those
options. Note that the comments you enter are displayed on each menu action’s
dialog box to help you define each action.

5. To save the entered prompt and comments, click Save. The main Visual Architect
window displays.

Recording a New Prompt for an Option on a V-Tree

Use this procedure to record a new prompt for an option on a V-Tree using Visual
Architect. Visual Architect uses a limited version of Visual Voice Editor (V-Edit) to record
prompts for V-Trees. Note that you can use any of the recording tools available on the
system to record a new prompt, then simply assign the prompt to the option. For
additional information, refer to Chapter 6, “Recording and Editing Prompts.”

To record a new prompt for an option:

1. Double-click the option for which you want to create a new prompt. The option’s
dialog box displays.

2. In the Comments field, enter a description of the prompt you are recording. It is
recommended that you enter an exact transcription of the prompt to provide a quick
reference of what options the prompt voices, as well as any special instructions for
selecting those options. Note that the comments you enter are displayed on each
menu action’s dialog box to help you define each action.

Comments can also be entered directly on the Text window of V-Edit. Regardless of
where the comments are entered, comments are saved with a .VXT file extension in
the same directory and file as the prompt number.

3. Click Voice Editor. V-Edit begins to run and the V-Edit Dialer dialog box displays.
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4. Enter the extension for the phone from which you want to record the prompt, then
click OK.

5. Answer the phone when it rings, then press <1> when prompted to continue logging
into V-Edit. The main V-Edit window displays the comments that were entered for
the option in the Text window.

 

6. From the Voice menu, select Record Phrase. The V-Editor # dialog box displays.

 

7. Click the Record button and begin recording the phrase when you hear the beep.

8. To end recording, click Stop. The phrase is saved and assigned the number
displayed next to V-Editor # in the dialog box title bar. The Time field displays the
length, in seconds, of the phrase you just recorded.

9. To listen to the phrase, click Play.

10. To rerecord the phrase, click Record. Begin recording the prompt when you hear the
beep.

11. To close the V-Edit # dialog box, click OK. A graphical representation of the
recording displays in the Voice window of the V-Editor main window.

12. To return to Visual Architect without closing V-Edit, click Return on the V-Edit
window. This feature allows you to return to the V-Tree to record additional prompts
without having to reenter V-Edit each time. To record another prompt, open the
option’s dialog box for which to record a prompt, click Voice Editor, then begin
recording the prompt starting with step 6 of this procedure.

13. To close V-Edit, select Quit from the File menu, then hang up the phone. The
option’s dialog box displays the prompt number of the new phrase.

14. To save the new prompt and comments, click Save. The main Visual Architect
window displays.
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Activating and Deactivating the Call Handling for V-Trees

Use these procedures to activate or deactivate a V-Tree for a mailbox. When you
activate a V-Tree for a mailbox, you specify conditions under which callers can access
the V-Tree for the mailbox. If the V-Tree is not selected as one of the Call Handling
options, callers cannot access the V-Tree. Using this technique, you can also deactivate
a V-Tree to prevent callers from using a V-Tree without deleting the V-Tree.

The mailbox for which you want to activate the V-Tree must have the V-Trees and Call
Handling options selected in its assigned class of service for a subscriber to be able to
access and activate the V-Tree. The system manager can activate a V-Tree for a
mailbox, even if the V-Trees and Call Handling options are not selected in the class of
service, by setting the call handling in the subscriber settings. For additional information,
refer to the topic, "Managing Subscriber Settings," in Chapter 4, “Managing System
Mailboxes.”

Activating a V-Tree for a Mailbox

Use this procedure to activate a V-Tree for a mailbox. Once a V-Tree is activated, test
the V-Tree to verify that it works appropriately and then callers can access it on the
system. Note that the mailbox subscriber can also activate a V-Tree through the phone
interface, if the V-Trees option is selected in the mailbox’s assigned Class of Service.

Do not activate a V-Tree until you create a V-Tree for the mailbox. Callers cannot
access the V-Tree on the system until it is created.

To activate a V-Tree for a mailbox:

1. Start M2000, if it is not running.

2. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.
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3. Enter the number of the mailbox for which you want to activate a V-Tree, then click
Edit. The Mailbox Entry dialog box displays the mailbox information.

 

4. Click Subscriber Settings. The Subscriber Settings dialog box displays.

 

5. Select one of the following options:

a. If you want calls to be immediately addressed by the V-Tree without having the
system first ring the mailbox extension, select the Call Blocking option, then
select the V-Tree option under No Answer/Call Blocking.

b. If you want calls addressed by the V-Tree after there is no answer at the mailbox
extension, do not select the Call Blocking option, then select the V-Tree option
under No Answer/Call Blocking.

c. If you want calls addressed by the V-Tree when the mailbox extension is busy,
select the V-Tree option under Busy.

Only one V-Tree can be assigned to a mailbox, no matter which Call Handling
options you select.
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6. To activate the V-Tree based on the entered subscriber settings, click OK. The
Mailbox Entry dialog box displays.

7. To save all of the entered information, click Save.

8. To close the dialog box, click OK. The V-Tree is now active on the system and the
main system window displays.

9. Call into the system and access the mailbox to verify that the V-Tree is activated
correctly and that each prompt and option work appropriately. If the V-Tree is not
functioning correctly, open the V-Tree and make the necessary changes.

Deactivating a V-Tree for a Mailbox

Use this procedure to deactivate a V-Tree for a mailbox. This allows you to prevent
callers to a mailbox from accessing the V-Tree without having to delete the mailbox
V-Tree. Note that the mailbox subscriber can also deactivate a V-Tree even if the
V-Trees option is not selected in the Class of Service assigned to the mailbox. The
subscriber, however, cannot re-activate the V-Tree unless the V-Trees option in the
Class of Service is selected.

To deactivate a V-Tree for a mailbox:

1. Start M2000, if it is not running.

2. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.

 

3. Enter the number of the mailbox for which you want to deactivate a V-Tree, then
click Edit. The Mailbox Entry dialog box displays the mailbox information.
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4. Click Subscriber Settings. The Subscriber Settings dialog box displays.

 

5. Select call handling options other than the V-Tree option. For additional information,
refer to the topic, "Managing Subscriber Settings," in Chapter 4, “Managing System
Mailboxes.”

6. To deactivate the V-Tree and assign the new call handling options to the mailbox,
click OK. The Mailbox Entry dialog box displays.

7. To save all of the entered information, click Save.

8. To close the dialog box, click OK. The V-Tree is no longer active for the mailbox and
the main system window displays.

9. Call into the system and access the mailbox to verify that calls to the mailbox are
handled appropriately.

Opening a V-Tree

Use these procedures to open V-Trees to view or edit. You can:

• Open a mailbox V-Tree.

• Copy a V-Tree file to a mailbox.

• Open a V-Tree file from outside of a mailbox.
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Opening a Mailbox V-Tree

Use this procedure to open a V-Tree that is assigned to a mailbox. You can open a
mailbox V-Tree using Visual V-Tree or Visual Architect ,even if the V-Tree was created
using the phone interface.

To open a mailbox V-Tree:

1. Start M2000, if it is not running.

2. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.

 

3. Enter the number of the mailbox containing the V-Tree you want to open, then click
Edit. The Mailbox Entry dialog box displays the mailbox information.

 

4. Under Edit, click Visual V-Tree. Visual V-Tree or Visual Architect starts, and the
V-Tree assigned to the mailbox displays.

Copying a V-Tree File to a Mailbox

Use this procedure to copy a V-Tree file to a mailbox, using Visual Architect. This allows
you to assign a V-Tree to a mailbox without having to create the V-Tree specifically for
that mailbox. Once a V-Tree file is copied to a mailbox, you can edit the mailbox V-Tree.
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Before you copy a V-Tree file to a mailbox, it is important to verify that the system does
not already have prompts or fax documents with the same numbers as prompts or fax
documents in the V-Tree you are copying. If duplicate numbers are found, the system
automatically renames the prompt or fax document in the new V-Tree to the next
available prompt or fax document number. You will then be required to edit the new V-
Tree to specify the new prompt or fax document number. Note that this automatic
renumbering occurs even if the two prompts or documents are the same.

To verify that no prompts with the same number as prompts in the new V-Tree exist,
compile a list of prompts used in the V-Tree you are copying and then check the prompts
in the \REC01 - \REC09 directories to verify that there are no prompts with the same
name. If there are, you should rename the prompt on the new V-Tree and modify the
V Tree before copying it to the mailbox.

To verify that no fax documents with the same number as fax documents in the new
V Tree exist, compile a list of fax documents used in the V-Tree you are copying and
then check the files in the \FAX00 - \FAX09 directories to verify that there are no fax
documents with the same name. If there are, you should rename the fax documents on
the new V-Tree and modify the V-Tree before copying it to the mailbox.

To copy a V-Tree file to a mailbox:

1. Start M2000, if it is not running.

2. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.

 

3. Enter the number of the mailbox to which you want to copy a V-Tree file, then click
Edit. The Mailbox Entry dialog box displays the mailbox information.

 

4. Under Edit, click Visual V-Tree. Visual Architect starts, and the current V-Tree for the
mailbox displays. If the mailbox does not currently have a V-Tree, a blank V-Tree
displays.

5. From the File menu, select Import. A confirmation dialog box displays. Note that this
dialog box displays even if a V-Tree has not been created for the mailbox.
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6. To confirm that you want to replace the existing V-Tree with a V-Tree from a file,
click Yes. The V-Tree Import dialog box displays.

 

7. Select the V-Tree file that you want to copy to the mailbox, then click OK. The
V-Tree is copied from the V-Tree file to the mailbox.

8. To close Visual Architect, select Exit from the File menu. The Mailbox Entry dialog
box displays. Note that Visual Architect automatically saves the V-Tree as you copy
the V-Tree to the mailbox.

9. Activate the V-Tree for the mailbox. For additional information, refer to the topic,
"Activating a V-Tree for a Mailbox," earlier in this chapter.

10. To close the Mailbox Entry dialog box, click OK. The V-Tree is active on the system
and the main system window displays.

11. Call into the system and access the mailbox to verify that the V-Tree is activated
correctly and each prompt and option work appropriately. If the V-Tree is not
functioning correctly, open the V-Tree and make the necessary changes.

Opening a V-Tree File from Outside a Mailbox

Use this procedure to open a V-Tree file to view or edit. This feature allows you to edit a
V-Tree without assigning it to a mailbox. You must have the Visual Architect Developer’s
Toolkit installed to open a V-Tree file.

To open a V-Tree file from outside a mailbox:

1. Start M2000, if it is not running.

2. Open an OS/2 window.

3. From the C:\ prompt, type CD CVR then press <ENTER>.
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4. From the \CVR prompt, type VTREE then press <ENTER>. Visual Architect starts,
and a blank V-Tree displays.

 

5. From the File menu, select Open. The Open V-Tree dialog box displays.

4. Select the V-Tree file that you want to open, then click OK. The V-Tree displays.

Saving a V-Tree

The following procedures save V-Trees using Visual Architect. Mailbox V-Trees are
automatically saved by the system as they are entered. V-Tree files, however, must be
saved manually. You can:

• Save a mailbox V-Tree to a V-Tree file.

• Save a V-Tree file.

• Save a V-Tree file to another file.

Saving a Mailbox V-Tree to a V-Tree File

Use this procedure to save a V-Tree assigned to a mailbox to a V-Tree file. This allows
you to copy the V-Tree to another mailbox, so that you do not have to re-create the
V-Tree in another mailbox.
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To save a mailbox V-Tree to a V-Tree file:

1. Start M2000, if it is not running.

2. From the Mailbox menu, click Edit. The Edit Mailbox dialog box displays.

 

3. Enter the number of the mailbox for which you want to save a mailbox V-Tree to a
V-Tree file, then click Edit. The Mailbox Entry dialog box displays the mailbox
information.

 

4. Under Edit, click Visual V-Tree. Visual Architect starts, and the mailbox V-Tree
displays.

5. To create the V-Tree file, select Export from the File menu. The Export Options
dialog box displays.

 

6. Select the export option you want to use:

a. To save all of the comments added to the V-Tree actions in the V-Tree file,
select the Copy V-Tree Comments option.

b. To save all of the prompts associated with the V-Tree in the V-Tree file, select
the Copy V-Tree Prompts option.

c. To save all of the faxes assigned to the V-Tree in the V-Tree file, select the
Copy V-Tree Fax Documents option.
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7. To save the V-Tree with the selected options in the V-Tree file, click OK. The V-Tree
Export dialog box displays.

 

8. In the Save as filename field, enter a name for the file followed by an .OVT file
extension.

9. In the Drive field, select the drive on which you want to save the V-Tree.

10. In the Directory field, select the directory in which you want to save the V-Tree.

11. To save the V-Tree with the entered name, drive, and directory, click OK. The
V-Tree is saved, and you can now copy it to another mailbox or copy it for use on
another system. For additional information, refer to the topic, "Copying a V-Tree File
to a Mailbox," earlier in this chapter.

12. To close Visual Architect, select Exit from the File menu. The Mailbox Entry dialog
box displays.

13. To close the Mailbox Entry dialog box, click OK. The main system window displays.

Saving a V-Tree File

Use this procedure to save a V-Tree file. V-Tree files are not automatically saved like
mailbox V-Trees. You must manually save the V-Tree file to retain changes you make to
the V-Tree.

To save a V-Tree file:

1. Open the V-Tree file, if it is not open.

2. Make the appropriate changes to the V-Tree.

3. From the File menu, select Save. The V-Tree file is saved with the new changes.

4. To close Visual Architect, select Exit from the File menu. Visual Architect closes.

Saving a V-Tree File to Another File

Use this procedure to save an existing V-Tree file to another V-Tree file. This allows you
to quickly create a V-Tree file that is similar to an existing V-Tree, without having to
create a new V-Tree (for example, if you only want to make slight modifications to the
V-Tree without overwriting the original V-Tree file).
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To save a V-Tree file to another file:

1. Start M2000, if it is not running.

2. Open an OS/2 window.

3. From the C:\ prompt, type CD CVR then press <ENTER>.

4. From the \CVR prompt, type VTREE then press <ENTER>. Visual Architect starts,
and a blank V-Tree displays.

 

5. From the File menu, select Open. The Open V-Tree dialog box displays.

 

6. Select the V-Tree file that you want to open, then click OK. The V-Tree displays.

7. From the File menu, select Save As. The V-Tree Save As dialog box displays.
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8. In the Save as filename field, enter a name for the file followed by an .OVT file
extension.

9. In the Drive field, select the drive on which you want to save the V-Tree.

10. In the Directory field, select the directory in which you want to save the V-Tree.

11. To save the V-Tree with the entered name, drive, and directory, click OK. The
Export Options dialog box displays.

 

12. Select one of the following export options:

a. To save all of the comments added to the V-Tree actions in the V-Tree file,
select the Copy V-Tree Comments option.

b. To save all of the prompts associated with the V-Tree in the V-Tree file, select
the Copy V-Tree Prompts option.

c. To save all of the faxes assigned to the V-Tree in the V-Tree file, select the
Copy V-Tree Fax Documents option.

11. To save the V-Tree with the selected options in the V-Tree file, click OK. The V-Tree
file is now saved under a different name, and you can now modify it or copy it to
another mailbox. For additional information, refer to the topic, "Copying a V-Tree
File to a Mailbox," earlier in this chapter.

12. To close Visual Architect, select Exit from the File menu. Visual Architect closes.

Editing a V-Tree

Use these procedures to edit an existing V-Tree created using Visual Architect. You can:

• Edit action information.

• Cut a menu option to the clipboard.

• Copy a menu option to the clipboard.

• Paste a menu option to the clipboard.

• Delete a menu option.

When editing V-Trees, ensure that the edits you make to the V-Tree are also reflected in
the prompts voiced by the V-Tree. When you edit a menu option, all submenus under
that option are also affected by the edit. For example, if you delete a menu option, all
the submenus that extend from that option are also deleted.
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It is recommended that you deactivate the call handling to the V-Tree for the mailbox
before you edit the V-Tree to prevent callers from accessing a V-Tree that is being
modified.

Editing V-Tree Action Information

Use this procedure to edit the information entered for an action in a V-Tree.

To edit action information:

1. Open the V-Tree you want to edit.

2. Double-click the action you want to edit. The corresponding action dialog box
displays.

3. Make the changes necessary to the action. For additional information, refer to the
topic, "Defining V-Tree Actions," earlier in this chapter.

4. To save the changes, click Save. The dialog box closes and the V-Tree changes are
applied.

Cutting a V-Tree Menu Option to the Clipboard

Use this procedure to remove a menu option from a V-Tree menu and place it on the
clipboard so you can paste the option in another location on the V-Tree. When you cut a
menu option, all of the prompt numbers, comments, and variable information for the
menu option and submenu options are also cut to the clipboard.

To cut a menu option:

1. Open the V-Tree you want to edit.

2. Click the menu option you want to cut from the V-Tree. A gray box displays around
the option.

3. From the Edit menu, select Cut, or click the Cut toolbar button. A deletion
confirmation dialog box displays.

4. To confirm that you want to cut the menu option and its submenu options and place
it on the clipboard, click Yes. The menu option is cut from the V-Tree and placed on
the clipboard, and a blank menu option displays.

5. If you close Visual Architect without pasting the cut menu option in the V-Tree, the
menu option is deleted from the system. For additional information, refer to the
topic, "Pasting a V-Tree Menu Option from the Clipboard," later in this chapter.

Copying a V-Tree Menu Option to the Clipboard

Copying a menu option on a V-Tree allows you to copy an option and all its submenus to
the clipboard. Once copied you can paste this option and its menus in another part of the
V-Tree. When you copy a menu option, all of the prompt numbers, comments, and
variable information for the menu option and submenu options are also copied to the
clipboard.
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To copy a menu option:

1. Open the V-Tree you want to edit.

2. Click the menu option you want to copy. A gray box displays around the option.

3. From the Edit menu, select Copy, or click the Copy toolbar button. The menu option
is copied to the clipboard.

4. If you close Visual Architect, the clipboard is automatically cleared of the copy of the
menu option.

Pasting a V-Tree Menu Option from the Clipboard

Use this procedure to paste a menu option in a V-Tree from the clipboard.

To paste a menu option:

1. Open the V-Tree you want to edit.

2. Copy or cut the options you want to paste in the V-Tree, if you have not already
done so.

3. Click the blank option to which you want to paste the contents from the clipboard. A
gray box displays around the option.

4. From the Edit menu, select Paste, or click the Paste toolbar button. The menu
options on the clipboard are pasted to the blank option.

5. Verify that each action that was pasted is defined appropriately in the V-Tree. For
additional information, refer to the topic, "Defining V-Tree Actions," earlier in this
chapter.

Deleting a V-Tree Option

Use the following procedure to delete a menu option from a V-Tree. Note that, when you
select an option to delete, all actions on submenus under the option are also deleted.

To delete a V-Tree menu option:

1. Open the V-Tree you want to edit.

2. Click the menu option you want to delete. A gray box displays around the option.

3. From the Edit menu, select Delete, or press the Delete key. A deletion confirmation
dialog box displays.

4. To delete the menu option, click Yes. The option is deleted from the V-Tree, and a
blank option displays.

5. To undo the deletion of a menu option, you must immediately select Undo from the
Edit menu. If you perform any action on the V-Tree after deleting a menu option, you
cannot undo the deletion.
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Deleting a V-Tree

Use these procedures to:

• Delete a mailbox V-Tree.

• Delete a V-Tree file.

Deleting a V-Tree from a Mailbox

Use this procedure to delete a V-Tree from a mailbox. If the system has the Visual
Architect Developer’s Toolkit installed and the V-Tree for the mailbox has also been
saved to a V-Tree file, the file is not deleted when you complete this procedure. You
must delete the file from the system using any of the file deletion features of OS/2.

To delete V-Trees from mailboxes:

1. From the Mailbox menu, select Clear. The Clear Mailbox dialog box displays.

 

2. Under Items to be cleared, select the V-Tree option.

To delete the V-Tree for a mailbox, the mailbox must be in the entered range of
mailbox numbers, in the entered company, and in the entered division. If a mailbox
only fits into one or two of the entered values, the mailbox V-Tree is not deleted. For
example, if you include all mailbox numbers in the range of divisions and enter ABC
for the company, only V-Trees in mailboxes in company ABC are deleted. V-Trees in
mailboxes in all other companies, such as XYZ, are not deleted.

3. If you do not want to include all the system mailboxes in the range to delete, enter
the number of the first mailbox number in the range you want to delete in the From
field under Clear Mailboxes, and enter the last mailbox number in the range you
want to delete in the To field. If you only want to delete a V-Tree for a single
mailbox, enter that mailbox number in both the From and To fields.

The number entered in the From field must be equal to or smaller than the number
entered in the To field.

4. In the Company field, enter the name of the company to clear or enter All to delete
V-Trees for all companies on the system. If this field is left blank, the system
includes all companies in the range.
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5. In the Division field, enter the name of the division to clear or enter All to delete
V-Trees for all divisions on the system. If this field is left blank, the system includes
all divisions in the range.

6. To delete V-Trees based on the entered options, click OK. A clear mailbox
confirmation dialog box displays.

 

7. Clear selected items as follows:

a. To delete the V-Tree for only the displayed mailbox, click OK. The next mailbox
in the range of mailboxes displays, or, if there are no more mailboxes in the
range, the main system window displays.

b. To retain the V-Tree for the displayed mailbox and continue with the next
mailbox in the range, click Skip. The next mailbox in the range displays, or, if
there are no more mailboxes in the range, the main system window displays.

c. To delete all the V-Trees in the mailboxes in the range you specified without
being prompted for each mailbox, click No Ask. All of the V-Trees in the
mailboxes in the range are deleted and the main system window displays.

8. To cancel deleting any additional V-Trees in mailboxes, click Stop. No additional
V-Trees in mailboxes in the range are deleted and the main system window displays.
Note that all V-Trees in mailboxes that were deleted before you clicked Stop remain
deleted.

Deleting a V-Tree File

To delete a V-Tree file from the system, use any of the deletion tools available in OS/2.
A V-Tree file is deleted the same way as any other file in OS/2. Note that none of the
mailbox V-Trees you created by copying this file to a mailbox are affected when you
delete a V-Tree file.
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Printing a V-Tree

Use this procedure to print a V-Tree created using Visual Architect. The M2000 PC must
be attached and set up to use a printer to print a V-Tree. Note that Visual Architect
automatically prints to the default printer for the PC.

To print a V-Tree:

1. Open the V-Tree you want to print.

2. From the File Menu, select Print. The Print dialog box displays.

 

3. To print the V-Tree as it appears on screen, select Graphical View under Print What,
then click OK. A graphical representation of the report prints at a view of 100%.

To quickly print a graphical view of the V-Tree, click the Graphical View toolbar
button.

4. To print a text description of the V-Tree, select Report under Print What, then click
OK. The report prints the title of each menu option, the prompt number voiced by
that option, the comments entered for that option prompt, variable information, and
the assigned actions. Note that blank menu options are not printed in the report.

To quickly print a report for the V-Tree, click the Report toolbar button.

Changing the V-Tree Display

In Visual Architect, use these procedures to:

• Set display options.

• Change the magnification of the displayed V-Tree.

• Hide and display blank options on the V-Tree.

• Expand and collapse menus.
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Setting V-Tree Display Options

Use this procedure to specify how V-Tree options are displayed. These options do not
affect the V-Tree functions; they only change how options are displayed in Visual
Architect.

To set display options:

1. Open the V-Tree you want to view.

2. From the Options menu, select Preferences. The Preferences dialog box displays.

 

3. Select display options as follows:

a. To display the keypress that the caller must press to perform an action next to
an option, select DTMF Selection for Option.

b. To display the action name next to each menu option, select Action Name.

c. To display the title for an action next to the menu option, select Node Title. Note
that some actions, such as Disconnect, cannot have associated titles. If you do
not enter a title for an option, the title for the option displays as Undefined.

d. To display the action variables for the options that contain variables, select
Action Variables. This displays the mailbox number or fax number that you enter
for an action that requires a variable.

4. To save the entered options, click Save. The Visual Architect main window displays
the V-Tree based on the display options selected.

Changing the V-Tree Magnification

Use this procedure to change the magnification of the displayed V-Tree. This feature
enables you to view more or less of the V-Tree at one time by changing the
magnification.

To change the magnification:

1. Open the V-Tree you want to view.

2. Select the desired V-Tree magnification as follows:

a. To view the V-Tree at 50%, select Zoom, then 50% from the View menu.

b. To view the V-Tree at 75%, select Zoom, then 75% from the View menu.
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c. To view the V-Tree at 100%, select Zoom, then 100% from the View menu. Note
that the V-Tree is displayed at 100% by default.

You can also change the magnification by clicking the Zoom In or Zoom Out toolbar
button to increase or decrease the magnification of the V-Tree by 25%, respectively.

Hiding and Displaying Blank V-Tree Options

Use this procedure to hide and display the blank options on a V-Tree. Blank options
simply denote options that do not have actions assigned to them. To assign an action to
a menu option, the blank options must be displayed so that you can drag actions to that
menu option.

To hide and display blank options:

1. Open the V-Tree you want to view.

2. If the blank options are currently hidden, select Show Blank Nodes from the View
menu to display the blank options. A check mark displays next to Show Blank Nodes
and the blank options on the V-Tree display.

If the blank options are currently displayed, select Show Blank Nodes from the View
menu to hide the blank options. The check mark next to Show Blank Nodes is
removed and the blank options on the V-Tree are hidden.

Expanding and Collapsing V-Tree Menus

You can control how much of a V-Tree displays at a time by expanding and collapsing
options on the V-Tree. When you expand a portion of a V-Tree, you display all of the
options available under another option. When you collapse a portion of the V-Tree, you
hide all of the options under another option.

A plus sign icon next to an option on the V-Tree indicates that there are other options
under that option. A minus sign icon denotes that all options under the option are
displayed. If neither a plus or minus icon displays next to an option, there are no options
under it.

To expand and collapse menus:

1. Open the V-Tree you want to view.

2. Specify how much of the V-Tree to display as follows:

a. To collapse the entire V-Tree so that only the first menu of options display,
select Collapse All from the View menu.

b. To expand the entire V-Tree so that all menu options on all menus display,
select Expand All from the View menu.

c. To collapse only a portion of the V-Tree, click the option for which you want to
hide all options under it, then click the minus sign icon .

d. To expand only a portion of the V-Tree, click the option for which you want to
display options under it, then click the plus sign icon .
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Managing Fax Retrieval Documents

The Fax Retrieval feature is available as part of the Fax Solution optional add-on
module. Fax Retrieval allows you to set up the system to automatically fax documents to
callers that request them from a V-Tree. With Fax Retrieval, people can call to request
information quickly and easily by selecting from documents on frequently requested
topics.

For example, you can instruct a caller to press <1> for a fax on the company’s history,
<2> for a fax on product information, or <3> for a fax of the product order form. Or, you
can set up Fax Retrieval to provide callers with fact sheets on any product in the
company’s catalog simply by prompting the caller to enter a certain number, such as the
catalog part number.

Using procedures provided in this chapter, you can:

• Add Fax Retrieval documents to the system.

• Change the number of a Fax Retrieval document.

• Update a Fax Retrieval document.

• Set up a cover page for the fax documents.

• Delete Fax Retrieval documents.

For additional information on assigning the Fax Retrieval actions to a V-Tree, refer to the
topics, "Send a Requested Fax and Advance," and, "Send a Predefined Fax and
Advance," earlier in this chapter.

Before you can use the Fax Retrieval feature, you must:

• Install and configure the fax board on the M2000 PC.

• Set up the system to use the Fax Retrieval options.

• Create a mailbox to use as the storage location of documents for Fax Retrieval.
In the Class of Service assigned to this mailbox, you must select the Fax
Receive option and set the Days to Save a Saved Message option to 99 to save
the faxes indefinitely. This mailbox number must also be specified in System
Setup as the Fax Retrieval Storage Mailbox.

• Install and set up the FaxComm Fax Mail module to use Fax Retrieval to fax
into the system.

Adding Fax Retrieval Documents

Use this procedure to add Fax Retrieval documents into the system. Fax documents are
stored in a specified mailbox, with a storage capacity of 99,999 documents.

Before you begin to add Fax Retrieval documents, disable the header feature on the fax
machine. Otherwise, the original header information will be transmitted every time that
fax is retrieved. Fax machine header information includes the date and time the fax was
originally faxed into the system, and should not be confused with the cover page that you
can define. Refer to the fax machine documentation for information on disabling the fax
machine header feature.

Note that every page of all documents prepared for use with Fax Retrieval should
include identifying information on the sender (company name and phone number).
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To add Fax Retrieval documents:

1. From a fax machine, load the first document in the fax machine’s tray as though you
were faxing it, then dial the extension that connects to the system.

2. When the system answers, press <#> and log into a mailbox. You use the mailbox
you log into to send fax documents from the fax machine to the fax storage mailbox.
This mailbox must have the Fax Send feature available in its assigned Class of
Service, so you can send faxes from the mailbox.

3. From the subscriber Main menu, press <2> to send a message.

4. When prompted, enter the number of the fax storage mailbox.

5. When prompted, record a short message describing the contents of the fax you are
sending, then press <#> to end the recording. Note that this message is only used to
help you identify fax documents in the fax storage mailbox. The message is not
voiced to callers.

6. From the Delivery Options menu, press <*> to attach a fax to the message.

7. When prompted, press the <Start> button on your fax machine. The fax is sent to
the mailbox.

8. Repeat steps 1-7 until the faxes have been sent to the mailbox storage mailbox,
then log out of the mailbox.

9. From any extension, log into the fax storage mailbox, which now contains all of the
documents you faxed to it.

10. Listen to the first message, then from the Message menu, press <0> for more
options.

11. From the More Options menu, press <5> for Envelope Information. The system
voices an 8-digit fax number.

The 8-digit fax number is only voiced as part of Envelope Information if the Fax
V-Tree option is enabled in the mailbox’s Class of Service. For more information on
specifying class of service options, refer to the topic, "Class of Service Options," in
Chapter 4, “Managing System Mailboxes.”

12. Record this number, along with a brief description of the fax or on a copy of the fax
itself. This 8-digit number represents the fax document number and filename of the
fax, which is what the system uses to retrieve the fax for a V-Tree. You will use the
fax document number when assigning Fax Retrieval actions to a V-Tree. Keeping a
record of the faxes and their fax document numbers is helpful should you decide to
change the document numbers at a later time.

Do not specify the extra zeroes to the left of the fax document number when
indicating fax document numbers in V-Trees. These extra zeroes are added by the
system to create files with 8-digit filenames. A caller or the V-Tree creator does not
need to enter these zeroes when specifying a fax.
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13. Repeat steps 10-12 until you have listened to all messages and recorded all the fax
document numbers.

14. Log out of the mailbox. You can now assign Fax Retrieval actions to options on a
V-Tree using the fax document numbers.

Changing the Number of a Fax Retrieval Document

Use this procedure to change the fax document number to a number you specify. For
example, you can use this procedure to change the fax document numbers to match the
catalog numbers of products, enabling customers using a V-Tree to receive a fax on a
product by entering the product’s catalog number.

If you do not know the document number of the fax you want to change, you can log into
the Fax Retrieval storage mailbox, obtain envelope information for the first fax message
and record the fax document number that is voiced, print the first fax message and
record the fax document number on the printed fax, then repeat for each fax until the fax
you want to change is printed.

To change the number of Fax Retrieval documents:

1. Identify the directory where the fax document file is stored on the system by
recording the last digit of the fax document number. This number indicates the last
number of the fax directories on the system.

 For example, if the fax document number is 00001005, the last digit of the fax
document number is 5, and the file is stored in the \FAX05 directory as
00001005.TIF.

2. To change the number of the Fax Retrieval document, at the \CVR directory prompt,
type COPY \FAX0A\XXXXXXXA.TIF \FAX0B\YYYYYYYB.TIF, where A is the last
digit of the original fax document number, X is the original fax number, B is the fax
directory where you want to store the changed fax, and Y is the new fax document
number.

 For example, if you want to change the fax document numbered 0001005 to
00023456, type COPY \FAX05\00001005.TIF \FAX06\00023456.TIF at the
\CVR directory prompt. Filenames must be 8 characters in length. If the filename is
not 8 characters, it must be left-filled with zeros to fill 8 characters.

Do not specify the extra zeroes to the left of the fax document number when
indicating fax document numbers in V-Trees. These extra zeroes are added by the
system to create files with eight-digit filenames. A caller or the V-Tree creator does
not need to enter these zeroes when specifying a fax.

3. Press <ENTER>. The system changes the fax document number to the entered
number.

Updating a Fax Retrieval Document

Use this procedure to replace an existing Fax Retrieval document with an updated
version of the document. This procedure essentially involves deleting the old Fax
Retrieval document that you want to replace, adding the new Fax Retrieval document on
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the system, then changing the number of the new document to the same number as the
old Fax Retrieval document.

If you do not want to delete the old document from the system, you can simply add the
new document to the system, then set the V-Tree options and the fax document
numbers listed for callers to reflect the new fax document number.

If you do not know the document number of the fax you want to update, you can log into
the Fax Retrieval Storage Mailbox, obtain envelope information for the first fax message
and record the fax document number that is voiced, print the first fax message and
record the fax document number on the printed fax, then repeat for each fax until the fax
you want to update is printed.

To update a Fax Retrieval document:

1. Identify the directory where the old fax document file is stored on the system by
recording the last digit of the fax document number. This number indicates the last
number of the fax directories on the system.

 For example, if the fax document number is 00001005, the last digit of the fax
document number is 5, and the file is stored in the \FAX05 directory where the
system is installed as 00001005.TIF.

2. To delete the old Fax Retrieval document from the system, use any of the file
deletion tools available in OS/2. A Fax Retrieval document file is deleted the same
way as any other file in OS/2.

3. From a fax machine, load the document to be added to the system in the fax
machine’s tray as though you were faxing it, then dial the extension that connects to
the system.

4. When the system answers, press <#> and log into a mailbox. You use the mailbox
you log into to send fax documents from the fax machine to the fax storage mailbox.
This mailbox must have the Fax Send feature available in its assigned class of
service, so you can send faxes from the mailbox.

5. From the subscriber Main menu, press <2> to send a message.

6. When prompted, enter number of the fax storage mailbox.

7. When prompted, record a short message describing the contents of the fax you are
sending, then press <#> to end the recording. Note that this message is only used to
help you identify fax documents in the fax storage mailbox. The message is not
voiced to callers.

8. From the Delivery Options menu, press <*> to attach a fax to the message.

9. When prompted, press the <Start> button on your fax machine. The fax is sent to
the mailbox.

10. From any extension, log into the fax storage mailbox, which now contains the
document you faxed to it.

11. Listen to the first message, then from the Message menu, press <0> for more
options.
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12. From the More Options menu, press <5> for Envelope Information. The system
voices an 8-digit fax number.

13. Record this number. This 8-digit number represents the fax document number and
filename of the fax, which is what the system uses to retrieve the fax for a V-Tree.

Do not specify the extra zeroes to the left of the fax document number when
indicating fax document numbers in V-Trees. These extra zeroes are added by the
system to create files with 8 digit filenames. A caller or the V-Tree creator does not
need to enter these zeroes when specifying a fax.

14. Log out of the mailbox.

15. To change the number of the new Fax Retrieval document to the old number, at the
\CVR directory prompt, type COPY \FAX0A\XXXXXXXA.TIF
\FAX0B\YYYYYYYB.TIF, where A is the last digit of the new fax document number,
X is the new fax number, B is the fax directory where old fax document was stored,
and Y is the old fax document number.

 For example, if you want to change the fax document numbered 0001005 to
00023456, type COPY \FAX05\00001005.TIF \FAX06\00023456.TIF at the
\CVR directory prompt. Filenames must be 8 characters in length. If the filename is
not 8 characters, it must be left-filled with zeros to fill 8 characters.

16. Press <ENTER>. The new fax document now has the same document number as
the old fax document.

Setting Up a Cover Page for Faxes

Use this procedure to set up the system to automatically fax a cover page with every
document. The cover page displays the number the caller entered as the destination for
the fax and the caller’s extension, if one was entered.

To set up a cover page:

1. Verify that the Use a Fax Cover Sheet option is selected on the Fax Parameters tab
of System Setup. A cover page is now automatically sent with each fax.

2. If you want to add a logo or header to the top of the cover page, fax the logo or
header into the system, then change the name of the fax document to HEADER.TIF
and save it in the \CVR1 directory.

Regardless of the size and contents of the header and footer files, the system always
prints the information bar immediately after the header.

3. If you want to add a footer or logo to the bottom of the cover page, fax the logo or
footer into the system, then change the name of the fax document to FOOTER.TIF
and save it in the \CVR1 directory.

You can also create a header or footer for the cover page by creating the file, saving
it with a TIF/F format, then saving it as the HEADER.TIF file or FOOTER.TIF file in
the \CVR1 directory. Note that the TIF/F format is not the same as the TIF format.
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Deleting Fax Retrieval Documents

To delete a Fax Retrieval document from the system, use any of the file deletion tools
available in OS/2. A Fax Retrieval document file is deleted the same way as any other
file in OS/2 is deleted.
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C H A P T E R  1 1

Troubleshooting the System

While M2000 is in use, system problems or other issues may surface that you need to
address. This chapter provides comprehensive troubleshooting information.

Some information provided in this chapter is highly technical. Your level of knowledge on
general telephony and the switch being used, as well as your access to tools such as
digit grabbers will dictate how effectively you can interpret some of this information. If
you have any questions, be sure to contact a Lucent Technologies technical support
representative.

Also note that because many parameter settings specified on M2000 System
Setup screens are interdependent, it is imperative that you contact your Lucent
Technologies representative before making any modifications to System Setup
screens.
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System Troubleshooting Table

If you encounter a problem with M2000, refer to this table for possible resolutions before
contacting a Lucent Technologies technical support representative. By following these
Troubleshooting Table guidelines, you may be able to solve the problem independently
or if not, at least gather information the Lucent Technologies technical support
representative can use to assist you more effectively.

For easy reference, this troubleshooting table lists problem areas and their possible
resolutions alphabetically. Note that some problem areas are very broad, with subtopics
listed below the main heading. For example, if you encounter a problem where
subscribers cannot log into their mailboxes, look under Mailboxes are not functioning
properly to locate the subtopic Cannot log into a mailbox.

When you encounter a problem with M2000, be sure the Activate Digit Grabber
(DIGRAB) parameter on the Inband Page 1 tab and the Debug Mode parameter on the
Voice System tab are activated in System Setup. These parameters instruct the system
to log system activity and incoming digit strings to the system log files. This information
helps technical support representatives solve the problems you encounter.

Remember that when certain system errors occur during system operation, an error file
is created and displayed in an OS/2 editor window to provide information about the error.
M2000 then shuts down and immediately restarts. When an error file displays,
immediately contact a technical support representative. A sample error file appears
below.
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Cannot access system fields,
buttons, checkboxes, or
menus onscreen

Resolution Possibilities:

• Verify that you are logged in at the appropriate security level to
access the feature associated with the fields.

• Verify that the M2000 sentinel permits the features associated
with the fields you want to access. For information on verifying
the features enabled on a sentinel, see the topic, "Displaying
Features Enabled on the Sentinel," later in this chapter.

• Verify that the field you want to access is available. If the field is
dimmed, it cannot be accessed.

• Log out of supervisor access, then log back in.

• Use the mouse to place the cursor in a field, button, or
checkbox, then click the left mouse button to select the option.

• Use <Tab> and <Shift-Tab> to move the cursor through the
options.

• Note that you can only select one item from a set of radio
buttons. However, in a set of checkboxes, you can select any
number (including all or none) of the options.

• To select menus, use the mouse or <Tab>, <Shift-Tab>, or the
right or left arrow keys to move the highlighted bar. Click or
press <ENTER> to select a highlighted menu.

• To select menu options, hold down <Alt> and type the first
highlighted character of the menu name.

Auto forwarding does not work

Resolution Possibilities:

Mailbox Entry dialog box:

• Verify that the Follow-Me-Forward checkbox is not enabled on
the Subscriber Settings dialog box.

• Verify that the Auto Forwarding checkbox is enabled on the
Auto Forwarding dialog box for the mailbox.

• Verify that the Delay field on the Auto Forwarding dialog box is
set to the default (three minutes) or greater value. Allow enough
time for the caller to review and/or rerecord the message.

System Setup parameters:

• Verify that at least one port is enabled for outbound calls on the
Port Parameters tab.
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Auto time-date does not work

Resolution Possibilities:

• Verify that the Class of Service assigned to the mailbox permits
the subscriber to activate the auto time-date feature over the
phone. This feature can also be activated by a system manager
on the Subscriber Settings dialog box.

• Verify that the correct date and time are set on the PC clock.

Call analysis does not work

Resolution Possibilities:

• Re-run the Call Analysis utility. Be sure to delete the existing
tone table when you run Call Analysis. See Chapter 10,
“Defining Phone System Signals” in the Implementation and
Service Manual.

• If you re-run Call Analysis and problems persist, contact a
technical support representative for information on using
Advanced Call Analysis.

Callers are disconnected

Resolution Possibilities:

• Verify that the method the switch uses for a disconnect. Verify
that the appropriate hang-up detection parameters are
configured. For information on verifying a switch’s disconnect
signal, see the topic, "Determining a Switch’s Disconnect
Signal," later in this chapter.

• Note under what conditions callers are being disconnected.

• Verify that call analysis was run and that M2000 correctly
interprets signals from the switch. If call analysis was run and
M2000 still cannot correctly interpret signals from the switch,
contact a technical support representative for information on
using Advanced Call Analysis.

System Setup parameters:

• Turn off all System Setup parameters that cause disconnects to
help determine if the problem is caused by the phone system or
M2000:

− Set Minimum Message Length in Seconds on the
Message Timing tab to 0.

− Make sure Maximum Silence on the Hangup tab is set to
at least the default, 2000.

− Set DTONDET on the Hangup tab to 0 if your switch uses
the BellCore tone table.

• Set HANGUPDLY on the Hangup tab to 0.
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Callers cannot transfer

Resolution Possibilities:

• See the Configuration Note for the switch for the proper transfer
and release codes. If you do not have the Configuration Note for
the switch, you can determine the switch code by replacing the
voice-mail port with a 2500 set—or the proprietary telephone
instrument if using a D/42D NS, D/42D SX, or D/42D SL
integration—and transferring a caller to an extension in a busy
state, then pulling the call back. Do the same for the no-answer
state.

• Verify that call analysis was run and that M2000 correctly
interprets signals from the switch. If call analysis was run and
M2000 still cannot correctly interpret signals from the switch,
contact a technical support representative for information on
using Advanced Call Analysis.

System Setup parameters:

• Verify the Custom Transfer Code on the Call Transfer tab is
entered correctly.

• Verify the Transfer Release Code for Busy on the Call Transfer
tab is entered correctly.

• Verify the Transfer Release Code for No Answer on the Call
Transfer tab is entered correctly.

• Verify the FLINTVL parameter on the Call Transfer tab matches
the hook flash time of the switch.

• • Verify the TONEDLY parameter on the Call Transfer tab is set
high enough for the system to distinguish the time between
DTMFs. If this parameter is set to 8 and callers still cannot
transfer, contact a technical support representative.

• Verify the TONELEN on the Call Transfer tab parameter is high
enough so the system can distinguish DTMFs. If this parameter
is set to 8 and callers still cannot transfer, contact a technical
support representative.

Call Forwarding does not work

Resolution Possibilities:

• Verify that the correct call condition is being satisfied for the call
forwarding option to work properly:  busy, no answer, busy or
no answer, or all calls.

System Setup parameters:

• Verify the Maximum Number of Forwarded Extensions
parameter on the Subscriber tab is not being exceeded.

Class of Service dialog box:

• Verify that the Call Handling checkbox is enabled.
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Mailbox Entry dialog box:

• Verify that call forwarding is activated for the mailbox by either
the subscriber over the phone or the system manager through
the Subscriber Settings dialog box.

• Verify a valid mailbox number is entered in the Forward field on
the Subscriber Settings dialog box.

Call Handling does not work

Resolution Possibilities:

• Verify that the correct call condition is being satisfied for the
Call Handling option selected: busy, no-answer, busy or no-
answer, or all calls.

• Verify that the mailbox has Call Handling enabled on the Class
of Service dialog box.

• Verify that the subscriber enabled the Call Handling option over
the phone or the system manager enabled it on the Subscriber
Settings dialog box.

• Note that if call paging is active for the mailbox, the subscriber
is paged on a no answer condition before the Call Handling
options are available.

• For more information on the conditions that affect Call
Handling, see the topic, "Prompts Voiced Under Specific Call
Handling Conditions," later in this chapter.

Call Queuing does not work

Resolution Possibilities:

• Verify the phone system switch is configured for supervised
transfers.

• Verify the PBX does not forward calls back to M2000 on a busy
condition.

System Setup parameters:

• Verify the correct code is entered for the Release Code on Busy
parameter on the Call Transfer tab.

Class of Service dialog box:

• Verify the Max Rings parameter is set to 3 or greater.
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Call Screening does not work

Resolution Possibilities:

• Disconnect a line from the M2000 system and attach a single
line phone. Attempt to use call screening manually to verify that
the switch supports call screening.

• Verify that call analysis recognizes no answer and busy
conditions properly.

• Verify that the appropriate Call Screening Busy, No Answer,
Transfer, and Reject codes are entered on the Call Screening
tab in System Setup.

Class of Service dialog box:

• Verify that Maximum Rings is set to 3 or greater.

• Verify that the Call Screening checkbox is enabled.

Mailbox Entry dialog box:

• Verify that Call Screening under Special Features is enabled on
the Subscriber Settings dialog box.

Daylight Savings Time does
not set correctly

Resolution Possibilities:

• Determine whether another application on the PC has a
Daylight Savings Time feature that may conflict with M2000’s.

System Setup parameters:

• If the time changes by two hours, disable the Automatic System
Clock Reset for Daylight Savings Time parameter on the
General tab.

• If the time did not change, enable the Automatic System Clock
Reset for Daylight Savings Time parameter on the General tab.

• Verify that the PC clock is set to the correct date and time. Note
that there is no timing mechanism in the M2000 system.

Disconnects are not
recognized properly

Resolution Possibilities:

• See the Configuration note for the switch to determine the type
of disconnect supervision the PBX provides. For information on
verifying a switch’s disconnect signal, see the topic,
"Determining a Switch’s Disconnect Signal," later in this
chapter.
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For Dial Tone detection • Verify the value entered for DTONDET on the Hangup tab of
System Setup is not set too low. If it is, the system disconnects
prematurely. This parameter is set by the Integrator utility.

• If the switch does not return dial tone, set this value to 0 to
disable it. If the switch does not use dial tone for disconnect
detection, and you want to keep DTONDET enabled but
inactive, set it to 1200 (12 seconds).

For Hangup String detection • Verify the correct string is entered in the HANGUPSTR
parameter on the Hangup tab of System Setup. It should be
blank if the switch does not use a hangup string.

• Verify the HANGUPDLY parameter on the Hangup tab is correct
for the switch. To calculate this value:

1. Multiply the number of digits in the switch’s hangup string
by 40 milliseconds.

2. Multiply the number of pauses between digits in the string
by 20 milliseconds.

3. Add the results from steps 1 and 2 to determine the
minimum amount of delay that should be entered in this
field.

4. If M2000 still does not recognize the hangup string, keep
increasing this value by 20 milliseconds until it does.

For Drop in Loop Current Detection • If the ports do not disconnect, set LCDTIME on the Hangup tab
in System Setup to 6 and restart the system.

• If ports drop the call, immediately go back off-hook, and
increase the value of LCDTIME on the Hangup tab in System
Setup. If you have an AT&T Legend with the new 012 card, set
this parameter to 75.

For systems using blind transfers • Use the following procedure to improve hangup detection for
systems using blind transfers:

a. 

1. Shut down M2000, if it is running.

2. To open Call Analysis, double-click the Call Analysis icon in
the Lucent Technologies Folder. The Call Analysis for OS/2
dialog box displays.

3. If Call Analysis was run previously, clear the previous Call
Analysis results by clicking on Clear CA.

4. When prompted, click OK to delete the tone table. The Call
analysis for OS/2 dialog box displays.

5. Click Set Defaults. The Call Analysis Default Parameters
dialog box displays.

6. Select Load Default Tone Table. Make sure Enable Fastbusy
Testing, Enable Dialtone Selection, and Load Tone Tables
are selected.

7. To close the dialog box, click OK. The Call Analysis for OS/2
dialog box displays.

8. Click Continue. The Call Analysis dialog box displays.

9. To close Call Analysis, click Exit.

10. Shut down OS/2 and restart the PC.
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Supervised transfers do not
work

Resolution Possibilities:

• Run Call Analysis again and delete the tone table by clicking on
Clear CA. For more information on running Call Analysis, refer
to Chapter 10, “Defining Phone System Signals,” in the
Implementation and Service Manual.

Distribution lists do not work

Group distribution lists do not
work

Resolution Possibilities:

• Verify Global Distribution List checkbox on the Class of Service
dialog box is enabled. The distribution lists feature provides
access to lists 11 through 20, which can be created by the
mailbox owner for that individual mailbox.

• Verify that a distribution list is created.

Global distribution lists do not
work

Resolution Possibilities:

• Verify Global Distribution List checkbox on the Class of Service
dialog box is enabled. This feature provides access to system
distribution lists 26 through 35, which can be created by a
system manager, and company-wide and division-wide lists (98
and 99), which are automatically created by the system.

• Note that system distribution lists (26 – 35) can only be created
using the supervisor’s main menu available through the phone
interface.

• Note that there must be more than one mailbox with entries in
the Company and Division fields on the Mailbox Entry dialog
box to create company-wide and division-wide distribution lists
(98 and 99).

• Verify that a system distribution list is created.

DTMFs are not recognized
properly

Resolution Possibilities:

System Setup parameters:

• Verify that the PLAYDTMF parameter on the Voice System tab
is set to the default.

• If the system experiences talkoff (when a recording session is
interrupted by the system voicing prompts), increase the
RECDTMF parameter setting on the Voice System tab.

• • Verify TONEDLY parameter on the Call Transfer tab is set high
enough for the system to distinguish the time between DTMFs.
If this parameter is set to 8 and DTMFs still are not recognized,
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contact a technical support representative.

• Verify the TONELEN parameter on the Call Transfer tab is high
enough so the system can distinguish DTMFs. If this parameter
is set to 8 and DTMFs still are not recognized, contact a
technical support representative.

Fax Features do not work

Fax AutoPrint does not work Resolution Possibilities:

• Verify the sentinel on the M2000 system permits fax mail. For
information on verifying the features enabled on a sentinel, see
the topic, "Displaying Features Enabled on the Sentinel," later in
this chapter.

• Verify that the wiring to the fax card is set up correctly for the
wiring method used (transfer or non-transfer).

• Verify that the fax was not deleted. If a fax scheduled for
printing is deleted before it is printed, the system still attempts
to print it. When the fax is not found, the system logs an error.

Mailbox Entry dialog box:

• Verify that AutoPrint is enabled on the Subscriber Settings
dialog box for the mailbox.

Class of Service dialog box:

• Verify that the Send Faxes and Receive Faxes checkboxes are
enabled.

System Setup parameters:

• Verify the parameters on the Fax tab are configured properly.

• Verify the parameters on the Fax Extensions tab are configured
properly.

Fax retrieval does not work Resolution Possibilities:

• Verify that the wiring to the fax card is set up correctly for the
wiring method used (transfer or non-transfer).

• Verify that faxes have been loaded onto the M2000 system and
are ready to be sent.

• Verify that a V-Tree has been created, includes the fax option,
and is activated.

• Verify that Configure utility has been set up properly for
Brooktrout fax boards. If you use this utility, you must shut
down and restart M2000 for the changes to take effect. Do not
use the Restart option under the Options menu.

• Verify the sentinel on the M2000 system allows Fax Retrieval.
For information on verifying the features enabled on a sentinel,
see the topic, "Displaying Features Enabled on the Sentinel,"
later in this chapter.

Class of Service dialog box:

• Verify that Fax V-Trees checkbox is enabled.
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System Setup parameters:

• Verify that the entries on the Fax Extensions tab in System
Setup are configured properly if using the transfer method.

• Verify that at least one outbound port is enabled for Fax on the
Port Parameters tab in System Setup.

Folders do not work

Resolution Possibilities:

• Verify that the Folders checkbox is enabled on the Class of
Service dialog box.

• Verify that folders are created in the subscriber’s mailbox and
that label names are recorded.

• Verify that messages are being saved to the proper folder.

Follow-me-forward does not
work

Resolution Possibilities:

• Verify that other messages sent via OctelNet are sent and
received as expected.

• Note that the destination must be predefined as an administered
AMIS or OctelNet node.

• Verify the sentinel on the M2000 system allows analog
networking. For information on verifying the features enabled on
a sentinel, see the topic, "Displaying Features Enabled on the
Sentinel," later in this chapter.

• Verify that the auto forwarding feature is not active on the Auto
Forwarding dialog box accessible from the Mailbox Entry dialog
box.

System Setup parameters:

• Verify that the system is configured with networking parameters
on the Networking tab.

• Verify that Dial Plan is properly configured and that the Use Dial
Plan parameter on the Outbound Dialing tab is enabled. Dial
Plan ensures that network node destinations are dialed
properly.

• Verify that at least one port on the Port Parameters tab is
enabled for outbound analog network events.

Class of Service dialog box:

• Verify that the Follow-Me-Forward checkbox is enabled and a
Networking Option is selected.

• Verify that a Dispatch Option other than Not Allowed is enabled.

• Verify that at least one Network Options checkbox is enabled.
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Greetings do not voice
properly

Holiday Greetings do not voice Resolution Possibilities:

• Verify that the date in question is specified as a holiday on the
Holiday dialog box and that a prompt for the holiday has been
recorded and specified on the dialog box, which is accessible
from the Attendant menu, Holidays option.

• Note that Holiday greetings do not voice if greeting by port is
configured.

• Verify the PC clock is set to the correct date and time.

• If a holiday greeting voices on a non-holiday date, access the
Holiday dialog box and check to see if the Retain field is
selected for the date in question. If so, this date was specified
as a holiday in a previous year and retained for use in the
current year.

Multilingual greetings do not
voice

Resolution Possibilities:

• Verify that the sentinel supports the multiple languages. For
information on verifying the features enabled on a sentinel, see
the topic, "Displaying Features Enabled on the Sentinel," later in
this chapter.

• Verify that the primary and secondary languages are defined on
the Language Selection dialog box, which is accessible from the
Options menu, Language Selection option.

• Verify that a Language Select prompt is recorded and specified
on the System Prompts dialog box, which is accessible from the
Attendant menu, System Prompts option.

• Listen to the Attendant Menu prompts and the Message
Notification prompts using SOLVE, or over the supervisor’s
menu phone interface to verify that they are correct.

• Note that Holiday greetings can only be voiced in one language.

• Verify that the Attendant Menu and Message Notification
prompts are recorded in each language being used. Specify the
appropriate prompt numbers on the System Prompts dialog box
for each language listed in the Language Select prompt.

• Verify that the correct language is specified in the Language
field on the Class of Service dialog box.

Greeting by port does not work

Resolution Possibilities:

• Verify that the appropriate trunks are routed to the correct ports.
This allows the system to voice the correct greetings when the
phone number is called.

• Verify that the port is active for greeting by port on the Greeting
by Port dialog box.
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• Verify that the correct mailboxes are assigned on the Greeting
by Port dialog box and that the Personal Greetings for the
mailboxes are recorded with an appropriate greeting.

Mailbox Entry dialog box:

• Verify that the correct company and division information is
entered on the Mailbox Entry dialog box. Note that these fields
are case-sensitive.

• Verify that the correct call handling option is selected for the
mailboxes handling calls for ports active for greeting by port.

Inband/DID integration does
not work

Resolution Possibilities:

• Attach a digit grabber to a line and verify that the switch is
sending the appropriate inband signaling digits.

System Setup parameters:

• Verify the following Inband Parameters:

− The Total Number of Inband Signaling Digits
(DIDCOUNT) is set equal to or higher than the total
number of digits in the inband signaling string.

− If the switch requires a * or # to signify the end of an
inband code, verify that it is entered in the DID
Terminating Character (DIDTERM) parameter.

− No spacer characters are entered in the DID Terminating
Character (DIDTERM) parameter.

− Seconds to Wait for DID (DIDTIME) is set to 5.

• If the beginning of the inband signaling string is missing, verify
that the Offhook Delay parameter is set to 25. If not, change it
to 25, then shut down and restart the system.

• If the end of the inband signaling string is missing, increase the
value for the Total number of DID digits parameter on the
Inband tab.

• If changing the Total number of DID digits parameter on the
Inband tab in System Setup did not work, increase the Number
of Milliseconds to Wait parameter on the Inband tab by 500
units.

Intercom paging does not work

Resolution Possibilities:

• Note that a paging system (external or extension) must be
available on the switch for the intercom paging feature to be
used.

• Note that there must be at least two ports available on the
M2000 system to complete a page cycle.

• Note that paging works on M2000 systems using supervised
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transfers or a switch that uses a unique code for busy and no-
answer.

• If there is a problem with intercom redirect, verify that the
sentinel allows intercom redirect feature. For information on
verifying the features enabled on a sentinel, see the topic,
"Displaying Features Enabled on the Sentinel," later in this
chapter.

• Verify that call analysis recognizes ring-no-answer and busy
conditions accurately.

System Setup parameters:

• Verify that an Intercom Paging Code is specified on the
Intercom Paging tab in System Setup.

• Verify that the Release Code for Intercom Paging is specified on
the Intercom Paging tab.

Class of Service dialog box:

• Verify that the Intercom Paging checkbox is enabled.

Mailbox Entry dialog box:

• If intercom paging was activated by the subscriber over the
phone, verify that the system manager did not override the
setting on the Subscriber Settings dialog box.

Callers hear, “There is a line
problem. Please try again
later,” when they access a
mailbox

Resolution Possibilities:

• This prompt indicates a possible file problem. Use the following
procedure:

1. Exit M2000 by selecting Exit from the File menu.

2. View the PLUS.LOG file for any errors indicating power
failures. For more information on viewing the log file, see
the topic, "Viewing the PLUS.LOG File," later in this
chapter.

3. Run Quick Assist using the Verify Recovery Mode and the
Delete Unattached Messages Recovery Option.

4. If Quick Assist does not report any errors, restart M2000.
If Quick Assist does report errors, it instructs you as to
which recovery options to run. Note that if Quick Assist
recommends using the Update All option, contact a
technical support representative for assistance.

5. Restart the PC and restart M2000. If the problem
persists, contact a technical support representative for
information.
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Mailboxes are not functioning
properly

Cannot edit a mailbox Resolution Possibilities:

• Verify that you have logged in at the necessary level of security.
To access all functions except a few on the Options menu, enter
the Level 2 security password (default = 12345). To access all
functions, including all those on the Options menu, enter the
Level 3 security password (default = 67890).

• Note that a guest mailbox cannot be edited, nor can a mailbox
that is in use.

• Note that when using greeting by port, the supervisor mailbox
must have either the same company entry as the subscriber’s
mailbox or no company entry to edit the mailbox using the
supervisor main menu functions over the phone.

Cannot change class of service Resolution Possibilities:

• Verify that you have logged in at a Level 3 security level.

• Note that a security Level 3 supervisor can change a class of
service for an individual mailbox by 1) selecting the View/Edit
push button on the Mailbox Entry dialog box, 2) adjusting (if
necessary) and applying a default class of service, or 3)
designing and applying a custom class of service.

Cannot access mailbox features Resolution Possibilities:

• Verify that the feature in question is enabled on the Class of
Service dialog box.

• Verify that the sentinel on the M2000 system permits the
feature. For information on verifying the features enabled on a
sentinel, see the topic, "Displaying Features Enabled on the
Sentinel," later in this chapter.

• Verify that the feature in question is permitted in the class of
service assigned to the mailbox.

• Verify that the feature is active in the Subscriber Settings dialog
box.

• Note that a guest mailbox can only send and receive messages.

Cannot log into a mailbox Resolution Possibilities:

• Dial the system’s extension or phone number and press <#>
after the system greeting. Enter the mailbox number and, when
prompted, the mailbox’s password.

• Do not log in using a speakerphone.

• If M2000 is on an integrated system using automatic station
login, verify that the Inband Signaling code is correct.

• Note that you must enter <#> after the password if the extended
security feature is active. Otherwise, the system pauses after
you finish entering the password before accessing the mailbox.

• Attempt to log in again. You may have entered an invalid
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password.

• Verify the password contains the minimum number of digits
specified in the Minimum Length of Password field on the
Subscriber tab in System Setup.

• Note that a guest mailbox is deleted with its sponsor mailbox.

• Note that the system manager can assign a new password
either through the Edit Mailbox dialog box or over the phone if
the subscriber cannot remember the password.

• Run Quick Assist using the Update Partial option. For
information on running the Quick Assist utility, refer to Chapter
24, “Maintaining the System,” in the Implementation and Service
Manual.

Cannot record mailbox prompts Resolution Possibilities:

• Verify that the class of service assigned to the mailbox permits
recording prompts.

• Verify that the Maximum Time to Record Mailbox Prompts
parameter is not set to zero on the Message Timing tab in
System Setup.

Mailbox is full Resolution Possibilities:

• The value specified in the Max Messages field in the class of
service assigned to the mailbox has been reached. Delete
messages to allow for more recording time in the mailbox or
increase the limits.

• Assign a new class of service to the mailbox.

• Run Quick Assist using the Update Partial option. For
information on running the Quick Assist utility, refer to Chapter
24, “Maintaining the System” in the Implementation and Service
Manual.

Messages

Cannot edit a sent message Resolution Possibilities:

• Verify that the Locate Messages Sent checkbox is enabled on
the Class of Service dialog box.

• Note that a sent message cannot be edited if it does not reside
in the recipient’s new message queue.

• Note that a message that is in the new message queue cannot
be edited if it has been reviewed or skipped.

• Note that messages scheduled for dispatch over a network
(OctelNet and AMIS) cannot be edited.
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Cannot save messages Resolution Possibilities:

• Verify that the Save Messages checkbox is enabled on the
Class of Service dialog box.

• Note that listen-only messages cannot be saved.

Messages include a clicking
noise at the end

Resolution Possibilities:

• By setting the environment variable DIALTONETRIM to the
number of seconds the clicking is typically recorded, you can
prevent the clicking from being included in messages. To set
the DIALTONETRIM variable, type the following line at the end
of the CONFIG.SYS file on the M2000 PC:

SET DIALTONETRIM=#

where # is the number of seconds of clicking that is typically
heard. The DIALTONETRIM variable removes the last number
of seconds (specified as #) from the message when the
message is not terminated by a DTMF.

Messages vanishing from
mailboxes

Resolution Possibilities:

• Verify the correct date and time are set on the PC clock.

Mailbox Entry dialog box:

• Deactivate the Auto Forwarding feature if is active.

• Note that the number of days to save messages can be set to
99, allowing saved messages to remain on M2000 indefinitely.

Class of Service dialog box:

• Note that a message will be removed from the saved message
queue when its age is equal to the days to save saved
messages value in the Class of Service. The age is calculated
from the time a message was first received in a mailbox.

System Setup parameters:

• When the number of days to save messages has expired,
messages are automatically deleted. To warn subscribers of
deleted messages, activate the Voice Warning When Messages
Expire parameter on the Subscriber tab.

Message confirmation does
not work

Resolution Possibilities:

• Verify that the Message Confirmation checkbox is enabled on
the Class of Service dialog box.

• Note that OctelNet confirmations are dispatched during the next
connection after the message is initially delivered. Therefore, if
no messages have been sent to that node since the original
message was sent, the confirmation has not had a chance to be
delivered to the sender.

• Note that confirmations are only generated for messages
tagged for confirmation when they are sent.
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• Note that subscribers must check message confirmations
through the message locator feature.

• Note that messages dispatched to remote sites using AMIS
cannot be sent with message confirmation activated. This
includes messages to mailboxes active for Follow-Me-Forward.

Message Indicators do not
work

Message Indicators do not work
for Inband

Resolution Possibilities:

• Disconnect a voice-mail port and attach a 2500 set or the
proprietary telephone instrument if using a D/42D NS, D/42D
SX, or D/42D SL integration. Go off hook and manually test the
message indicator by entering the codes specified on the MI tab
in System Setup.

System Setup parameters:

• Verify that the Port Parameters tab has at least one port
enabled for outbound and that the same port is also enabled for
Message Indicators.

• Verify that the Permit Message Indicators parameter on the MI
tab is enabled.

• Verify that the MI prefix and suffix on and off codes are entered
in the fields on the MI tab. If using the Dialogic SX or SL
integration, see the appropriate Configuration Note for the
correct codes to enter in these fields.

• Some PBXs require M2000 to wait for a confirmation tone to
complete the message indicator event. For these systems, enter
a comma (,) at the end of the MI Suffix OFF or ON code.

• Verify that the value for DTONDET is greater than the value for
DTONWAIT, unless DTONDET is set to 0.

• Verify that the values for DTONWAIT and DTONDET are at
least 400 units apart, unless DTONDET is set to 0.

Class of Service dialog box:

• Verify the Message Indicator checkbox is enabled.

Message Indicators do not work
for SMDI

Resolution Possibilities:

• Place a breakout box on the line and verify that message
indicator information is being sent over the SMDI link.
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System Setup parameters:

• Verify that COMMWL is enabled on the SMDI tab.

• Verify that the Port Parameters tab has at least one port
enabled for outbound and that the same port is also enabled for
Message Indicators.

• Verify that the Permit Message Indicators parameter on the MI
tab is enabled.

• Verify that the value for DTONDET is greater than the value for
DTONWAIT, unless DTONDET is set to 0.

• Verify that the values for DTONWAIT and DTONDET are at
least 400 units apart, unless DTONDET is set to 0.

Class of Service dialog box:

• Verify the Message Indicator checkbox is enabled.

Message Indicators do not work
for Centrex

Resolution Possibilities:

• Verify the codes in the SMDI.PFX file in the \CVR directory are
correct.

System Setup parameters:

• Verify that the message indicator prefix is entered correctly on
the MI tab.

• Verify that the Permit Message Indicators parameter on the MI
tab is enabled.

• Verify that COMMMWL is enabled on the Simplified Message
Desk Interface tab.

• Verify that the Port Parameters tab has at least one port
enabled for outbound and that the same port is also enabled for
Message Indicators.

• Verify that the value for DTONDET is greater than the value for
DTONWAIT, unless DTONDET is set to 0.

• Verify that the values for DTONWAIT and DTONDET are at
least 400 units apart, unless DTONDET is set to 0.

Class of Service dialog box:

• Verify the Message Indicator checkbox is enabled.

Message Indicators do not work
for DID

Resolution Possibilities:

• Unplug the port from the M2000 system and attach a digital
phone to the port. Verify that the message indicator can be lit.

System Setup parameters:

• Verify that the Port Parameters tab has at least one port
enabled for outbound.

• Verify that the MI tab allows message indicators and the correct
codes are entered in the fields.

Class of Service dialog box:

• Verify the Message Indicator checkbox is enabled.
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Message Notification does not
work for a phone

Resolution Possibilities:

• Attach a digit grabber to monitor a line. Verify that the M2000
system can access the line and connect to the phone number.

• If Debug displays the error, “WARNING 18 No Dial tone
Detected,” all outbound ports were busy when notification was
attempted. You may want to enable more outbound ports on the
system.

System Setup parameters:

• Verify that at least one port is enabled for Outbound and
Message Notification in the Port Parameters tab.

• Verify that the values entered for DTONWAIT on the Message
Delivery tab and DTONDET on the Hangup tab are set at least
400 units apart, unless DTONDET is set to 0.

• Verify that the value for DTONDET is greater than the value for
DTONWAIT, unless DTONDET is set to 0.

• The value for DTONDET may be set too low. If it is, M2000 may
hang up prematurely. Adjust this parameter only if instructed to
by a technical support representative.

• The value for SCHDWAIT on the Outbound Calls tab may be
set too low. If it is, M2000 may not detect a dial tone on an
outbound line and must reschedule the event. Adjust this
parameter only if instructed to by a technical support
representative.

Mailbox Entry dialog box:

• Verify the message notification feature is enabled in the
Subscriber Settings dialog box.

• Verify the time blocks are configured for the message
notification feature in the Mailbox Entry dialog box.

• Verify the Mailbox Entry/Message Notification dialog box
indicates PHONE in the Call Back field.

Class of Service dialog box:

• Verify the Message Notification checkbox is enabled.

• Verify that the Long Distance option under Delivery Options is
selected.
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Message Notification does not
work for a beeper

Resolution Possibilities:

• Attach a digit grabber to monitor a line. Verify that the M2000
system can access the line and connect to the phone number.

• If Debug displays the error “WARNING 18 No Dial tone
Detected,” all outbound ports were busy when notification was
attempted. You may want to enable more outbound ports on the
system.

• Some pager companies use three beep tones to indicate a
connect. If the system does not recognize this connect signal,
configure notification with no call progress using the steps
below:

1. Call the paging company phone number and determine
the number of seconds after the digits are dialed and the
call is connected. Write this number down for use in step
3.

2. Remove all data from the call back field on the Mailbox
Entry/Message Notification dialog box.

3. In the Phone # field, enter an N followed by a 1, if
required, followed by the area code and pager company’s
phone number. Insert a comma for every two seconds of
time it took to connect that you found in step 1, then enter
the call back number. For a company that took ten
seconds to connect, a phone number would look like:

 N+1+Area Code+Pager Company’s #+,,,,,+Callback #

4. Verify that the entire callback number is displayed on the
pager. If not, adjust the number of commas in the Phone
# field.

System Setup Parameters:

• Verify that at least one port is enabled for Outbound and
Message Notification in the Port Parameters tab.

• Verify that the values entered for DTONWAIT on the Message
Delivery tab and DTONDET on the Hangup tab are set at least
400 units apart, unless DTONDET is 0.

• Verify that the value for DTONDET is greater than the value for
DTONWAIT, unless DTONDET is 0.

• The value for DTONDET on the Hangup Detection tab may be
set too low. If it is, M2000 may hang up prematurely. Adjust this
parameter only if instructed to by a technical support
representative.

• The value for SCHDWAIT on the Outbound Calls tab may be
set too low. If it is, M2000 may not detect dial tone on an
outbound line and must reschedule the event.

Subscriber Settings dialog box:

• Verify that the Message Notification feature is enabled.
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Message Notification dialog box:

• Verify that the time blocks are configured.

• Verify that the proper phone number for the subscriber to return
the call in the Call Back field.

• Verify that the Phone # field contains the pager company’s
phone number. If it is a long-distance call, verify that a 1
precedes the area code.

Class of Service dialog box:

• Verify that the Message Notification checkbox is enabled.

• Verify that the Long Distance option under Delivery Options is
selected.

NameNet information is not
voiced

Resolution Possibilities:

• The system may not yet have retrieved the NameNet
information from the remote site.

• Verify that the node exists on the M2000 system.

System Setup parameters:

• Increase the value for the Maximum Number of Idle Days for
NameNet Records parameter. Records that have exceeded this
value are automatically purged.

• Increase the value for the Maximum Number of NameNet
Entries parameter on the NameNet tab. NameNet does not
retrieve information for new entries if the NameNet list is full.

OctelNet/AMIS messages are
returned to mailboxes

Resolution Possibilities:

• Verify that OctelNet is enabled on the sentinel. For information
on verifying the features enabled on a sentinel, see the topic,
"Displaying Features Enabled on the Sentinel," later in this
chapter.

• Verify that the access number on the Network Maintenance
dialog box is correct.

• If using Dial Plan, verify that  that the Dial Plan database is set
up correctly.

• Dedicate a line for testing the networking feature and attach a
digit grabber. Verify that M2000 can access the line and
connect to the remote site.

• If the switch requires a suffix code to access an outside line,
add the suffix code to the SET_UP.CFG A-69 bucket.

• Note that OctelNet does not work if the greeting by port feature
is used.
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Class of Service dialog box:

• Verify that the Networking Options are set to access the
appropriate nodes.

• Verify that Dispatch Options are not set to Not Allowed.

System Setup parameters:

• Verify that the Outbound parameter on the Networking tab is
enabled.

Operator or subscriber gets
blank messages

Resolution Possibilities:

• Verify that the method the switch uses for a disconnect and
verify that the appropriate parameters are configured properly.
For more information, see the topic, "Determining a Switch’s
Disconnect Signal," later in this chapter.

• If the blank messages are recorded noise, check the phone
system for the following problems:

− Noisy phone lines.
− RF interference.
− Ground problems.
− Cross talk/wiring problems.
− Tip and ring reversed.

System Setup parameters:

• Verify that the Minimum Message Length parameter on the
Message Timing tab is set to the recommended setting, 2
seconds. Note that any message shorter in length than two
seconds is automatically deleted.

• If setting the Minimum Message Length parameter on the
Message Timing tab to 2 seconds does not correct the problem,
set the parameter to 4 seconds and set the Maximum Silence
parameter on the Hangup Detection tab to 350.

PC is locked up

Resolution Possibilities:

• Press <CTRL+ESC> and hold them down for a few seconds.
OS/2 may indicate that an executable file is not responding and
prompt you to end it. End the file. If this does not work the first
time, hold down <CTRL+ESC> again for a longer period of
time.

• Press <CTRL+ALT+DEL>. The PC will restart, and you can
restart M2000.

• If the previous two procedures do not work, the last resort is to
turn off power to the PC. If you must turn off the PC, use the
following procedure:

1. Turn off the power to the PC. Wait 30 seconds, then turn



25. Troubleshooting the System

Lucent Technologies Messaging 2000   System Troubleshooting Table
Implementation and Service Manual
585-345-102  (Issue 1.0 May 1998) 11-24

power back on.

2. After M2000 has restarted, view the PLUS.LOG file for an
error that might have caused the lockup. Report this error
to a technical support representative. For more
information on viewing the log file, see the topic, "Viewing
the PLUS.LOG File," later in this chapter.

3. Log in as a Level 2 or Level 3 supervisor and shut down
M2000 by selecting Exit from the File menu.

4. Run the Quick Assist utility using the Verify option.

5. If Quick Assist does not report any errors, restart M2000.
If Quick Assist detects errors, it instructs you on which
recovery options to run. Contact a Lucent Technologies
technical support representative if Quick Assist
recommends you use the Update All or Rebuild All
options.

Ports come off hook when
there are no calls

Resolution Possibilities:

System Setup parameters:

• Verify that all ports enabled for outbound calls on the Port
Parameters tab have a dial tone. If M2000 does not detect a
dial tone, it assumes there is an incoming call and attempts to
answer it.

• Verify that DTONDET on the Hangup tab and DTONWAIT on
the Message Delivery tab are set to values at least 400 units
apart.

• Verify that the value for DTONDET is greater than the value for
DTONWAIT.

Reports are not functioning
properly

Reports menu options are
dimmed

Resolution Possibilities:

• A report window may be minimized instead of closed. Use this
procedure to access the Reports menu:

1. Press <CTRL+ESC>. The OS/2 Window List displays.

2. Select Lister and press <Enter>. A report window
displays.

3. Close the report window by double-clicking on the
upper-left-hand corner of the window.
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Cannot save reports to disk Resolution Possibilities:

• Verify that you are selecting to save the report to a disk on the
Reports dialog box.

• Verify that the drive name and directory is specified and a
filename is entered in the Report Filename dialog box.

• Verify that a formatted diskette is in a valid PC disk drive and
that the drive door is closed properly.

• Attempt to save a file from another application on the M2000
PC to determine if there is a problem with the disk drive.

• Verify that the correct LPT port is selected for the printer.

Cannot print reports Resolution Possibilities:

• Verify that the user is selecting to print the report to a printer
(not to a disk or screen) on the Reports dialog box.

• Verify that the printer was plugged in and turned on when the
M2000 system was started.

• Attempt to print a document from another application on the PC
to isolate the problem to M2000 or OS/2.

• Verify that the printer is ready to print (power is on, printer is on-
line, printer contains paper).

• Verify that the printer is attached to the M2000 PC or accessible
through the network.

Cannot delete statistical
information from reports

Resolution Possibilities:

• Use the Clear Mailbox/Statistics option on the Mailbox menu to
clear a specific mailbox or a range of mailboxes.

• Reset the Mailbox by using the supervisor main menu functions
over the phone. After logging in, press <1> from the supervisor
menu for mailbox functions and select <4> to reset a mailbox.

• Note that when you use the clear statistics option, the statistics
are deleted permanently.

Some mailboxes are not
included in reports

Resolution Possibilities:

• The entry in the mailbox’s Company or Division field is incorrect
or missing. Check the field for spelling errors or extra spaces.
Note that this field is case-sensitive.

• Use the Mailbox Quick List report to display the information
entered in the Company and Division fields for the mailboxes.

• Verify that the mailbox owner’s name was specified on the
Mailbox Entry dialog box during mailbox creation. Select the
Edit option from the Mailbox menu. Enter the mailbox number
when prompted, then type an entry in the First and Last Name
fields of the dialog box.
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Serial Integration (SMDI) does
not work

Resolution Possibilities:

• Verify that incoming data packets use the appropriate protocol
and the data being sent contains the proper codes for the
integration device.

• Verify that the sentinel allows Serial Integration. For information
on verifying the features enabled on a sentinel, see the topic,
"Displaying Features Enabled on the Sentinel," later in this
chapter.

• Verify that the baud rate entered on the ICONFIG dialog box for
the Serial Integration utility is the correct value for the serial
integration device.

• Verify that the PARITY value selected on the ICONFIG dialog
box in the Serial Integration utility is the correct value for the
serial integration device.

• Verify that the STOPBITS value selected on the ICONFIG
dialog box for the Serial Integration utility is the correct value for
the serial integration device.

• Verify that the DESKID number entered on the ICONFIG Port ID
dialog box for the Serial Integration utility is the correct number.
Verify this number with the central office.

• Verify that the port numbers are entered on the ICONFIG Port
ID dialog box.

Visual Architect V-Trees do not
print

Resolution Possibilities:

• Verify the printer was plugged in and turned on when the M2000
system was started.

• Verify that the correct LPT port is specified for the printer.

• Attempt to print a document from another application on the
M2000 PC to isolate the problem to M2000 or OS/2.

• Verify that the printer is ready to print (power is on, printer is on-
line, printer contains paper).

• Verify the printer is attached to the M2000 PC or accessible
through the network.



25. Troubleshooting the System

Lucent Technologies Messaging 2000   Determining a Switch’s Disconnect Signal
Implementation and Service Manual
585-345-102  (Issue 1.0 May 1998) 11-27

V-Trees do not work

Resolution Possibilities:

• Verify that V-Trees are permitted in the mailbox’s class of
service.

• Verify that the V-Tree is created and has been activated through
call handling.

• Verify that the correct Call Handling condition is being satisfied:
busy, no-answer, busy or no-answer, or all calls.

• Listen to the V-Tree over the phone interface to verify that the
V-Tree is complete.

Determining a Switch’s Disconnect Signal

When you are troubleshooting certain integration issues, you are instructed to confirm
that M2000 is configured to detect the appropriate disconnect signal from the switch.
When possible, consult the Configuration Note and the switch documentation for this
information. If you do not have access to this information, you can use the procedure
below to determine the switch’s disconnect signal.

To determine a switch’s disconnect signal:

1. Disconnect a voice-mail port and attach a 2500 set (or the proprietary telephone
instrument if using a D/42D NS, D/42D SX, or D/42D SL integration) and a digit
grabber.

2. Call the port, from another phone.

3. Answer the phone connected to the port and listen over the handset.

4. Hang up the calling phone.

5. Use the following table to determine the disconnect signal:

Volt Meter Reading Audible Signals Disconnect Signal

drops to 0 V silence loop current drop

no change DTMF tones hangup string

no change dial tone dial tone

no change silence silence

Displaying Features Enabled on the Sentinel

An improperly programmed sentinel can inhibit the functionality of certain system
features. To confirm the sentinel is programmed appropriately, you can use the View
Sentinel program to display a list of enabled features.
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To display features enabled on the Sentinel:

1. Open an OS/2 window.

2. At the command prompt, type VIEWSENT and press <ENTER>.

3. The sentinel information displays.

Interpreting the View Sentinel Information

The following information displays when you run the View Sentinel program:

• Serial Number – Identifies the sentinel unit’s serial number. You may be asked
to provide this number when you contact a technical support representative.

• Product Code – Indicates the product the sentinel is programmed to run.

• Max Ports – Indicates the maximum number of channels M2000 is allowed to
use.

• Max Mailboxes – This feature is not used for products running under OS/2.

• Revision – Identifies the software version number the sentinel is programmed to
use.

• Max Visual Mailboxes – Identifies the maximum number of Visual Mailbox
logins allowed on M2000 at one time.

• Max Languages – Identifies the maximum number of languages allowed on
M2000.

• Fax Retrieval – Indicates whether the Fax Retrieval feature is enabled.

• Fax Mail – Indicates whether the fax mail feature is enabled.

• SMDI – Indicates whether SMDI Integration is allowed on M2000.

• AMIS – Indicates whether the AMIS analog protocol for networking is enabled.

• ONet –  Indicates whether the OctelNet protocol for networking is enabled.

• Intercom Redirect – Indicates whether the intercom redirect feature is enabled.

• Octel Board Required – Indicates whether M2000 must use voice and fax
boards with the proper signature.

• Visual Architect Version – Identifies whether the sentinel is programmed to run
Visual Architect or Visual V-Tree.

Viewing the PLUS.LOG File

System events and errors are recorded in the PLUS.LOG file located in the \CVR
directory. When troubleshooting an issue, it helps to view the log file to determine any
error messages recorded during a failure. Be prepared to provide these error messages
to a technical support representative.

To view the PLUS.LOG file:

1. Log into M2000 as a Level 2 or 3 supervisor.
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2. From the File menu, select View Log File. A window containing the log file
information displays.

 

3. To close the PLUS.LOG file, double-click the upper-left-hand corner of the window.

Prompts Voiced Under Specific Call Handling Conditions

When M2000 transfers a call to a mailbox, the prompt the caller hears and the
associated options offered to the caller depend on:

• The combination of Call Handling settings defined in the Subscriber Settings
dialog box for the particular mailbox.

• Specific interface and integration factors, such as whether the call is supervised
and the functions set up in inband templates.

By manipulating Call Handling settings, which include the settings indicated in the Call
Blocking field, the No Answer/Call Blocking area, and the Busy area, and by considering
interface and integration factors, you can set up M2000 to voice different prompts and
provide callers with different options when they reach a specific mailbox.

The Call Handling tables define what prompts callers hear and what options are
available to them when subscriber settings are activated in certain ways under certain
conditions. The first table identifies prompts voiced to calls that are supervised transfers.
(A call is a supervised transfer if the Max Rings setting in the mailbox’s class of service
is 1 or above. A call is a blind transfer if the Max Rings setting is 0.)

The next three tables identify prompts voiced to calls on systems that are integrated
using inband templates defined in System Setup. Each of the three tables identify
system responses for each function defined by a template.

Use this information to set up a mailbox to respond to transferred callers in the manner
best suited to your needs. Begin by selecting the prompt(s) you want the system to voice
and the associated options you want callers to have when a call reaches a mailbox. Scan
the available combinations in the Prompt Played and Caller’s Available DTMF Options
columns of the appropriate table. Next, follow the table to the right to identify whether
Call Blocking must be activated and to see which options should be selected in the No
Answer/Call Blocking area (N/CB columns) and the Busy area (Busy columns) on the
Subscriber Settings dialog box.
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Interpreting the Call Handling Tables

Use the following key to interpret information provided in the Call Handling tables:

RNA = Ring No Answer condition (the extension rang, but was not answered).
Busy = Busy condition (the extension was in use).
N/CB columns = No Answer/Call Blocking area of Subscriber Settings dialog box.
Busy columns = Busy area of Subscriber Settings dialog box.
Def. = Default.
Opt. 1 = Optional Prompt 1.
Opt. 2 = Optional Prompt 2.

RNA/Busy Menu = The following options are voiced to callers by system prompts:

Caller can press... To...

<1> Enter another extension.

<2> Leave a voice or fax mail message (fax mail is available
only if the optional Fax Solutions module is installed and
enabled).

<3> Transfer to the personal operator (or system operator if
a personal operator is not defined).

Optional Set 1 = The following options are provided to callers. Note that these
options are not voiced by system prompts and should be voiced by subscribers in the
Personal Greeting prompt:

Caller can press... To...

<*> Disconnect.

<#>, <2 – 9> Leave a voice- or fax-mail message (fax mail is available
only if the optional Fax Solutions module is installed and
enabled).

<1> Enter another extension.

<0> Transfer to the personal operator (or system operator if
a personal operator is not defined).

Optional Set 2 = The following options are provided to callers. Note that these
options are not voiced by system prompts and should be voiced by subscribers in the
Personal Greeting prompt:

Caller can press... To...

<*>, <#>, <1 – 9> Leave a voice- or fax-mail message (fax mail is available
only if the optional Fax Solutions module is installed and
enabled).

<0> Transfer to the personal operator (or system operator if
a personal operator is not defined).
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Optional Set 3 = The following options are provided to callers. Note that these
options are not voiced by system prompts and should be voiced by subscribers in the
Personal Greeting prompt:

Caller can press... To...

<*> Initiate mailbox login (caller is prompted to enter the
mailbox password).

<#>, <2 – 9> Leave a voice- or fax-mail message (fax mail is available
only if the optional Fax Solutions module is installed and
enabled).

<1> Enter another extension.

<0> Transfer to the personal operator (or system operator if
a personal operator is not defined).
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Supervised Call Handling Table

Call
Blocking

N/CB
Def.

N/CB
Opt. 1

N/CB
Opt. 2

Busy
Def.

Busy
Opt. 1

Busy
Opt. 2

Prompt Played Caller’s Available
DTMF Options

x x x Personal Greeting Option Set 2

x x x Optional Prompt 1 Option Set 1

x x x Optional Prompt 2 Option Set 1

x x x Personal Greeting Option Set 2

x x x Personal Greeting Option Set 2

x x x Personal Greeting Option Set 2

x x RNA = RNA/Busy Menu
Busy = RNA/Busy Menu

RNA = Option Set 2
Busy = Option Set 2

x x RNA = Optional Prompt 1
Busy = RNA/Busy Menu

RNA = Option Set 1
Busy = Option Set 2

x x RNA = Optional Prompt 2
Busy = RNA/Busy Menu

RNA = Option Set 1
Busy = Option Set 2

x x RNA = RNA/Busy Menu
Busy = Optional Prompt 1

RNA = Option Set 2
Busy = Option Set 1

x x RNA = RNA/Busy Menu
Busy = Optional Prompt 2

RNA = Option Set 2
Busy = Option Set 1

x x RNA = Optional Prompt 1
Busy = Optional Prompt 1

Option Set 1

x x RNA = Optional Prompt 2
Busy = Optional Prompt 2

Option Set 1

 x x RNA = Optional Prompt 1
Busy = Optional Prompt 2

Option Set 1

x x RNA = Optional Prompt 2
Busy = Optional Prompt 1

Option Set 1
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Integrations with Inband Templates Call Handling Tables

Go to Voice Mail (Call Forward to Personal Greeting) Function Table

Call
Blocking

N/CB
Def.

N/CB
Opt. 1

N/CB
Opt. 2

Busy
Def.

Busy
Opt. 1

Busy
Opt. 2

Prompt Played Caller’s Available
DTMF Options

x x x Personal Greeting Option Set 3

x x x Optional Prompt 1 Option Set 3

x x x Optional Prompt 2 Option Set 3

x x x Personal Greeting Option Set 3

x x x Personal Greeting Option Set 3

x x x Personal Greeting Option Set 3

x x RNA = Personal Greeting
Busy = Personal Greeting

Option Set 3

x x RNA = Personal Greeting
Busy = Personal Greeting

Option Set 3

x x RNA = Personal Greeting
Busy = Personal Greeting

Option Set 3

x x RNA = Personal Greeting
Busy = Personal Greeting

Option Set 3

x x RNA = Personal Greeting
Busy = Personal Greeting

Option Set 3

x x RNA = Optional Prompt 1
Busy = Optional Prompt 1

Option Set 3

x x RNA = Optional Prompt 2
Busy = Optional Prompt 2

Option Set 3

 x x RNA = Personal Greeting
Busy = Personal Greeting

Option Set 3

x x RNA = Personal Greeting
Busy = Personal Greeting

Option Set 3

Go to Voice Mail Function Table Notes:

If the Call Blocking checkbox is inactive (an “x” does not display in the Call Blocking column), and the
options selected in the No Answer/Call Blocking area (N/CB columns) and the Busy area (Busy columns)
are the same, the option selected (Optional Prompt, V-Tree, Call Forward, etc.) automatically executes.
If, however, the options selected are different, the caller hears the personal greeting recorded for the
mailbox.

If the Call Blocking checkbox is active (an “x” displays in the Call Blocking column), and Default is
selected in the No Answer/Call Blocking area on the Subscriber Settings dialog box (an “x” displays in
the N/CB Def. column), the system voices the personal greeting when it receives a Go to Voice Mail
code.
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Busy Function Table

Call
Blocking

N/CB
Def.

N/CB
Opt. 1

N/CB
Opt. 2

Busy
Def.

Busy
Opt. 1

Busy
Opt. 2

Prompt Played Caller’s Available
DTMF Options

x x x RNA/Busy Menu Option Set 2

x x x Optional Prompt 1 Option Set 1

x x x Optional Prompt 2 Option Set 1

x x x RNA/Busy Menu Option Set 2

x x x RNA/Busy Menu Option Set 2

x x x RNA/Busy Menu Option Set 2

x x Busy = RNA/Busy Menu
RNA = Not applicable

Option Set 2

x x Busy = RNA/Busy Menu
RNA = Not applicable

Option Set 2

x x Busy = RNA/Busy Menu
RNA = Not applicable

Option Set 2

x x Busy = Optional Prompt 1
RNA = Not applicable

Option Set 1

x x Busy = Optional Prompt 2
RNA = Not applicable

Option Set 1

x x Busy = Optional Prompt 1
RNA = Not applicable

Option Set 1

x x Busy = Optional Prompt 2
RNA = Not applicable

Option Set 1

 x x Busy = Optional Prompt 2
RNA = Not applicable

Option Set 1

x x Busy = Optional Prompt 1
RNA = Not applicable

Option Set 1

Busy Function Table Notes:

If the Call Blocking checkbox is active (an “x” displays in the Call Blocking column), and Default is
selected in the No Answer/Call Blocking area on the Subscriber Settings dialog box (an “x” displays in
the N/CB Def. column), the system voices the RNA/Busy menu when it receives a Busy Code.
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Ring No Answer Function Table

Call
Blocking

N/CB
Def.

N/CB
Opt. 1

N/CB
Opt. 2

Busy
Def.

Busy
Opt. 1

Busy
Opt. 2

Prompt Played Caller’s Available
DTMF Options

x x x RNA/Busy Menu Option Set 2

x x x Optional Prompt 1 Option Set 1

x x x Optional Prompt 2 Option Set 1

x x x RNA/Busy Menu Option Set 2

x x x RNA/Busy Menu Option Set 2

x x x RNA/Busy Menu Option Set 2

x x RNA = RNA/Busy Menu
Busy = Not applicable

Option Set 2

x x RNA = RNA/Busy Menu
Busy = Not applicable

Option Set 1

x x RNA = RNA/Busy Menu
Busy = Not applicable

Option Set 1

x x RNA = Optional Prompt 1
Busy = Not applicable

Option Set 2

x x RNA = Optional Prompt 2
Busy = Not applicable

Option Set 2

x x RNA = Optional Prompt 1
Busy = Not applicable

Option Set 1

x x RNA = Optional Prompt 2
Busy = Not applicable

Option Set 1

x x RNA = Optional Prompt 2
Busy = Not applicable

Option Set 1

x x RNA = Optional Prompt 1
Busy = Not applicable

Option Set 1
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C H A P T E R  1 2

Adding Visual Mailbox to a Subscriber’s PC Desktop

Visual Mailbox is an optional module that provides subscribers with a Windows-based
desktop interface to their mailboxes. Using Visual Mailbox, subscribers can graphically
perform many M2000 functions, such as sending, listening to, and deleting messages
and manipulating call handling features, from their desktop. This chapter describes the
steps to install the Visual Mailbox user interface—called the client software—on a
subscriber’s PC desktop. The procedures in this chapter will help you to:

• Access the Visual Mailbox client software from the local area network (LAN).

• Set up the subscriber’s PC to run the Visual Mailbox client software.
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Client Software Installation Options

Your Lucent Technologies representative installs and configures the Visual Mailbox
software module on the local area network (LAN) server at your site. However, to run the
Visual Mailbox M2000 interface on the subscriber PCs, each PC must be set up to
access certain Visual Mailbox files, collectively referred to as client software. You can
set up each PC to access client software files from their location on the network, or you
can install the client software files directly on each PC’s hard drive.

It is recommended that you set up the subscriber PCs to access client software files over
the network, since it eliminates the need for subscribers to free hard disk space on their
PCs.

You may prefer to have new Visual Mailbox users set up their own PCs to run Visual
Mailbox client software. A Client Software Installation Template, designed to walk
subscribers through the process, is provided at the end of this chapter.

Subscribers can access extensive online help on using Visual Mailbox features by
selecting the Help drop-down menu from the Visual Mailbox main window.

Subscriber PC Considerations

Before you set up subscriber PCs to use Visual Mailbox, note that each PC should have
the following hardware and software installed:

• Minimum of a 386SX processor with 4 MB RAM running Windows 3.x (this
includes Windows for Workgroups) or Windows 95.

• A network interface card and the ability to attach and log into the file server
where Visual Mailbox is installed. Also, the PC must be mapped to the correct
path where the VMBOX directory resides on the LAN server.

Also, subscriber mailboxes must have the Visual Mailbox feature enabled in their classes
of service. Make this adjustment before setting up the client software on the subscriber’s
PC desktop.

Additional Client Requirements for PC Audio Features

If a client (subscriber) PC is equipped with a sound card, and all the necessary device
drivers for the sound card are correctly installed, Visual Mailbox’s PC audio features
allow the subscriber to use speakers or headphones attached to the PC to play
messages and greetings instead of using the telephone. If the subscriber plugs a
microphone into the sound card or the PC has a built-in microphone, it may be used to
record new messages and greetings.

If a client PC is not equipped with a sound card, Visual Mailbox detects this and disables
all of the PC audio features of Visual Mailbox.
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Be advised of the following additional considerations:

• The sound card installed in any PC using PC audio features must be Sound
Blaster compatible (MPC compliant).

• Each PC using the PC audio features must have hard-drive space available to
store WAV files temporarily. A WAV file is downloaded to the client PC hard
drive each time a subscriber plays a message using PC audio features. A
downloaded WAV file is automatically deleted when the subscriber deletes the
associated message or logs out of Visual Mailbox.

 The amount of hard drive space required for WAV files depends on the length of
messages downloaded (played) by subscribers.  A subscriber running PC audio
features in 8-bit mode requires 8,000 bytes of space to play one second of a
recorded message (or .5 MB for every minute of play). A subscriber running PC
audio in 16-bit mode requires 16,000 bytes of space to play one second of a
recorded message (or 1 MB for every minute of play).

• Subscribers using a microphone to record messages and greetings should
activate the multimedia Automatic Gain Control option, if it is available on the
PC. Consult the PC’s documentation for instructions on activating this option.

• PC audio users must be assigned all network rights (read, write, create, erase,
modify, and scan) to the ...\DATA\BIN directory on the LAN server.

The playback sound quality of greetings and messages may vary depending on several
factors, including the quality of the sound card and microphone, a subscriber’s recording
techniques, and the level of background noise. Also, certain hardware setups (including
some laptops), sound card setups, and operating system anomalies may impair the
ability of the PC audio features to function as they should. If you encounter issues or
problems, immediately report them to a technical support representative.

Setting Up Subscriber PCs to Use Visual Mailbox

Use the following procedure to install the Visual Mailbox client software from the
network.

To set up subscriber PCs to use Visual Mailbox:

1. If Windows 3.x is installed on the client PC,  from the Program Manager in Windows,
select Run from the File menu. The Run dialog box displays.

 If Windows 95 is installed on the client PC, from the Windows 95 desktop, click the
Start button and select Run from the menu that displays. The Run dialog box
displays.

2. Click Browse. The Browse dialog box displays.

3. Select the network drive and directories where Visual Mailbox is installed. If the
default directory was not changed during the initial installation, it is the
\VMBOX\CLIENT directory.
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4. To begin installing the client software on the PC, click the SETUP.EXE file, then
click OK. The Visual Mailbox Select Client Installation dialog box displays.

 

5. Select an installation option, then click Continue:

• Use the Client software on the Server – Select this option to access and
use the Visual Mailbox client software files housed on the LAN server, instead
of copying the files to the PC’s hard drive. Choose this option only if client
software files have been installed on the LAN.

• Copy the Client software to your computer – Select this option to copy
Visual Mailbox client software files to the PC’s hard drive.

6. If you selected Use the Client software on the Server, Visual Mailbox begins
installing. When the installation is complete, the Installation Complete dialog box
displays. Skip to step 9 to continue the installation.

7. If you selected Copy the Client software to your computer, the Installation Directory
dialog box displays.
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8. Enter the directory in which you want to store the client software files you are
downloading from the LAN server or disk, then click Continue. Visual Mailbox begins
installing. When the installation is complete, the Installation Complete dialog box
displays.

 

9. To close this dialog box, click Exit. The Visual Mailbox client software is installed
and a Lucent Technologies group window with the Visual Mailbox and Visual Fax
icons is created on the client PC desktop.

Client Software Installation Template

You can save time setting up subscriber PCs to use the Visual Mailbox M2000 interface
by using the following template to guide subscribers through completing the setup
procedure themselves. By following the steps on this template, subscribers set up their
PCs to access the client software over the LAN. Note that, in step 3 of the template, you
must provide the drive and directory information subscribers will need to indicate during
the setup process.
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Client Software Installation Template

To Install the client software from the LAN

1. If Windows 3.x is installed on the client PC,  from the Program Manager in Windows,
select Run from the File menu. The Run dialog box displays.

 If Windows 95 is installed on the client PC, click the Start button and select Run
from the menu that displays. The Run dialog box displays.

2. Click Browse. The Browse dialog box displays.

3. Under Directories, select the Visual Mailbox network directory provided below:

 _______________________________________________________________

4. Click the SETUP.EXE file, then click OK. The Visual Mailbox Client Installation
dialog box displays.

 

5. Select Use the Client software on the Server option, then click Continue. Visual
Mailbox begins installing. When the installation is complete, the Visual Mailbox
Installation Complete dialog box displays.

 

6. To close this dialog box, click Exit. The Visual Mailbox client software is installed
and a Lucent Technologies group window with the Visual Mailbox and Visual Fax
icons is created on the client PC desktop.

Subscribers can access extensive online help on using Visual Mailbox features by
selecting the Help drop-down menu from the Visual Mailbox main window.
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A P P E N D I X  A

System Security and Toll Fraud

Telecommunications fraud is the unauthorized use of another company’s
telecommunications service. This type of fraud has been in existence since the 1950’s
with the introduction of Direct Distance Dialing (DDD).

Twenty years later, Remote Access became a target of individuals seeking unauthorized
network access. Now, with the added capabilities of voice mail and automated attendant
services, customer premises equipment-based toll fraud has expanded as a new type of
communications abuse. With its subculture of “hackers” and “phreakers,”
telecommunications fraud has rapidly become a highly profitable criminal activity.
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Protecting Your System

Voice messaging toll fraud has risen dramatically in recent years. Now more than ever, it
is imperative that you take steps to secure your system. Callers into the voice
messaging/automated attendant system may transfer to an outgoing trunk if adequate
security measures are not implemented. Callers who have unauthorized access to a
voice mailbox can use it as a message drop for communications at your expense on
your 800 numbers. Securing your system means protecting the switch, protecting the
voice messaging system, and protecting any automated attendant applications.

Switch Security

The only tool a criminal needs to breach an inadequately secured system is a touch-tone
telephone. If criminals can gain access to an inside dial tone, they will attempt to gain
access to an outside line by using normal switch functions such as:

• Automatic Routing System (ARS) access codes

• Pool Access Codes

Security Tips

To help prevent toll fraud at the switch, follow these guidelines:

• Assign toll restrictions to voice messaging system and automated attendant ports.

• If you do not to use the outcalling features of the voice messaging system, restrict
the outward calling capability of all voice ports.

• Use a dial plan that does not allow extensions beginning with the same digits as
ARS, TAC, or verification and test codes.

• Inform all system operators that they are not to dial outside calls. Request that
operators report all attempts to bypass switch restrictions to the telecommunications
department for repairs or to the corporate security office for investigation.

• Restrict the numbers for outcalling and AMIS with a disallowed list.

Voice Messaging System Security

With regard to toll fraud, voice messaging systems have two areas of weakness:

• Codes that transfer to inside or outside dial tone

• Mailboxes that can be used as message drops

Once thieves transfer to inside dial tone, they have access to any unprotected switch
features. Preventing this type of abuse requires security at both the switch and at the
voice messaging system.

Once thieves break into a mailbox, they can use it as a message drop for untraceable
calls or for illegal activities. If you have 800 lines that can connect to your voice
messaging system, they can use them to pass stolen information around at your
expense. If you have user-administrated outcalling, they can pass stolen information
around at your expense automatically. Preventing this type of abuse requires security at
the voice messaging system and on the part of your subscribers.
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Cellular telephones can be monitored. If a subscriber enters a mailbox number and a
password on a cellular telephone, the mailbox number and the password will be known to
anyone listening.

To break a password, every word in a computerized 100,000 word-processor spelling
checker or dictionary can be tried in just a few minutes. In a slightly longer time, every
digit combination from 1 to 100,000 can be tried.

Security Tips

To help prevent toll fraud at the voice messaging system, follow these guidelines:

• Do not create voice mailboxes before they are needed.

• Deactivate unassigned mailboxes. When an employee leaves the company, close or
reassign the mailbox.

• Do not have permanent “guest” mailboxes (mailboxes without a physical extension
that are loaned to outsiders for the duration of a project). If you need a guest
mailbox, assign it when it is needed and deactivate or change its password
immediately after it is no longer needed. Do not reassign a guest mailbox without
changing the password.

• Lock out multiple unsuccessful attempts to enter a voice mailbox on a single call.
(Allow no more than two or three attempts on the same call.)

• Do not use default initial passwords that follow any scheme. Have a list of random
passwords and select one when you create the mailbox. Require that the mailbox
owner personally appear at the corporate security office or telecommunications
office to obtain the initial password. Go over the subscriber password guidelines with
the user when you give out the initial password.

• Make sure user change the initial password the first time they log in to the system by
making the initial password shorter than the minimum password length.

• Use the password-aging feature so that users must change their passwords monthly.

• Discourage the practice of writing down passwords, storing them, or sharing them
with others.

• Restrict the use of outcalling to personnel who actually need it.

• Inform all system operators that they are not to dial outside calls. Request that
operators report all attempts to bypass switch restrictions to the telecommunications
department for repairs or to the corporate security office for investigation.

• Inform users that programming passwords onto auto-dial buttons is a breach of
corporate security.

• Inform employees on how to report suspected toll fraud to the corporate security
office.

• Monitor call detail recording (SMDR) reports, call traffic reports, Lucent Messaging
2000 reports, and other available reports regularly.
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Automated Attendant System Security

Automated attendants are used by many companies to augment or replace a
switchboard operator. When an automated attendant answers, the caller is generally
given several options that are appropriate to the company’s business.

• There may be other unstated options such as a code for dial tone or a code for
transfers that allow criminals to access unanticipated parts of the
telecommunications system.

• Pressing # will cause a transfer from the automated attendant to the voice
messaging service.

• Even anticipated transfers may cause problems if they are not well thought out.

• Naive operators may dial an outside call for someone who has dialed 0 and
complains of trouble making a call.

Security Tips

To help prevent toll fraud at the automated attendant, follow these guidelines:

• Do not allow transfers to inside or outside dial tone.

• Restrict transfers to subscribers only. See Chapter 14, “Setting Up the Lucent
Messaging 2000 System,” topic “Invalid Mailbox Parameters” in the Implementation
and Service Manual.

• Inform all system operators that they are not to dial outside calls. Request that
operators report all attempts to bypass switch restrictions to the telecommunications
department for repairs or to the corporate security office for investigation.

• Inform employees on how to report suspected toll fraud to the System Administrator.

• Monitor call detail recording (SMDR) reports, call traffic reports, Lucent Messaging
2000 reports, and other available reports regularly.

Password Guidelines

To minimize the risk of unauthorized persons accessing subscriber mailboxes and using
them for toll fraud, inform all system users of these guidelines for voice messaging
system passwords.

• Mailbox passwords are required.

• Require that passwords be as long as feasible, with a minimum of five digits, and a
length that is at least one digit longer than the maximum extension length.

• System users must change the initial password the first time they log in to the voice
messaging system.

• Never have greetings that state you will accept third party billed calls. A greeting like
this allows unauthorized individuals to charge calls to your company. If a user calls
somebody within the company and receives a greeting like this, they should point out
the vulnerability to the person and recommend that they change the greeting
immediately.

• Never use obvious or trivial passwords such as your telephone extension, room
number, employee identification number, social security number, or the birthday of
any family member. Also avoid easily guessed numeric combinations such as
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1,3,9,7  and 2,4,8,6  (geometric pattern on the dial 9,9,9,9,9,9  (repeated digits), and
7,2,7,7,9,6,7,3  (“password” spelled out on the dial).

• Passwords should not be written down, stored, or shared with others.

• Passwords must not be programmed into auto-dial buttons.

• If subscribers receive any strange voice mail messages, find that their greeting or
password has been changed, or suspect for any reason that their voice mailbox is
being used by someone else, they should contact the System Administrator
immediately.

Switch Administration

The measures you can take to minimize the security risk of owning a
telecommunications system depend on how the telecommunications system and any
associated voice messaging or automated attendant system is used.

To minimize the risk of unauthorized persons using the voice messaging or automated
attendant systems to make toll calls, administer the voice ports on your switch in any of
the following ways:

Restrict Outward Dialing

A voice port with outward restriction cannot make any outside calls unless an allowed
number list is used for specific area codes and/or exchanges that can be called. Outward
restriction prevents or limits outcalling and AMIS networking. All ports should be toll
restricted. If the Outcalling feature will not be used, outward restrict all voice messaging
system ports. If Outcalling will be used, ports not used for Outcalling should be outward
restricted.

Restrict Toll Areas

A voice port with toll restriction cannot make toll calls, but it can still make local calls. If
supported by the telecommunications system, toll restriction may prevent or limit
outcalling and AMIS networking. An allowed number list can be used for specific area
codes and/or exchanges that can be called.

Create Disallowed Number Lists

When a voice port is unrestricted or has toll restriction, a disallowed number list can be
used to prevent calls to specific numbers, specific exchanges within all area codes, or
specific numbers, if supported by the telecommunications system.

Create Allowed Number Lists

When a voice port is outward or toll restricted, an allowed number list can be used to
allow calls to specific area codes and/or exchanges, if supported by the
telecommunications system. When outcalling or AMIS networking is required, using
outward or toll restriction in combination with an allowed number list limits the risk of
unauthorized persons using the voice messaging or automated attendant systems to
make toll calls because calls can only be made to the specified area codes and/or
exchanges.
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Restrict AMIS Networking Number Ranges

To increase security for AMIS analog networking, including the Message Delivery
service, restrict the number ranges that may be used to address messages. If possible,
also place outward or toll restriction on the voice ports and use an allowed number list.

Lucent Messaging 2000 Administration

To minimize the risk of unauthorized persons using the Lucent Messaging 2000 system
to make toll calls, administer the system in any of the following ways:

Outcalling

Outcalling uses the voice messaging ports. If mailbox security is broken, unauthorized
persons can use outcalling to transfer messages or gain access to an outside line at your
expense. If you need outcalling, restrict it as much as possible to prevent unauthorized
use of the Lucent Messaging 2000 system. See Chapter 14, “Setting Up the 
 System,” in the Implementation and Service Manual and Chapter 24,
“Maintaining the System,” topic “Maintaining System Security” in
the Implementation and Service Manual.

Mailbox Administration

Proper administration of Lucent Messaging 2000 mailboxes can help reduce the risk of
unauthorized use of mailboxes.

• Use the Minimum Length of Password parameter in System Setup to require that
passwords be a minimum length of 5 digits and at least one digit longer than the
mailbox numbers.

• Use the Consecutive Login Failures Before Lockout parameter in System Setup to
lock subscriber mailboxes after unsuccessful login attempts.

• Delete unused mailboxes.

• Avoid or closely monitor the use of “guest” mailboxes.

See Chapter 14, “Setting Up the System,” and Chapter 24,
“Maintaining the System,” topic “Maintaining System Security.”

Call Transfer

When a caller enters an extension, M2000 performs the following validation:

• The M2000 system verifies that the digits entered contain the same number of digits
as system mailbox numbers, as specified in the Number of Digits in a Mailbox
parameter in System Setup.

• If the Transfer to Invalid Extension parameters in System Setup are disabled, M2000
verifies that the digits match an existing system mailbox number and sends the
digits to the switch.

Phone system extensions assigned M2000 mailboxes should not allow access to trunk
facilities or to specific dial-out codes for the switch.
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Detecting Toll Fraud

Some of the Lucent Messaging 2000 system reports are valuable in determining if your
voice messaging or automated attendant systems are being used for fraudulent
purposes.

Call Detail Recording

With Station Message Detail Recording (SMDR) activated for incoming calls, you can
check the calls in to your voice mail ports. A series of short holding times may indicate
repeated attempts to enter voice mailbox passwords.

Review SMDR reports for the following symptoms of voice messaging abuse:

• Short holding times on calls where voice messaging is the originating or terminating
endpoint

• Calls to international locations not normal for your business

• Calls to suspicious destinations

• Numerous calls to the same number

• Undefined account codes

Lucent Messaging 2000 Reports

The system tracks traffic data over various time spans. Reviewing these reports on a
regular basis helps to establish traffic trends. If increased activity or unusual usage
patterns occur, such as heavy call volume on ports assigned to outcalling, they can be
investigated immediately.

Lucent Technologies Statement of Direction

The telecommunications industry is faced with a significant and growing problem of theft
of customer services. To aid in combating these crimes, Lucent intends to strengthen
relationships with its customers and its support of law enforcement officials in
apprehending and successfully prosecuting those responsible.

No telecommunications system can be entirely free from risk of unauthorized use. But
diligent attention to system management and to security can reduce that risk
considerably. Often a tradeoff is required between reduced risk and ease of use and
flexibility. Customers who use and administer their systems make this tradeoff decision.
They know best how to tailor the system to meet their unique needs and, necessarily, are
in the best position to protect the system from unauthorized use.

Because the customer has ultimate control over the configuration and use of Lucent
services and products it purchases, the customer properly bears responsibility for
fraudulent uses of those services and products.

To help customers use and manage their systems in light of the tradeoff decisions they
make and to ensure the greatest security possible, Lucent commits to the following:

Lucent products and services will offer the widest range of options available in the
industry to help customers secure their communications systems in ways consistent with
their telecommunications needs.
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Lucent is committed to develop and offer services that, for a fee, reduce or eliminate
customer liability for PBX toll fraud, provided the customer implements prescribed
security requirements in its telecommunications systems.

Lucent’s product and service literature, marketing information and contractual
documents will address, wherever practical, the security features of our offerings and
their limitations, and the responsibility our customers have for preventing fraudulent use
of their Lucent products and services.

Lucent sales and service people will be the best informed in the industry on how to help
customers manage their systems securely. In their continuing contacts with customers,
they will provide the latest information on how to do that most effectively.

Lucent will train its sales, installation and maintenance, and technical support people to
focus customers on known toll fraud risks; to describe mechanisms that reduce those
risks; to discuss the tradeoffs between enhanced security and diminished ease of use
and flexibility; and to ensure that customers understand their role in the decision-making
process and their corresponding financial responsibility for fraudulent use of their
telecommunications system.

Lucent will provide education programs for customers and our own people to keep them
apprised of emerging technologies, trends, and options in the area of
telecommunications fraud.

As new fraudulent schemes develop, we will promptly initiate ways to impede those
schemes, share our learning with our customers, and work with law enforcement officials
to identify and prosecute fraudulent users whenever possible.

We are committed to meeting and exceeding our customer’s expectations, and to
providing services and products that are easy to use and are of high value. This
fundamental principle drives our renewed assault on the fraudulent use by third parties
of our customers’ communications services and products.

Lucent’s Security Offerings

Lucent has developed a variety of offerings to assist in maximizing the security of your
system. These offerings include:

• Security Audit Service of your installed systems.

• Fraud Intervention Service.

• Individualized Learning Program, a self-paced text that uses diagrams of system
administration screens to help customers design security into their systems. The
program also includes a videotape and the BCS Products Security Handbook.

• Call Accounting package that calls you when preset types and thresholds of calls are
established.

• Remote Port Security Device that makes it difficult for computer hackers to access
the remote maintenance ports.

• Software that can identify the exact digits passed through the voice mail system.

For more information about these services, see the BCS Products Security Handbook.
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Lucent Toll Fraud Crisis Intervention

If you suspect you are being victimized by toll fraud or theft of service and need
technical support or assistance, call the Lucent National Service Assistance Center
(NSAC) at 800-628-2888 immediately.

These services are available 24 hours a day, 365 days a year. Consultation charges may
apply.

Lucent Corporate Security

Whether or not immediate support is required, please report all toll fraud incidents
perpetrated on Lucent services to Lucent Technologies National Service Assistance
Center (NSAC) at 800-628-2888. In addition to recording the incident, Lucent services
are available for consultation on product issues, investigative support, law enforcement,
and education programs.

Lucent Technologies Messaging 2000
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585-345-101 (Issue 1.0 May 1998)
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G L O S S A R Y  G

Glossary

The following glossary definitions will help you to understand the terminology used in this
manual.
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After Hours Greeting

A message that greets a caller during non-business hours.

AMIS (Audio Messaging Interchange Specification)

.A voice-mail system communication protocol that allows two voice-mail systems to
communicate with each other.

AMIS, Administered

A method of addressing an AMIS message that requires a subscriber to enter only the
predefined node number of the other voice-mail system, along with the destination
mailbox number. See also Node.

AMIS, Casual

A method of addressing an AMIS message that requires a subscriber to manually enter
the complete telephone number of the other voice-mail system, along with the
destination mailbox number.

AMIS Interface Module

An optional module that allows subscribers to send and receive messages to and from
subscribers on other voice-mail systems that support the AMIS protocol.

Archived Message

A message saved by a subscriber in the subscriber’s mailbox.

Audiotext

A communications product that enables users to send or receive information via a
telephone connection by using audio input (either voice or DTMF) with a voice
processing system.

Auto Date and Time Voiceback

A system feature that automatically voices the time and date when each new and saved
message is received in a subscriber’s mailbox.

Auto Forwarding

A system feature that automatically forwards a message that has not been listened to
after a predetermined amount of time to another specified mailbox.

Automated Attendant

A system feature that routes phone calls in a manner similar to a receptionist.

AutoPrint

A system feature that directs fax messages received in a mailbox to the mailbox’s
default fax machine for immediate printing.
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Automatic Station Login

A system feature that allows subscribers immediate access to their mailboxes when they
dial into the system from their own extensions. This feature is switch-dependent and is
not available on all systems.

Beeper Notification

A system feature that instructs the system to dial a subscriber’s beeper when a message
is received in the subscriber’s mailbox. See also Message Notification.

Business Hours

The hours a company is open for business. The system references the business hours
specified to determine when to voice the during- and after-hours greetings.

Busy Signal

A tone that signals that a phone is in use.

Call Blocking

A system feature that allows subscribers to route calls directly to their mailboxes without
ringing the extensions.

Call Forwarding

A system feature that routes a call to ring an extension other than that originally entered.
A subscriber can use this feature to assure that another subscriber will handle important
calls when the original subscriber is unavailable.

Call Handling

A system feature that allows subscribers to use default or optional prompts, a V-Tree, or
Call Forwarding to route calls to a mailbox immediately, or if the extension is busy
and/or not answered.

Call Paging

See Intercom Paging.

Call Progress

See Supervised Call.

Call Queuing

A system feature that allows a caller to hold for a specific extension when that extension
is busy. The Call Queuing feature can be set up to inform a caller on hold of their status
in the queue and to provide the caller with prerecorded music or messages.

Call Screening

A system feature that allows subscribers to choose whether or not they want to take
calls. A caller is prompted to voice their name, which the system then announces to the
subscriber, who can take or refuse the call. If refused, the caller is told there was no
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answer at that extension and is given the option to leave a message, to transfer to
another extension, to transfer to the operator, or to disconnect.

Channel Status

The activity of each port or line; this status displays whether a port is in use or waiting for
a ring.

Class of Service (COS)

A group of system features that is activated for one mailbox, or a set of mailboxes. The
feature settings within a Class of Service determine a mailbox owner’s access to system
options and features (such as long distance outcalling and call screening). There are 25
predefined Classes of Service set up on the system. You can also set up custom Classes
of Service.

Default Operator

See Personal Operator.

Delivery Options

System options that allow a message sender to designate a message for future delivery
or as a private, urgent, or listen-only message.

Destination System

A remote AMIS- or OctelNet-compatible voice-mail system to which an AMIS or
OctelNet message is to be delivered.

Dial by Name

A system feature that allows a caller to access a subscriber’s extension by entering the
letters in the subscriber’s last name.

Dial Tone

A constant tone used on telephones as a signal that the equipment is ready to accept a
phone number pulse or DTMF information.

DID

A PBX feature that allows an outside caller to dial a specific extension within the phone
system without the assistance of an attendant.

Dispatch

The action of sending a message to an AMIS- or OctelNet-compatible voice-mail
system. A subscriber can assign a message to one of three dispatch options:  Economy,
Standard, and Priority. These options dictate when messages queued for dispatch are
sent to destination systems.
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Distribution List

A group of mailbox numbers collectively identified by one, unique number. By using this
feature, subscribers can send messages to multiple mailboxes at once by simply
entering one distribution list number, instead of the mailbox number of each intended
recipient. A Distribution List may include, as an entry, another distribution list number.
See also Global Group List and Personal Group List.

DTMF

Dual Tone Modulated Frequency—“Touch-Tone.” The two distinct frequencies emitted
when a digit on a push-button phone is pressed.

Economy Dispatch

A dispatch option provided to subscribers sending messages to AMIS- or OctelNet-
compatible voice mail systems. A message marked Economy is held in an Economy
queue and dispatched during a time frame that is usually an off-peak phone rate period.

Envelope Information

A system feature that provides a message recipient with the date and time a message
was sent, who sent it, the length of the message, and whether the message was
designated for future delivery or as a listen-only, private, or urgent message.

Extended Password Security

A system security feature used with variable-length passwords that requires a subscriber
to press the <#> key after entering the mailbox password.

Failed Login Notification

A system feature that notifies the subscriber when one or more unsuccessful attempts
are made to log into the mailbox.

Fax Mail

A system feature that allows a caller accessing a subscriber mailbox to send a fax to that
mailbox. The caller must be placing the call from a fax machine. The subscriber can
view and print the fax using a variety of system options.

Fax Retrieval

A system feature that allows callers accessing a V-Tree to request that available
documents be faxed to them at the fax machine of their choice.

Fax Solution

An optional module that equips the M2000 system with fax-retrieval and fax-mail
capabilities.

Folders

Subscriber-defined headings in a mailbox under which a subscriber can efficiently
classify and save voice and fax messages.
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Follow-Me-Forward

A system feature that allows subscribers to forward messages received in their
mailboxes to a mailbox on an AMIS- or OctelNet-compatible voice mail system. Also
referred to as Network Message Forwarding.

Force Shutdown

A method of shutting down the M2000 system by which all ports, both idle and occupied,
are immediately disabled and active calls are terminated.

Future Delivery

A system feature that saves a recorded message for delivery at a subscriber-specified
future time.

Global Group List

A system feature that provides each subscriber with two system-generated distribution
lists (one containing all mailboxes assigned to the same company as the subscriber, and
the other containing all mailboxes assigned to the same division as the subscriber). Up
to ten additional distribution lists can be defined by the system manager.

Greeting

An announcement that a caller hears after dialing the company’s phone number or a
subscriber’s extension.

Greeting by Port

A system feature that plays specific greetings for incoming calls to certain ports. This
feature enables several businesses in an office complex to share one system and still
greet calls with unique office greetings.

Guest Mailbox

A mailbox, created under the sponsorship of a system subscriber, that allows non-
subscribers limited system access.

Holiday Greeting

A message that greets callers on dates specified as holidays—i.e., days the office is
closed.

Inbound Port

A port defined in System Setup to accept incoming calls.

Integration

The ability to link a voice-mail environment to a PBX.
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Intercom Paging

A system feature that allows a caller to page a subscriber who does not answer at their
extension. Intercom Paging is not available to callers reaching an extension that is busy.
Also referred to as Call Paging.

Intercom Redirect

A system feature that allows a paged subscriber to alert the system of an alternate
extension or mailbox number to which the call should be transferred.

Keypad Prompt Recording Functions

A technique by which a system manager can record prompts to be voiced by the system.

Language Selection

A system feature that allows callers to a M2000 system that supports multiple languages
to select their language choice for system prompts.

Listen-Only Message

A message that can only be listened to and possibly reviewed, depending on System
Setup settings. A listen-only message cannot be saved, skipped, copied, or auto-
forwarded to another subscriber.

Log In

To enter a password to access a mailbox on the system, or to access menus and
features available through the M2000 PC screen interface.

Mailbox

A system destination from which a subscriber can access many system functions and
store new and saved messages sent to the subscriber. A mailbox number may or may
not be the same as the corresponding extension number.

Mailbox Lock-Out

A system feature that locks a subscriber’s mailbox when a specified number of
consecutive login attempts fail.

Message

A vocal communication recorded into a subscriber’s mailbox by another subscriber or an
outside caller. Messages can also include faxes.

Message Confirmation

A system feature that enables a subscriber to determine if another subscriber has
received a certain message. A message is considered “confirmed” when the intended
recipient has listened to or skipped it. Message confirmation information includes the
recipient’s name, the date and time the message was sent, and when the subscriber
listened to or skipped it.
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Message Indicator

The indicator (such as a light or LED display) on a telephone that notifies a subscriber of
a message. A message indicator turns off as soon as a subscriber accesses the new
message queue, even if the subscriber does not listen to messages in the queue.

Message Locator

A system feature that allows a mailbox owner to scan messages in the new message
queue for entries from a particular local subscriber.

Message Notification

A system feature that instructs the system to call a subscriber at a specified number
when a message is received in the subscriber’s mailbox. Message notification attempts
are halted as soon as the subscriber accesses the new message queue in the mailbox,
even if the subscriber does not listen to messages in the queue.

Message Recovery

A system feature that allows subscribers to recover messages they accidentally delete
during the current call to the system.

Multiple Message Capability

A system feature that allows an outside caller to leave more than one voice message per
call.

Name Prompt

A prompt, containing only a subscriber’s name, that the system inserts into many of its
voice phrases—for example, “John Smith.”

Network Message Forwarding

See Follow-Me-Forward.

Node

A number assigned to represent the telephone number of a remote site supporting
OctelNet or AMIS. To dispatch a message to a site with an assigned node number, a
subscriber enters both the node number and the destination mailbox number after
pressing <2> to record and send a message.

Non-Subscriber

A person who calls into the system and does not have an assigned mailbox.

OctelNet

A full-feature voice-mail system communication protocol that allows two OctelNet-
supporting voice-mail systems to communicate with each other.
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Operator

The person, usually the receptionist, to whom the system defaults certain calls.

Optional Prompts

A prompt that a subscriber can record and activate at any time to answer the
subscriber’s extension and forward callers directly to their mailbox—for example, “Hi.
You have reached John Smith. I’m in a meeting right now; please press two to leave a
message, or press zero to speak to the operator.”

Outbound Port

A port defined in System Setup to be used for outcalling.

Outcall/Outdial

A term used when the system places a call. A system outcalls to deliver OctelNet and
AMIS messages, message notification, wake-up calls, etc.

Password

A group of characters that uniquely identifies a user who wants to gain access to a
mailbox or to options available through the M2000 PC screen interface.

PBX

A telephone system.

Personal Fax Number

A system feature that allows subscribers to retrieve faxes at their personal or
departmental fax machine or at a fax machine at another location.

Personal Greeting Prompt

A prompt that can be recorded and used by a subscriber to add a personal touch when
callers request to be transferred to the subscriber’s mailbox—for example, “Hi. This is
John. I’m sorry I cannot take your call right now. Please leave a message, and I’ll return
your call as soon as possible.”

Personal Group List

A system feature that provides each subscriber with the ability to create up to ten
Distribution Lists, which they can use when sending messages to other subscribers.

Personal Operator

The extension to which a call defaults when the caller is transferred to an operator.

Personalized Prompts

Five prompts that can be recorded by a subscriber to personalize a mailbox (Name,
Please Hold, Optional Prompts 1 and 2, and Personal Greeting).
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Phrase Files

Files containing recorded phrases that automatically voice or that can be set up to be
voiced by the system.

Playback Controls

Keys a subscriber presses to control the volume and speed of message playback.

Please Hold Prompt

The prompt that a caller hears when transferred to the requested extension—for
example, “Please hold for John Smith.”

Port

A telephone voice circuit connection on a voice-processing system.

Port Statistics

Data for each line or port that displays the number of calls, number of failed calls, and
average length of calls.

Port Status

See Channel Status.

Priority Dispatch

A message marked for delivery at the earliest opportunity to an address at an AMIS- or
OctelNet-compatible voice mail system.

Private Message

A message that is intended for one subscriber only. A private message cannot be
forwarded.

Prompts

Audio information from a voice system that guides the user’s interaction with the system.

Queued Dispatch

See Standard Dispatch.

Recipient

The person who receives a message.

Recording Controls

Keys a subscriber can press to pause, replay, or rerecord some or all of a message or
prompt being recorded.
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Regular Message

A message sent without any special delivery functions.

Search

A system feature that allows a system manager to view a list of mailbox owners' names
and corresponding mailbox numbers, so they can locate a particular subscriber’s mailbox
number.

Security Access Levels

Three levels that control a system manager’s access to different System Setup and
configuration parameters. Levels 2 and 3 require password entry.

Sent Message Editing

A system feature that allows a subscriber to edit a message previously sent to another
system subscriber, as long as that message has not been skipped or listened to by the
recipient.

SOLVE (Supervisor Online Voice Editor)

A tool that allows a system manager to record and specify prompts to be played by the
system.

Standard Dispatch

A message placed in a queue for a period of time established by the system manager.
The message is delivered to the specified AMIS- or OctelNet-compatible voice mail
system when a defined number of messages are queued for the same remote access
telephone number or when the maximum period of time has expired, whichever occurs
first. The maximum time is based on the earliest of the messages placed in the queue.
All messages in the queue are delivered during the same outcall.

Subscriber

A person to whom a system mailbox is assigned.

Supervised Call

A call monitored by the system to determine if the requested line returns a busy or ring-
no-answer condition. If it does, the call is not transferred to the line and the caller is
given other options. The call monitoring function is also referred to as Call Progress.

Supervisor Mailbox

A system mailbox that allows a system manager to access the supervisor functions
through the phone keypad.

Supervisor Password

The password used by the system manager to access supervisor functions either on the
M2000 PC or in a supervisor mailbox.
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Switch

A telephone system.

System Manager

The person responsible for the day-to-day maintenance of the system at the site. The
system manager authorizes subscriber use of special system features.

System Prompts

Prompts voiced by the system to callers.

System Setup

A M2000 software utility that allows a user to customize M2000 to best meet system user
needs.

Transmission Failure

A term used when a message dispatched to an AMIS- or OctelNet-compatible voice-mail
system cannot be delivered to its intended recipient.

Undelete Messages

A system feature that allows subscribers to restore messages mistakenly deleted from a
new or saved message queue.

Uninitialized Mailbox

A mailbox still using the system default password.

Urgent Message

A message-sending option that places the message at the top of a subscriber’s new
message queue.

Visual Architect

A system feature available with certain M2000 releases that provides a visual, onscreen
interface for creating and editing V-Trees. See also Visual V-Tree.

Visual Architect Developer’s Toolkit

An add-on module that allows users to access Visual Architect on a PC that is not
running the M2000 system. It also allows users to create V-Tree files.

Visual Mailbox

An optional module available with certain M2000 releases that allows subscribers to
access the system’s onscreen mailbox interface through a Windows desktop.
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Visual V-Tree

A system feature available with certain M2000 releases that provides a visual, onscreen
interface for creating and editing V-Trees. See also Visual Architect.

Voice Mail

A system that uses telephone equipment and a computer program to allow callers and
subscribers to send voice communications to mailboxes set up on the system.
Subscribers can retrieve, store, delete, forward, and obtain information on messages
sent to their mailboxes.

V-Tree

A built-in, touch-tone-programmable audiotext/call-routing application generator for
individual mailboxes. V-Trees allow users to create multi-level voice menus within
system mailboxes.

V-Tree File

A V-Tree storage vehicle that allows a user to move a V-Tree from one mailbox on the
system to another.

Wake-Up Call

A system feature that allows a subscriber to enter a date and time that the system is to
place a call to a specified phone number.
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Notes:
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Index

A

Actions (V-Tree)
Advance to Next Menu, 10-19
Disconnect, 10-34
editing, 10-52
Go to Directory Services, 10-36
Go to Extension Entry Point, 10-35
Go to Mailbox Login Point, 10-34
Go to Voice Mail, 10-35
Record to Mailbox and Advance, 10-23
Record to Mailbox and Return to Previous Level,

10-22
Require Password to Proceed to Next Level, 10-25
Return to Previous Menu, 10-21
Review/Edit Message and Advance, 10-27
Send a Predefined Fax and Advance, 10-32
Send a Requested Fax and Advance, 10-30
Transfer to a Mailbox, 10-36

Activating
nodes, 9-15
ports, 3-5
V-Tree for a mailbox, 10-40

Adding
fax retrieval documents, 10-59
file or recording to a phrase, 6-12
guest mailbox, 4-15
mailboxes, 4-2
NameNet entries, 9-16
nodes, 9-3
OctelNet node, 9-7
parts of a phrase to another phrase, 6-12
text comments for phrase, 6-17
Visual Mailbox, 12-1

Administered AMIS, 4-43, 9-2

Advance to Next Menu (V-Tree action), 10-19

Afternoon prompt, 5-2

AMIS, 2-12, 9-2

Ampersand (&) dialing code, 4-47

Assigning prompts to V-Trees, 10-37
assigning existing prompts to a V-Tree, 10-37
recording a new prompt for a V-Tree, 10-38

Attendant Menu options
directory, 5-10
fax, 5-10
mailbox number, 5-10
message, 5-10

Attendant Menu
definition of prompt, 5-2

setting up, 5-8

Audiotext, 2-11

Auto-forwarding messages, 2-8, 4-19
from one mailbox to another, 4-20
from one system to another system, 4-21
not working, 11-3

Automated attendant, definition of, 2-2

Automatic Date and Time, 2-7, 4-41
not working, 11-4

Automatic station login and password, 2-7

B

B dialing code, 4-47

Batch Mode Delivery Option, 4-42

Beeper notification, 2-5

Blocking calls to a mailbox, 4-29

Business hours
closed all day, 5-4
open all day, 5-4
setting up, 5-3

C

C dialing code, 4-48

Call Analysis does not work, 11-4

Call blocking, 2-2
setting options, 4-29

Call forwarding, 2-2
not working, 11-5

Call handling, 4-29
activating/deactivating for V-Trees, 10-40
busy options, 4-29
call blocking, 2-2
call forwarding, 2-2, 4-29
call queuing, 2-2
call screening, 2-2
does not work, 11-6
no answer options, 4-29
understanding prompts voiced under specific call

handling conditions, 11-29

Call queuing, 2-2, 4-36
definition of prompt, 5-2
does not work, 11-6
setting up, 5-12
setting up in a mailbox, 4-30

Call routing V-Trees, 2-11
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Call screening, 2-2, 4-36
not working, 11-7

Caller hears, ”There is a line problem”, 11-14

Callers are disconnected, 11-4

Callers cannot transfer, 11-5

Calls Per Hour screen, 8-4

Casual AMIS, 4-43, 9-2

Changing
class of service in a mailbox, 4-35
number of a fax retrieval document, 10-61
subscriber settings, 4-27
system manager passwords, 3-3
V-Edit display, 6-6
V-Tree display, 10-56

Channel Status window, 8-2

Class of Service, 4-35
Auto Time-Date Voiceback, 4-41
Call Handling, 4-38
Call Queuing, 4-36
Call Screening, 4-36
cannot change, 11-15
Class of Service report, 7-13
custom, 4-35
Delivery Options, 4-42
Dial by Name, 4-38
Enable Multilingual Support, 4-41
Failed Login Notification, 4-40
Fax Options, 4-44
Fax V-Tree, 4-39
folders, 4-36
Global Group Lists, 4-38
Intercom Paging, 4-37
Language Selection, 4-44
Locate Messages Received, 4-40
Locate Messages Sent, 4-40
Max Rings, 4-45
Mailbox Lock-Out Option, 4-40
Max Messages, 4-45
Message Confirmation, 4-36
Message Indicators, 4-37
Msg Time , 4-45
Networking Options, 4-42
New Message, 4-46
Operator Access, 4-40
Personal Group List, 4-37
Receive Messages, 4-39
Record Prompts, 4-40
Save Messages, 4-39
Saved Messages, 4-46
Send Messages, 4-39
Supervisor, 4-41
Undelete Messages, 4-39
Visual Mailbox, 4-41
V-Tree, 4-39

Clearing mailbox information, 4-31

Client software (Visual Mailbox)
definition of, 12-2
installing from diskette, 12-3

Comma (,) dialing code, 4-47

Compressing phrase files, 6-16

Copying
V-Tree file to a mailbox, 10-44
V-Tree menu options to the clipboard, 10-52

Cover page (fax retrieval), 10-63

Creating
AMIS node, 9-4
duplicating a single mailbox, 4-6
duplicating multiple mailboxes, 4-11
guest mailbox, 4-15
mailbox V-Trees using Visual Architect, 10-4
multiple mailboxes, 4-8
nodes, 9-3
OctelNet node, 9-7
single mailbox, 4-3
V-Tree file from a mailbox V-Tree, 10-7
V-Tree file with the Toolkit, 10-12
V-Trees, 10-3
V-Trees using the phone, 10-18
V-Trees using Visual V-Tree, 10-16

Custom class of service options, 4-35

Cutting V-Tree menu options to clipboard, 10-52

D

D dialing code, 4-47

Daily business hours
closed all day, 5-4
open all day, 5-4
selected hours, 5-4
setting up, 5-3

Daylight saving time, not working, 11-7

Deactivating
node, 9-13
ports, 3-5
V-Tree for a mailbox, 10-42

Defining V-Tree actions, 10-18

Deleting
fax retrieval documents, 10-64
mailboxes, 4-17
NameNet entries, 9-20
nodes, 9-13
parts of a phrase, 6-13
statistical information from reports, not working,

11-25
text comments for a phrase, 6-19
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trimming parts of a phrase, 6-13
V-Tree files, 10-55
V-Tree from a mailbox, 10-54
V-Tree options, 10-53
V-Trees, 10-54

Delivery Options, 4-42
Batch Mode, 4-42
Local Only, 4-42
Long Distance, 4-42
Not Allowed, 4-42

Dial by Name, 4-38, 5-10
extension directory, 2-3

Dialing codes, 4-47

Disabling ports. See Deactivating ports

Disconnect (V-Tree action), 10-34

Disconnect signal, determining, 11-27

Disconnected callers, 11-4

Disconnects are not recognized properly, 11-7

Displaying
100% Contention screen, 8-6
50% Contention screen, 8-5
Calls Per Hour screen, 8-4
Channel Status window, 8-2
Class of Service report, 7-13
features enabled on the sentinel, 11-27
Login Failure report, 7-9
Mailbox Information report, 7-7
Mailbox Quick List report, 7-3
Mailbox Status screen, 8-2
Mailbox Usage report, 7-5
Network Statistics report, 7-16
phrase file information, 6-15
PLUS.LOG file, 11-28
Port Assignments report, 7-12
Prompt Assignments report, 7-14
reports, 7-3
system statistics, 8-1
System Status dialog box, 8-7
System Usage screen, 8-4
Uninitialized Mailboxes report, 7-11
V-Edit windows, 6-6
V-Trees, 10-56

Distribution Lists (group lists) , 2-8, 4-37
not working, 11-9

Dropping calls, 3-5

DTMFs are not recognized properly, 11-9

Duplicating mailboxes
multiple mailboxes, 4-11
single mailbox, 4-6

E

Economy Dispatch, 4-43

Editing
mailbox, not working, 11-15
mailboxes, 4-16
nodes, 9-12
sent message, 2-6
sent message, not working, 11-16
V-Trees, 10-51

Enabling ports. See Activating, ports

ENGLISH1.O32 and ENGLISH2.O32, 6-8

Entering
NameNet entries, 9-16
text comments for phrase, 6-17

Evening prompt, 5-2

Exporting a mailbox V-Tree to a file, 10-47

Extension Directory (dial-by-name), 2-3

F

Failed Login Notification, 4-40

Fax on Demand V-Trees, 10-32

Fax V-Tree, 4-39

Fax
adding fax retrieval documents, 10-59
AutoPrint, 2-11
AutoPrint, not working, 11-10
changing the number of a fax retrieval document,

10-61
cover page, 10-63
definition of fax retrieval, 2-12
deleting fax retrieval documents, 10-64
fax features, not working, 11-10
Fax Mail, 2-10
fax retrieval, 10-59
fax retrieval, not working, 11-10
Fax Solution, 2-4, 2-10
Fax Tone Transfer, 2-3
mailbox options, 4-44
receive faxes in mailbox, 4-45
send faxes from mailbox, 4-44
setting up a cover page for faxes, 10-63
updating a fax retrieval document, 10-61

Fax-on-Demand V-Trees, 2-11, 10-30

Fifty Percent (50%) Contention screen, 8-5

Folders, 2-9, 4-36
not working, 11-11

Follow-Me-Forward, 4-44
not working, 11-11
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Forced password change, 2-10

Forms Filler V-Trees, 2-11, 10-23

Forwarding network messages, 2-8

Future delivery message dispatch, 2-6

G

Generating
Class of Service report, 7-13
Login Failure report, 7-9
Mailbox Information report, 7-7
Mailbox Quick List report, 7-4
Mailbox Usage report, 7-5
Network Statistics report, 7-16
Port Assignments report, 7-12
Prompt Assignments report, 7-15
reports, 7-1
Uninitialized Mailboxes report, 7-11
V-Trees, 2-12

Global Group Lists, 4-38

Go to Directory Services (V-Tree action), 10-36

Go to Extension Entry Point (V-Tree action), 10-35

Go to Mailbox Login Point (V-Tree action), 10-34

Go to Voice Mail (V-Tree action), 10-35

Greeting by port does not work, 11-12

Greeting by Port, 2-3
definition of prompt, 5-2
setting business hours, 5-6
setting up, 5-4

Greetings. See Prompts
not working, 11-12

Guest mailbox, 2-9, 4-15

H

H dialing code, 4-47

Highest Outgoing Dispatch, 4-43
Economy, 4-43
Not Allowed, 4-43
Priority, 4-43
Standard, 4-43

Holiday greetings
definition of prompt, 5-2
not working, 11-12
setting up, 5-11

Hyphen (-) dialing code, 4-47

I

Importing a V-Tree file to a mailbox, 10-44

Inband/DID integration, not working, 11-13

Installing
client software, 12-2
Visual Mailbox, 12-2

Integrated telephone answering, 2-8

Intercom paging, 2-3, 4-37
not working, 11-13

Intercom redirect, 2-3

Interpreting
100% Contention screen, 8-7
50% Contention screen, 8-6
Calls Per Hour screen, 8-4
Channel Status window, 8-2
Class of Service report, 7-14
Login Failure report, 7-10
Mailbox Information report, 7-7
Mailbox Quick List report, 7-4
Mailbox Status screen, 8-3
Mailbox Usage report, 7-6
Network Statistics report, 7-17
Port Assignments report, 7-13
Prompt Assignments report, 7-15
System Status dialog box, 8-7
System Usage screen, 8-5
Uninitialized Mailboxes report, 7-11
view sentinel information, 11-28

Interview V-Trees, 2-11, 10-23

K

Keypad prompt recording functions, 6-2

L

Language selection
definition of prompt, 5-2
for mailbox, 4-44
setting up, 5-6

Launching the system, 3-2

Local Only Delivery Option, 4-42

Locate messages
received in mailbox, 4-40
sent from mailbox, 4-40

Locating mailboxes, 4-19

Locked mailbox. See Unlocking a mailbox

Logging into a mailbox, not working, 11-15

Logging into the system, 3-2
using the phone, 3-3
using the screen, 3-3

Logging off the system, 3-4
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Login Failure report, 7-9

Long Distance Delivery Option, 4-42

M

M dialing code, 4-48

M2000 System
troubleshooting, 11-1

Mailboxes
Auto Time-Date Voiceback, 4-41
auto-forwarding messages to, 4-19
call blocking options, 4-29
Call Handling, 4-38
Call Queuing, 4-36
Call Screening, 4-36
class of service, cannot change, 11-15
class of service, selecting, 4-35
clearing information from, 4-31
considerations for creating, 4-2
creating, 4-2
creating a guest mailbox, 4-15
creating a single mailbox, 4-3
creating multiple mailboxes, 4-8
creating V-Tree for, 10-4
days to save a message, 4-46
default operators, 2-5
deleting V-Trees from, 10-54
Delivery Options, 4-42
Dial by Name, 4-38
deleting, 4-17
duplicating a single mailbox, 4-6
editing, 4-16
editing, not working, 11-15
Failed Login Notification, 4-40
Fax Options, 4-44
Fax V-Tree, 4-39
folders, 4-36
Global Group Lists, 4-38
guest mailboxes, 2-9, 4-15
Intercom Paging, 4-37
Language Selection, 4-44
Locate Messages Received, 4-40
Lock-Out Option, 4-40
locate messages sent, 4-40
logging into a mailbox, not working, 11-15
mailbox features, not working, 11-15
Mailbox Information report, 7-7
mailbox is full, 11-16
mailbox passwords, 2-10
Mailbox Quick List report, 7-3
Mailbox Status screen, 8-2
Mailbox Usage report, 7-5
mailboxes not included in reports, 11-25
managing, 4-1
maximum number of messages, 4-45
maximum number of rings, 4-45
Message Confirmation, 4-36

Message Indicators, 4-37
message time, 4-45
Multilingual Support, 4-41
Network Options, 4-42
not working, 11-15
opening a mailbox V-Tree, 10-44
Operator Access, 4-40
personalization features, 2-5
prompts, not working, 11-16
receive-only, 2-9
Receive Messages, 4-39
Record Prompts, 4-40
Save Messages, 4-39
searching for, 4-19
security features, 2-10
Send Messages, 4-39
specific busy and no answer greetings, 2-5
subscriber settings, 4-27
Supervisor, 4-41
Undelete Messages, 4-39
Uninitialized Mailboxes report, 7-11
unlocking, 4-33
viewing information, 4-18
Visual Mailbox, 4-41
voice-only, 2-9
V-Tree, 4-39

Managing
fax retrieval documents, 10-59
mailboxes, 4-1
messages, 2-8
phrase files, 6-15
subscriber settings, 4-27

Maximum
message length, 4-45
number of messages in mailbox, 4-45
number of rings for mailbox, 4-45

Menu options (V-Tree)
copying to the clipboard, 10-52
cutting to the clipboard, 10-52
deleting, 10-53
pasting from the clipboard, 10-53

Message notification sample scenarios, 4-26

Message, 2-7
auto-forwarding, 2-8
Confirmation, 4-36
days to save a message in mailbox, 4-46
deletion notification, 2-7
editing sent message, not working, 11-16
fast forward, 2-7
features, 2-5
hold, 2-7
locate messages received in mailbox, 4-40
locate messages sent from mailbox, 4-40
managing, 2-8
maximum length in mailbox, 4-45
maximum number in mailbox, 4-45
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message confirmation, 2-6
message confirmation, not working, 11-17
message includes clicking noise, 11-17
Message Indicators, 2-7, 4-37
message indicators, not working, 11-18
message notification, 2-5
message notification, not working, 11-20
message notification prompt, definition of, 5-2
message retrieval, 2-7
network forwarding, 2-8
receiving from other voice mail systems, 9-3
recovering deleted messages, 2-8
rewind, 2-7
saving, 2-8
saving messages, not working, 11-17
scanning for, 2-7
sending copies of, 2-9
sending options, 2-6
sending to another voice system, 9-2
setting up Message Notification prompts, 5-13
skipping, 2-8
speed control, 2-7
vanishing messages, 11-17
volume control, 2-7

Morning prompt, 5-2

Multilingual
greetings, not working, 11-12
prompts, 2-4
support, 4-41

Multiple message capability, 2-6

N

N dialing code, 4-47

Name prompt on transfer, 2-3

NameNet
definition of, 9-16
deleting an entry, 9-20
entering a new entry, 9-17
marking an entry as permanent, 9-18
not working, 11-22

Network Messaging, 9-1

Network
AMIS, 9-2
message forwarding, 2-8
Network Statistics report, 7-16
OctelNet, 9-2
receiving messages, 9-3
sending messages, 9-2

Networking Options (Class of Service), 4-42
Aministered AMIS, 4-43
Casual AMIS, 4-43
Delivery Options, 4-42
Follow-Me-Forward, 4-44

Highest Outgoing Dispatch, 4-42
Network Reply, 4-44
OctelNet, 4-43

New messages in mailbox, 4-46

Node
activating, 9-15
AMIS, 9-4
creating, 9-3
deactivating, 9-13
deleting, 9-13
editing, 9-12
entering NameNet entries for, 9-17
OctelNet, 9-7
receiving messages, 9-3
searching for, 9-16
sending messages to, 9-2

Not Allowed
Delivery Option, 4-42
Network Dispatch Option, 4-43

O

OctelNet, 2-13, 4-43, 9-2
not working, 11-22

Office closed prompt, 5-2

One Hundred Percent (100%) Contention screen, 8-6

Online system displays and reports, 2-9

Opening
phrase files, 6-8
V-Tree, 10-43
V-Tree file from outside a mailbox, 10-46

Operator
Operator access, 4-40
Operator gets blank messages, 11-23

P

P dialing code, 4-48

Passwords
mailbox, 2-10
protection, 2-10
V-Tree, 2-10

Pasting a V-Tree menu option, 10-53

PC audio, 12-2

PC is locked up, 11-23

Personal default fax number, 2-10

Personal Group Lists, 4-37

Personalized prompts, 2-5
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Phrase files
compressing, 6-16
displaying information about, 6-15
managing, 6-15
opening, 6-8
saving phrases into another phrase file, 6-15
selecting a phrase, 6-8
understanding, 6-8

Phrase. See Prompts

Plus (+) dialing code, 4-47

Port
Port Assignments report, 7-12
ports come off hook when there are no calls, 11-24

Primary language selection, 5-7

Printing
reports, 7-2
text comments for a phrase, 6-18
V-Trees, 10-56

Priority Dispatch, 4-43

Product information sources, 1-3

Prompts
assigning to V-Trees, 10-37
Attendant Menu, 5-8
Call Queuing, 5-12
definitions of, 5-2
Greeting by Port, 5-4
Holiday Greetings, 5-11
Language Selection, 5-6
mailbox prompts, not working, 11-16
Message Notification, 5-13
Network Node, 5-13
Prompt Assignments report, 7-14
recording, 6-1
System Greeting, 5-2
understanding, 5-2

R

R dialing code, 4-47

REC Directory,storing prompts in, 6-2

Receive
faxes in mailbox, 4-45
messages in mailbox, 4-39
messages from other voice mail systems, 9-3

Receive-only mailboxes, 2-9

Record to Mailbox and Advance (V-Tree action),
10-23

Record to Mailbox and Return to Previous Level
(V-Tree action), 10-22

Recording phrases (V-Edit)
group of phrases, 6-11

single phrase, 6-10

Recording system prompts
mailbox prompts, 4-40
using SOLVE, 6-3
using the keypad prompt recording functions, 6-2
using V-Edit, 6-4
V-Tree prompts, 10-38

Recover deleted messages, 2-8

Removing
deleting parts of a phrase, 6-13
trimming parts of a phrase, 6-13

Reports
Class of Service, 7-13
displaying onscreen, 7-3
Login Failure, 7-9
Mailbox Information, 7-7

Mailbox Quick List, 7-3
Mailbox Usage report, 7-5
mailboxes not included in reports, 11-25
Network Statistics, 7-16
not working, 11-24
Port Assignments, 7-12
printing, 7-2
Prompt Assignments, 7-14
saving to disk, 7-2
Uninitialized Mailboxes, 7-11

Require Password to Proceed to Next Level (V-Tree
action), 10-25

Requirements for Visual Mailbox subscriber PC, 12-2

Responsibilities of system manager, 1-2

Return to Previous Menu (V-Tree action), 10-21

Review/Edit Message and Advance (V-Tree action),
10-27

Rings, maximum number of for mailbox, 4-45

S

Saving
days to save messages in mailbox, 4-46
saving messages in mailbox, 4-39
range of phrases into a phrase file, 6-15
reports, 7-2
saving messages, not working, 11-17
V-Tree files, 10-49
V-Trees, 10-47

Scanning for messages, 2-7

Searching
for a mailbox, 4-19
for a node, 9-16

Secondary languages selection, 5-7
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Selecting
phrases by number, 6-9
phrases from a list, 6-9
phrases in a phrase file, 6-9
primary language, 5-7
secondary language, 5-7

Send a Predefined Fax and Advance (V-Tree action),
10-32

Send a Requested Fax and Advance (V-Tree action),
10-30

Send
copy of message, 2-9
faxes from mailbox, 4-44
messages from mailbox, 4-39
messages to other voice mail systems, 9-2

Sending options, 2-6

Sent message editing, 2-6

Serial Integration utility
Serial Integration (SMDI) does not work, 11-26

Setting up
Attendant Menu, 5-8
auto time-date voiceback, 4-30
auto-forwarding, 4-19
call blocking, 4-29
call handling, 4-29
Call Queuing prompts, 5-12
call screening, 4-30
cover page for faxes, 10-63
daily business hours, 5-3
follow-me-forward, 4-21
Greeting by Port, 5-4
Holiday Greetings, 5-11
intercom paging, 4-28
Language Selection prompt, 5-6
Message Notification prompts, 5-13
multilingual system, 5-6
Network Node prompts, 5-13
nodes, 9-3
primary language, 5-7
secondary languages, 5-7
System Greetings, 5-2
system prompts, 5-1
V-Tree display options, 10-57
V-Tree prompts, 10-37
Visual Mailbox, 12-2

Sharing OPC, 5-4

Shutting down
SOLVE, 6-4
system, 3-4
V-Edit, 6-19

Skip messages, 2-8

SOLVE, 6-2
recording prompts, 6-4

rerecording prompts, 6-4
shutting down, 6-4
starting, 6-3

Specialty mailboxes, 2-9

Specifying settings for prompts, 5-1

Standard Dispatch, 4-43

Starting
SOLVE, 6-3
System, 3-2
V-Edit, 6-5
Visual Architect, 10-12

Statistics
100% Contention screen, 8-6
50% Contention screen, 8-5
Calls Per Hour screen, 8-4
Channel Status window, 8-2
Mailbox Status screen, 8-2
System Status dialog box, 8-7
System Usage screen, 8-4

Subscriber settings, 4-27

Supervised transfers do not work, 11-9

Supervisor mailbox, 4-41
accessing, 3-3

Supervisor’s Online Voice Editor. See SOLVE

System greetings, 2-3
definition of prompt, 5-2
setting up, 5-2

System manager, definition of, 1-2

System security
changing system manager passwords, 3-3
disabling ports, 3-5
enabling ports, 3-5
features, 2-10
forced password change, 2-10
logging off the system, 3-4
mailbox password, 2-10
shutting down the system, 3-4
system manager passwords, 3-2
unlocking a mailbox, 4-33
V-Tree passwords, 2-10

System Status dialog box, 8-7

System Usage screen, 8-4

T

T dialing code, 4-48

Telephone interface, 2-4

Text comments
deleting for a phrase, 6-19
entering for phrase, 6-17
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exporting for a phrase, 6-18
importing for phrase, 6-17
printing for a phrase, 6-18

Text window (V-Edit), 6-7

Toolkit. See Visual Architect Developer’s Toolkit

Transfer messages or reply to sender, 2-9

Transfer to a Mailbox (V-Tree action), 10-36

Troubleshooting, 11-1

U

Undelete messages in mailbox, 4-39

Understanding
automated attendant, 2-2
phrase files, 6-8
system prompts, 5-2
system security, 3-2
V-Trees, 10-2
voice/fax mail features, 2-4

Uninitialized Mailboxes report, 7-11

Unlocking a mailbox, 4-33

Updating a fax retrieval document, 10-61

Using
Network Messaging, 9-1
Visual Architect, 10-4

V

V-Edit, 6-2
changing the display, 6-6
compressing phrase files, 6-16
connecting to, 6-5
controlling silence before and after a phrase, 6-14
copying a phrase, 6-12
creating text comments, 6-17
cutting a phrase, 6-12
deleting a part of a phrase, 6-13
deleting text comments for a phrase, 6-19
displaying phrase file information, 6-15
displaying text comments, 6-17
entering text comments for phrase, 6-17
exporting text comments for a phrase, 6-18
importing text comments for phrase, 6-17
inserting a file into a phrase, 6-12
inserting a recording into a phrase, 6-12
managing phrase files, 6-15
opening phrase files, 6-8
pasting a phrase, 6-12
printing text comments, 6-18
recording a group of phrases, 6-11
recording a phrase, 6-10
replacing a phrase, 6-12
saving phrases into another phrase file, 6-15

selecting a phrase, 6-8
shutting down V-Edit, 6-19
starting, 6-5
trimming a phrase, 6-13

Viewing
100% Contention screen, 8-6
50% Contention screen, 8-5
Calls Per Hour screen, 8-4
Channel Status window, 8-2
Class of Service report, 7-13
Login Failure report, 7-9
mailbox information, 4-18
Mailbox Information report, 7-7
Mailbox Quick Llist report, 7-3
Mailbox Status screen, 8-2
Mailbox Usage report, 7-5
Network Statistics report, 7-16
Port Assignments report, 7-12
Prompt Assignments report, 7-14
reports, 7-3
system statistics, 8-1
System Status dialog box, 8-7
System Usage screen, 8-4

Visual Architect Developer’s Toolkit
creating V-Trees, 10-4

Visual Architect, 2-12
V-Trees do not print, 11-26

Visual Mailbox, 2-4, 4-41
client software installation, 12-2
client software installation template, 12-5
PC audio, 12-2
setting up subscriber PCs, 12-3
subscriber PC requirements, 12-2

Visual Voice Editor. See V-Edit

Visual V-Tree, 2-12

Voice folders. See Folders

Voice message cover sheets, 2-11

Voice window (V-Edit), 6-7

Voice-only mailboxes, 2-9

V-Tree actions, 10-18
Advance to Next Menu, 10-19
Disconnect, 10-34
Go to Directory Services, 10-36
Go to Extension Entry Point, 10-35
Go to Mailbox Login Point, 10-34
Go to Voice Mail, 10-35
Record to Mailbox and Advance, 10-23
Record to Mailbox and Return to Previous Level,

10-22
Require Password to Proceed Next Level, 10-25
Return to Previous Menu, 10-21
Review/Edit Message and Advance, 10-27
Send a Predefined Fax and Advance, 10-32
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Send a Requested Fax and Advance, 10-30
summary table, 10-19
Transfer to a Mailbox, 10-36

V-Trees, 2-11, 4-39, 10-1
action summary table, 10-19
actions, 10-18
activating for a mailbox, 10-40
assigning prompts to, 10-37
call routing, 2-11
changing V-Tree display, 10-56
changing V-Tree magnification, 10-57
copying a V-Tree file to a mailbox, 10-44
copying V-Tree menu options, 10-52
creating, 10-3
creating a V-Tree file for use in other mailboxes,

10-7
creating mailbox V-Tree using Visual Architect,

10-4
creating using the phone, 10-18
creating using Visual V-Tree, 10-16
creating V-Tree file with Toolkit, 10-12
cutting menu options to the clipboard, 10-52
deactivating for a mailbox, 10-42
deleting, 10-54
deleting from a mailbox, 10-54
deleting options, 10-53
deleting V-Tree files, 10-55
do not work, 11-2
editing, 10-51
editing actions, 10-52
expanding and collapsing V-Tree menus, 10-58
fax retrieval, 2-12
fax-on-demand, 2-11
forms-filler, 2-11
hiding and displaying blank V-Tree options, 10-58
interview, 2-11
opening, 10-43
opening a V-Tree file from outside a mailbox, 10-46
options, 10-18
pasting menu options, 10-53
printing, 10-56
saving, 10-47
saving a V-Tree file, 10-49
saving a V-Tree file to another file, 10-49
saving mailbox V-Tree to a file, 10-47
understanding, 10-2
Visual Architect, 2-12
Visual V-Tree, 2-12

W

W dialing code, 4-47

Wake-Up messages, 2-6

X

X dialing code, 4-47
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